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lafIa;%j,  YS>% ÈhqKqj;a iuÕ j;auka isiq ore oeßhka yuqfõ kj wNsfhda. /ila ks¾udKh ù 

;sfí' wo iudcfha mj;sk /lshdj, iajNdjh kqÿre wkd.;fha § iqúfYaIS fjkialï /ilg 

,la jkq we;' tjka jgmsgdjla ;=< kj ;dlaI‚l oekqu iy nqoaêh flakaø lr.;a iudchl 

fjkia wdldrfha /lshd wjia:d o ,laI .Kkska ks¾udKh jkq we;' ta wkd.; wNsfhda. 

ch.ekSu fjkqfjka" Tn iún, .ekaùu wOHdmk wud;Hjrhd f,i uf.a;a" wm rcfha;a m%uqL 
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ukdj mßYS,kh lsÍu;a" bka wjYH oekqu Wlyd .ekSu;a Tfí taldhk wruqK úh hq;= h'  

tfuka u Tfí ujqmshka we;=¿ jeäysáhkaf.a Y%ufha iy lemlsÍfï m%;sM,hla f,i rch úiska 

fkdñf,a mdi,a fm<fmd;a Tn w;g m;a lrkq ,nk nj o Tn jgyd .; hq;= h' 

 f,dalh fõ.fhka fjkia jk jgmsgdjl" kj m%jK;dj,g  .e<fmk whqßka kj úIh 

ud,d ilia lsÍug;a" wOHdmk moaO;sh ;=<  ;SrKd;aul fjkialï isÿ lsÍu i|yd;a rchla 

f,i wm lghq;= lrkafka rgl wkd.;h wOHdmkh u;ska isÿ jk nj wm fyd¢ka u wjfndaO 

lrf.k isák neúks' ksoyia wOHdmkfha Wmßu m%;sM, N=la;s ú¢ñka" rgg muKla fkdj 

f,djg u jevodhS Y%S ,dxlsl mqrjeishl= f,i keÕS isákakg Tn o wÈgka lr.; hq;=  jkafka 

tneúks' ta i|yd fï fmd; mßYS,kh lsÍfuka Tn ,nk oekqu o bjy,a jkq we;s nj uf.a 

úYajdihhs'  

 rch Tfí wOHdmkh fjkqfjka úhoï lrk w;súYd, OkialkaOhg jákdlula tla 

lsÍu o Tfí hq;=lula jk w;r" mdi,a wOHdmkh yryd Tn ,nd .kakd oekqu yd l=i,;d Tfí 

wkd.;h  ;SrKh lrk nj o Tn fyd¢ka wjfndaO lr .; hq;= h' Tn iudcfha l=uk 

;rd;srul isáh o ish¨ ndOd ì| ouñka iudcfha by< u ia;rhlg .uka lsÍfï yelshdj  

wOHdmkh yryd Tng ysñ jk nj o Tn fyd¢ka wjOdrKh lr .; hq;= h' 

 tneúka ksoyia wOHdmkfha Wmßu m%;sM, ,nd" f.!rjkSh mqrjeishl=  f,i fyg f,dj 

Èkkakg;a foaY foaYdka;rj, mjd Y%S ,dxflah kduh nn<jkakg;a Tng yels fõjdæ hs wOHdmk 

wud;Hjrhd f,i uu Y=N m%d¾:kh lrñ'  
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fkdñf,a fnod yeÍu msKsihs 1

fuu mdvu yeoEÍfuka Tng"

²² .eg¨jla úYaf,aIKh lsÍu yd .eg¨jla i|yd we,af.dß;u f.dv ke.Su

²² md,k jHqyh yd tAjdfha wjYH;dj 

²² .e,Sï igyka we£u" jHdc fla; ,sùu iy tajd w;r mßj¾;k lsÍu

²² .eg¨jla i|yd úl,am úi÷ï fiùu

²² úp,H yd ksh; 

²² meial,a l%uf,aLk NdIdj 

²² l%uf,aL NdIdj, mßKduh 

    		  ms<sn| j wjfndaOhla ,nd .ekSug yels jkq we;'
	

1'1   .eg¨jla úYaf,aIKh lsÍu
		
	 .eg¨jla úi£u i|yd fhdod.kakd wuqøjH wdodk ^Input& f,i ye¢kafõ' 

th úi£fuka ,nd .kakd m%;sM,h" m%;sodkh ^Output& f,i ye¢kafõ' wdodk" 

m%;sodk njg m;alsÍu" l%shdj,sh fyj;a ieliSu ^Process& f,i ye¢kafõ' 

l%shdj,shla mshjfrka mshjr isÿ jk w;r tajd wkqms<sfj<lska oelaùu b;d jeo.;a 

fõ' .eg¨jla úYaf,aIKh lsÍfï § tys wdodk" l%shdj,sh yd m%;sodk fjka fjka j 

y÷kd .kq ,nhs' 

WodyrK -
.eg¨j 1 (

 	;eme,a lsÍug iqÿiq ,smshla iE§u

	 wdodk (     	 ,smsh ,sùug iqÿiq fld<hla iy mEkla

		      	 ,shqï ljrhla iy uqoaor

		      	 ue,shï

	 l%shdj,sh ( 	 1' ,smsh ,sùu 

		      	 2' ,smsh kjd ,shqï ljrhg nyd ,Su

			   3' ,shqï ljrh we,ùu

			   4' hd hq;= ,smskh ,shqï ljrfha ,sùu

			   5' uqoaor we,ùu

	 m%;sodkh (	 ;eme,a lsÍug iqÿiq ;;a;ajfha mj;sk ,smshla

	 igyk ( 	 fuu l%shdj,sfha mshjr wxl 4 iy 5 yqjudre lr isÿ l< yels h'  

			   tfy;a wfkl=;a mshjr wkqms<sfj<ska u isÿ l< hq;= fõ'

1 .eg¨ úi£ug l%uf,aL ,sùu
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.eg¨j 2 (  rij;a f;a fldamamhla ms<sfh, lsÍu

      

	 wdodk (  	 f;a fld<" iSks" WKq c,h 

	 l%shdj,sh ( 	 1' f;a fld< fmrkhg oeóu

			   2' fmrkh ;=<ska WKq c,h fldamamhg 

			      oeóu

			   3' iSks álla f;a fldamamhg oeóu

			   4' yekafoka f;a fldamamfhys jQ iSks Èh lsÍu 

			   5' yekafoka f;a iaj,amhla f.k rih mÍlaId lsÍu

			   6' rih m%udKj;a fkdfõ kï mshjr wxl 3g hdu iy 4  

			      iy 5 mshjr kej; isÿ lsÍu'

	 m%;sodkh (	 rij;a f;a fldamamh

.eg¨j 3 (  fmd;a md¾i,hl we;s msgq 40 iy msgq 80 fmd;a ms<sfj<ska  

		          i÷ks iy wkQmu hk ifydaorhka fofokd w;r fn§u

	 wdodkh ( 	 fmd;a md¾i,h

	 l%shdj,sh ( 	 1' fmd;a md¾i,h újD; lsÍu

			   2' md¾i,fhka fmd;la .ekSu

			   3' msgq ixLHdj 40 kï i÷ksg §u

			   4' msgq ixLHdj 80 kï wkQmug §u

			   5' md¾i,fha we;s fmd;a wjika jk f;la   

			      mshjr wxl 2 fj; hdu

	 m%;sodkh (	 i÷ksg msgq 40 fmd;a ,eîu

			   wkQmug msgq 80 fmd;a ,eîu

.eg¨j 4 (  ixLHd foll tl;=j fiùu

	 wdodk ( 	 ixLHd fol 

	 l%shdj,sh ( 	 ixLHd fol tl;= lsÍu

	 m%;sodkh ( 	 tl;=j

 

.eg¨j 5 (  RcqfldaKdi%hl j¾.M,h fiùu

È.

j¾.M,h m<,

	 wdodkh (	 RcqfldaKdi%fha È. yd m<, 

	 l%shdj,sh ( 	 j¾.M,h } È. × m<,

	 m%;sodkh ( 	 j¾.M,h
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.eg¨j 6 (  ixLHd follska úYd, ixLHdj fiùu

	 wdodkh ( 	 ixLHd fol 

	 l%shdj,sh ( 	 ixLHd fol iei£fuka úYd, ixLHdj wkdjrKh lsÍu

	 m%;sodkh ( 	 úYd, ixLHdj

.eg¨j 7 (  ixLHdjla T;af;a o brÜfÜ o hkak fiùu

T;af;a ixLHd

brÜfÜ ixLHd

	 wdodkh ( 	 ixLHdj

	 l%shdj,sh ( 	 ixLHdj foflka fnod fYaIh 

			   fiùu	

			   fYaIh } 0 kï brÜfÜ ixLHdjla nj ;SrKh lsÍu

			   fYaIh } 1 kï T;af;a ixLHd‍jla nj ;SrKh lsÍu

	 m%;sodkh ( 	 ixLHdj T;af;a fyda brÜfÜ nj oelaùu

ls%hdldrlu   

1'	 fgd*s 100la 20 fofkl= w;f¾ iu iu j fn§u iïnkaOfhka 

wdodkh" l%shdj,sh iy m%;sodkh ,shd olajkak'

2'	 irex.,hla iE§u i|yd wdodkh" l%shdj,sh iy m%;sodkh olajkak'

úl,am úi÷ï y÷kd.ekSu

	 .eg¨jla i|yd úi÷ï tllg jvd jeäfhka mj;S kï tajd úl,am úi÷ï 

f,i ye¢kafõ' fuh .eg¨fõ iajNdjh u; ;SrKh jkakls'
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ksoiqk

Tn mdi,g meñfKkafka mdi,a nihlska hehs is;kak' mdi,g meñfKñka isák 

úg nia r:fha fodaIhla ksid w;ru. kej;=‚ kï Tng mdi, fj; meñŒug 

yels fjk;a l%u .ek is;kjd fka o@ fufia Tn is;kafka mdi, fj; hdug yels 

fjk;a úl,am úi÷ï h'

1' mdi,g tk fjk;a mdi,a nia r:hlska mdi, fj; meñŒu

2' Tn <Õ uqo,a we;s kï ,x.u fyda fm!oa.,sl nia r:hlska mdi, fj; meñŒu

3' mdr Èf.a mhska u .uka lr mdi, fj; meñŒu

4' flá ud¾.hlska mhska .uka lr mdi, fj; meñŒu

5' foujqmshkag fï nj oekaúh yels kï Tjqkaf.a iydh we;s j mdi, fj; meñŒu

6' úYajdijka; wfhl=f.a iydh we;s j fudag¾ r:hlska fyda fudag¾ ihsl,hlska 

   mdi, fj; meñŒu

tÈk wksjd¾hfhka u mdi,g meñŒug wjYH Èkhla kï fuu úl,am úi÷ï 

w;ßka fyd| úi÷ula f;dard .kakjd fka o@

ta wkqj hï .eg¨jlg úi÷ï iuQyhla ^l=,lhla& mj;S kï ta ms<sn| j i,ld n,d 

fyd| úi÷ula f;dard .ekSu jvd;a WÑ; fõ'

fufia .eg¨jlg mj;sk ish¨ úi÷ï" úi÷ï wjldYh (Solution Space) f,i 

ye¢kafõ' mß.Kl l%u f,aLkfha § o úúO úi÷ï y÷kdf.k fyd| u úi÷u 

f;dard .ekSu l< hq;= h' túg ir, flá l%uf,aLkhla ks¾udKh lsÍug yels fõ'

ksoiqk 1

RcqfldaKdi%hl mßñ;sh fiùug we;s úi÷ï wjldYh fidhd n,uq'

fuu .eg¨jg wod< wdodk" m%;sodk iy ieliSu úYaf,aIKh fldg olajuq'

	 wdodk 	 ( 	 RcqfldaKdi%fha È. yd m<, 

	 ieliSu ( 	 mßñ;sh .Kkh lsÍu

	 m%;sodk 	( 	 mßñ;sh

mßñ;sh .Kkh lsÍu i|yd úi÷ï wjldYh fidhuq'

	 1 jk úi÷u' 	mßñ;sh } È. ¬ m<, ¬ È. ¬ m<,

	 2 jk úi÷u' 	mßñ;sh } ^È. × 2& ¬ m<, × 2

	 3 jk úi÷u' 	mßñ;sh } ^È. ¬ m<,& × 2

fuu úi÷ï w;ßka tl;= lsÍu ms<sn| j muKla wjfndaOhla we;s wfhl=g fyd| 

u úi÷u f,i 1 jk úi÷u f;dard .; yels h' .=K lsÍu yd tl;= lsÍu ms<sn| j 

wjfndaOhla we;s wfhl=g fyd| u úi÷u f,i 3 jk úi÷u f;dard .; yels h' 

thg fya;=j tl;= lsÍfï yd .=K lsÍfï ldrl wju m%udKhla mj;sk neúks'
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ksoiqka 2 

YsIHhl= f;dr;=re yd ikaksfõok ;dlaIK úIhh i|yd ,nd .;a ,l=Kq ixLHdj 

35g wvq kï Tyq wiu;a nj fyda 35 fyda Bg jeä kï Tyq iu;a nj o oelaùu 

	 wdodk ( 	 ,l=Kq ixLHdj

	 ieliSu ( 	 ,nd we;s ,l=Kq m%udKh 35 iu. iei£u

 
	      úi÷u 1' 	,l=Kq 35g wvq kï 

				    m%;sM,h } wiu;a

			   tfia fkdfõ kï

				    m%;sM,h } iu;a 

	      úi÷u 2'  ,l=Kq 35 fyda Bg jvd jeä kï  

		          		 m%;sM,h } iu;a

		   	 tfia fkdfõ kï

				    m%;sM,h } wiu;a

	 m%;sodk ( iu;a fyda wiu;a nj

ksoiqka 3 

ixLHd follska úYd, ixLHdj fiùu ^msgq wxl 03ys .eg¨j 06 n,kak'&

wdodkh lrkq ,nk ixLHd fol n1 iy n2 f,i .ksuq'

	 úi÷u 1' 	n1, n2 g jvd úYd, kï úYd, ixLHdj jkafka n1 fõ'

			   n2" n1 g jvd úYd, kï úYd, ixLHdj jkafka n2 fõ'

	 úi÷u 2' 	n1ka n2 wvq lrkak'

	   		  túg ,efnk w.h 0g jvd úYd, kï n1 úYd, ixLHdj fõ'

 	  		  túg ,efnk w.h 0g jvd l=vd kï n2 úYd, ixLHdj fõ'

fufia .eg¨j,g mj;sk úi÷ï w;ßka fyd| úi÷u f;dard .ekSu b;d jeo.;a fõ'
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1'2   .eg¨ úi£u i|yd we,af.dß;u f.dvke.Su

	 .eg¨jla úi£u i|yd wkq.ukh lrkq ,nk mshjr oelaùfï l%uh  

we,af.dß;uhla f,i ye¢kafõ' fuys wjYH;dj jkafka mQ¾j ie,iqula iys; j  

ksjerÈ j .eg¨jlg úi÷ula fiúh yels l%shdud¾.hla oelaùuhs'

WodyrK 1 - ,smshla ;eme,a lsÍu 

	 ^1& ,smsh ,sùu

	 ^2& ,smsh keùu

	 ^3& ,shqï ljrhlg oeóu

	 ^4& ,smskh ,sùu

	 ^5& uqoaor we,ùu

	 ^6& ;eme,a lsÍu

	 by; mshjr ,smshla ;eme,a lsÍu i|yd jQ we,af.dß;uh fõ' fuu  

we,af.dß;ufha ^1&" ^2& iy ^3& jk mshjr wkqms<sfj<sska u isÿ‍l< hq;= h' ^4& iy ^5& 

mshjr udrel< yels h' thg fya;=j ,smskh ,shd uqoaor we,úh yels h' tfuka u 

uqoaorh w,jd ,smskh ,súh yels h'

	 ta wkqj we,af.dß;uhl wkqms<sfj<sska u l%shd;aul l< hq;= mshjr mj;sk 

w;r iuyr úg mshjr lsysmhl wkqms<sfj< fjkia l< o tu.ska bÈßm;a flfrk 

l%shdj,shg ydkshla isÿ fkdfõ'

WodyrK 2 - ;rdÈhlska iSks .a?ï 500la lsrd .ekSu'

^1& iSks ljrhlg oeóu

^2& ;rdÈh u; ;nd mdGdxlh lshùu

^3& iSks .a?ï 500g wvq kï mdGdxlh .a?ï 500g iudk jk 

    ;=re ljrhg iSks ±óu

^4& iSks .a?ï 500g jeä kï mdGdxlh .a?ï 500g iudk jk 

    ;=re ljrfhka iSks bj;a lsÍu

^5& mdGdxlh .a?ï 500 jQ úg iSks ljrh ;rdÈfhka bj;g 

    .ekSu

by; mshjr u.ska iSks .a?ï 500 la lsrd .ekSu i|yd jQ we,af.dß;uh ±lafõ'

ls%hdldrlu   

m%d:ñl mdi,l isiq isiqúhka 183 la isá;s' Tjqka ´¨" fk¿ï iy 

udfk,a f,i ksjdi ;=klg fjka lr ksjdidka;r l%Svd W;aijhla 

meje;aùug úÿy,am;s;=ud ;SrKh lrhs' isiq isiqúhka ksjdij,g fjka 

lsÍu oelafjk we,af.dß;uhla f.dv k.kak'
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1'2'1  we,af.dß;u ixj¾Okh lsÍu i|yd md,k jHqy Ndú;h

	 we,af.dß;uhl l%shdldß;ajh wOHhkh lsÍfï § md,k jHqy (control 
structures) ;=kla y÷kd.; yels fõ'

²² wkql%uh (Sequence)	   

²² jrKh (Selection)		        
					   

²² mqk¾lrKh (Iteration)	       
					   

wkql%uh

	 we,af.dß;uhl msysá mshjr lsysmhla fyda ish,a, u fyda wdrïNl mshjrl 

isg wjidk mshjr olajd by< isg my<g tfl,af,a wkqms<sfj<ska l%shd;aul ùu 

wkql%uh f,i ye¢kafõ'

WodyrK - 

	 1' mäfm<lska .uka lsÍfï § mäfhka mäh ke.Su fyda  

	    neiSu

 

	 2' mdif,a 1 fY%a‚hg we;=<;a jQ isiqka 11 fY%a‚h olajd 

	    wLKav j wOHdmkh ,eîu

ls%hdldrlu   

wkql%uhla iys; ixisoaêka ;=kla i|yka lrkak'

jrKh

	 we,af.dß;uhl we;=<;a fldkafoaishla ;Dma; ùu fyda fkdùu fyda wkqj 

l%shd;aul l< hq;= mshjr l=ula o hkak ;SrKh jk wjia:djla jrKhla f,i 

ye¢kafõ' fuys § jrK folla mj;sk w;r fldkafoaish ;Dma; jkafka kï tla 

jrKhla o ;Dma; fkdjkafka kï wfkla jrKh o f;dard .efka'
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    WodyrK -
	 1'    m<uq fY%a‚hg orefjl= we;=<;a lsÍu:

	     tu jif¾ ckjdß 31 Èkg orejl=f.a jhi wjqreÿ 5g jeä kï 

	    	 mdi,g we;=<;a l< yels h'

	    tfia fkdfõ kï 

	    	 mdi,g we;=<;a l< fkdyels h'

	 2' úIhlska iu;a ùu:
	 ,l=Kq ixLHdj 35 fyda Bg jeä kï

	  	 iu;a fõ

	    tfia fkdfõ kï 

	    	 wiu;a fõ'

	 3' fmd;la ñ, § .ekSu:
	      fmdf;ys ñ,g iudk fyda Bg jeä fyda uqo,la 

	    Tng we;akï

	    	 fmd; ñ, § .; yels h'

	    ke;s kï

	    	 fmd; ñ, § .; fkdyels h'

	
ls%hdldrlu   

1'	 jrKh iys; ixisoaê ;=kla i|yka lrkak'

2'	 Y%S ,dxlsl mqrjeishl=g ish i¾jck Pkao whs;sh ysñ jkafka jhi 

wjqreÿ 18 iïmQ¾K jQ miq j kï my; oelafjk ysia;ekaj,g jvd;a 

.e<fmk jpkh f;darkak'

	 jhi wjqreÿ 18 fyda Bg '''''''''''' ^wvq" jeä& kï

		  Pkaoh m%ldY l< ''''''''''''''''' ^yels h" fkdyels h&

	 ke;skï 

		  Pkaoh m%ldY l< ''''''''''''''''' ^yels h" fkdyels h&

 
mqk¾lrKh

	 we,af.dß;uhl fldkafoaishla ;Dma; jk f;la fyda ;Dma; j mj;sk f;la 

fyda" mshjrla fyda mshjr lsysmhla kej; kej; isÿùuhs'
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WodyrK -
1'	 mka;sNdr .=re;=ud fyda .=re;=ñh YsIH kduf,aLkh ,l=Kq lsÍfï l%shdj,sh 

i,luq'

	 ^1& kdu f,aLkfha uq,ska u we;s ku lshùu

	 ^2& tu isiqjd meñK isà kï 1 f,i igyka  

	     lsÍu

	 ^3& tu isiqjd meñK ke;s kï 0 f,i igyka  

	     lsÍu

	 ^4& B<Õ isiqjdf.a ku w~ .eiSu

	 ^5& kdu f,aLkfha we;s kï wjika jk ;=re  

	     u mshjr 2 fyda 3 iy mshjr 4 isÿlsÍu

2'	 fþohla lshjd tys we;s jpk ixLHdj ‍fiùfï 

l%shdj,sh i,luq'

	 ^1& fþofha wdrïNl jpkh lshùu

	 ^2& jpk ixLHdj } 1 

	 ^3& B<Õ jpkh lshùu

	 ^4& jpk ixLHdjg tlla tl;= lsÍu

	 ^5& fþoh wjika jk ;=re u mshjr wxl 3 iy 4 isÿ lsÍu

	 ^6& fþoh lshjd wjika jQ úg jpk ixLHdj m%ldY lsÍu

ls%hdldrlu   

1'	 mqk¾lrKh iys; isoaê 2la i|yd mshjr jYfhka i|yka lrkak'

2'	 5 isg 60 olajd we;s 5ys .=Kdldr m%ldY lsÍu i|yd jQ mqk¾lrKhg 

wod< ysia;eka mqrjkak'

mshjr 1   n = 5 
mshjr 2   n ys w.h m%ldY lrkak'

mshjr 3   n ys w.hg 5 la tl;= lrkak'

mshjr 4  n ys w.h 60 jk f;la mshjr wxl ''''' iy ''''' isÿ  

		     lrkak'
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1'3   we,af.dß;u bÈßm;a lsÍug úúO fuj,ï Ndú;h

	 we,af.dß;u ks¾udKfha § ir, j yd myiqfjka bÈßm;a lsÍu i|yd;a  

we,af.dß;uh jvd;a fyd¢ka wjfndaO lr .ekSu i|yd;a .e,Sï igyka iy jHdc 

fla; hk fuj,ï Ndú; flf¾'

1'3'1  .e,Sï igyka (Flow charts) 

	 we,af.dß;uh rEmuh wdldrfhka mshjfrka mshjr f.dv kef.k fyda 

f.dv ke.S we;s wdldrh fyda bÈßm;a lsÍu i|yd .e,Sï igyka fhdod .efka' fuys 

§ tla tla l%shdj oelaùu i|yd my; oelafjk ixfla; Ndú; flf¾' ^j.=j 1'1&

j.=j 1'1 - .e,Sï igyka ixfla;

ixfla;h woyi

wdrïNh fyda wjidkh

wdodkh fyda m%;sodkh

l%shdj,sh

;SrKh

.e,Sï ÈYdj

iïnkaOlh

wkql%uh iys; .e,Sï igyka :
	 wdrïNl mshjf¾ isg wjidk mshjr olajd we;s mshjr ish,a, u tlska tl 

wkqms<sfj<lg isÿùu wkql%uhl ,laIKh fõ'
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Wod - 1' jD;a;hl j¾.M,h .Kkh lsÍu

jD;a;fha wrh ,nd .ekSu

jD;a;fha j¾.M,h .Kkh 

lsÍu

jD;a;fha j¾.M,h fmkaùu

wdrïNh

wjidkh

jrKh iys; .e,Sï igyka 

	 fldkafoaishla ;Dma; ùu fyda fkdùu fyda wkqj .e,Sï ÈYdj ;SrKh ùu 

jrKhl we;s úfYaI;ajh hs'

Wod - 	ixLHdjla T;af;a o" brÜfÜ o hkak fiùu

ixLHdj ,nd .ekSu

ixLHdj foflka fnod fYaIh 

fiùu

fYaIh ìxÿj fõ o@

ke; 

T;af;a ixLHdjls                                                               

Tõ 

 brÜfÜ ixLHdjls                                                                                             

wdrïNh

wjidkh
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mqk¾lrK iys; .e,Sï igyka :
	 mshjr lsysmhla" fldkafoishla ;Dma; jk f;la fyda ;Dma; j mj;sk ;dla 

l,a fyda kej; kej; isÿùu fuys we;s úfYaI;ajhhs'

ixLHd iuQyhl tl;=j fiùu

ixLHdj N lshùu

tl;=j = 0

tl;=j = tl;=j + N

;j;a ixLHdjla 

;sfí o@

tl;=j m%;sÞkh lsÍu

ke;

Tõ

wdrïNh

wjidkh

ls%hdldrlu   

my; oelafjk .eg¨ i|yd .e,Sï igyka w¢kak'

1'	 iDcqfldaKdi%hl mßñ;sh iy j¾.M,h fiùu 

2'	 wdh;khl fiajlhskaf.a uQ,sl jegqmg remsh,a 5000'00l §ukdjla 

,nd §ug ;SrKh lr we;' ta wkqj kj jegqm .Kkh l< hq;= j 

we;'

3'	 ,smshla ;eme,a lsÍfï § .dia;= wh lrkafka tys nr m%udKh 

wkqj h' iïu; nr m%udKhg wvq fyda iudk nr iys; ,sms i|yd 

kshñ; .dia;= muKla f.úh hq;= h' iïu; nr m%udKhg jvd 

jeä nr iys; ,sms i|yd wu;r .dia;= f.úh hq;= fõ'

4'	 7 ys uq,a u .=Kdldr 12 oelaùu

5'  msgqj 8 - 9ys we;s WÞyrK i|yd .e,Sï igyka w¢kak'
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1'3'2  jHdc fla; (Pseudo codes) 

	 we,af.dß;uhla ir, bx.%Sis jpk fhdod f.k ,sÅ; j oelaùu jHdc fla; 

u.sska isÿ fõ' fufia ,shkq ,nk jHdc fla; mß.Kl NdIdjlska iajdh;a; fõ' 

jHdc fla; ´kE u mß.Kl NdId Wmfoia njg mßj¾;kh l< yels h' tneúka 

jHdc fla; ,sùfuka mß.Kl l%uf,aLkh myiq lrhs'

	 we,af.dß;ufha tla tla m%ldYh ir, bx.%Sis jpkj,ska olajk wdldrh 

úuid n,uq'

	 wdrïNh	 BEGIN
	 wjidkh	 END
	 wdodkh	 INPUT, READ, GET
	 m%;sodkh	 OUTPUT, DISPLAY, SHOW
	 l%shdj,sh	 PROCESS, CALCULATE
	 jrKh		 IF … THEN .. .ELSE  … ENDIF
	 mqk¾lrKh	 FOR – DO
			   WHILE – ENDWHILE 
			   REPEAT - UNTIL

jHdc fla; ,sùu

Wod 1 -- jD;a;hl j¾.M,h .Kkh lsÍu

	 BEGIN
		  INPUT Radius 
		  CALCULATE Area = 22/7 « Radius « Radius
		  DISPLAY Area
	 END.
Wod 2 - ixLHdjla T;af;a o" brÜfÜ o hkak fiùu

	 BEGIN
		  READ number as N
		  CALCULATE  Remainder after number divided by 2
		  IF Remainder = 0 THEN
			   DISPLAY “Even number”
	      	 ELSE
			   DISPLAY “Odd number”
		  ENDIF
	 END.
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Wod 3 - ixLHd iuQyhl tl;=j fiùu

	 BEGIN
		  Total = 0
		  REPEAT
			   READ Number as N
			   CALCULATE Total = Total + N
		  UNTIL numbers are over
		  DISPLAY Total
	 END.

Wod 4 - ixLHd 10l tl;=j iy idudkHh fiùu

Value hk 

úp,Hhg 20 hk 

w.h mjrhs

	 BEGIN
		  Total = 0
		  Average = 0
		  n = 1
		  WHILE n <= 10

			   READ number 
			   CALCULATE Total = Total + number
			   n = n + 1
		  ENDWHILE
		  CALCULATE Average = Total/(n-1)  
		  DISPLAY Total, Average
	 END.
by; WodyrK 4 ys jHdc fla;h ms<sn| j olajd we;s my; lreKq flfrys wjOdkh 

fhduq lrkak'

²² Total, Average, number iy n hkq úp,H (Variable) fõ'

◦◦ Number hk úp,H i|yd w.hka wdodkh lrk úg Bg idfmalaI j 

Total, Average iy n hk úp,Hj, w.hka o fjkia fõ'

²² n úp,H u.ska mqk¾lrKh jk jdr .Kk ksrEmKh lrhs'

²² Total = 0 iy Average = 0 u.ska tu úp,Hj, wdrïNl w.h 0 f,i mjrd we;'

◦◦ ñka woyia lrkafka number úp,H i|yd w.hka ,nd .ekSug m%:ufhka 

Total iy Average hk úp,Hj, ixLHd;aul w.hka 0 f,i f.k we;s 

njhs'
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²² n = 1 u.ska n ys wdrïNl w.h 1 f,i mjrd we;'

◦◦ ñka woyia lrkafka n úp,Hfha wdrïNl w.h 1 jk njhs'

²² n <= 10 hkq mqk¾lrKh ùu md,kh lrk fldkafoaish fõ'

²² WHILE n <= 10 u.ska n ys w.h 10 jk f;la mqk¾lrKh úh hq;= nj olajhs'

◦◦ n ys w.h 10 fyda 10 g wvq wjia:dj, mqk¾lrKh isÿfõ' tkï n <= 10 
hk fldkafoaish i;H j mj;sk ;=re mqk¾lrKh isÿfõ' nys w.h 11 jk 

úg mqk¾lrKh ùu kj;S' túg fldkafoaish wi;H fõ'

²² READ u.ska number úp,Hh i|yd 

w.hla ,nd .ekSu olajhs'

²² Total + Total = number u.ska number 
i|yd ,nd .;a w.h Total úp,Hhg 

tl;= lr tu w.h kej; Total 
úp,Hhg u mejÍu olajhs'

²² n = n + 1 u.ska mqk¾lrKh jk jdr 

.Kk .Kkh fõ' fuys § number 
úp,Hh i|yd w.hla ,nd .;a miq 

n ys w.hg 1 la tl;= lr tu w.h 

kej; n úp,Hhg u mjrkq ,nhs' 

²² ENDWHILE u.ska mqk¾lrKh wjika lrk iSudj olajhs' ta wkqj 

READ number" Total = Total + number iy n = n + 1 hk m%ldYk muKla  

n <= 10 hk fldkafoaish ;Dma; j mj;sk f;la mqk¾lrKh fõ' 

²² mqk¾lrKh ùu kj;sk úg n ys w.h 11 fõ' tu wjia:dfõ fldkafoaish wi;H  

fõ'

²² Average = Total/(n-1)  u.ska Total ys wjika w.h n-1 ka fnod ,efnk w.h 
Average úp,Hhg mjrkq ,nhs' tkï Average úp,Hh u.ska idudkHh .Kkh 

flf¾'

²² DISPLAY Total, Average u.ska wdodkh lrk ,o ixLHd oyfha tl;=j iy 

idudkHh m%;sodkh lrhs'

 

ksÍlaIKh 

²² úp,Hhla i|yd w.hka mejfrk úg fmr mej;s w.h ke;s ù 

hhs'

²² Total = Total + number hk m%ldYkh l%shd;aul jk úg number 
úp,Hh i|yd we;s w.h Total úp,Hfha mej;s w.h iu. tl;= 

ùfuka miq ,efnk w.h Total úp,Hh fj; u mejf¾'

²² Total = Total + number hkq .‚;uh iólrKhla fkdfõ'
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1'3'3  .e,Sï igyka jHdc fla;j,g mßj¾;kh lsÍu

	 tl u we,af.dß;uhla .e,Sï igyklska fuka u jHdc fla;hlska o 

ksrEmKh l< yels h' tneúka .e,Sï igykla jHdc fla;hla njg mßj¾;kh 

lrk wdldrh úuid n,uq'

BEGIN

	 Put tea bag in cup

	 WHILE (not Water boiled)

		  Boil water

	 ENDWHILE

	 Pour water in cup

	 WHILE (sugar needed)
		  Add sugar
		  Stir tea

	 ENDWHILE

END

wdrïNh

lj,ï lsÍu

iSks tla lsÍu

c,h WKq ù 

we;a o@

iSks wjYH o@

ke; 

ke; 

Tõ 

Tõ 

c,h fldamamhg j;a lrkak

f;a nE.h fldamamhg oeóu 

wjidkh

c,h WKq lsÍu

 

Wod 1 - wiudk ixLHd folla w;ßka úYd, ixLHdj fiùu

wdrïNh

N1, N2 ixLHd fol ,nd .ekSu

úYd, ixLHdj N2 fõ'
N1, N2 g jvd 

úYd, o@ ke; 

Tõ 

 úYd, ixLHdj fmkajkak'                                                                               

úYd, ixLHdj N1fõ

wjidkh
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	 BEGIN
		  READ N1, N2
		  IF N1 > N2 THEN
			   Large = N1
		  ELSE
			   Large = N2
		  ENDIF
		  DISPLAY Large
	 END

Wod 2 - ixLHd oyhla w;ßka l=vd u ixLHdj fiùu'

wdrïNh

ixLHdj N ,nd .ekSu

Min m%;sodkh lrkak Count < 10 ?

ke; 

ke; 

Tõ 

Tõ 

ixLHdj N ,nd .ekSu

Min =  N
Count = 1

N  < Min ?

 Min =  N

Count = Count + 1
wjidkh
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	 BEGIN
		  INPUT Number as N
		  Min = N
		  Count = 1
		  WHILE Count<10
			   INPUT Number as N
			   IF N < Min  Then
				    Min = N
			   ENDIF
			   Count = Count + 1
		  ENDWHILE
		  PRINT  Min
	 END.

1'4   meial,a l%uf,aLk NdIdj

1'4'1  y÷kajk (Identifiers)

	 y÷kajkhla hkq úp,Hhla (Variable)" ksh;hla (Constant) fyda l%uf,aLkhla 

(Program) ye¢kaùu i|yd fhdod .kakd kuls' fuu y÷kajkhla fh§fï § my; 

oelafjk idudkH kS;s-Í;s wkq.ukh l< hq;= h'

Var year : integer; 

data type

reserved word data identifier²² meial,a NdIdj y÷kajd §u i|yd 

Ndú; lrkq ,nk wejqreKq mo 

(Reserved words) fhdod fkd.; 

hq;= h' ´kE u NdIdjl wejqreKq 

mo y÷kajk i|yd fhdÞ .;  

fkdyel'

		 WÞ - BEGIN, END wdÈh j,x.=  

	      ke;' 

²² bx.%Sis fydaäfha wlaIrhlska wdrïN l< hq;= h' (eg : A-Z, a-z)
²² y÷kajkfha m<uq wlaIrhg miq j wlaIr (a-z, A-Z) fyda ixLHdxl ^0-9& iy 

hábr ^ _ & fhdod .; yels h'

		 WÞ - Student_name
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²² meial,a NdIdfõ § y÷kajk i|yd wlaIr fíoh n, fkdmdhs' 

	  ^WÞ - Art, art, ART hkq tl u y÷kajkhls'&

²² jpk w;r mr;rhla (space) fkdmej;sh hq;= h'

	   Wod - Student Name - j,x.= ke;'

²² y÷kajkhla ;=< my; wkq,laIK wvx.= fkdúh hq;= h'

      ~   !   @   #   $  %   ^    &   *   (  )    -   +  =  {  }  [  ]  :  ;  ‘  “  <> ?  ,  .  /  |  \ 
	 kuq;a há br (underscore _ ) ,l=K muKla j,x.= fõ'

²² y÷kajk i|yd w¾:j;a kdu fhdod .ekSfuka l%uf,aL f;areï .ekSug myiq 

fõ'

	 j,x.= y÷kajk i|yd WodyrK -
	 Sum, SUM, Total_Nos, Num1, FirstName, Last_Name 
	 j,x.= fkdjk y÷kajk i|yd WodyrK -
	 $75, Average  Marks, 9A, Last-name

1'4'2  weúreKq mo (Reserved words)

	 meial,a NdIdfõ Ndú; lrk wejqreKq mo meial,a NdIdj y÷kajd §u i|yd 

fhdod f.k we;' tneúka y÷kajk (Identifier) i|yd wejqreKq mo Ndú; fkd 

flf¾'

	 wejqreKq mo l%uf,aLk NdIdfjka NdIdjg fjkia fõ' meial,aj, Ndú; 

lrk wejqreKq mo my; oelafõ'

exports
file
for
function
goto
if
implementation
in
inherited
inline
interface
label
library

mod
nil
not
object
of
or
packed
procedure
program
record
repeat
set
shl

shr
string
then
to
type
unit
until
uses
var
while
with
xor

and
		
asm
array
begin
case
const
constructor
destructor
div
do
downto
else
end
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1'4'3  meial,a NdIdfõ iïu; o;a; m%rEm (Data type)

	 l%uf,aLh l%shd;aul jk úg wdodk iy l%shdj,sh ;=<ska .Kkh jQ 

m%;sM, mß.Kl u;lh ;=< r|jd ;nd .ekSug wjYH fõ' ta i|yd wjYH‍ bv 

m%udKh ;SrKh lrkq ,nkafka o;a; m%rEmh u; h' tneúka o;a; m%rEm ms<sn| j 

l%uf,aLlhl= oek isàu b;d jeo.;a fõ'

o;a; m%rEm yd tajdfha mrdi my; oelafõ'

Integer - Ok fyda RK ksÅ, ixLHd$mQ¾K ixLHd

 Wod - 0" 46" -12

Real - Ok fyda RK ;d;aúl ixLHd$oYu ixLHd

 Wod - 0'0" 25'68

Boolean

 True fyda False

Char - h;=re mqjrefõ we;s ´kE u 

	  wkq,laIKhla

 Wod -‘k’, ‘#’, ‘7’ 

String - ´kE u wkq,laIK wkql%uhlaa

 Wod -‘ICT’, ‘programming’, 'Sri Lanka'

jeo.;a

Char iy String hk o;a; m%rEm ;ks Wvq fldud ;=< (‘ ’) (single 
quotation) olajkq ,efí'

1'4'4  l%uf,aLkfha § fhdod .kakd úp,H (variable) iy ksh;  
	 (constant)

úp,H (Variable) 

	 l%uf,aLh l%shd;aul jk úg y÷kajkh i|yd mjrk ,o w.hka fjkia jk 

y÷kajk" úp,Hhla f,i kï flf¾' 
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meial,a NdIdfõ § úp,H w¾: oelaùu i|yd —var˜ hk wejqreKq moh fhdod .efka'

Retrieve StoreWod -	 Var  count : integer;
	 Var  a,b : Real;
	 Var 	 n1, n2 : integer;
		  Avg : real ;
		  Pass : boolean;
		  Character : char;
		  Name,school : String;

jeo.;a
úp,Hhla i|yd kula mj;sk w;r tys ksYaÑ; o;a; m%rEmhlg wÞ< 

o;a; ;ekam;a flf¾' 

A variable has a name, stores a value of the declared type.

ksh; (Const) 

	 l%uf,aLh l%shd;aul jk úg y÷kajkh i|yd mjrk ,o w.hka fjkia 

fkdjk y÷kajk" ksh; f,i kï flf¾' meial,a NdIdfõ § ksh; w¾: oelaùu 

i|yd —const˜ hk wejqreKq moh fhdod .efka'

Wod - 	
	 Const   	 max = 100;
	 Const  		 pi = 22/7;

 

ksÍlaIKh 

²² l%uf,aLh Odjkh ùfï § úp,Hhla i|yd úúO w.hka mj;sk 

w;r ksh;hl w.h fkdfjkia j mj;S'

1'5 ldrl (Operators)

	 ldrl fkdue;s j .Kkh lsÍu" ixikaokh lsÍu iy ;d¾lsl m%ldYk 

f.dv ke.Su l< fkdyels h' tneúka l%uf,aL ,sùug ldrl w;HjYH fõ'
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uQ,sl ldrl j¾. lsysmhls'

1' wxl .‚;uh ldrl 

        ldrlh 		    Ndú;h		           m%ldYh		        m%;sM,h

            +	     	 tl;= lsÍu			   6 + 3		  9

	 -		  wvq lsÍu			   7 - 5		  2

	 * 		  .=K lsÍu			   2 * 5		  10

	 /		  fn§u				    10/4		    2'50

	 DIV		  mQ¾K ixLHduh fn§u		 20 DIV 6	 3

	 MOD 		 fn§fuka miq fYaIh		  20 MOD 6	 2

3
6 20

18
2

DIV

MOD

2' iei÷ï ldrl 

	
	 w.hka fyda m%ldYk ixikaokh lsÍu i|yd iei÷ï ldrl fhdod .efka' 

iei÷ï ldrlhla wvx.= m%ldYkhl wjika m%;sM,h iEu úg u nQ,shdkq w.hla 

.kS' tkï m%ldYkh i;H fyda wi;H fõ'

     ldrlh		   Ndú;h		      m%ldYh		  m%;sM,h

	 >		   úYd,			      7 > 3	 	   i;H‍		

	 >=		   úYd, fyda iudk	     8 >= 8		    i;H

	 <		   l=vd			       3 < 2	 	   wi;H

	 <=		   l=vd fyda iudk	     4 <= 6		    i;H 

	 =		   iudk			      3 = 1	 	   wi;H

	 < >		   wiudk		      2 < > 5		    i;H

3' ;d¾lsl ldrl

	 m%ldYk folla fyda lsysmhla tAldnoaO lsÍu i|yd ;d¾lsl ldrl (Logical 
Operator) fhdÞ .efka' fuys jeäÿr wOHhkh i|yd 10 fY%a‚fha § Tn yeoErE 

uQ,sl ;d¾lsl oajdr n,kak'
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i)  AND ldrlh

	 —^m<uq m%ldYkh& AND ^fojk m%ldYkh&˜ f,i uQ,sl j fhdokq ,nhs' 

tys § m<uq yd fojk m%ldYk i;H fyda wi;H ùu wkqj AND ldrlh .ekSfuka 

,efnk m%;sM,h o i;H fyda wi;H fyda fõ' my; j.=j u.ska AND ldrlfha 

l%shdldß;ajh oelafõ'

m<uq m%ldYkh fojk m%ldYkh ^m<uq m%ldYkh& AND ^fojk m%ldYkh&

wi;H wi;H wi;H

wi;H i;H wi;H

i;H  wi;H wi;H

i;H i;H i;H

Wod -   1' ^j¾Idm;kh > 56& AND ^WIaK;ajh < 30&"
	  2' ^Wi > 60& AND  ^jhi < 15& 
	

	  3' (3 >= 2) AND (3 < > 3) hk m%ldYkh i,luq'

	                  3 >= 2 hk m%ldYkh i;H fõ' 3 < > 3 hk m%ldYkh wi;H o fõ' 

	     tneúka iuia; m%ldYkh o wi;H fõ'

jeo.;a
�� wju jYfhka tla m%ldYkhla fyda wi;H jQ úg AND  ldrlh 

iys; iuia; m%ldYkh o wi;H fõ' 

�� ish¨ u m%ldYk i;H jk úg muKla AND ldrlh iys; 

m%ldYkh i;H fõ'

ii)  OR ldrlh

 	 —^m<uq m%ldYkh& OR ^fojk m%ldYkh&˜ f,i uQ,sl j fhdokq ,nhs' tys 

§ m<uq yd fojk m%ldYk i;H fyda wi;H fyda ùu wkqj OR ldrlh .ekSfuka 

,efnk m%;sM,h o i;H fyda wi;H fyda fõ' my; j.=j u.ska OR ldrlfha 

l%shdldß;ajh oelafõ'

m<uq m%ldYkh fojk m%ldYkh ^m<uq m%ldYkh& OR ^fojk m%ldYkh&

wi;H wi;H wi;H

wi;H i;H i;H

i;H wi;H i;H

i;H i;H i;H
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Wod -   1' ^WIaK;ajh > 30& OR ^j¾Idm;kh < 55&
	  2' (3 >= 2)  OR (3 < > 3)  hk m%ldYkh i,luq'	

	    3 >= 2  hk m%ldYkh i;H fõ' 3 < > 3  hk m%ldYkh wi;H fõ' 

	    tneúka iuia; m%ldYkh i;H fõ'

jeo.;a
�� wju jYfhka tla m%ldYkhla fyda i;H jQ úg OR ldrlh iys; 

m%ldYkh o i;H fõ'

�� ish¨ u m%ldYk wi;H jk úg muKla OR ldrlh iys; 

m%ldYkh wi;H fõ'

iii)  NOT ldrlh

	 iEu úg u i;H m%ldYkhla NOT ldrlh u.ska wi;H f,i olajk w;r 

wi;H m%ldYkhla NOT ldrlh u.sska i;H f,i olajhs'

m%ldYkh NOT ^m%ldYkh&

wi;H i;H

i;H wi;H 

Wod - 
	 1' NOT ^WIaK;ajh > 30& 
	 2' NOT (5 = 5) wi;H m%ldYkhls'

	    5 = 5 hk m%ldYkh i;H fõ'

	    tneúka NOT(5 = 5) hk m%ldYkh wi;H f,i olajhs'

ldrl m%uqL;dj

	 meial,a m%ldYk l%shd;aul ùfï § my; oelafjk ldrl m%uqL;d wkqms<sfj< 

(Operator Precedence) wkq.ukh flf¾'

m%uqL;d uÜgu			   ldrl

1			   NOT
2			   *	 /	 DIV	 MOD	 AND
3			   +	 -	 OR
4			   =	 < >	 <	 <=	 >	 >= wvq h

jeä h
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meial,a m%ldYk we.hSu lrk whqre 

WÞ -- ^1&				   WÞ -- ^2&				   WÞ -- ^3&
	 5 + 14 MOD 4		    	 3 + 7 DIV 2 			   16 / 4 * 2
	 5 + 2				    3 + 3				    4 * 2
	 7				    6				    8

WÞ -- ^4&				   WÞ -- ^5&
        	 NOT (8 MOD 2 > 5)		  4 >= 4 AND NOT(7 > 9)	
	 NOT (0 > 5)			   True AND NOT(False)
	 NOT(False)			   True AND True
	 True				    True

idudkH meial,a l%uf,aLhl wvx.= uQ,sl fldgia y÷kd .ksuq'

wdodk

Write(‘Welcome Pascal Programming’);
{calculate total and  average of two numbers}  
Writeln(‘Enter First Number’);
Read(num1);
Writeln(‘Enter Second Number’);
Read(num2);
total :} num1 + num2;
avg :} total/2;
writeln(‘Total is ‘ , total);
writeln(‘Average is ‘ , avg);

m%;sodk

} l%shdj,sh oelafjk m%ldY

Begin  		 m%Odk l%uf,aLfha wdrïNh

program addNum  (input,output); l%uf,aLfha ku

var  		            num1,num2,total : integer; } 	
úp,H y÷kajd §u		            avg: real;

End.   		  m%Odk l%uf,aLfha wjidkh 

újrK (comments)
±laùu

 

igyk - újrK ±laùu i|yd (*..........*) o Ndú; l< yels h'

²² fuys —program˜" —input˜ iy —output˜ hkq weúreKq mo fõ'

²² —addNum˜ hkq y÷kajkhls' fuh l%uf,aLfha kduh hs' l%uf,aLfha kduh 

iu. jryka ;=< input" output f,i oelaùu w;HjYH fkd fõ'

²² wdodkh i|yd read^& iy readln^& weúreKq mo Ndú; flf¾'

¾¾ Read^num1&¦ m%ldYkh u.ska num1 jQ úp,H i|yd o;a; wdodkh lr 

.efka'

¾¾ readln^& u.sska o;a; wdodkh lr .kafka kj fma<shl isg h'
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²² m%;sodkh i|yd write^& iy writeln^& weúreKq mo Ndú; flf¾' 

¾¾ Write ̂ ‘Welcome Pascal Programming’&; m%ldYkh u.ska Welcome Pascal 
Programming  kï jQ mdG fldgi m%;sodkh lrhs'

¾¾ writeln ̂ ‘Average is Z, avg&; m%ldYkh u.ska kj fma<shl Average is hk mdG 

fldgi iu. avg úp,Hfha w.h m%;sodkh lrhs'

=

num 1

3.4

num 2

2.3

Total

5.7 +
Pascal m%ldYk (statements) ,sùfï §;
²² m%ldYkhl fl<jf¾ semi-colon ̂ ;& fhdokq 

,nhs' semi-colon u.ska m%ldYkh wjika 

nj lshfõ'

²² total :} num1 + num2; hk m%ldYkfhka 

isÿjkafka num1 iy num2 úp,H fofla w.hka tl;= lr total kï jQ úp,Hhg 

mjrkq ,eîuhs'

²² fuys § Ndú; lrk —:}˜ mejreï ldrlh (Assignment Operator) f,i ye¢kafõ'

 

fmr miq

  

i: integer 
i := 4;

1'6 jrK md,k jHqyh iïnkaO jk l%uf,aL ks¾udKh

ir, IF m%ldYh

jrK md,k jHqyh ir, u wdldrfhka my; oelafõ' fuys wdldr 02 ls' 

m%ldYkh

fldkafoaish i;H 

fõ o@

ke;

Tõ

jHdc fla;h

IF  Condition  THEN
	 Statement

ENDIF
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i) IF... THEN.... ENDIF
               

fuys § fldkafoaish ;Dma; jkafka kï muKla m%ldYkh l%shd;aul fõ'

Wod 1 - wdodkh lrk ixLHdj Ok kï muKla tu ixLHdj uqøKh lsÍu'

Program positiveNo(input, output);
Var  N : integer;
Begin
	 Writeln(‘Enter Number’);
	 Read(N);
	 If N > 0 then
	 Writeln(‘Positive Number’);
End.

ixLHdj N ,nd .ekSu

N > 0 o?
ke; 

Tõ 

ixLHdj uqøKh lsÍu

wjidkh

wdrïNh

jHdc fla;h

Begin
   Input N
   IF  N > 0  
THEN
	 Print N
   ENDIF
End.

.e,Sï igyk 

meial,a l%uf,aLh

ii) IF... THEN.... ELSE .......... ENDIF      

	 fuys § fldkafoaish ;Dma; jkafka kï m%ldYkh 1 o ;Dma; fkdfõ kï  

m%ldYkh 2 o l%shd;aul fõ'
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Wod 2 -- wiudk ixLHd folla w;ßka úYd, ixLHdj fiùu

fldkafoaish i;H 

fõ o@

ke; 

Tõ 

m%ldYkh1

m%ldYkh2

IF  Condition  THEN

	 Statement1

ELSE
	 Statement2

ENDIF

jHdc fla;h

program LargeNo(input,output);
Var  N1,N2,Large: integer;
Begin
	 Writeln(‘Enter Two Numbers’);
	 Read(N1,N2);
	 If N1 > N2 then
		  Large :} N1
	 Else
		  Large :} N2;
	 Writeln(‘Large Number is ’ , Large);
End.

.e,Sï igyk 

meial,a l%uf,aLh

NESTED IF

	 fldkafoaishlg miq j fldkafoaishla jYfhka fldkafoais iuQyhla fhfok 

wjia:djl NESTED IF fhdÞ .efka' 

i) flaj, úp,Hhlg nyq fldkafoais we;s úg NESTED IF  Ndú;h 

Wod 3 -- úIhlg isiqjl= ,nd .;a ,l=Kq wdodkh l< úg Bg wod< idu¾:Hh fiùu
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,l=Kq (M) ,nd .ekSu

M >= 75 o?
ke; ke; ke; ke; 

Tõ Tõ Tõ Tõ 

M >= 65 o? M >= 50 o? M >= 35 o?

idu¾:Hh = ''A'' idu¾:Hh = ''B'' idu¾:Hh = ''C'' idu¾:Hh = ''S'' 

idu¾:Hh = ''F'' 
idu¾:Hh m%;sodkh lsÍu

wjidkh

wdrïNh

	      jHdc fla;h    	       meial,a l%uf,aLh
                                                                                                                          

     

Begin
	 Input Marks as M
	 IF M >= 75 Then 
	       Grade = ‘‘A’’
	       ELSE
	       IF M >= 65 then
	             Grade = ‘‘B’’
	             ELSE
	             IF M >= 50 then
		         Grade = ‘‘C’’
		         ELSE
		         IF M >= 35 then
			   Grade = ‘‘S’’
			   ELSE 
			   Grade = ‘‘F’’
		          ENDIF
		  ENDIF
	         ENDIF
	 ENDIF
	 Display Grade
End.

program GradeForMarks (input,output);
Var  	 M: integer;
	 Grade: char;
Begin
	 Writeln(‘Enter Marks’);
	 Read(M);
	 If M >= 75 then
	     Grade :} ‘A’
	 Else 
	     If M >= 65 then
	 Grade :} ‘B’
                Else
		          If M >= 50 then
		  Grade :} ‘C’ 
	        Else
		  If M >= 35 then
		      Grade :} ‘S’
		  Else
		      Grade :} ‘F’;
	 Writeln(‘‘Grade = ’’, Grade);
End.

.e,Saï igyk
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flaj, úp,Hhlg nyq fldkafoais we;s úg Case Statement Ndú;h

	 IF …THEN…  ELSE…  ENDIF jrK md,k jHqyh kej; kej; fhdod 

.ekSug jvd myiqfjka Case Ndú; l< yels h' 

.e,Sï igyk

0-34

,l=Kq (Marks) ,nd .ekSu

Marks

50-64  65-74 75-100

idu¾:Hh = ''S'' idu¾:Hh = ''C'' idu¾:Hh = ''B'' idu¾:Hh = ''A'' 

idu¾:Hh m%;sodkh lsÍu

idu¾:Hh = ''W'' 

35-49 fjk;a

wj,x.= ,l=Kq nj fmkajkak

wdrïNh

wjidkh

program FindGrade(input,output);
var	 Marks : integer;
	 Grade: char;
Begin
	 Writeln(‘Enter Marks’);
	 Read(Marks);
	 Case Marks of
		  0..34 : Grade :} ‘W’;
		  35..49 : Grade :} ‘S’;
		  50..64 : Grade :} ‘C’;
		  65..74 : Grade :} ‘B’;
		  75..100 : Grade :} ‘A’;
	 Else
		  Writeln(‘Invalid Marks’);
	 End;
	 if (Marks >= 0) AND (Marks <= 100) then
		  Writeln(‘Grade is ’ , Grade);
End.

meial,a l%uf,aLh
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1'7 mqk¾lrK Ndú;fhka l%uf,aL ,sùu

	 mqk¾lrK jdr .Kk ksYaÑ; j okakd wjia:dj, §  mqk¾lrK jHqy Ndú; 

lrk wdldrh úuid n,uq'

i) FOR - DO jHqyh ^wdldrh 1& 

FOR  Variable :} Value_1 TO Value_2 DO

²² fuys Variable , Value_1 iy Value_2 j, o;a; m%rEmh ksÅ, ixLHd ^integer& 
úh hq;= h'

²² mqk¾lrKh wdrïN ùu i|yd Value_2 ys w.h Value_1 ys w.hg jvd jeä úh 

hq;= h'

²² mqk¾lrKh Value_1 j,ska wdrïN jk w;r Value_2 j,ska wjika fõ'

²² tneúka FOR - DO jHqyhla Ndú; l< yels jkafka mqk¾lrKh jk jdr .Kk 

ksYaÑ; j okafka kï mu‚'

mqk¾lrK jHqyh wdrïNl w.h wjidk w.h mqk¾lrKh jk 

jdr .Kk

FOR X :} 1 TO 5 DO 1 5 5
FOR X :} 0 TO 4 DO 0 4 5
FOR X :} 5 TO 10 DO 5 10 6

Wod : 1 isg 10 olajd w.hka m%;sodkh lsÍu

Program print10Nos (input,output);
Var 	 count : integer;
Begin
	 For  count :} 1 to 10 do
	 Writeln(count);
End.

	 fuys § count úp,H w.h 1 isg 10 olajd fjkia fjñka m%;sodkh lrk 

w;r mqk¾lrK jdr oyhla l%shd;aul fõ'
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ii) FOR - DO jHqyh ^wdldrh 2& 

FOR  Variable :} Value_1 DOWNTO Value_2 DO

²² mqk¾lrKh wdrïN ùu i|yd  Value_1 ys w.h Value_2 ys w.hg jvd jeä úh 

hq;= h'

²² mqk¾lrKh Value_1 j,ska wdrïN jk w;r Value_2 j,ska wjika fõ'

mqk¾lrK jHqyh wdrïNl w.h wjidk w.h mqk¾lrKh jk 

jdr .Kk

FOR X :} 10 DOWNTO 5 DO 10 5 6
FOR X :} 4 DOWNTO 0 DO 4 0 5

Wod : 10 isg 1 olajd w.hka m%;sodkh lsÍu

Program printReverse (input,output);

Var 	 count : integer;
Begin
	 For  count :} 10  downto 1 do
	 Writeln(count);
End.
	 fuys § count úp,H w.h 10 isg 1 olajd fjkia fjñka m%;sodkh lrk 

w;r mqk¾lrK jdr oyhla l%shd;aul fõ'

ixLHd oyhl tl;=j iy idudkHh fiùu

mqk¾lrKh ;=< ixhqla; 

m%ldYkhls'

program total_avg (input,output);
var 	 I,num,total : integer;
	 avg: real;
Begin
	 total :} 0;
	 for I :} 1 to  10 do
	 begin
			   writeln(‘Enter Number’);
			   read(num);
			   total :} total + num;
	 end;
	 avg :} total/I;
	 writeln(‘Total is ‘ , total);
	 writeln(‘Average is ‘,avg);
End.

}
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jeo.;a

ixhqla; m%ldYkhla begin iy end w;r ,shkq ,efí'

	 mqk¾lrK jdr .Kk wúksYaÑ; wjia:dj, § while do jHqyh iy repeat 
until jHqyh Ndú; fõ'

i) while do jHqyh

²² mqk¾lrKh wdrïNfha § u fldkafoaish mÍlaId flf¾'

²² fldkafoaish i;H jkafka kï muKla mqk¾lrKh wdrïN fõ'

²² fldkafoaish wi;H jkafka kï lsis úfgl mqk¾lrKh wdrïN fkd fõ'

²² mqk¾lrKh ùu wjika ùu i|yd fldkafoaish wi;H úh hq;= u h'

²² mqk¾lrKh jk w;r jdrfha § fldkafoaish wi;H fkdfõ kï wmßñ; jdr 

.Kkla mqk¾lrKh ^infinite loop& fõ'

Wod 1 -- while number > 0 do
	  number úp,Hfha w.h Ok kï muKla mqk¾lrKh isÿ fõ'

Wod 2 -- number :} 1;
	     while number <= 10 do
		  number :} number ¬ 1;

◦	 number úp,Hfha wdrïNl w.h 1 neúka fldkafoaish i;H fõ'

◦	 tu ksid mqk¾lrKh wdrïN fõ'

◦◦ mqk¾lrKh jk jdrhla mdid number ys w.hg 1 la tl;= fõ'

◦◦ tneúka number ys w.h 10 fyda 10 g wvq úg mqk¾lrKh isÿfõ'

◦◦ number úp,Hfha w.h 11 jQ úg mqk¾lrKh ùu kj;S'

ii) Repeat Until jHqyh

²² mqk¾lrKh wdrïNfha § u fldkafoaish mÍlaId fkd flf¾'

²² mqk¾lrKh ùug we;s m%ldYk tla jrla l%shd;aul ùfuka miq j fldkafoaish 

mÍlaId flf¾'

²² fldkafoaish wi;H jkafka kï muKla mqk¾lrKh ùu wdrïN fõ'

²² fldkafoaish i;H ùu;a iu. u mqk¾lrKh ùu wjika fõ'

²² mqk¾lrKh jk w;r jdrfha § fldkafoaish i;H fkdfõ kï wmßñ; jdr 

.Kkla mqk¾lrKh ^Infinite loop& fõ' 
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Wod 1 -- meial,a hk jpkh mqk¾lrKh ùu

	 count :} 0;
	 Repeat
		  writeln  ^‘Pascal’&;
		  count :} count+1

	 Until count > 5;
◦◦ count úp,Hfha wdrïNl w.h 0 fõ'

◦◦ Pascal hk jpkh ;srh u; o¾Ykh fõ'

◦◦ count úp,Hfha w.hg 1la tl;= fõ'

◦◦ count  úp,Hfha w.h 5g úYd, fõ oehs mÍlaId flf¾'

◦◦ fufia count  úp,Hfha w.h 5 jk f;la mqk¾lrKh isÿfõ'

◦◦ countys w.h 6 jQ úg mqk¾lrKh ùu kj;S'

◦◦ mqk¾lrKh kj;sk úg Pascal hk jpkh ;srh u; 6 jrla o¾Ykh fõ'

Wod 2 --

	 sum :} 0;
	 repeat
		  sum :} sum + 5;
		  writeln(sum);
	 until sum < 50;

²² sum úp,Hfha wdrïNl w.h 0 fõ'

²² sum ys w.hg 5la tl;= fõ'

²² sum ys w.h jk 5 ;srh u; o¾Ykh fõ'

²² sum  úp,Hfha w.h 50 g wvq fõ oehs mÍlaId flf¾'

²² sum < 50 fldkafoaish ;Dma; fõ' ^i;H fõ'&

²² tneúka mqk¾lrKh ùu kj;S'

Wod 3 -
	 sum :} 0;
	 repeat
		  sum :} sum ¬ 5;
		  writeln^sum&;
	 until sum >= 50;

²² sum úp,Hfha wdrïNl w.h 0 fõ'

²² sumys w.hg 5 la tl;= fõ'

²² sumys w.h ;srh u; o¾Ykh fõ'

²² sum  úp,Hfha w.h 50 g úYd, fyda iudk fõ oehs mÍlaId flf¾'

²² sum >= 50 fldkafoaish ;Dma; ^i;H& jk f;la mqk¾lrKh fõ'
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²² mqk¾lrKh kj;sk úg sum ys w.h 50 fõ'

²² jdr 10 la mqk¾lrKh fõ'

²² m%;sodkh f,i 5 isg 50 olajd we;s 5 ys .=Kdldr ,nd fohs'

1'8 kSä; md,k jHqyj, (Nested Control Structures)     	
      wjYH;dj       

	 jrKh fyda mqk¾lrKh tlsfkl fjkia md,k jHqy folla jqj o .eg¨fõ 

iajNdjh u; jrKhlska miq j mqk¾lrKhla isÿùu fyda isÿ fkdùu úh yels h' 

tfuka u mqk¾lrKh isÿjk w;r;=r jrKhlg wod< j tlsflg fjkia l%shdj,s 

isÿúh yels h' fujeks ;;a;aj hgf;a l%uf,aLlrKh i|yd kSä; md,k jHqy 

fhdod .ekSug wjYH fõ'

1'8'1  jrKh ;=< mqk¾lrK fhdod .ekSu

	 jrKhl fldkafoaishla ;Dma; ùu fyda fkdùu fyda wkqj mqk¾lrKhla 

isÿúh yels h'

Wod -- mßYS,lf.a f;aÍu wkqj m%;sodkh" wdfrdayK fyda wjfrdayK ixLHd 

wkql%uhla ,eîu

program orderNos(input,output);
var 	 num:integer;
	 cho:char;
begin

     writeln('Select Assending(A) or Desending(D)');
     read(cho);
     if cho =  'A' then
        begin
             writeln('Asending Order');
             for num :} 1 to 6 do
                 writeln(num);
        end;
     if cho = 'D' then
         begin
              writeln('Desending Order');
              for num :} 6 downto 1 do
                  writeln(num);
         end;
end.
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1'8'2  mqk¾lrKh ;=< jrKh fhdod .ekSu

mqk¾lrKh isÿ jk w;r;=r § jrKhla isÿ lrk wdldrh i,ld n,uq'

 

Wod -- mßYS,l úiska wdodkh lrkq ,nk ixLHd T;af;a ixLHd o" brÜfÜ ixLHd o" 

	  hkak y÷kd .ekSu yd T;af;a yd brÜfÜ ixLHd m%udK fjk fjk u .Kkh 

	  lsÍu

program rep_sel(input,output);
var num,rem,count,e_count,o_count:integer;
begin
 e_count :} 0, o_count :} 0;
     for count :} 1 to 10 do
         begin
              writeln('Enter Number');
              read(num);
              rem :} num mod 2;
              if rem = 0 then
                 begin
                      writeln('Even number');
                e_count :} e_count + 1;
                 end
              else
                  begin
                       writeln('Odd number');
                       o_count :} o_count + 1;
                  end;
         end;
     writeln(e_count,'Even Number/s');
     writeln((o_count ,'Odd Number/s');
end.

1'9 wrdj (Array) Ndú;h

	 l%uf,aLkfha § u;lh ;=< o;a; ;ekam;a lsÍug úp,Hh Ndú; lsÍu 

wksjd¾h fõ' tfuka u tu Ñp,Hhla i|yd iqÿiq o;a; m%rEmhla mej;sh hq;= h' 

tl u o;a; m%rEmhg wh;a o;a; ;ekam;a lsÍug tlsfklg fjkia kï j,ska hq;a 

fjkia úp,H o iuQyhla wjYH fõ' 
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Wod -- mQ¾K ixLHd 5 la u;lh ;=< ;ekam;a lsÍu i|yd úp,H 5 la wjYH fõ' tjeks  

      úp,H Ndú;hg fmr my; oelafjk wdldrfhka y÷kajd Èh hq;= h'

Var	 p, q, r, s, t : integer; fyda 

	 n1, n2, n3, n4, n5 : real;

1'9'1  wrdjka Ndú;fha wjYH;dj 

	 tl u m%rEmhg wh;a o;a; tl u kula fhdod .ksñka u;lh ;=< ;eïm;a 

lsÍug wrdj Ndú; flf¾' tneúka tla tla o;a;h i|yd fjk fjk u úp,H 

kdu fjkqjg ;ks úp,H kduhla hgf;a wjYH m%udKhlg o;a; ;ekam;a lsÍug 

wrdjla Ndú;fhka yels fõ'

   

1'9'2  taludk wrdjla w¾: oelaùu  

	 wkql%ñl j ksYaÑ; m%udKhl tl u m%rEmhlg wh;a o;a; ;ekam;a lsÍu 

i|yd Ndú; lrk o;a; jHqyhls' wrdjla u.ska hdno u;l wjldY iuQyhla fjka 

lr .kS'

	 tal-udk wrdjla my; oelafjk whqßka y÷kajd fokq ,nhs'

	 Var  Name_of_Array : array [first value '' last value] of data type

Wod --  var marks : array [0''9] of integer;

²² fuu.ska mQ¾K ixLHd;aul w.hka 10 la we;=<;a l< yels marks kï jQ wrdj 

iEfoa'

Each cart holds a 
single piece of data

Here comes the data 
train
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1'9'3  wrdjl ,laIK    

²² wrdjl fldgia tkï wjhj (Element) hdno j msysghs'

²² wrdjl o¾Ylh (Index) tkï" wkqms<sfj< wxlh wrdfõ ku iu. fldgq jryka 

;=< olajkq ,efí'

M[0]

X[0]

M[1]

X[1]

M[2]

X[2]

M[3]

X[3]

M[4]

X[4]

wdrïNl wjhjh

^wvq u o¾Ylh&

wjidk wjhjh

^jeä u o¾Ylh&

Array Name 
Index

wjhjh 1 wjhjh 5

Wod -- 
Var M : Array[0..4] of integer; jk wrdfõ m%udKh 5ls' 

th M[0] isg M[4]  olajd wjhj 5 lska iukaú; fõ'

	 fldgq jryk ;=< o¾Ylh olajkq ,nhs'

	 wrdj y÷kajd fok l%uh wkqj tys o¾Yl msysgk ia:dkh fjkia fõ'
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Wod --  Var X : Array[1..5] of integer; 
tl u m%rEmhlg wh;a o;a; muKla wrdfõ ;ekam;a l< yels h'

	 wrdfõ ́ kE u wjhjhla fj; wyUq f,i msúiSug yels h' tneúka mqk¾lrK 

jHqyhla u.ska wrdjla myiqfjka md,kh l< yels h'

Wod -- isiqka 40 fokl=f.a .‚; ,l=Kq wrdjlg we;=<;a lsÍu

var 	 maths : array[0..39] of integer;
	 i,marks : integer;	
for i :} 0 to 39 do
	 begin
		  writeln(‘Enter marks’);
		  read(marks);
		  maths[i] :} marks;
	 end;

 
1'9'4  wrdjlg w.hka mejÍu (Assign values to an array)

wrdjl wjhjj,g fjk fjk u w.hhka mjrkq ,efí' 

mQ¾K ixLHd we;=<;a l< yels wjhj 5lska iukaú; num wrdj i,luq'

num[0] num[1] num[2] num[3] num[4]

45 36 60

45 75 36 81 60

var  	 num : array[0..4] of integer;
	
	 num[0] :} 45; 
	
	 num[2] :} 36,num[4] :} 60;
	
	 num[1] :} num[4] + 15;
	 num[3] :} num[0] + num[2]
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1'9'5  wrdjl w.hka m%ldYhg m;a lsÍu (Display values in an array)

wrdjl w.hka m%ldYhg m;a lsÍu tys wjhj u.ska isÿ flf¾'

‍writeln ^num[3]&;	 - 4 jk wjhjh m%ldYhg m;a lsÍu ^81&

writeln ^num[1]" num[4]&; - 2" 5 jk wjhj m%ldYhg m;a lsÍu ^36" 60&

for  x :} 0 to 3 do	 - wrdfõ m<uq wjhj 4 m%ldYhg m;a lsÍu ^45" 75" 36" 81&

	   writeln ^num[x]&;	
for  x :} 2 to 4 do	 - wrdfõ 3" 4" 5 hk wjhj 3 m%ldYhg m;a lsÍu ^36" 81" 60&

	   writeln ^num[x]&;	
for  x :} 0 to 4 do	 - wrdfõ ish¨ u wjhj m%ldYhg m;a lsÍu ̂ 45" 75" 36" 81" 60&

	   writeln ^num[x]&;

Wod --  mka;shl isiqka 35 fofkl=f.a f;dr;=re yd ikaksfõok ;dlaIK úIhhg ,nd 

      .;a ,l=Kq we;=<;a lr jeä u ,l=K iy ,l=Kqj, idudkH w.h .Kkh  

       lsÍu'

program ictMarks(input,output);
var marks:array[0..34] of integer;
    i,tot,max:integer;
    avg:real;
begin
     for i :} 0 to 34 do
         begin
              writeln('Enter Marks');
              read(marks[i]);   (* Read Marks to array *)
              tot :} tot + marks[i]; (* Add marks *)
         end;
     avg :} tot/35;
     max :} marks[0];
     for i :} 1 to 34 do
         if marks[i] > max then max :} marks[i];
     writeln('Maximum marks = ', max);
     writeln('Average marks = ',avg);
end.
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1'10 Wml%uf,aL Ndú;h

	 l%uf,aLhl l%shdj,s m%udKh jeäùu;a iu. u th ixlS¾K jk ksid lshjd 

f;areï .ekSu" l%uf,aLh kv;a;= lsÍu jeks lghq;= wmyiq fõ' tneúka l%uf,aL 

,sùfï § yels;dla ÿrg Wml%uf,aL f,i ,sùu id¾:l l%uhls'

Wm.eg¨j

1

Wm.eg¨j

2

Wm.eg¨j

n

m%Odk 

.eg¨j

Wml%uf,aLh 1

-----------------       

-----------------

Wml%uf,aLh 2

-----------------       

-----------------

Wml%uf,aLh n
-----------------       

-----------------

1'10'1  Wml%uf,aL j¾.

	 m%Odk l%uf,aLh yd iïnkaO Wml%uf,aL u.sska m%Odk l%uf,aLh fj; 

m%;sodkhla wdmiq ,nd §ug yels iy fkdyels jYfhka Wml%uf,aL j¾. folla 

we;' m%;sodkhla wdmiq ,nd Èh yels Wml%uf,aL Y%s; ̂ Function& f,i o" m%;sodkhla 

wdmiq ,nd Èh fkdyels Wml%uf,aL ld¾h mámdáh ^Procedure& f,i o ye¢kafõ'

1'10'2  Wml%uf,aL y÷kajd §u

PROGRAM 
CONST 

VAR
Y%s; iy ld¾h 

mámdá m%ldY 

lsÍu (Function 
and procedure 

declaration)

m%Odk 

l%uf,aLh

(Main program)

BEGIN

END
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	 m%Odk l%uf,aLh wdrïN lsÍug m%:ufhka Y%s; iy ld¾h mámdá y÷kajd 

Èh hq;= h' m%Odk l%uf,aLh ;=< § Wml%uf,aLj,g weu;sh ^Calling the function or 
Procedure& hq;= h'

ld¾h mámdáhla y÷kajd §u i|yd ksjerÈ ldrl Í;sh ^Syntax& my; oelafõ'

Procedure  Name_of_Procedure ^name_of_variable: data type&;

Wod --  jD;a;hl j¾.M,h fiùu i|yd ld¾h mámdáh

	      Procedure calculateArea ^var radius : real&; 

Y%s;hla y÷kajd §u i|yd ksjerÈ ldrl Í;sh ^Syntax& my; oelafõ'

	 Function  Name_of_Function^name_of_variable : data type& : data type ;

Wod -- jD;a;hl j¾.M,h fiùu i|yd Y%s;h

         	 Function calculateArea ^var radius ( real&( real¦

m%;sÞkh wdmiq ,nd§u

(Return Output)

ld¾h mámdá weu;Su 

(Calling the procedure)

Y%s; weu;Su

(Calling the function)

Procedure sub1(var x:real);
begin
	 statement
	 ………………
end;	

Function sub2(var x:real): 
real ;
	 begin
		  statement
		  ………….
	 end;

begin
	 statement
	 ………………
	 sub1(value);
	 ………………
	 V = sub2(value);
	 ………………
	 statement
end.

 

ld¾h mámdá m%ldYkh 
Procedure declaration

Y%s; m%ldYkh 
(Function declaration)

m%Odk l%uf,aLkh 

(Main Program)

{
{
{
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Wod -- jD;a;hl j¾.M,h iy mßêh .Kkh lsÍfï l%uf,aLh i,luq'

1' ld¾h mámdá fhdod f.k f.dvk.k ,o l%uf,aLh

program procedure_circle(input,output);
const pie = 22/7;
var radius:real;
procedure getData(var radius: real);
          begin
               writeln('Enter Radius');
               read(radius);
          end;
procedure processArea(var radius:real);
          var area:real;
          begin
               area :} pie * radius * radius;
               writeln('Area = ',area);
          end;
procedure processCircumferance(var radius:real);
          var circum:real;
          begin
              circum :} 2 * pie * radius;
              writeln('Circumferance = ',circum);
          end;
begin
     getData(radius);
     processCircumferance(radius);
     processArea(radius);
end.

2' Y%s; fhdod f.k f.dv k.k ,o l%uf,aLh

program function_circle(input,output);
const pi = 22/7;
var radius:real;
function processArea(var radius:real):real;
          var area:real;
          begin
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               area :} pi * radius * radius;
               processArea :} area;
          end;
function processCircumferance(var radius:real):real;
          var circum:real;
          begin
              circum :} 2 * pi * radius;
              processCircumferance :} circum;
          end;
begin
     writeln('Enter Radius');
               read(radius);
     writeln('Circumferance = ',processCircumferance(radius));
     writeln('Area = ', processArea(radius));
end.

1'11 l%uf,aL NdIdj, mßKduh 

1'11'1  l%uf,aL NdIdjl wjYH;dj

Hello Mr. 
Computer?

'1010101010101010'
	 l%uf,aLhla hkq mß.Klh úiska l< 

hq;= úfYaI ld¾hhla bgqlrk wdldrh oelafjk 

Wmfoia wkql%uhls' fuu Wmfoia ,nd §u 

i|yd NdIdjla wjYH fõ'

mß.Klfha l%uf,aLhla l%shd;aul jk wdldrh

(Instructions)
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1'11'2  my< ;,fha NdId (Low level languages)

hka;% NdIdj (Machine language)

	 mß.Klh ;=< Rcq j u l%shd;aul l< yels NdIdjls' Wmfoia ,nd §u i|yd 

0 iy 1 hk oaúuh ixLHdxl ^ìgq& fhdod .kakd ,È' tneúka hka;% NdIdfjka ,shk 

,o l%uf,aLhla Rcq j u ilikhg Odjkh l< yels úh'

hka;% NdIdfjka ,shk ,o l%uf,aLhl ,laIK

	

²² l%shd;aul ùu b;d u fõ.j;a ùu

²² NdId mßj¾;l jevigyka wjYH fkdùu

²² hka;%h u; hemSu ^tla mß.Klhlg ,shk ,o l%uf,aLhla fjk;a 

mß.Klhl Odjkh fkdùu&

²² 0 iy 1 muKla Ndú;fhka ,shd we;s ksid ñksidg f;areï .ekSu ixlS¾K 

ùu

tfiïí,s NdIdj (Assembly language)

	 hka;% NdIdfjka 0 iy 1 u; mokï j ,shk ,o úOdk fjkqjg ir, 

ixfla; kdu Ndú; lr tfiïí,s NdIdj ks¾udKh lr we;'

tfiïí,s NdIdfjka ,shk ,o l%uf,aLhl ,laIK

²² l%shd;aul ùu hka;% NdId l%uf,aLhllg idfmalaI j fõ.j;a nj wvq h'

²² wefiïí,¾ kï jQ NdId mßj¾;l jevigyk u.ska hka;% NdId Wmfoia 

njg mßj¾;kh l< hq;= ùu

²² hka;%h u; hemSu ^tla mß.Klhlg ,shk ,o l%uf,aLhla fjk;a 

mß.Klhl Odjkh fkdùu&

²² ixfla; fhdod .ekSu ksid f;areï .ekSu hka;% NdIdjg idfmalaI j ir, 

ùu

tfiïí,s NdIdfjka 

,shk ,o l%uf,aLhla 

(A program written in 
Assembly language)

hka;% NdId úOdk 

(Machine language 
instructions)

wefiïí,¾ 

(Assembler)
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1'11'3  by< ;,fha NdId (High level languages)

	 bx.%Sis NdIdfõ ir, jpk fhdod .ksñka l%uf,aLlhdg jvd myiqfjka 

f;areï .ekSug yels jk mßÈ ks¾udKh lrk ,o NdId by< ;,fha NdId f,i 

ye¢kafõ'

by< ;,fha NdId i|yd WodyrK

FORTRAN" BASIC" COBOL" PASCAL" C

by< ;,fha NdIdfjka ,shk ,o l%uf,aLhl ,laIK

²² f;areï .ekSu myiq h'

²² Odjkh lsÍug m%:ufhka hka;% NdId Wmfoia njg mßj¾;kh l< hq;= h'

²² hka;%h u; hefmk NdIdjla fkd fõ'

FORTRAN Pascal C 

by< ;,fha NdId 

tfiïí,s NdIdj 

hka;% NdIdj

oDVdx.

1'11'4  l%uf,aL NdId j¾. 

	 l%uf,aLh lsÍu hkq lsis hï ld¾hhla lrk wdldrh ms<sn| j mß.Klhg 

Wmfoia fokq ms‚i mß.Kl l%uf,aLlfhla úiska ilikq ,nk ks¾udKYS,S 

l%shdj,shls' lsis hï .eg¨jlg úi÷ula fokq ms‚i l=uk ld¾hhla l< hq;= o 

hkak .ek mß.Klhg Wmfoia §ug ilia l< Wmfoia ud,dj l%uf,aLhla f,i 

ye¢kaúh yels h' 

	 l%uf,aLk l%shdj,shg m%fõY ùu ms‚i úl,am m%fõY .Kkdjla we;' tAjd 

l%uf,aLk mervhsu (Paradigms) f,i ye¢kafõ' l%uf,aLk Ndú; fldg úfYaI 

.eg¨j,g úi÷ï f.dvke.Su i|yd uQ,sl jYfhka fjkia wdldr m%fõY" úúO 

mervhsu u.ska ksfhdackh fõ' nyq;r l%uf,aLk NdId tl mervhsu j¾.hla 

hg;g .efkk kuq;a iuyr NdIdj, úúO mervhsuj,g wh;a uQ,sldx. ±lsh yels 

h'
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mervhsu 

(Paradigms)

m%ldYk  

(Declarative)
úOdkd;aul 

(Imperative)

;d¾lsl 

(Logic)

Y%s;uh o;a; 

.e,Sï  
(Functional 
Dataflow)

o;a; .nvd 

(Database)
mámdá.; 

(Procedural)

jia;= keUqre 

(Object 
Oriented)

iudka;r.; 

ieleiau  
(Parallel 

Processing)

•   C •   Java •   Java •   Prolog •   Lisp •   SQL

l%uf,aL mervhsu

úOdkd;aul m%ldYk jia;= keUqre

Y%s;uh l%uf,aL  ;d¾lsl l%uf,aL   

Algol
Cobol 
PL/1 
Ada 
C

Modula - 3

Lisp
Haskell

ML
Miranda

APL

Prolog Smalltalk
Simula 

C++ 
Java

	

	 wo jk úg l%uf,aLk NdId úYd, m%udKhla ìys ù we;' tAjd ld,h;a iu. 

we.hSulg ,la l< úg my; ±lafjk whqßka fjkialï ±lsh yels h'

mámdá.; (Procedural) yd m%ldYk (Declarative) l%uf,aL w;r fjki

	 mámdá.; NdIdjla hkq b;d fyd¢ka jHqy.; jQ mshjr ud,djlska iy 

mámdáj,ska (Procedural) iukaú; mß.Kl l%uf,aLk NdId j¾.hls' tys l%uj;a 

mshjrj,ska iukaú; m%ldYk (Statements) wvx.= fõ'
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WÞ - 

mámdá w;r 

o;a; yqjudre 

fõ'

m%ldYk wkql%uh

mámdá.; l%uf,aLh

mámdá 1

mámdá 2

mámdá 3

m%ldYk wkql%uh

fla;

o;a;

Tn bf.k.;a Pascal l%uf,aLfha mámdá.; l%uf,aLfha ,laIK we;' 

	 m%ldYk l%uf,aLhla hkq md,k .e,Su úia;r lsÍulska f;drj" .Kkh 

lsÍfï ;d¾lsl kHdh úoyd olajk" mß.Kl l%uf,aLj, jHqyh iy wjhj 

f.dvkxjk wdldrhls' fuu ks¾udKYS,S wdldrh Ndú; flfrk fndfyda ks¾udK 

u.ska w;=re m%;sM, wju lsÍug fyda ;=rka lsÍug fyda W;aidy orkq ,efí' th 

lrkq ,nkafka m%d:ñl l%uf,aL NdIdj, fuka .eg¨j úi£ug lghq;= lrkafka 

flfia ±hs úia;r lrkjdg jvd .eg¨ úi£ug l=uk l%uf,aLh ilia l< 

hq;= ±hs úia;r lsÍfuks' tfia jqj o tu.ska flf,i isÿjkafka o hkak úia;r 

fkdfõ' tkï mß.Klh ±kqï fokafka .eg¨j l=ulao hkak muKla jk w;r 

th úi|k wdldrh fkdfõ' wdodkh lrk .eg¨jg wjYH j úi÷ï mß.Klh 

u.ska fidhdfohs' fuh úia;rd;aul mshjr jYfhka we,af.dß;u l%shdjg kexfjk" 

mámdá.; l%uf,aLj,g m%;súreoaO fõ' m%ldYk l%uf,aL lD;su nqoaêh u; mokï 

ù we;'
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jeo.;a

mámdá.; l%uf,aL 

(Procedural Paradigm)

úi÷u fidhk wdldrh mejiSu

Saying how you achieve it

A
B
C

1'  A legh ;nkak' 

2' A legh u; B legh 

    ;nkak'

3' C legh B legh u; 

    ;nkak'

  
m%ldYk l%uf,aL 

(Declarative Paradigm)

wjYH foa mejiSu

Saying what you want

A
B
C leg 3lska iukaú; 

lKqjla

jHQy.; (Structured) iy jia;= keUqre (Object oriented) l%uf,aL ixikaokh

       jHqy.; l%uf,aL hkq ;d¾lsl l%uf,aLk mervhsuhla jk w;r th jia;= 

keUqre l%uf,aLj, mq¾j wjia:djls' jHqy.; l%uf,aL mervhsu u.ska l%uf,aLh 

f;areï .ekSu iy kùlrKh i|yd myiqlï i,ihs' moaO;sh ixrpluh Wm 

moaO;sj,g fnÞ we;s w;r by< isg my<g (Top - down) m%fõY we;' 

	 l%uf,aLfha fla;j,g ;d¾lsl úOdk mejÍfï ;dlaIKhla fuys we;' 

tneúka tys l%shdj,sh myiq lrhs' úYd, l%uf,aL l=vd tAllj,g fnÞ fjka lr 

we;s w;r tu fldgia l%udkql+, j tlsfkl w;r ne£ mj;S'

mßYS,lg o;a; we;=<;a lrk 

f,i ±kqï fohs'

mßYS,l we;=<;a l< o;a; ,nd 

.kS'

mßYS,lg m%;sM,h ,nd fohs'

o;a; l%shdj,shg Ndckh lrhs'

jHqy.; l%uf,aL

Tn bf.k.;a Pascal l%uf,aLfha jHqy.; l%uf,aL ,laIK o mj;S'
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 Object 

Property Method 

	 jia;= keUqre mß.Kl l%uf,aL hkq 

jia;= (Objects) hk ixl,amh u; mokï jQ 

l%uf,aL mervhsu fõ' jia;= hkq" o;a; wvx.= 

o;a; jHqy (Data Structures) fõ' fuu o;a; 

jHqy Wm ,laIK (Attributes) kñka y÷kajk 

lafIa;% wdldrfhka (Form of fields) mj;S' tu 

o;a; yeisrùu i|yd l%u (Methods) hehs y÷kajkq ,nk l%shdud¾. (Procedure) 
iajrEmfhka fla; (code) mj;S' jia;= keUqre l%uf,aLj, jia;+ka tlla fyda lsysmhla 

úia;r lsÍu i|yd mx;sh (Class) fhdÞ.efka'

jia;= keUqre l%uf,aL tlsfkl wka;¾ l%shdlrkakd jQ jia;+kaf.ka 

iukaú; h'

moaO;sh (System)

jd¾;d ieliSu 

(Record Loans)
iïm;a tl;= 

lsÍu 

(Add 
Resources)

f.dkq jd¾;d 

lsÍu 

(Report Fines)

jHqy.; msúiSu (Structured Approach)
Y%s; iy l%shdmámdá j,ska iukaú; h' 

(Decompose by functions or processes) 

mqia;ld, f;dr;=re moaO;sh 

(Library Information Systems)

iqÑh 

(Catalog)

fmd;a 

(Book)

mqia;ld,dêm;s 

(Librarian)

mqia;ld,h 

(Library)

jia;= keUqre msúiSu (Object Approach)
jia;= iy l%ufõoj,ska iukaú; h' 

(Decompose by objects or concepts) 

 Object 

Property Method 

	 jia;= keUqre mß.Kl l%uf,aL hkq 

jia;= (Objects) hk ixl,amh u; mokï 

jQ l%uf,aL mervhsu fõ' jia;=" o;a; (data) 
iy l%uj,ska (Methods) iukaú; fõ' l%u 
(Methods) hkq o;a; yeisrùu i|yd mj;sk 

l%shdud¾. (Procedure) iajrEmfhka mj;sk 

fla; fõ'

	 mka;s (Class) hkq jia;= keUqre l%uf,aLj, uQ,sl ;ekqï tallhhs' mka;s 

u.ska o;a; iy mka;sfha wjia:d yd iïnkaO yeisÍï úia;r lrhs' mka;s Ndú;fhka 

tlu wdldrhlg wh;ajk jia;= ks¾udKh l< yels h' 

jia;= keUqre l%uf,aL tlsfkl wka;¾ l%shdlrkakd jQ jia;+kaf.ka 

iukaú; h'

moaO;sh (System)

jd¾;d ieliSu 

(Record Loans)
iïm;a tl;= 

lsÍu 

(Add 
Resources)

f.dkq jd¾;d 

lsÍu 

(Report Fines)

jHqy.; msúiSu (Structured Approach)
Y%s; iy l%shdmámdá j,ska iukaú; h' 

(Decompose by functions or processes) 

mqia;ld, f;dr;=re moaO;sh 

(Library Information Systems)

iqÑh 

(Catalog)

fmd;a 

(Book)

mqia;ld,dêm;s 

(Librarian)

mqia;ld,h 

(Library)

jia;= keUqre msúiSu (Object Approach)
jia;= iy l%ufõoj,ska iukaú; h' 

(Decompose by objects or concepts) 
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.=Kdx. 

(Property) 
(Data)
ifï meyeh 

weiaj, j¾Kh 

Wi 

È.

nr

l%ufõo 

(Methods) 
(Code)
ys|.ekSu

je;sÍu 

fi,ùu

weú§u

.=Kdx.j, w.hka 

(Property Values)
j¾Kh - w¿" iqÿ  

iy l¿

weiaj, j¾Kh - 

ks,a iy ÿUqre 

Wi - 18''
È. - 38''
nr - rd;a;,a 30

l%ufõo 

(Methods)
ys|.ekSu

je;sÍu 

fi,ùu

weú§u

fgdón,a,d

mx;sh (Class) jia;+ (Object)

Procedural Languages Computation involves 
code operating on Data

Code (Methods)

Data (Property)

Object-Oriented Languages
An object encapsulates 
both code and data

Code (Methods)
Data (Property)

Computation involves 
objects interacting with 
each other



fkdñf,a fnod yeÍu msKsihs52

ls%hdldrlu   

Car kï mka;sh (Class) ie,l+ úg tys jia;= (Objects)" .=Kdx. 

(Properties) iy l%ufõo (Methods) fudkjdo hkak y÷kd.kak'

l%uf,aLkh (Programming) iy msgm;a f,aLkh (Scripting)

 

	 l%uf,aLk NdIdj, idudkHfhka mo fhdackh (Syntax) iïnkaOfhka ±ä 

kS;s Í;s mj;S' ks;r u mdfya iïmdokh lsÍu wjYH fõ' l%uf,aL NdId iïmdokh 

(Compile) l< hq;= fõ. msgm;a f,aLk NdId idudkHfhka fjk;a fhojqula ^WÞ 

- fjí n%jqirhla fyda fjí i¾jrhla& iu. fndfyda úg l%shd;aul jk fla;hla 

ksIamdokh flf¾' tfuka u msgm;a f,aLk NdId w¾: úkHdY (Interprit) l< hq;= 

h' kjlhkaf.ka w;sYh nyq;rhla msgm;a rpk NdIdj Ndú; lsÍu jvd myiq hehs 

is;;s'

JavaScript iy PHP hk fol u msgm;a f,aLk NdId fõ'

ls%hdldrlu   

my; i|yka l%uf,aL mervhsuj, fjkialï ixikaokh lrkak'

•• mámdá.; yd m%ldYk (Procedural vs Declarative)
•• jHqy.; yd jia;= keUqre (Structured vs Object oriented)
•• l%uf,aL yd msgm;a f,aLkh (Programming vs Scripting)

1'11'5 NdId mßj¾;l jevigyka 

	 hka;% NdIdfjka yer fjk;a ´kE u NdIdjlska ,shk ,o l%uf,aL ^jia;= 

fla;& Odjkh lsÍug m%:ufhka hka;% NdId Wmfoia ^hka;% fla;& njg mßj¾;kh 

l< hq;= h' 

	 wefiïí,s NdIdfjka ,shk ,o l%uf,aLhla wefiïí,¾ kï jQ NdId 

mßj¾;l jevigyk u.sska hka;% NdId Wmfoia njg mßj¾;kh lrkq ,eî h'

	 by< ;,fha NdIdjla fhdod .ksñka ,shk ,o l%uf,aLhla hka;% NdId 

Wmfoia njg mßj¾;kh lsÍu i|yd jevigyka ^uDÿldx.& folla fhdod .efka'

1' w¾: úkHdil (Interpreter)
2' iïmdol (Compiler)
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w¾: úkHdil (Interpreter) 

	 by< ;,fha mß.Kl NdIdjlska ,shk ,o l%uf,aLhla l%shd;aul lsÍug 

m%:ufhka tys wvx.= m%ldYkfhka m%ldYkh hka;% NdId úOdk njg mßj¾;kh 

lr tie‚ka u Bg wkqrEmS úOdk Odjkh lrñka mßj¾;k l%shdj,sh isÿ lrk 

NdId mßj¾;lh w¾: úkHdilhla f,i ye¢kafjhs'

w¾: úkHdilhla Ndú; lrk mß.Kl NdIdj, l%uf,aL mßj¾;kfha §

1'	 l%uf,aLfha ldrl Í;s fodaI fkdue;s kï Odjkfhka miq ksjerÈ m%;sodk ,nd 

fohs'

2'	 l%uf,aLfha ldrl Í;s fodaI mj;S kï th wjidkh olajd u l%shd;aul fkd 

fõ' ^fodaIh we;s ia:dkh olajd l%shd;aul ùug yelshdj we;'&

jeo.;a

l%uf,aLh Odjkh lrk jdrhla mdid hka;% fla;h njg mßj¾;kh 

isÿ fõ'

by< ;,fha NdIdjlska 

,shQ l%uf,aLh 

(A program written in 
high level language)

hka;% NdId úOdk 

(Machine language 
instructions)

w¾: úkHdil  

(Interpreter)

iïmdol (Compiler)

	 by< ;,fha mß.Kl NdIdjlska ,shk ,o l%uf,aLh l%shd;aul lsÍug 

m%:ufhka th iïmQ¾Kfhka u tl jr hka;% NdId Wmfoia njg mßj¾;kh 

lsÍfuka miq Odjkh lsÍu iïmdolh u.ska isÿ fõ'

by< ;,fha NdIdjlska 

,shQ l%uf,aLh 

(A program written in 
high level language)

hka;% NdId úOdk 

(Machine language 
instructions)

iïmdol 

(Compiler)
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	 iïmdol Ndú; lrk mß.Kl NdIdj, m%Nj fla; (Source code) hka;% 

fla; njg mßj¾;kfha §

1'	 l%uf,aLfha ldrl Í;s fodaI fkdue;s kï Odjkfhka miq m%;sodk ,nd fohs'

2'	 l%uf,aLfha ldrl Í;s fodaI mj;S kï th hka;% fla; njg mßj¾;kh fkd 

fõ' tu fodaI iys; ia:dk fmkajhs'

jeo.;a
l%uf,aLh tla jrla hka;% fla;h njg mßj¾;kh jQ miq wjYH ́ kE 

u jdr .Kkla Odjkh l< yels h' kej; mßj¾;kh lsÍula wjYH 

jkafka m%Nj fla;h fjkia l< fyd;a mu‚'
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²² .eg¨jla úYaf,aIKh lsÍfuka wdÞk" m%;sodk iy l%shdj,sh y÷kd .; yels  

fõ' 

²² we,af.dß;u f.dvke.Sug .e,Sï igyka iy jHdc fla; fhdÞ .; yels 

fõ' 

²² ´kE u wkql%uhla ,sùfï § Ndú; jk uQ,sl wkql%uh" jrKh iy 

mqk¾lrKh f,i md,k j.=j f,i mj;S'

²² we,af.dß;uhl msysá mshjr lsysmhla fyda ish,a, u fydaa wdrïNl mshjrl 

isg wjidk mshjr olajd wkqms<sfj<ska l%shd;aul ùu wkql%uh (Sequence)
ye¢kafõ' 

²² fldkafoaishla ;Dma; ùu fyda fkdùu fyda wkqj l%shd;aul l< hq;= mshjr 

l=ula o hkak ;SrKh jk wjia:djla jrKhla (Selection) f,i ye¢kafõ'

²² we,af.dß;uhl we;=<;a mshjrla fyda mshjr lsysmhla fyda fldkafoaishla 

fyda ;Dma; jk f;la fyda ;Dma; j mj;sk ;=re fyda kej; kej;;a isÿùu 

mqk¾lrKh (Repetition) f,i ye¢kafõ'

²² úp,Hhla" ksh;hla fyda l%uf,aLhla ye¢kaùu i|yd fhdÞ .kakd kduhla 

y÷kajkhla (identifier) f,i kï flf¾' 

²² l%uf,aLh l%shd;aul jk úg y÷kajk i|yd mjrk ,o w.hka fjkia jk 

y÷kajk" úp,H (Variable) f,i kï flf¾' 

²² meial,a hkq by< ;,fha l%uf,aLk NdIdjls'

²² m%ldYkhla iq¿ ùu ldrlj, m%uqL;d wkqms<sfj< wkqj isÿ fõ' 

²² hka;% NdIdj iy wefiïí,s NdIdj my< ;,fha l%uf,aLk NdId f,i 

ie,fla' 

²² PASCAL, BASIC, C yd JAVA jeks NdId by< ;,fha l%uf,aLk NdId 

i|yd WÞyrK fõ'

²² hka;% NdIdfjka ,shk ,o l%uf,aLhla Rcq j u ilikhg Odjkh l< 

yels fõ' 

²² hka;% NdIdfjka yer fjk;a ´kE u mß.Kl NdIdjlska ,shk ,o 

l%uf,aLhla Odjkh lsÍug m%:ufhka hka;% NdId Wmfoia njg mßj¾;kh 

l< hq;= h' 

²² mámdá.;" m%ldYk" jHqy.;" jia;= keUqre" l%uf,aL yd msgm;a f,aLk f,i 

l%uf,aL mervhsu we;' 

²² w¾:úkHdil (Interpreter) iy iïmdol (Compiler) hkq NdId mßj¾;l 

jevigyka folls'

idrdxYh
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fuu mdvu yeoEÍfuka Tng"

²² moaO;shla hkq l=ula o@

²² moaO;shl ix>gl moaO;s 

²² w;ahqre f;dr;=re moaO;s iy mß.Kl mdol f;dr;=re moaO;s

²² moaO;s ixj¾Ok Ôjk pl%h

²² mqk¾lrK-jDoaê Ôjk pl%h

		  ms<sn| j wjfndaOhla ,nd .; yels jkq we;'

2'¡1 f;dr;=re moaO;s ixl,amh

	

	 moaO;shla hkq hï fmdÿ wruqKla idlaId;a lr .ekSug ksrka;r wka;¾ 

ls%hdldß;ajfhka hq;= ix>gl iuQyhl tl;=jls' 

	 my;ska olajd we;s 2¡1 rEmhg wkqj mdr ilia lrk hka;%fha fldgia 

tlsfklg wka;¾-ls%hdldß;ajfhka hq;= j lghq;= fkdlrhs¡ fï ksid mdr ilia 

lsÍfï ld¾hh isÿ l< fkdyels h¡ 2¡2 rEmhg wkqj mdr ilia lsÍfï hka;%h 

tlsfklg wka;¾-ls%hdldß;ajfhka hq;= j lghq;= lr mdr ilia lsÍfï wruqK 

idlaId;a lr .ekSug yels whqßka ilia lr we;¡ ta wkqj 2¡2 rEmfhka olajd we;s 

hka;%h moaO;shla f,i ls%hd lrhs¡

     

	 	 rEmh 2¡1	 	 mdr ilia lrk hka;%	          rEmh 2¡2		

	

2
f;dr;=re moaO;s ixj¾Ok ls%hdj,sh 

moaO;shla hkq l=ula o@



PB

fkdñf,a fnod yeÍu msKsihs 57

moaO;shl uQ,sl ix>gl

	

moaO;shla uQ,sl l%shdj,s ;=klska iukaú; fõ'

1'	 wdodkh

2'	 ls%hdj,sh

3'	 m%;sodkh

moaO;shlg ,efnk wdÞk" ieliqu u.ska m%;sÞk njg m;a flf¾'

Output
m%;sodkh

Input
wdodkh

Process 
ieliSu

rEmh 2¡3 - moaO;shl uQ,sl ix>gl (Basic components of a system)

WodyrK - 1 - mdi, moaO;shla f,i ie,lSfï §"

moaO;sh 		  -	 mdi,

wruqK  		  - 	 rgg oehg jevodhl hym;a mqrjeishka ìyslsÍu 

wdÞk 	 - 	 orejkaa

ieliSu   	 -	 mdi, ;=< .=rejre" mdif,a wfkl=;a iïm;a  

	 wka;¾-ls%hdldß;ajfhka hq;= j lghq;= lr orejka  

	 bf.kqï b.ekaùï ls%hdj,shlg Ndckh lr;s'

m%;sodk	     	 - 	 hym;a mqrjeishka cd;shg odhdo lsÍu 

WodyrK - 2 

	 jdhqf.da, mSvkh" WIaK;ajh" iq<fÕa ÈYdj" f;;ukh wdÈ o;a; we;=<;a l< 

úg ld,.=K mqfrdal:k moaO;shla u.ska fyg ojfia ld,.=K wkdjelsh m%;sÞkh 

flf¾' 

	 m%;sodk f,i ,efnk fuu f;dr;=rej, jeo.;alu jkafka tAjdhska wmg 

;SrK .ekSug myiq ùuhs' 

f;dr;=re moaO;sh

	 o;a; f;dr;=re njg m;a lrk moaO;shla f;dr;=re moaO;shla (Information 
system) f,i ye¢kafõ'	

o;a; 

(Data)
ieliSu 

(Process)
f;dr;=re  

(Information)

	 f;dr;=re moaO;shla m%Odk jYfhka w;ahqre f;dr;=re moaO;s ^Manual 
Information System) iy mß.Kl mdol f;dr;=re moaO;s ^Computer Based 
Information System) f,i j¾. l< yels h'

rEmh 2¡4 - f;dr;=re moaO;shl l%shdj,sh



fkdñf,a fnod yeÍu msKsihs58

w;ahqre f;dr;=re moaO;s

fujeks moaO;sj, ish¨ u ieliqï mqoa.,hka úiska w;ska isÿ lrkq ,nhs'

WodyrK - mdi,l w;ahqre YsIH f;dr;=re moaO;shla i,luq'

	 mdi,g isiqjl= we;=<;a lsÍfï § Tyqg ,shdmÈxÑ wxlhla ,nd foa' tfuka u 

Tyqf.a fm!oa.,sl f;dr;=re wvx.= jk ,sms f.dkqjla o ilia lrkqq ,efí' mdi,a 

ld,h w;r;=r § <uhdf.a úúO olaI;d" ch.%yK fuu ,sms f.dkqjg we;=<;a lrkq 

,efí¡

	 hï wjia:djl hï isiqfjl=f.a miq.sh jif¾ m%.;sh ms<sn| jd¾;djla 

úÿy,am;sg wjYH jQfha hehs is;uq' fuys wdÞk" l%shdj,sh iy m%;sÞk my; mßÈ fõ' 

wdÞk 

isiqjdf.a ku iy wÞ< j¾Ih

l%shdj,sh

1' <uhdg wÞ< ,shdmÈxÑ wxlh imhd .ekSu

2' tu ,shdmÈxÑ wxlhg wo< ,smsf.dkqj fidhd .ekSu

3' tu ,smsf.dkqj u.ska wÞ< j¾Ifha m%;sM, úia;r Wlyd .ekSu

4' tu f;dr;=re weiqfrka jd¾;djla ieliSu

m%;sÞkh 

wÞ< j¾Ih i`oyd isiqjdf.a m%.;s jd¾;dj

ls%hdldrlu   

by; YsIH f;dr;=re w;ahqre moaO;sh fjkqjg mß.Kl mdol YsIH 

f;dr;=re moaO;shla we;ehs Wml,amkh lrkak' by; lS" hï 

YsIHfhl=f.a" hï jirlg wÞ< f;dr;=re ,nd .ekSfï l%shdj,sh" 

w;ahqre yd mß.Kl mdol moaO;sj,ska fjk fjk u lsÍfï § we;s jdis 

yd wjdis ixikaokh lrkak' 

mß.Kl mdol f;dr;=re moaO;s

	 mß.Kl wdY%fhka o;a; f;dr;=re njg m;alrk moaO;shla mß.Kl mdol 

f;dr;=re moaO;shla f,i ye¢kafõ' 	

mß.Kl mdol mdi,a mqia;ld, moaO;shla i,lkak' tu.ska mqia;ld,hdêm;sg 

,efnk m%fhdack my; ±lafõ'

²² hï fudfyd;l" hï fmd;la mqia;ld,fha ;sfí o keoao hk nj yd th ;sfí 

kï th ;sfnk ia:dkh ks¾Kh lr .; yels ùu
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²² ;Sre ixfla; lshjkhla (Bar code System) u.ska mqia;ld,fha fmd;a  

Ndr.ekSï" neyer §ï myiqfjka l< yels ùu

²² fmd;a i|yd m%udo .dia;= iajhxl%Sh j .Kkh lr .; yels ùu

²² ld¾hlaIu j fmd;a fidhd .ekSug myiq ùu

²² fmd;a neyer f.k hkakka ms<sn| j jd¾;d ;nd .ekSug yelshdj ,eîu

²² kshñ; Èkg fmd;a wdmiq ,nd kqÿka mqoa.,hka ,ehsia;=.; lsÍu myiq ùu

²² mqia;ld,h ud¾..; moaO;shla (Online System) f,i ilia lr tu.ska 

idudðlhkag ÿria: j isg mqia;ld, fiajd ^fmd;a fiùu" fjka lr .ekSu& 

l< yel

²² idudðlhkag bf,lafg%dksl fmd;a (e books) ,ndÈh yels ùu

²² mdif,a m%Odk ld¾hd,h iu. cd,.; lsÍu u.ska YsIHhkaf.a wiaùï iy;sl 

,nd fok wjia:dj, mqia;ld, fmd;a Ndr ÿka$fkdÿka nj laI‚l j iy;sl 

lr .; yels ùu

ls%hdldrlu   

by; i|yka m%;s,dNj,g wu;r j YsIHhkag ,efnk fjk;a m%;s,dN 

,ehsia;= .; lrkak' 

w;ahqre moaO;s iy mß.Kl mdol f;dr;=re moaO;s w;r m%Odk fjkialï

w;ahqre moaO;s mß.Kl mdol f;dr;=re moaO;s

o;a; ieliSfuka f;dr;=re ,nd §u 

mqoa.,hd yia;Sh j isÿ lrk ksid 

fodaI isÿ ùug we;s bvlv jeä h'

ilik ,o jevigyklg wkqj f;dr;=re 

,nd fok neúka fodaI we;sùu wju fõ'

f;dr;=re ilid .ekSu i|yd jeä 

ld,hla .; fõ'

b;d wvq ld,hlska f;dr;=re ilid .; 

yel'

o;a; .nvd lsÍu i|yd úYd, bv 

m%udKhla wjYH jk w;r ,sms f,aLk 

wiqrd ;eîu i|yd lnâ wdÈh wjYH 

fõ'

b;d iq¿ bv m%udKhl úYd, o;a; 

m%udKhla .nvd lr ;nd .; yels w;r ta 

i|yd o;a; mdol uDÿldx.hla Ndú; l< 

yels h'

o;a; fkdfhla jHikj,g Ndckh 

úh yels w;r o;a; i|yd wdrlaIdj 

mß.Kl mdol f;dr;=re moaO;shg 

idfmalaI j wvq  fõ'

Wmia: (backups) fhdod .ekSu ksid;a 

uqqrmo fh§u u.skq;a o;a; m%fõYh  i|yd 

jrm%ido ,nd fok wdldrh wkqj o;a;j,g 

wdrlaIdjla ,nd .ekSug yels jkq we;¡
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2'2 moaO;s ixj¾Ok l%ufõo

	 f;dr;=re moaO;shla f.dvke.Sfï § úúO l%ufõo Ndú; lrkq ,efí' tAjd 

w;=ßka moaO;s ixj¾Ok Ôjk pl%h (System Development Life Cycle) m%Odk fõ'

2'2'1  moaO;s ixj¾Ok Ôjk pl%h  

fuh mshjr lsysmhlska iukaú; h'

        1' wjYH;d y÷kd .ekSu (Identification of requirements)
2' úi÷u ie,iqï lsÍu (Designing the solution)
3' úi÷u fla;lrKh lsÍu (Coding  of the solution)
4' úi÷u mÍlaId lsÍu yd fodaI bj;a lsÍu (Testing and debugging)
5' moaO;sh msysgqùu (Deployment of  the system)
6' moaO;s kv;a;= lsÍu (Maintenance of the system)

	 moaO;shla ia:dms; lr Ndú; lrk úg kj wjYH;d u;=úh yel' túg 

m<uqfjks mshjrg kej; f.dia tu kj wjYH;d imqrd .ekSug fuu l%shdj,sh 

mqk¾lrKh l< yels h' 	

moaO;s ixj¾Ok Ôjk pl%fha mshjr

	 1' wjYH;d y÷kd .ekSu (Identification of requirements)

	 fuys § mj;sk w;ahqre moaO;sh fyda ixj¾Okh l< hq;= mß.Kl mdol 

f;dr;=re moaO;sh ms<ssn| j mQ¾K úuid ne,Sula isÿ flfrhs' kj moaO;sfha 

wruqKq" m%;s,dN" ld¾hlaIu;dj" jeks foa ms<sn| ,sÅ; igyka ms<sfh, flf¾' fuh 

wdh;kfha ld¾h uKav,h iy moaO;sh f.dvk.k lKavdhu tl;=j isÿ lrkq 

,efí'

 	 fuu mshjf¾ § moaO;s úYaf,aIl (System analyst) úiska mj;sk moaO;sh 

úia;rd;aul  j wOHhkh lrkq ,nk w;r w¨;a wjYH;d y÷kd.kq ,efí' mrsYS,l 

wjYH;d imqrd,Su i|yd f;dr;=re tla/ia l< hq;= fõ' f;dr;=re tla/ia lsÍfï 

l%ufõo lsysmhla mj;sk w;r bka lsysmhla my; oelafõ'  

1&  ksÍlaIKh (Observation) 
2)  iïuqL idlÉPd (Interview)
3&  m%Yakdj,s (Questionnaire)
4&  jd¾;d fyda ,sms f.dkq ksÍlaIKh (Document sample collection)

	 5&	 uQ,do¾Y (Prototyping)
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1&  ksÍlaIKh	

	 moaO;s ixj¾Okh wdrïNl wjia:dfõ § mj;sk moaO;sh th mj;sk 

iajNdjfhka u ksÍlaIKh lsÍfuka f;dr;=re ,nd .ekSu isÿ fõ' Wml,amk 

f.dvke.Sug fuh jeo.;a fõ'

WÞ - mqia;ld,hg f.dia mqia;ld,hdêm;s fmd;a ksl=;a lrk wdldrh ksÍlaIKh  

      lsÍu

2&  iïuqL idlÉPd

	 uqyqKg uqyqK ,d m%Yak weiSu u.ska ,efnk ms<s;=re úYaf,aIKh lr 

f;dr;=re /ia lrkq ,efí' mqoa., wdl,am ms<sn| j wjxl f,i l;d lsÍug wjldY 

,efnk neúka mqoa., wjYH;d ksje/È j y÷kd .efka'

WÞ - mqia;ld,dêm;s yuq ù Tyq iu. iïuqL idlÉPdjla meje;aùu 

3& m%Yakdj,s

	 jHqy.; m%Yakdj,shla iemfhk w;r ,sÅ; j ,efnk ms<s;=re úYaf,aIKfhka 

f;dr;=re ,nd .kq ,efí' 

WÞ - ilik ,o m%Yakdj,shla mqia;ld,hdêm;sg ,nd § Tyqf.ka th iïmQ¾K lr  

      .ekSu	

4& jd¾;d fyda ,sms f.dkq ksÍlaIKh

	 wdh;khl we;s jd¾;d fyda ,sms f.dkq fydA ksÍlaIKfhka f;dr;=re ,nd 

.efka'

WÞ - mqia;ld,fha we;s jd¾;d" mqia;ld,h ldâm;a wdÈh ksÍlaIKh 

5& uQ,do¾Y

	 ia:dmkh lsÍug wfmalaIs; moaO;sfha wkqrejla ld¾h uKav,hg iy 

mßYS,lhkag fmkaùug ie,eiaùfuka Tjqkaf.a woyia ,nd .ekSu fuu.ska isÿ 

flf¾' 

WÞ - kj mqia;ld,h moaO;sh ;sìh yels wdldrfha o¾Yk" jd¾;d" idïm, wdÈh  

         fmkaùu 

	 2' úi÷ï ie,iqï lsÍu (Designing the solution)

		  fuu mshjr moaO;s ixj¾Okh Ôjk pl%fha wfkla 

mshjrj,ska fjkia jk w;r moaO;sfha úúO foa ie,iqï lsÍu 

fuys m%Odk wruqKhs' moaO;s ie,iqïlrKfha § lrkq ,nk 

ld¾hhka iuyrla my; mßÈ fõ' 
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  1' uDÿldx. y÷kd .ekSu" uDÿldx. ks¾ñ;sh (Sofware architecture) y÷kd .ekSu

  2' w;=re uqyqK;a (User interface) tkï mßYS,lg ;srfha o¾Ykh jk wdldrh yd  

     o;a; .nvd ieliqu 

  3' m%Odk oDVdx. moaO;s iy tAjdfha ix>gl y÷kd .ekSu

  4' tla tla WmmoaO;sj, mrdh;a; nj y÷kd .ekSu

  5' moaO;sh l%shd;aul lsÍu i|yd WÑ; oDVdx. iy uDÿldx. ;SrKh lsÍu

  6' uDÿldx." o;a; .nvd" w;=re uqyqK;a ms<sn| há;, jHqyh ks¾udKh lsÍu

  7' mÍlaIK ie,iqï (Test plans) lsÍu

	 3' úi÷ï fla;lrKh lsÍu (Coding  of the solution)

		  l%uf,aLl iqÿiq mß.Kl NdIdjla fhdod f.k  

ie,iqï lrk ,o moaO;sh fla;lrKh lsÍu fuu mshjf¾ 

m%Odk wruqKhs' fla;lrKfha § fla; ir, ùu yd ld¾hlaIu 

ùu u.ska f;areï .ekSug iy f.dvke.Sug myiq fõ' 

moaO;shla ksje/È j fla;lrKh lsÍu u.ska moaO;sh mÍlaId 

lsÍug iy kv;a;= lsÍug hk úhou iy ld,h wju lr .; yels h¡ 	

	 4' úi÷ï mÍlaId lsÍu iy fodaI bj;a lsÍu (Testing and debugging)

 

	   fuu wÈhf¾ m%Odk wruqK jkafka fodaI 

ksrdlrKh lsÍuhs' fla;k fodaI" ie,iqï fodaI fyda 

wjYH;d fodaI fuys § ksje/È lrkq ,nhs'

úi÷ï mÍlaId lsÍfï l%u lsysmhla we;' tAjdhska iuyrla my; oelafõ' 

  

m%;s.%yK mÍlaIdj

moaO;s mÍlaIdj 

iuia; mÍlaIdj

tall mÍlaIdj

rEmh 2¡5 - moaO;s mÍlaId
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1&  tall mÍlaIdj (Unit Testing)

		  moaO;sfha tAll fjk fjk u mÍlaId flf¾' mÍlaId 

flfrk tAllh ;=< wdÞkhg wÞ< m%;sodkh ,efí ± hs mÍlaId 

flf¾'

WÞ - ld¾hd,hla ;=< .sKqï YdLdj" wdh;k YdLdj wdÈ tAll  

			       fjk fjk u mÍlaIdj

2&  iuia; mÍlaIdj (Integrated Testing)

		  by; wdldrhg tall mÍlaIdj isÿlr tla tla tAll 

ksis f,i taldnoaO lr mÍlaIdjg ,lalsÍu iuia; mÍlaIdj 

f,i y÷kajkq ,nhs'  

3&  moaO;s mÍlaIdj  (System Testing)

		  iïmQ¾K moaO;shg wÞ< wdÞk ,nd foñka wfmalaIs; 

m%;sodk ,efí±hs mÍlaId flf¾' wjÞkï iys; wjia:d" 

fufyhqï moaO;s iu. wka;¾l%shd wdÈh ms<sn| ie,ls,su;a fõ'

4&  m%;s.%yK mÍlaIdj (Acceptance Testing)

		  moaO;s mÍlaIK wjika lr wjidkfha § isÿ flfrk 

mÍlaIdj m%;s.%yK mÍlaIdjhs¡ fuu mÍlaIdfõ § mßYS,lhkag 

moaO;sh Ndú; lsÍug bv i,iajkq ,efí' fuys § mßYS,lhd 

fhdað; moaO;sh wkqu; lsÍu fyda ksje/È l< hq;= oE fmkaùu 

isÿlrhs' 

  
5'  moaO;sh msysgqùu (Deployment of the system)

		  ifÞia ;eka ksfÞia lr .;a kj moaO;sh msysgqùu 

fuu mshjf¾ § isÿfõ' 

moaO;s msysgqùfï úúO l%u my; mßÈ fõ¡

	 1& Rcq msysgqùu  (Direct deployment)
	 2& iudka;r j msysgqùu (Parallel deployment)

			   3& kshuquh msysgqùu (Pilot deployment)
			   4& wÈhruh msysgqùu (Phase deployment)
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Rcq msysgqùu  (Direct deployment)

	 mer‚ moaO;sh iïmQ¾Kfhka u bj;a lr kj moaO;sh 

ls%hd;aul lsÍu isÿlrkq ,nhs¡ kj moaO;sh id¾:l kï fmr 

moaO;sh Ndú;h kj;d ±ñh yels h'
 

Wod - mqia;ld,fha w;ahqre moaO;sfha l%shdldß;ajh iïmQ¾Kfhka  

	  u kj;d mqia;ld, l<ukdlrK uDÿldx.h (Library  
	    management software) ia:dmkh lsÍu

iudka;r j msysgqùu (Parallel deployment)

	     mj;sk moaO;sh yd kj moaO;sh hï ksYaÑ; 

ld,hla ;=< iudka;r j mj;ajd f.k hkq ,efí' 

kj moaO;sh id¾:l jkafka kï mer‚ moaO;sh 

kj;d kj moAO;sh ls%hdjg kxjkq ,efí'

Wod - -mqia;ld,fha mer‚ moaO;sh l%shd;aul  

	  fjñka mj;sk w;r;=f¾ § kj moaO;sh 

					       ia:dmkh lr l%shd;aul lsÍu

kshuquh msysgqùu (Pilot deployment)
	   moaO;shla l=vd mßudK lafIa;%hl uq,ska 

ia:dmkh lsÍu' fuys §" uq¿ rgg u wod< jk 

moaO;shla f;dard.;a Èia;%slalhl uq,ska ia:dmkh 

lr ne,Su ie,lsh yel'

 Wod -  jdyk wdÞhï n,m;% .ekSu iïnkaOfhka 

	   ieliQ moaO;sh uq,ska tla m<d;lg muKla  

						        ia:dmkh lr miq j id¾:l jkafka kï 

						        ish¨ u m<d;aj,g ia:dmkh lsÍu   

wÈhruh msysgqùu (Phase deployment)

	  fuys § kj moaO;sh wÈhr jYfhka ia:dmkh 

flf¾' id¾:l jk iEu wÈhrla u B,Õ wÈhrg 

.uka lrk w;r wjidk wÈhr iïmQ¾K jkúg 

mer‚ moaO;sh kj moaO;sh u.ska iïmQ¾Kfhka u m%;sia:dmkh ù we;'

Wod - mdie,a mqia;ld, moaO;shl we;s fmd;a j¾. wÈhr jYfhka tkï m<uqj  

       Yío fldaI" fojkqj fldaI .%ka:" ;=kafjkqj m%nkaO wdÈ f,i kj moaO;sh 

       u.ska ia:dmkh lsÍu 
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6' moaO;s kv;a;= lsÍu (Maintenance of the system)

	
	 kj moaO;sh ia:dmkh lsÍfuka miq hï 

ld,hla ;=< ls%hd;aul lsÍfï § moaO;sh kv;a;=j 

ksis f,i isÿ l< hq;= fõ' moaO;s kv;a;=lrKfha § 

mß.Kl" mß.Kl uDÿldx." mß.Kl cd,h wdÈh 

kv;a;= lsÍu isÿ lrkq ,nhs¡

moaO;s kv;a;= wÈhf¾ § ixj¾ê; moaO;shg isÿl< hq;= fjkialï f,i" 

²² w¨;ska y÷kd .;a mßYS,l wjYH;d wkqj moaO;sh ks¾udKh 

²² moaO;s mÍlaIKfha § y÷kd fkd.;a kuq;a moaO;sh ls%hdjg kexùfï § y÷kd 

.;a iq¿ .eg¨j,g ms<shï fh§u

²² kj ;dlAIKfha ÈhqKqj moaO;shg fhdod .ekSu u.ska moaO;sfha ld¾hlaIu;dj 

by< ±óu

	 wdÈh oelaúh yels h' 

2'2'2  moaO;s ixj¾Ok wdlD;s 
	

	 moaO;s ixj¾Ok Ôjk pl%h ;=< fkdfhla wdlD;s ±l .ekSug yels h' fuu 

tla tla wdlD;s u.ska moaO;s ixj¾Ok l%ufõoh úúOdldr f,i l%shd;aul fõ' 

	 1' Èhwe,s wdlD;sh (Waterfall Model)
	 2' mqk¾lrK jDoaê wdlD;sh (Iterative Incremental Model)
	 3' uQ,do¾Y wdlD;sh (Prototype Model)
	 4' i¾ms, wdlD;sh (Spiral Model) 

Èhwe,s wdlD;sh 

	 Èhwe,s wdlD;sh l,dm f,i moaO;s ixj¾Ok f;dr;=re moaO;shla i|yd 

WÞyrKhls' Ôjk pl%fha mshjr f¾Çh f,i l%shd;aul lsÍu Èhwe,s wdlD;sfhka 

fmkajd foa' fuu wdlD;sh u.ska moaO;shla f.dv ke.Sfï §"

²² m<uq j wjYH;d fyd¢ka y÷kd.; hq;= h'

²² tla mshjrla iïmQ¾Kfhka u wjika lsÍfuka miq wfkla mshjr wdrïN fõ' 

²² ixj¾ê; moaO;sfha wjidk m%;sM,h ±l .ekSug yels jkafka wjidk wÈhf¾ 

§ h' tneúka moaO;sh u.ska n,dfmdfrd;a;= fkdjQ m%;sM,hla  o ,eìh yels h'
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rEmh 2'6 l,dm f,i moaO;s ixj¾Ok wdlD;sh - Èhwe,s wdlD;sh

mqk¾lrK jDoaê wdlD;sh

moaO;s ixj¾Ok wdlD;shla f,i mqk¾lrK-jDoaê pl%h o Ndú; lrkq ,efí' 

wjYH;d y÷kd .ekSu 

(Identification of 
requirements)

ie,iqï lsÍu 

(Planning)

wdrïNl ie,iqï 

lsÍu (Initial 
Planning)

we.hSu (Evalution)
mÍlaId lsÍu 

(Testing)
msysgqùu

(Deployment)

l%shd;aul lsÍu

(Implementation)

úYaf,aIKh yd msßie,iqï lsÍu

(Analysis and Design)

 rEmh 2'7 - mqk¾lrK-jDoaê Ôjk pl%h (Iterative Incremental Life Cycle)
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fuu wdlD;sfha ,laIKj,ska iuyrla my; ±lafõ' 

²² fuu ixj¾Ok wdlD;sfhys m%Odk woyi jkafka tla j;djlg l=vd fldgila 

ne.ska kej; kej; mqk¾lrKh jkakd jQ (iterative) iy iEu mqk¾lrKhl 

§ u jeä ÈhqKq jkakd jQ (incremental) wdldrhg moaO;shla ixj¾Okh lsÍuhs'

²² moaO;s ixj¾Olhka (System developers) yg ;uka fmr mshjrj, § ,nd.;a 

±kqu Ndú;hg .; yels ùu jdishls' 

²² fuys m%Odk mshjr wdrïN jkafka moaO;sfha wjYH;djla ir, j l%shd;aul 

lsÍu u.sks' 

²² moaO;sh iïmQ¾Kfhka u ixj¾Okh jk ;=re mqk¾lrKh fjñka jeä ÈhqKq 

flf¾'

²² iEu mqk¾lrKhl § u moaO;s ie,iqfuys fjkialï isÿflfrk w;r kj 

l%shdldß;ajhka tl;= fõ' 

ls%hdldrlu   

	 moaO;s ixj¾Ok Ôjk pl%h l%shd;aul lr moaO;shla ilia lsÍfï §  

mqk¾lrK jDoaê wdlD;sh iy l,dm wdlD;s fhdÞ.ekSfï §  olakg 

,efnk m%Odk fjkialï olajkak' 

²² moaO;shla hkq hï fmdÿ wruqKla idlaId;a lr .ekSug ksrka;r  

wka;¾-ls%hdldß;ajfhka hq;= ix>gl iuQyhl tl;=jls'

²² ´kE u moaO;shla uQ,sl ix>gl 3lska iukaú; h' tajd kï wdodk" ieliSu 

iy m%;sodk fõ'

²² f;dr;=re moaO;shla hkq o;a;" f;dr;=re njg m;a lrk moaO;shls'

²² f;dr;=re moaO;s m%Odk jYfhka yia;Sh f;dr;=re moaO;s ̂Manual  Information 
System) iy mß.Kl mdol f;dr;=re moaO;s (Computer Based  Information 
System) f,i j¾. l< yels h'

²² ñksid ;u oE;ska ilia lr m%;sodk ,nd fok moaO;s w;ahqre moaO;s f,i 

ye¢kafõ'

²² mß.Kl mdol f;dr;=re moaO;shla hkq mß.Klhla wdOdrfhka o;a; 

f;dr;=re njg m;a lsÍuhs' 

²² moaO;s ixj¾Ok Ôjk pl%h Wmfhda.S lr .ksñka kj moaO;shla ilia lsÍu 

fyda mj;akd moaO;sh ixj¾Okh lsÍu fyda isÿlrkq ,nhs'

idrdxYh
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²² moaO;s ixj¾Ok Ôjk pl%h uQ,sl mshjr yhlska iukaú; h' tAjd kï" 

	 1' wjYH;d y÷kd .ekSu (Identification of requirements)
	 2' úi÷u ie,iqï lsÍu (Designing the solution)
	 3' úi÷u fla;lrKh lsÍu (Coding  of the solution)
	 4' úi÷u mÍlaId lsÍu yd fodaI bj;a lsÍu (Testing and debugging)
	 5' moaO;sh msysgqùu (Deployment of  the system)
	 6' moaO;s kv;a;= lsÍu (Maintenance of the system)

²² moaO;s ixj¾Okh wdlD;shla f,i mqk¾lrK-jDoaê pl%h o Ndú; lrkq ,efí'
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fuu mdvu yeoEÍfuka Tng"

²² wka;¾cd,fha fufyhqu

²² wka;¾cd,fha fiajd

²² f;dr;=re fiùu

²² taldldr iïm;a ksYapdhlh

²² IP ,smsk

²² jiï kduh

²² jiï kdu fiajdodhlh

²² kshudj,s

²² úoHq;a ;emE,

²² ùäfhda iïuka;%K

²² iudÔh cd,

		  ms<sn| wjfndaOhla ,nd .ekSug yels jkq we;'

3'1'1 wka;¾cd,h

	
	 wka;¾cd,h hkq f,dj mqrd msysá 

mß.Kl cd,j, tl;=jls' f,dal m%cdj iu. 

f;dr;=re ikaksfõokh lr .ekSug we;s 

fõ.j;a u ud¾.h ^Information super highway& 
wka;¾cd,hhs' wka;¾cd,h Ndú;h;a iu. u wo 

uq¿ f,dalh u úYaj .ïudkhla ^Global village& 
njg m;a j we;' iqúYd, fufyjrla bgq lrk 

wka;¾cd,hg ;ks ysñlrejl= fkdue;s w;r fï jk úg wka;¾cd, iudch ^The 
Internet Society& kï jQ wdodhï fkd,nk ixúOdkhla u.sska wka;¾cd,h Ndú;h 

ms<sn| m%;sm;a;s o wka;¾cd,fha l%shdldß;ajh mj;ajd f.k hkq ,nk kshudj,s 

^Protocol& ms<sn| j o lghq;= lrhs' Tnf.a mß.Klfhka wka;¾cd,hg iïnkaO jQ 

úg tu mß.Klh o wka;¾cd,hg wh;a mß.Klhla fõ' túg Tng wjYH ´kE u 

úIh lafIa;%hlg wod< f;dr;=re wka;¾cd,h Tiafia ,nd .ekSug yelshdj we;'

3
wka;¾cd,h yd úoHq;a ;emE,
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3'1'2 URL hkq l=ula o

	 wmf.a oekqu j¾Okh lr .ekSug wjYH jk f;dr;=re b;d jeo.;a 

iïm;ls' f;dr;=re ,nd .; yels ud¾. w;ßka f,dj mj;sk iqmsß u ud¾.h jkafka 

wka;¾cd,hhs' fuu f;dr;=re wka;¾cd,fha we;s mß.Kl w;r iïfm%aIKh 

lsÍug HTTP (Hypertext Transfer Protocol) kï jQ kshudj,sh fhdod .efka' tfuka 

u w;súYd, f;dr;=re iïNdrhla wka;¾cd,h ;=< wvx.= fõ' tu f;dr;=re imhk 

m%Odk fiajdj f,dal jHdma; úhuk (World Wide Web - WWW) fõ' fuh f,dal 

úisß úhuk f,i o ye¢kafõ' tneúka f,dal jHdma; úhuk ;=< fjí wvúj, 

f;dr;=re wvx.= j we;' fufia fjí wvú ;=< mj;sk úúO iïm;a wkkH j y÷kd 

.ekSug fhdod .kakd l%uh jkafka taldldr iïm;a ksYapdhlh fõ' (Uniform 
Resource Locator - URL)

taldldr iïm;a ksYapdhlhl (URL) we;s fldgia y÷kd .ksuqq'

ksoiqkla f,i my; oelafjk taldldr iïm;a ksYapdhlh i,luq'

http(//www.edupub.gov.lk/e-books/english/ict.pdf

fuys wvx.= fldgia rEmh 3'1 wdldrhg fjka lr oelafjhs'

http://www.edupub.gov.lk/e-books/english/ict.pdf

kshudj,sh 
(hypertext transfer

protocol) 

fiajdj

(World Wide Web)
iïm;a mj;sk ia:dkh

(path where the  
resource is located)

jiï kduh

(domain name)
iïm;a f.dkqj

(resource)

↓

↓ ↓ ↓

rEmh 3'1 - tAldldr iïm;a ksYapdhlhl fldgia 

igyk ( taldldr iïm;a ksYapdhlhl http kshudj,sfha isg jiï kduh olajd 

mej;Su wksjd¾h fõ'

wOHdmk lafIa;%hg iïnkaO URL w;ßka lsysmhla my; oelafõ'

http(//www.edupub.gov.lk		  - wOHdmk m%ldYk fomd¾;fïka;=j

http(//www.moe.gov.lk		  - wOHdmk wud;HdxYh 

http(//www.nie.lk	 		  - cd;sl wOHdmk wdh;kh

http(//www.doenets.lk			  - Y%S ,xld úNd. fomd¾;fïka;=j
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3'1'3 IP ,smsk hkq fudkjd o

 	 wka;¾cd,fha we;s iEu mß.Klhla u wkkH j  y÷kd .ekSug IP (Internet 
Protocol) ,smsk Ndú; flf¾' fuu IP ,smskh oYu ;sf;ka fjka lrk ,o 0 isg 

255 olajd jQ w.hka y;rla u.ska olajkq ,efí ^rEmh 3'2&' fuu wxlkh —Dotted 
Decimal Notation˜ f,i ye¢kafõ'

WodyrK  	 172'64'85'42
		  193'213'78'154

 

rEmh 3'2 - wka;¾cd,fha we;s mß.Kl y÷kd.ekSug IP ,smsk Ndú;h

	 fuu IP ,smsk ,nd fokq ,nkafka wka;¾cd, fiajd imhkakl= ^Internet 
Service Provider-ISP& úisks' —wka;¾cd, fiajd imhkakd˜ hkq fjf<|  

iud.ula jk w;r tu.ska wka;¾cd, yd úoHq;a ;eme,a myiqlï imhd fohs' fï 

i|yd tu iud.u úiska wod< f.ùï wh lrkq ,efí'

3'1'4  jiï kduh (Domain name)
	

	 by; olajk ,o taldldr iïm;a ksYapdhlfhys 

edupub.gov.lk hk jiï kduh i,luq' fuys gov 
u.ska rdcH ^government& iy lk u.ska lanka - Y%S 

,xldj  ksfhdackh flf¾' ta wkqj gov jiug miqj 

fhfok lk jiu by< jiï kduh fõ' ta wdldrfhka 

wka;¾cd,h ;=< mj;sk iEu fjí wvúhl u 

wkkH;dj jiï kduh u.ska ,nd fohs' 
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jiu wh;a lafIa;%h ksrEmKh lsÍu i|yd my; kdu Ndú; flf¾'

			   jiu (Domain)	 	     w¾:h

com				       jd‚cuh

org					        wdodhï rys; ixúOdk

gov			              rdcH

edu					        wOHdmk

net					        cd,.;

jiu wh;a rg ksfhdackh lsÍu i|yd my; kdu fhdod .efka' ^country domains&
                jiu (Domain)	 			      rg

     lk			           Y%S ,xldj	

     in			           bkaÈhdj

     au			         ´iafÜ%,shdj

     jp			           cmdkh

     uk			       tlai;a rdcOdksh

     us			       tlai;a ckmoh

	 jiï kduhl ol=Kq mi fl<jf¾ u mj;sk  jiu" by< uÜgfï jiu ̂ Top 
Level Domain& f,i y÷kajkq ,efí'

WodyrK

URL jiï kduh by< uÜgfï jiu

http://www.google.com google.com com
http://www.edupub.gov.lk edupub.gov.lk lk
http://www.nie.lk/pages/syllabus.asp nie.lk lk
http://www.unicode.org/consortium/
consort.html

unicode.org org

3'1'5  wka;¾cd,fha fufyhqu isÿ jk wdldrh

	 mß.Kl fuka fkdj ñksiqkag iudk ixLHd úYd, m%udKhla isys ;nd 

.ekSu wmyiq h' kuq;a Tjqkag mqoa.,hkaf.a kï u;l ;nd .ekSu Bg jvd myiq 

jk w;r tu.ska jerÈ isÿùug we;s wjia:d o wvq h' wka;¾cd,fhys § yqÿ ixLHd 

muKla Tng olakg fkd,efnkafka tA fya;=j ksid h' fjí wvúhla ±l .ekSu 

ms‚i Tn Tfí n%jqirhg taldldr iïm;a ksYapdhlhla (URL) m%fõY lsÍfï § 

Tfí wheÿu m%:ufhka lshúh yels ,sÅ; ,smskhl isg IP ,smskhlg mßj¾;kh 

l< hq;= h' fuu mßj¾;kh lsÍu jiï kdu fiajdÞhlh (Domain Name System) 
fyj;a DNS u.ska lrkq ,efí' 
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	 Tn lsis hï fjí wvúhlg iïnkaO ùu i|yd tys ,smskh fjí w;ßlaiqj 

;=, jQ fijqu hka;%hg (Browser) g we;=<;a l< miq ̂ WÞyrKhla f,i www.yahoo.
com i,luq'& we;a; jYfhka u isÿjkafka Tn we;=<;a l< fjí wvú ,smskhg 

wkqrEm ksjerÈ IP ,smskhg mßj¾;kh lsÍu i|yd 209'191'122'70 hk ienE DNS 

i¾jrhg b,a,Sula heùu h' tu IP ,smskfhka" Tng B<Õg wÞ< fjí wvúhg ienE 

iïnkaOhla f.dv k.d fohs ^rEmh 3'3&' fuh ;srh msgqmi isÿjk l%shdjla jk 

w;r th idudkHfhka tjekakla isÿ fj;s hs Tng fkd±fkk ;rï blaukska isÿ 

jkakls' 	

Web 
server

DNS 
server

OS

1 mßYS,l fjí w;ßlaiqj 

újD; lr úYaj iïm;a 

ksYapdhlh (URL) 
we;=<;a lsÍu

fjí w;ßlaiqj URL 

tl DNS i¾jrhg 

fhduq lrhs

6 fjí w;ßlaiqj u.ska 

HTML fjí msgqj 

o¾Ykh lrhs

5 fjí fiajdÞhlhd  u.ska 

HTML o;a; m%jdyhla 

wdmiq ,nd fohs

4 IP  ,smskh 

we;s fjí 

i¾jrhg 

b,a,Su fhduq 

lrhs

3 DNS i¾jrh 

u.ska URL ys 

±lafjk kug 

wÞ< IP ,smskhg 

mßj¾;kh lrhs

2

		  rEmh 3'3 - wka;¾cd,fha fufyhqï isÿ lrk wdldrh

	 lsisÿ ysñlrejl= fkdue;s wka;¾cd,h fufyhjkq ,nkafka kshudj,s 

^Protocol& u.sks' kshudj,shla hkq mß.Kl cd, ;=< l%shd;aul kS;s moaO;shls' 
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wka;¾cd,fha l%shd;aul jk kshudj,sj,ska lsysmhla my; oelafõ'

HTTP - Hypertext Transfer Protocol
TCP/IP - Transmission Control Protocol/Internet Protocol 
FTP - File Transfer Protocol
SMTP - Simple Mail Transfer Protocol
ICMP- Internet Control Message Protocol

kshudj,sh Ndú;h

HTTP HTML f,aLk yqjudrej

TCP/IP IP ,smsk yqjudrej md,kh lsÍu

FTP f.dkq yqjudrej

SMTP úoHq;a ;eme,a yqjudrej

ICMP fodaI we;s wjia:dj, m‚úv oekaùu yd m‚úv md,kh

		 wka;¾cd,h mq¿,a fmfoia cd,hla ^WAN-Wide Area Network& jk w;r 

fiajd,dNS iy fiajdodhl ^Client Server Model& wdlD;shla u; ks¾udKh lr 

we;' ta wkqj wka;¾cd,fha we;s ish¨‍ u mß.Kl fiajd,dNS fyda fiajdodhl hk 

foj¾.fhka tla j¾.hlg wh;a fõ' ^rEmh 3'4&

	

rEmh 3'4 - wka;¾cd,fha fiajd,dNS iy fiajdÞhl wdlD;sh

	 fiajdodhl mß.Kl (Server) fiajd fhdað; mß.Kl f,i o y÷kajkq 

,nhs' fuu.ska fiajd,dNS ^Client& mß.Kl fj; wjYH iïm;a fnod fokq ,nhs'

	 fiajdodhl mß.Klj, we;s f;dr;=re fiajd,dNS mß.Kl fj; 

,nd .ekSu —nd.; lsÍu˜ ^Download& f,i y÷kajkq ,efí'

	 fiajd,dNS mß.Klj, we;s f;dr;=re fiajdodhl mß.Kl fj; 

,nd§u —Wvq.; lsÍu˜ ^Upload& f,i y÷kajkq ,efí'

	 ta wkqj fiajdodhl yd fiajd,dNS mß.Kl w;r f;dr;=re foÈYdjg u 

yqjudre fõ'
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wka;¾cd, fiajdodhl mß.Kl lsysmhla y÷kd .ksuq'

Web Server - 	fjí msgq ;ekam;a lr ;nd .ekSu yd fiajd,dNS mß.Kl fj; ,nd  

		  §u

Mail Server - úoHqq;a ;eme,a ;ekam;a lr ;nd .ekSu yd fiajd,dNS mß.Kl fj; 

		  ,nd §u

DNS Server - URL, IP ,smsk njg mßj¾;kh lsÍu

3'1'6  wka;¾cd,fha ld¾hhka

	 wka;¾cd,h fhdodf.k ,nd .; yels fiajdjka /ila mj;shs' bka lsysmhla 

my; ±lafõ'

1'	 f,dal jHdma; úhuk ^World Wide Web - WWW&

2'	 úoHqq;a ;emE, ^Electronic Mail - E-Mail&
3'	 f.dkq yqjudre kshudj,sh ^File Transfer Protocol&
4'	 ÿria: msúiqu ^Remote Access&
5'	 f.dkq fnod .ekSu ^File Sharing&
6'	 nyqudOH iemhqu ^Streaming of media&
7'	 fijqï hka;% ^Search Engines&

3'1'7 f,dal jHdma; úhuk ^World Wide Web - WWW&

	 f,dal jHdma; úhuk hkq wka;¾cd,fhka 

imhk fiajdjla jk w;r wka;¾cd,hg iïnkaO 

f,dj mqrd we;s mß.Klj, .nvd lr we;s úoHq;a 

f,aLkj, úYd, tl;=jls' 

	 wwwys ks¾ud;D f,i i¾ áï n¾k¾ia ,S 

^Sir Tim Berners Lee& i,lkq ,efí' www Ndú; 

lrkakdg fjí w;ßlaiqjla ^Web Browser& yryd 

fjí wvúj,g msúiSfï yelshdj we;' 

	 fjí w;ßlaiqjla hkq fhÿï uDÿldx.hla 

fõ' fjí w;ßlaiq i|yd WodyrK lsysmhla rEmh 

3'5 ys olajd we;'

rEmh 3'5 - fjí w;ßlaiq

	 fjí wvúhla fjí msgq lsysmhlska iukaú; 

fõ' fjí msgqjla ;=< ,sÅ; igyka" mska;+r" ùäfhda 

iy wfkl=;a nyqudOH iy wêikaOdk ̂Hyperlink& 
we;=<;a lr we;' wêikaOdk Ndú;fhka fjí 

wvúh ;=< myiqfjka ießieÍug yelshdj we;' 

fjí wvúhlg msúiSu i|yd fjí w;ßlaiqfõ 

,smsk ;Srefõ taldldr iïm;a ksYapdhlh ^fjí 
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wvú ,smskh& ghsma lr —Enter˜ h;=r l%shd;aul l< hq;= h' fjí wvúh ms<sn| uQ,sl 

úia;r we;=<;a msgqj —Home Page˜ f,i ye¢kafõ' tys we;=<;a j we;s wêikaOdk 

Tiafia fjí wvúfha wfkl=;a msgq fj; msúish yels h'

ksoiqkla f,i Y%S ,xld úNd. fomd¾;fïka;=fõ ks, fjí wvúh i,luq ^rEmh 

3'6&'

,smsk 

;Srej

wêikaOdk

 

Home 
page

rEmh 3'6 - Y%S ,xld úNd. fomd¾;fïka;=fõ ks, fjí wvúh

3'1'8  f.dkq yqjudre kshudj,sh (File Transfer Protocol - FTP)

	 úoHq;a ;eme,a m‚úv heùfï § l=vd m%udKfha 

f.dkq tA iu. weuqKqula f,i heùug yels fõ' 

tfy;a" úYd, m%udKfha f.dkq úoHq;a ;eme,a m‚úv 

iu. weuqKqula f,i heúh fkdyel' tneúka úYd, 

m%udKfha f.dkq wka;¾cd,fha mß.Kl w;r yqjudre 

lsÍu i|yd FTP Ndú; flf¾' úfYaIfhka fiajd,dNS mß.Klhl we;s f.dkq 

wka;¾cd,hg uqod yeÍug;a ̂ Upload Files& wka;¾cd,fha fiajdodhl mß.Klj,ska 

f.dkq ,nd .ekSug;a ^Download Files& Ndú; fõ' ^rEmh 3'7&

rEmh 3'7 - f.dkq yqjudre moaO;sh

FTP úOdk 

FTP ms<s;=re 

o;a;

iïnkaO;dj

FTP fiajd,dNs mß.Klh FTP fiajdodhl mß.Klh

download

upload
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3'1'9 ¥ria: msúiqu ^Remote access&

rEmh 3'8 - ¥ria: msúiqu

	 wka;¾cd,fha we;s mß.Klhla ¥ria: j isg md,kh yd yeisrùu ¥ria: 

msúiqu u.ska isÿflf¾ ^rEmh 3'8&' wka;¾cd,hg msúiSfuka miq j ¥ria: msúiqu 

u.sska isÿ l< yels ld¾hhka i|yd ksoiqka lsysmhla my; oelafõ'

1'	 fiajdodhl mß.Klj, we;s uDÿldx. fiajd,dNS mß.Kl fj; ia:dmkh lsÍu

2'	 fiajd,dNS mß.Klj, we;s fodaI ksrdlrKh yd kshdukh

	 we;eï úg mßYS,lf.a wkqoekqulska f;dr j fjk;a mßYS,lhl= úiska 

mß.Kl .; jeo.;a o;a; yd f;dr;=re fidrd .ekSu ¥ria: msúiqfï § isÿúh yels 

h' ^fuh —hacking˜ f,i ye¢kafõ'&

3'1'10 f.dkq fnod .ekSu ^File Sharing&

	 mß.Kl cd,.; lsÍfï m%Odk wruqKla jkafka 

iïm;a yjqf,a Ndú; lsÍuhs' fiajdodhl mß.Klhl 

we;s iïm;a fiajd,dNS mß.Kl w;f¾ yjqf,a Ndú; 

lsÍu f.dkq fnod .ekSu f,i ye¢kafõ' ta wkqj 

wka;¾cd,h ;=< we;s úúO f.dkq j¾. yjqf,a Ndú; 

lsÍu ksr;=re j u isÿfõ'

m%Odk ld¾hd,h
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ksoiqka 

1'	 ud¾..; j úNd. m%;sM, n,k úg tu f.dkqj úYd, fiajdodhlhka m%udKhla 

tl jr Ndú;h

2'	 fjí wvúhla fj; mßYS,lhska oyia .Kkla tl jr iïnkaO ùu'

3'1'11 nyqudOH iemhqu ^Streaming of media&

m%Odk nyqudOH iemhqï l%shdj,sh  

mßYs,l fjí msgqjla 

weiqfrka ;udg weiSug 

fyda keröug leu;s 

nyqudOH f.dkqjla 

fidhd .kS'

 

fjí fiajdÞhl mß.Klh 

mßYS,l úiska b,a,Sï lrk 

,o úfYaIs; f.dkqj ms<sn| 

mKsúvh nyqudOH  fiajdÞhl 

mß.Klh fj; fhduq lrhs'

mßYS,l úiska b,a¨ï 

lrk ,o f.dkqj fjí 

fiajdÞhl mß.Klhg 

fkdhjd fl<ska u 

fiajd,dNS mß.Klh 

fj; fhduq lrhs'

fjí fiajdÞhl mß.Klh

4 fiajd,dNS mß.Klfha 

we;s uDÿldx. u.ska tu 

f.dkqj weiSug fyda 

keröug i,iajhs'

nyqudOH fiajdÞhl mß.Klh

rEmh 3'9 - nyqudOH iemhqï l%shdj,sh

	

	 mdG" Y%jH iy oDYH hk ish¨‍ wdldrfha nyqudOH iys; f;dr;=re mß.Kl 

w;r yqjudre lsÍug wka;¾cd,h ukd msájy,la imhhs' ^rEmh 3'9&

Wod - wkA;¾cd,fhka .S; iy ùäfhda oiqka keröu
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3'1'12 fijqï hka;% ^Search Engines&

	 wka;¾cd,fha we;s f;dr;=re úYd, jYfhka 

fjí wvúj, wka;¾.; fõ' tu f;dr;=re ,nd 

.ekSug tu fjí wvú fj; msúish hq;= h' ta i|yd 

fjí wvúfha ,smskh ^URL& oek isáh hq;= h' tfy;a 

fuh m%dfhda.sl j b;d wiSre ld¾hhla jkafka 

wka;¾cd,h ;=< mj;sk wiSñ; fjí wvú m%udKh 

ksid h' 

	 wka;¾cd, mßYS,lhkag myiqfjka wjYH ´kE u f;dr;=rla fidhd 

.ekSug fijqï hka;% ksmojd we;' fijqï hka;%fha fijqï fldgqj ;=< fiùug 

wjYH f;dr;=re we;=<;a uQ,mo i|yka lr fijqï fnd;a;u l%shd;aul l< úg 

wjYH f;dr;=re we;=<;a fjí wvú úYd, ixLHdjla wêikaOdk iys; j ,efí' tu 

wêikaOdkj,ska wjYH‍ tlla fyda lsysmhla l%shd;aul lr f;dr;=re ,nd .; yels 

h' nyq, j Ndú; flfrk fijqï hka;% i|yd WodyrK lsysmhla my; oelafõ'

http://www.google.com fyda  http://www.google.lk 
http://www.yahoo.com
http://www.ask.com
http://www.msn.com

 3'1'13 jiï kdu fiajdodhlh ^Domain Name Server&

			 	

rEmh 3'10 - jiï kdu fiajdÞhlh u.ska jiï kdu IP ,smsk njg m;a lsÍu 

				 fjí wvúhla wkkH j y÷kd .ekSu i|yd jiï kduh Ndú; flfrhs' 

fuh mßYS,lhkag u;l ;nd .ekSu ;rula ÿrg myiq lrhs' tfy;a wka;¾cd,fha 

we;s mß.Klhla wkkH j y÷kd .ekSu i|yd IP ,smskh Ndú; flfrhs' jiï 

kdu fiajdodhlh u.ska isÿ flfrkafka jiï kduh IP ,smskh njg mßj¾;kh 

lr §uhs' ^rEmh 3'10&
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3'2  ikaksfõokh i|yd wka;¾cd,h Ndú;h

3'2'1 úoHq;a ;emE, 

			 mqoa.,hka fofofkl= fyda iuQyhla fyda w;r úoHq;a l%uhg ,sms yd ,sms 

f.dkq f,i m‚jqv yqjudre lsÍu úoHq;a ;emE, u.ska isÿfõ' fuu fiajh fkdñf,aa 

wka;¾cd,h yryd imhk wdh;k nyq, j we;' fï i|yd jeh jkafka wka;¾cd, 

.dia;=j mu‚' fuh f,dj we;s b;d ,dNodhS yd fõ.j;a u ikaksfõok l%uhhs' 

^rEmh 3'11&

úoHq;a ;eme,a 

m‚úvh heùu wka;¾cd,h 
úoHq;a m‚úvh 

,nd .ekSu 

;eme,a 

fiajdÞhlh 

;eme,a 

fiajdÞhlh 

fm!oa.,sl 

mß.Klh

		      rEmh 3'11 - úoHq;a ;emE, u.ska ,sms yd ,smsf.dkq yqjudrej	

	 	
	 f,dj ´kE u mqoa.,hl= wka;¾cd,h yryd úoHq;a ;eme,a .sKqula idod.;a 

úg th wka;¾cd,h ;=< wkkH;dj i|yd Ndú; l< yels h'

			 úoHq;aa ;eme,a ,smskhl we;s ,laIK y÷kd .ekSu i|yd Y%S ,xld úNd. 

fomd¾;fïka;=fõ úoHq;a ;eme,a ,smskh i,luq' fuys exams hkq mßYS,l kduh 

jk w;r doenets.lk hkq jiï kduh fõ' @ ixfla;h u.sska mßYS,l kduh yd 

jiï kduh fjka lr olajkq ,efí'

exams@doenets.lk

mßYS,l kduh 

(User name) 
jiï kduh

(Domain name)

↓ ↓

			 úoHq;aa ;eme,a m‚úv hjkakdg fuka u ,nkakdg o úoHq;a ;eme,a ,smskhla 

wksjd¾hfhka u ;sìh hq;= h' úoHq;a ;emE, Ndú;hg fmr úoHq;a ;eme,a .sKqula 

idod .; hq;= h' fï i|yd wka;¾cd,fha úoHq;a ;eme,a fiajdj iys; fjí wvú 

u.ska fkdñ,fha myiqlï imhhs'



PB

fkdñf,a fnod yeÍu msKsihs 81

			

			 úoHq;a ;eme,a .sKqulg úoHq;a ;eme,a ,smskh 

(e-mail address) iy uqrmohla (password) mej;Su 

wksjd¾h fõ' úoHq;a ;eme,a heùug fyda ,eî we;s úoHq;a 

;eme,a n,d .ekSug úoHq;a ;eme,a .sKqu újD; l< hq;= 

h' fï i|yd mßYS,l kduh iy uqrmoh ksjerÈ j 

we;=<;a lr Sign in u; la,sla l< hq;= h'

úoHq;a ;eme,a ,smshla heùu

úoHq;a ;eme,a ,smshla heùu my; wdldrhg isÿ l< yels h' ^rEmh 3'12&

Dear All,

Please see the attachment for my results.

Shani

Subject	 OL results released

To	 sasikala7@gmail.com
Cc	 bpdasun@yahoo.com
Bcc	 monali@sltnet.lk

weuqKqu (Attachment)

rEmh 3'12 - úoHq;a ;eme,a ,smshla heùu

²² To  hk ia:dkfha ,nkakdf.a úoHqq;a ;eme,a ,smskh i|yka lrkak.  
(sasikala7@gmail.com)

²² Cc(Carbon copy) hk ia:dkfha fuu 

úoHq;a ;eme,a m‚úvfha msgm;a heúh 

hq;= whf.a úoHqq;a ;eme,a ,smskh i|yka 

lrkak' (bpdasun@yahoo.com)
²² Bcc (Blind carbon copy) fuu úoHq;a 

,smsh ,efnk To iy Cc hgf;a i|yka 

whg fkdoefkk f,i heúh hq;= whf.a úoHq;a ;eme,a ,smskh Bcc hk ia:dkfha 

i|yka lrkak' (monali@sltnet.lk)



fkdñf,a fnod yeÍu msKsihs82

²² Bcc msgm; ,nkakdg (monali@sltnet.lk) fuu úoHqq;a ,smsh hjk ,o ish¨‍ 

fokdf.a u úoHqq;a ;eme,a ,smsk o¾Ykh fõ' (sasikala7@gmail.com iy 

bpdasun@yahoo.com). To iy Cc hgf;a i|yka whg (sasikala7@gmail.
com iy bpdasun@yahoo.com) Bcc msgm; ,o whf.a úoHqq;a ;eme,a ,smskh 

(monali@sltnet.lk) o¾Ykh fkdfõ'

²² Subject hk ia:dkfha úoHqq;a ;eme,a ,smshg wod< ud;Dldj fyda wod< úIh fyda  

i|yka lrkak' (O/L results released)
²² Attachment weuqKqï lgqjla olajk ia:dkh u; la,sla lr úoHq;a ;eme,a ,smsh 

iu. heúh hq;= fjk;a úoHq;a f.dkqjla fyda f.dkq fyda iïnkaO lrkak' 
      (Results.jpg)
²² Send hk ia:dkh u; la,sla lr úoHq;a ;eme,a ,smsh hjkak'

úoHq;a ;eme,a .sKqula ;=< Ndú;fha myiqj i|yd my; mßÈ ,sms j¾. lr we;'

²² Inbox - ,efnk ,sms ;ekam;a lsÍug 

²² Drafts - heùug ilia l< kuq;a iïmQ¾K lr .; fkdyels jQ ,sms ;ekam;a 

lsÍug 

²² Sent - hjk ,o ,sms ;ekam;a lsÍug 

²² Trash/Deleted - uldouk ,o ,sms hï ld,hla r|jd ;nd .ekSug

²² Spam/Junk - wdhdÑ; ^wkjYH& ,sms r|jd .ekSug  

	 wmg ,efnk wkjYH úoHq;a ,sms Inbox g ndOdjla fkdjk f,i fjk u 

f.dkqjl mj;S' tAjd wdhdÑ; ,sms f,i ye¢kafõ' 

  

Inbox Spam
  

rEmh 3'13 - wdhdÑ; ;emE,
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3'2'2  laI‚l m‚úv heùu (Instant Messaging - IM)

	

rEmh 3'14 - laI‚l m‚úv heùu

	

rEmh 3'15 - kùk laI‚l m‚úv heùfï hdka;%K

	 wka;¾cd,h yryd 

fofokl= w;r fm!oa.,sl j 

ir, flá mdG fhdod .ksñka 

iefKlska woyia yqjudre lr 

.ekSu laI‚l m‚úv heùu 

u.sska isÿ fõ' ^rEmh 3'14&

3'2'3 ùäfhda iïuka;%K (Vedio conferencing)
	

	 ùäfhda iïuka;%Khla hkq ÿria ia:dkj, 

isák fofofkla fyda jeä msßila fyda w;r Y%jH 

yd oDYH o;a; iïfm%aIKh lrñka mß.Kl cd, 

weiqfrka ixjdohla meje;aùu fõ'
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ùäfhda iïuka;%Khla meje;aùu i|yd imqrd,sh hq;= wjYH;d

²² mß.Kl

²² fjí leurd

²² wka;¾cd, iïnkaO;dj

²² ikaksfõok uDÿldx. ^Y%jH oDYH myiqlï iys;& 

3'2'4 iudÔh cd,

	 iudÔh cd, hkq mqoa.,hka wka;¾cd,h Tiafia 

iudc in|;d mj;ajdf.k hEfï l%ufõohls'

	 fuu iudc cd, yryd ;u fm!oa.,sl f;dr;=re" 

PdhdrEm" ùäfhda yd tÈfkod lghq;= ms<sn| f;dr;=re 

yqjudre lr .efka' fuys m%;sM,hla f,i iudc iïnkaO;d 

mq¿,a jkakd fia u fkdfhl=;a iudc wlghq;=lï o isÿfõ'

iudÔh cd, i|yd ksoiqka lsysmhla my; oelafõ'

http://www.facebook.com
http://www.twitter.com
http://www.youtube.com
http://www.flickr.com
http://www.pinterest.com
http://www.secondlife.com

3'2'5 j,dl=¿ mß.Kl ixl,amh (Cloud Computing)

		 fm!oa.,sl mß.Kl we;=¿ ish¨‍ mß.Kl cd, 

iy cx.u fuj,ï ^mobile devices& ish,a,;a /yeka rys; 

wka;¾cd, iïnkaO;d Tiafia taldnoaO j wjYH ´kE u 

fudfyd;l" ´kE u ;ekl isg f;dr;=re ,nd .ekSug yd 

;ekam;a lsÍug myiqlï i,ik l%uh j,dl=¿ mß.Kl 

ixl,amh f,i ye¢kafõ' 

j,dl=¿ mß.Klh u.ska bgq flfrk m%Odk fiajd

²² há;, myiqlï fiajdjla f,i ^Infrastructure as a Service&-IaaS
²² ixj¾Ok mßir fiajdjla f,i ^Platform as a Service&-PaaS
²² uDÿldx. fiajdjla f,i (Software as a Service)-SaaS
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Infrastructure as a Service (IaaS)
	 fuu.sska mß.Klj, w;:H mßirhla f.dvk.d fiajdodhl mß.Klj, 

iydh ;=<ska o;a; .nvd lsÍug wjYH wjldYh ,nd§u iy ia:dmkh lr we;s 

úYd, o;a; uOHia:dk yryd úúO iïm;a ,nd §u isÿflf¾'

WÞ - ;ukag u fiajdÞhl mß.Klhla" .sks mjqrla fkd;snqK o j,dl=¿ mß.Kl  

       fiajd u.ska fiajdÞhl mß.Kl (Server space) iy .sks mjqre myiqlï Ndú;  

      l< yels h'

Platform as a Service (PaaS)
	 fuu fiajh uQ,sl j u uDÿldx. ixj¾Okh iy uDÿldx. Odjkh i|yd 

wjYH mßirhla ,nd §fï wruq‚ka l%shd;aul fõ' fufyhqï moaO;sh" mß.Kl 

NdId mßirh" o;a; iuqodh iy fjí fiajdÞhl mß.Kl hk myiqlï ish,a, 

fiajd,dNshdyg fuu.ska ,nd .; yels h' 

WÞ - fufyhqï moaO;sh (Operating system), iïmdol (Compilers) hkdÈh Tnf.a  

       mß.Klfha ia:dmkh lr fkd;snqK o j,dl=¿ mß.Kl fiajd ;=< uDÿldx.  

       ksIamdokh isÿ l< yels h'

Software as a Service (SaaS)
	 fiajd,dNshdg wjYH fhÿï uDÿldx. ia:dmkh fkdlr j,dl=< fkdfyd;a 

wka;¾cd,h ;=< ia:dmkh lr we;s uDÿldx. Ndú; lsÍug myiqlï i,ihs'

	 tys § úfYaIfhka uDÿldx. ixj¾Olhkag uDÿldx. ksmoùug wjYH oDVdx. 

iy ixj¾Ol uDÿldx. ñ, § .ekSfï § iy l<ukdlrKfha § oeÍug isÿ jk 

msßjeh iy ixlS¾K;ajh úYd, jYfhka wvq lr .; yels h'

WÞ - 10 fY%a‚fha § Tn yeoErE joka ieliSfï uDÿldx." úoHq;a me;=reï uDÿldx.  

      wdÈh Android Wml%uj, Ndú; jkafka Bg wÞ< uDÿldx. ia:dmkh lsÍfuka  

      fkdj fjí w;ßlaiqjla yryd h'

²² uDÿldx. i|yd hk úhou wvqùu

²² ld¾h idOkh jeä ÈhqKq ùu

²² kv;a;= .eg¨ wju ùu

²² uDÿldx. laI‚l j hdj;ald,Sk lsÍï 

²² fkdlvjd mj;sk wka;¾cd, myiqlï 

wjYH ùu

²² wvq fõ. iïnkaO;d j,§ l%shdldß;ajh 

wvqùu

jdis 

wjdis 

j<dl=¿ mß.Kl Ndú;fha jdis wjdis
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ls%hdldrlu   

1' A yd B j, .e<fmk whs;u B;, u.ska hd lrkak'

 A ;Srej B ;Srej

úoHqq;a ;eme,a ,smskh doenets.lk
jiï kduh 172.92.83.106
taldldr iïm;a ksYapdhlh somasiri@gmail.com
IP ,smskh http://www.nie.lk/syallabus/ol/ict.pdf

A ;Srej B ;Srej

fjí w;ßlaiqj jiï kdu IP ,smsk njg yrjhs

wka;¾cd,fha fiajdjls' Google
jiï kdu fiajdodhlh (DNS) Mozilla Firefox
fijqï hka;%hls' f,dal jHdma; úhuk (WWW)

²² taldldr iïm;a ksYapdhlh ̂ URL& u.ska fjí wvú ;=< mj;sk iïm;a  wkkH 

j y÷kd .ekSug yels fõ'

²² wka;¾cd,fha we;s iEu mß.Klhla u wkkH j y÷kd .ekSug IP ,smsk 

Ndú; flf¾'

²² fjí wvúhla wkkH j y÷kd .ekSu i|yd jiï kduh ̂ Domain name& Ndú; 

lrhs'

²² jiï kdu fiajdodhlh u.ska jiï kduh IP ,smsk njg mßj¾;kh lrkq 

,efí'

²² wka;¾cd,fha fufyhqï lghq;= kshudj,s ^Protocol& u.ska isÿ flf¾'

²² f,dal úisß úhuk ^WWW& iy úoHq;a ;emE, ^E-mail& wka;¾cd,fhka 

iemfhk m%Odk fiajd folls'

²² fjí msgq o¾Ykh lsÍug fjí w;ßlaiq ^Web browser& Ndú; flf¾'

²² wka;¾cd,fhka f;dr;=re fiùug fijqï hka;%  ^Search engine& Ndú; 

flf¾'

²² úoHq;a ;emE, hkq fõ.j;a u iy ,dNodhS u ikaksfõok l%uhhs'

²² úoHq;a ;eme,a ,smskhla o wkkH fõ'

²² laI‚l m‚jqv" ùäfhda iïuka;%K iy iudÔh cd, o ikaksfõokh i|yd 

fhdod .efka' 

idrdxYh
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fuu mdvu yeoEÍfuka Tng"

²² wxls; .%dmslhkays uQ,sldx.

²² .%dmslhl Odß;dj yd ixfldapkh

²² .%dmsl m%rEm

²² .%dmsl uDÿldx. Ndú;fha uQ,sldx.

²² iÔùlrK uQ,sldx.

²² cHdñ;sl jia;= yd yev;,

²² rduq j¾.

²² iÔùlrKh

²² fnod yeÍu

²² Y%jH má.; lsÍu

²² nyq udOH ixialrKh

²² Y%jH-oDYH ixl,kh iy iÔùlrKh

		  ms<sn| j wjfndaOhla ,nd .ekSug yels jkq we;'

4'1   wxls; .%dmsl (Digital graphic)
	
	 isf;a we;s jk is;=ú,a,la fyda weig wiq jk iqúfYaI jQ oiqkla .,a m;=rl" 

,S m;=rl fyda lvodishl rEm lrkakg;a mdg .,ajñka yev lrkakg;a wE; 

w;S;fha mgka ñksid mqreÿ j isáfha h' rEm" ñksidf.a woyia m%ldY lsÍfï m%Odk 

udOHh jQ nj mer‚ ì;= is;=jï ÿgq úg wmg wjfndaO fõ' tfia u tys § isÿ 

jQ fkdfhl=;a wvq ¨‍yq~qlï fyda w;a jer§ï ksjerÈ lr .ekSug;a wjYH j¾K 

ixl,kh lr .ekSug;a Tyqg fndfyda fjfyi orkakg isÿ ù we;s nj tjeks rEm 

u.ska wmg meyeÈ,s fõ' 

	 tfy;a ;dlaIKfha ÈhqKqj;a iu. u wm i;= jQ mß.Kl .%dmsl uDÿldx. 

Wmfhda.s lr.ksñka fkdfhl=;a wdldrfha .%dmsl ks¾udKh lsÍu yd ks¾udKh lr 

.;a .%dmsl wjYH wdldrhg ixialrKh lr .ekSu b;d ir, fuka u úfkdaÞ;aul 

lghq;a;la ù we;' 

	 mß.Kl .%dmsl uDÿldx. Ndú;fhka ks¾udKh lrkq ,nk Ñ;% fyda rEm" 

wxls; .%dmsl f,iska ye¢kafõ'

4 nyqudOH Ndú;h
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wxls; .%dmslhl uQ,sldx. fudkjd oehs y÷kd .ksuq' ^rEmh 4'1&

mslai,a

Pixel

úfNaokh

Resolution
m%udKh

Size

j¾Kh

Colour
wxls; 

.%dmslhl 

uQ,sldx.

rEmh 4'1 - wxls; .%dmslhl uQ,sldx.

²² mslai,a (Pixel)

	 mslai,hla hkq wxls; .%dmslhl uQ,sl ;ekqï tAllhhs' wm úiska krUkq 

,nk wxls; .%dmslhla mslai,a oyia .Kklska ks¾udKh ù we;'

	 fuu mslai,a" fma<s iy ;Sr f,iska tlsfklg hd jk wdldrhg b;d 

<Õska ilia ù we;s w;r tu.ska .%dmsl ks¾udKh fõ' ^rEmh 4'2& wxls; .%dmslhla 

RcqfldaKdi%dldr mslai,a wrdjla ^array& jk w;r fuh ìgq wkqrEms;hla ^bitmap& 
f,iska o ye¢kafõ'

mslai,

mslai, wdrdjla

mslai, fma<shla

mslai, ;Srejla úYd, lrk ,o rEmhla

rEmh 4'2 - mslai,a

	
	 .%dmslhl m%udKh mß.Kl ;srfhys m%udKhg fyda uqøK lvodisfha 

m%udKhg fyda wkqj úYd, fyda l=vd fyda l< yels h' fuys § fjkia jkafka 

mslai,fha m%udKhhs' wvq mslai, m%udKhla we;s .%dmslhla kï th úYd, ùfï § 

tys .=Kd;aul nj wvq fõ ^rEmh 4'3&'
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rEmh 4'3 - .%dmslhla úYd, ùfï § .=Kd;aul nj wvq ùu

	 .%dmslhlhg fhdod we;s j¾K" mslai,hl ìgq m%udKh ksfhdackh lrkq 

,nhs' fuh mslai,hlg we;s ìgq m%udKh ^Bits Per Pixel-Bpp& f,iska oelafõ' ìgq 

m%udKh jeä mslai, iys; .%dmslhla .=Kd;aul núka by< h'

²² mslai,hl j¾K iy ìgq m%udKh

	 mslai,hl ìgq m%udKh ;SrKh jkafka .%dmsl ks¾udKfha § fhdod .kq 

,nk j¾Khkag wkqj h'

ìgq tlla ksfhdackh jk j¾K .Kk ìgq folla ksfhdackh jk j¾K .Kk

j¾K folls
0 }1

j¾K 4lss

00		 01		 10
11    
}

	

	 .%dmslhla ksÍlaIKh lsÍfuka mslai,hl we;s j¾K m%udKh ;SrKh l< 

fkdyels h' kuq;a mslai,hg we;s ìgq m%udKfhka mslai,hg fhdod we;s j¾K 

.Kk fidhd .; yels fõ' ta i|yd fuu Y%s;h fhdod .; yels h'

mslai,hl j¾K m%udKh } (2) bpp ^mslai,hlg we;s ìgq m%udKh&

Wod - mslai,hg we;af;a ìgq 4 la kï"

mslai,hl j¾K m%udKh	 } ^2&4

				    } 2 « 2 « 2 « 2

				    } j¾K 16ls'

tfia kï j¾K m%udKh okakd úg ìgq m%udKh fidhd .ekSu i|yd

mslai,hl ìgq m%udKh 	 } √j¾K

				    } √16
mslai,hl ìgq m%udKh 	 } 4
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		     ìgq 1 	    ìgq 4 	   ìgq 8 	   ìgq 24 

mslai,hlg we;s  ìgq m%udKh ^Bits per pixel& Y%s;h j¾K .Kk

1 bpp (2)1 2
2 bpp (2)2 4
3 bpp (2)3 8
16 bpp (2)16 65536
24 bpp (2)24 16777216

^j¾K ñ,shk 16'7&

32 bpp (2)32 4294967296 j¾K

^j¾K ñ,shk 

4294&

²² .%dmsl úfNaokh (resolution)

1

7

5

 

ms

la

i

,a 250 mslai,

^45"500 mslai,&

rEmh 4'4 - .%dmsl úfNaokh

	 wxls; .%dmslhl fN!;sl mßudKh ^Physical 
dimension& uekSfï tallh mslai,a jk w;r 

fN!;sl mßudKh .%dmsl úfNaokh ^Image 
resolution& f,iska oelafõ' ^rEmh 4'4&

	 fuu wxls; Ñ;%h mslai, 250 la m<,ska iy 

175la Wiska hqla; h' tys .%dmsl úfNaokh ^Image 
resolution& mslai, 250«175 fyda mslai, 43"750 

f,iska oelafõ'

	 mslai, m%udKh jeä" Wiia úfNaokhlska 

^High resolution& hq;= wxls; Ñ;%lhla by< .=K;aul njlska hq;= h' .%dmslhl 

.=Kd;aul nj ;SrKh lsÍfï § j¾. wÕ,lg we;s mslai, m%udKh ^pixels per 
inch-ppi& fyda j¾. wÕ,lg we;s ;s;a m%udKh ^dots per inch-dpi& ^rEmh 4'5& 

fldmuK m%udKhla oehs fidhd nef,a'

rEmh 4'5 - wÕ,lg we;s ;s;a m%udKh
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²² j¾K
 

	 wxls; .%dmslhla mslai, oioyia .Kkl tl;=jla nj bf.k .;af;uq' iEu 

mslai,hla u j¾Khla ksfhdackh lrhs' tfia kï mslai,h hï lsis j¾Khla iys; 

l=vd ;s;ls'

	 j¾K ix>gl ixl,kh ùfuka ks¾udKh jk idudkH mshú weig y÷kd 

.; yels j¾K ñ,shk 16la muK we;;a ta iEu j¾Khla u ksjerÈ j fjka lr 

y÷kd .ekSu wmyiq ld¾hhls' ^rEmh 4'6&

mdrcïnq, (Ultra Violet)  (Infrared) wfOdarla;mshú weig y÷kd .; 

yels j¾K

rEmh 4'6 - mshú weig y÷kd .; yels yd fkdyels j¾K

	 wxls; .%dmsl ks¾udKfha § fndfyda j¾K fhdod .; yels w;r tu ks¾udKh 

m%;sodkh lrk Wml%uh fyda udOHhg ^rEmh 4'7& wkqj ks¾udKfha § fhdod .; 

hq;= j¾K wdfoaYlh ^Colour models& l=ula oehs ;SrKh l< hq;= h'

nyq, j Ndú; jk j¾K wdfoaYl foj¾.hls' tkï"

CMYK wdfoaYlh

(CMYK model)

j¾K wdfoaYl

(Colour models)

RGB wdfoaYlh

(RGB model)

rEmh 4'7 - j¾K wdfoaYl

²² RGB wdfoaYlh ̂ RGB model& - nyq, f,i Ndú; jk RGB wdfoaYlh j¾Kj;a 

wdf,dal ^Coloured lights& wdOdrfhka rEmjdyskS fyda mß.Kl ;sr u; rEm 

ks¾udKh lsÍfï § fhdod .kq ,nhs' fuys uQ,sl j¾K ̂ Primary colours& jkafka 

r;=" fld< iy ks,a ^Red, Green and Blue& j¾Khs'

²² CMYK wdfoAYlh ^CMYK model& - ;Ska; ^Coloured inks& wdOdrfhka lvodis 

u; rEm uqøKh lsÍfï § CMYK j¾K wdfoaYlh Ndú; fõ' fuys uQ,sl j¾K 

^Primary colours& jkafka <d ks,a" oï" ly iy l¿ ^Cyan, Magenta, Yellow, 
Black& j¾Khs'
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uQ,sl j¾Kdf,dal ^RGB& ñY% 

ùfuka oaú;Shsl j¾K iEfoa'
oaú;Shsl j¾K ^CMYK& ;Ska; ñY% 

ùfuka uQ,sl j¾K ^RGB& iEfoa'

rEmh 4'8 - j¾K ixfhdackh

	 wxls; .%dmslhl fhdod .kakd j¾K u.ska tys ksrEmKh jk f;dr;=re 

jgyd .; yels h' tu ksid rEmfhys .=Kd;aul Ndjh r|jd .ekSug j¾K fndfyda 

f,iska Wmldß fõ'

	 ;ks j¾K uQ,sl j¾K ^Primary colours& f,iska o" j¾K folla tl;= 

ùfuka iEfok j¾K oaú;Shsl j¾K ^Secondary colours& f,iska o" j¾K ;=kla 

tl;= ùfuka iEfok j¾K ;D;Shsl j¾K ^Triplet colours& f,i o ye¢kafõ' uQ,sl 

j¾Khl m%fNao 256 la ^0 - 255 olajd& we;'

;D;shsl j¾Khla idok wdldrh (Triplet Colour)

	 ;D;shsl j¾K iE§u i|yd j¾K m%fNao ñY% jkafka 000" 000" 000 isg 255" 

255" 255 olajd h' fuh zRGB TripletZ f,i ye¢kafjk w;r th RGB ^245" 102" 36& 
f,i fyda RGB ^F5" 66" 24& Iâ oYu ixLHd wdldrfhka o oelafõ' ^rEmh 4'9&

uQ,sl j¾K 

m%fNao

rEmh 4'9 - ;D;Shsl j¾K ñY%Kh
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.%dmsl ixfldapkh (compression of graphic)

	 .%dmslhl m%udKh ;SrKh jkafka th ks¾udKfha § fhdod .kq ,nk 

mslai, m%udKhg" f¾Ld m%udKhg yd fhdod .kq ,nk j¾K ixl,khg wkqj h' 

mslai, úYd, m%udKhlska hq;=" j¾Kj;a" Wiia úfNaokhla iys; .%dmslhla by< 

m%udKhlska hqla; fõ' tjeks .%dmslhla ;ekam;a lsÍfï § iy iïfm%aIKh lsÍfï § 

isÿ jk wmyiq;d u.yrjd .ekSu i|yd .%dmsl ixfldapkh ^Graphic compression& 
lsÍug wjYH fõ' .%dmslh ;ekam;a ^Save& lsÍfï § fyda Bg miq j fyda ixfldapkh 

lsÍu l< yels h'

	 .%dmslh ;ekam;a lsÍfï § ixfldapkh i|yd fhdod .kq ,nk f.dkq wdlD;s 

^File formats& wkqj .%dmslfha iajdNdúl ;;a;ajhg ydks isÿùu fyda fkdisÿùu 

;SrKh fõ' fuu f.dkq wdlD;s úúO l%ufõoj,g wkqj ilia lrkq ,enQ  

we,af.dß;u ^Algorithms& Ndú; lr .ksñka ks¾udKhg .e<fmk wdldrhg ilia 

lr we;'

	 .%dmsl ixfldapkh ^Graphic compression& lsÍï folls' ^rEmh 4'10& tkï" 

ydks jk ^Lossy& ixfldapk iy ydks fkdjk ^Lossless& ixfldapk hkqfjks'

ydks jk (Lossy) ixfldapkh ydks fkdjk (Lossless) ixfldapkh

uq,a .%dmslh

ixfldapkh 

jQ .%dmslh

kej; újD; 

jQ .%dmslh

uq,a ks¾udKfha ;;a;ajfhka 

u újD; ù fkdue;'

ydks jk 

ixfldapkh 

fhdÞ .ekSu

.%dmslh 

újD;

 lsÍu

uq,a .%dmslh

ydks fkdjk 

ixfldapkh 

fhdÞ .ekSu
ixfldapkh 

jQ .%dmslh

kej; újD; 

jQ .%dmslh

uq,a ks¾udKfha ;;a;ajfhka 

u újD; ù we;'

.%dmslh 

újD;

lsÍu

rEmh 4'10 - .%dmsl ixfldapkh lsÍu

	 ydks jk ixfldapk f.dkq wdlD;s ^Lossy file formats& fhdod .ksñka 

.%dmslh ixfldapkh lsÍfuka .%dmslfhys Odß;dj wju uÜgula olajd wvq lr .; 

yels kuq;a tys ;;a;ajh úkdY fõ' kej; újD; lsÍfï § tys iajdNdúl iajrEmh 

olakg fkd ,efí' kuq;a .%dmsl iïfm%aIKfha § iy ;ekam;a lsÍfï § we;s myiqj 

fuka u wka;¾cd,fhkaa nd.; lsÍu i|yd wvq Odß;djla iys; .%dmsl fhdod .kakd 

neúka o ydks jk .%dmsl ixfldapkh jeo.;a fõ' ydks jk ixfldapk f.dkq 

wdlD;s lsysmhla fõ' tajd JPEG" TIFF" BMP wdÈhhs'
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	 tfy;a ks¾udKh lrk ,o .%dmslfha .=Kd;aul nj /flk wdldrfhka 

th ixfldapkh l< yels h' kej; újD; lsÍfï § tys iajdNdúl iajrEmh olakg 

,efí' th ydks fkdjk ixfldapkh ^Lossless& f,i ye¢kafõ' ta i|yd fhdod .; 

yels ydks fkdjk ixfldapk f.dkq wdlD;s lsysmhla jkafka GIF" PNG" RAW 

wdÈhhs'

.%dmsl m%rEm (Graphic types)

	 wxls; .%dmslh m%Odk jYfhka m%rEm folls' tkï rdiag¾ .%dmsl ^Raster 
graphic& iy fjlag¾ .%dmsl ̂ Vector graphic& hkqfjks' .%dmslh fohdldrhla jkafka 

mßYS,lhd úiska ks¾udKfhA § fhdod .kq ,nk .%dmsl uDÿldx.hg wkqj h'

rdiag¾ .%dmsl iy fjlag¾ .%dmsl w;r fjki

rdiag¾ .%dmsl 

^Raster graphic& 

fjlag¾ .%dmsl 

^Vector graphic&

.%dmsl 

ks¾udKh

úúO j¾Kfhka hq;= mslai,a 

wdrdjlska h

iDcq fyda jl% f¾Ld tlg tl;= 

ùfuks

f.dkq igyka fkdue; ks¾udKfha wdrïNh" wjidkh" 

fldmuK f¾Ld m%udKhla o" iDcq 

fyda jl% f¾Ld o fhdÞ .kq ,nk 

j¾K ms<sn| igyka we;'

.%dmslfha 

.=Kd;aul nj

mßudj fjkia lsÍfï § 

.=Kd;aul nj úkdY ù hhs

mßudj fjkia lsÍfï § .=Kd;aul 

nj fjkia fkdfõ

Wiia ks¾udK 

i|yd 

iqÿiq fkdfõ iqÿiqhs

ks¾udKh lsÍu 

iy ;ekam;a 

lsÍu

mß.Kl u;lfha Odß;dj 

wvqfjka fhdÞ .kshs

mß.Kl u;lfha Odß;dj jeäfhka 

fhdÞ .kshs

ks¾udKfha § 

mß.Klfha 

l%shdldß fõ.h

fjkia fkdfõ wvq lrhs

uDÿldx. 

lsysmhla

Adobe Image Ready, Adobe 
P h o t o s h o p , P r o A r t R a g e , 
Artweaver, Corel PHOTO-
PAINT, GIMP, Deluxe Paint, 
GIMP shop, Microsoft Photo 
Editor

Adobe Illustrator, Adobe Live 
Motion, Corel Paint Shop Pro, 
Adobe Fireworks, Microsoft 
Expression Design, DrawPlus, X 
ara Photo & Graphic Designer, 
CorelDRAW, Litha-Paint
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rdiag¾ udOHfhka ks¾udKh lr 

úYd, l< úg

fjlag¾ udOHfhka ks¾udKh lr 

úYd, l< úg

ks¾udKh l< hq;= .%dmslh

rEmh 4'11 - rdiag¾ .%dmsl iy fjlag¾ .%dmsl w;r fjki

.%dmsl uDÿldx.hla Ndú;fhka iaÓ;sl .%dmslhla ks¾udKh lsÍu

	 iaÓ;sl .%dmslhla ks¾udKh lsÍu i|yd iqÿiq uDÿldx. fndfyda we;' bka 

lsysmhl ,ehsia;=jla by; § y÷kajd fok ,È' tfy;a fndfyda uDÿldx. ñ, § 

.; hq;= tajd ùu yd iEu fufyhqï moaO;shla i|yd u wkql+, fkdùu ksid Tng 

wmyiqjla jk neúka" wka;¾cd,h Tiafia myiqfjka nd.; yels" ksoyia" fndfyda 

fufyhqï moaO;sj, ia:dmkh l< yels uDÿldx.hla y÷kd .ksuq'

GIMP uDÿldx.h

	 GIMP hkq GNU keue;s ksoyia fufyhqï moaO;sh i|yd ks¾udKh lrk 

,o .%dmsl yeisrùfï uDÿldx.fha ^Image Manipulation Program& ixfla; kduhhs'

	 ksoyia uDÿldx.hla jk fuh PdhdrEm m%;sixialrKh" .%dmsl ks¾udKh" 

ixialrKh iy yeviùu i|yd fhdod .; yels h' fndfyda fuj,ï iys; fuu 

uDÿldx.h ir, Ñ;%hla ks¾udK lsÍfï isg Wiia ;;a;ajfha PdhdrEm ixialrKh 

olajd o fhdod .; yels h' fuh rdiag¾ m%rEmK uDÿldx.hls'

	 UNIX fufyhqï moaO;sh u; l%shdlsÍu i|yd ks¾udKh lrk ,o GIMP 
.%dmsl uDÿldx.h Microsoft Windows iy Mac fufyhqï moaO;s u; o l%shd lrhs'

	 GIMP mß.Klhg ia:dmkh lsÍu i|yd http://www.gimp.org/downloads / 
Ndú; lrkak'
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GIMP uDÿldx.fha Ñ;%l mßYS,l w;=reuqyqK; ^Graphical User Interface&

1 3 4

2

5

1' m%Odk fuj,ï ;Srej

2' fuj,ï úl,am

3' .%dmsl ljq¿j

4' ia;r" wkqux" m: 

5' mskai,a$fudaia;r$j¾K

1' m%Odk fuj,ï ;Srej (The Main Toolbox)

	 .%dmslhla ixialrKh lsÍfï § fhdod .kq ,nk fuys we;s fuj,ï wjYH 

mßÈ ,nd .ekSu iy jid oeóu l< yels h' ta i|yd"

Edit → Preferences →Toolbox → fuj,ï ,nd .ekSu i|yd enable o jid oeóu 

i|yd disable f;dard .kak'
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whslkh

 Icon
fuj,ï kduh 

Name
flá ux 

Shortcut
úia;rh

f;aÍfï fuj,ï (Selection tools)
Rectangle ctrl or R wjYH fldgi p;=ri%dldr fyda 

iDcqfldaKdi%dldr yevfhka f;dard 

.ekSug

Ellipse E wjYH fldgi b,smaidldr yevfhka 

f;dard .ekSug

Free (Lasso) F uQislfha wdOdrfhka .%dmslfhys 

wjYH fldgi wjYH yevfhka f;dard 

.ekSug

Fuzzy (Magic 
Wand)

U tl u j¾Kfhka hq;= jQ tlg iïnkaO 

jQ fldgia f;dard .ekSug

By Colour Shift + O ‍f;dard .;a j¾Kh .%dmslfha 

fld;ekl ;snqK o tu j¾K iys; 

fldgia f;dard .ekSug

Scissors I f;aÍug wjYH fldgi jghñka 

f;dard .ekSug

Foreground - rEmfhys miqìu ‍f;dard .ekSug

j¾K .e,aùfï fuj,ï

Bucket Fill Shift + B f;dard .;a fldgig j¾Khla fyda 

fudaia;rhla fh§ug

Blend 
(Gradient)

L f;dard .;a fldgig j¾K iïñY%Khla 

fh§ug 

Pencil N f;dard .;a fldgi u; j¾K fh§u 

iy f;dard .;a mekai,a m%udKhg 

wkqj bß we£u

Paintbrush P f;dard .;a mskai,a m%udKhg wkqj 

iqug jQ bß we£ug iy j¾K fh§ug
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Eraser Shift + E idudkH ulkhla wdldrhg 

l%shdlrñka .%dmslh u; we¢ bß uld 

oeóug

Airbrush A j¾K mskai,h fuka .%dmslh u; 

j¾K ù§ula f,i l%shdlrñka j¾K 

.e,aùug

Ink K j¾K mskai,h fuka .%dmslh u; 

j¾K .,ajhs' uQislh fõ.fhka .uka 

lrùfï § mskai,fha mßudj l=vd jk 

w;r fiñka .uka lsÍfï § mßudj 

úYd, fõ'

Clone C .%dmslfha f;dard .;a fldgila fjk;a 

ia:dkhlg msgm;a lrhs'

Heal H .%dmslfha fkd.e<fmk j¾K iys; 

m%foaY ksjerÈ ‍lrñka j¾K .,ajhs'

Perspective 
Clone

- oDIaáfldaKh fjkia l< miq laf,daka 

fuj,u f,i l%shd lrhs'

Convolve 
(Blur/Sharpen)

Shift + U .%dmslh w÷re lsÍu fyda ;shqKq lsÍu 

lrkq ,nhs'

Smudge S .%dmslh fnd| lrkq ,nhs

Dodge/Burn Shift + D fvdÊ u.ska .%dmslh wdf,dalj;a 

lrk w;r n¾ka u.ska th w÷re meye 

.kajhs'

mßñ;sh fjka lsÍfï fuj,ï (Transform Tools)
Move M f;dard .;a fldgi p,kh$ tyd 

fuyd lsÍug

Align Q .%dmslh tfl,a, lsÍug

Crop Shift + C .%dmslh wjYH wdldrhg lmamdÿ 

lsÍug
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Rotate Shift + R f;dard .;a fldgila" ;Ügqjla fyda 

ia;rhla wjYH wdldrhg lrleùug

Scale Shift + T f;dard .;a fldgil" ;Ügqjl fyda 

ia;rhl mßudj wjYH wdldrhg 

fjkia lsÍug

Shear Shift + S f;dard .;a fldgila tla ÈYdjlg 

;,a¨‍ lsÍug

Perspective Shift + P f;dard .;a fldgila fyda ia;rhla 

wjYH wdldrhg oDIaáfldaKh fjkia 

lsÍu

wfkl=;a fuj,ï Other tools
Path B yev;, iys; bß we£u" f;dard .ekSu 

iy tajd fjkia lsÍu

Colour Picker O .%dmslfha we;s ́ kE u j¾Khla f;dard 

.ekSsu

Magnify 
(Zoom)

Z .%dmslfha iQuh wvq jeä lsÍu

Measure Shift + M È. m%udKh iy fldaKh fmkakqï 

lsÍu

A Text M wlaIr we;=<;a lsÍu

2'	 fuj,ï úl,am (Tool options) - .%dmsl ks¾udKfha § wm úiska fhdod .kq ,nk 

fuj,ug wkqj fjkia jk fuu ;Srej tu fuj,u md,kh lsÍu i|yd fhdod 

.kq ,nhs'

3'	 .%dmsl ljq¿j (Image window) - ks¾udKh lrkq ,nk .%dmslh o¾Ykh lr 

.ekSu i|yd Wmldr fõ' fhdod .kq ,nk fma<shg wkqj wmg wjYH m%udKhla 

.%dmsl ljq¿ újD; lr ;nd .; yels h' fuys § ljq¿ lsysmhla tl úg újD; fõ' 

tfia fkdue;s kï tla ljq¿jla muKla újD; j ;nd .ekSu i|yd wjYH;djg 

wkqj fjkia lr .; yels h' ta i|yd"

		  Windows → Single-Window Mode f;dard .kak'
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4'	 ia;r" wkqux" m: (Layers, Channels, Paths) - fïjd má;s  ̂ Tabs& f,iska oelafõ' 

wjYH mßÈ ta u; la,sla lsÍfuka újD; lr .; yels h'

5'	 mskai,a$fudaia;r$j¾K (Brushes/Patterns/Gradients) - .%dmslh ks¾udKh 

lsÍug fuka u wjYH mßÈ j¾K .e,aùug fuu má;s WmldÍ fõ'

²² .%dmsl uDÿldx.hla Ndú;fha uQ,sldx.

.%dmslh wmkhkh 

lsÍu ^Export&

²² 'File' → 'Export' f;dard .kak'

²² 'Image' ixjdo fldgqfõ 'Name' 
ia:dkfhka .%dmslhg kduhla ,nd 

fokak'

²² 'Places' ia:dkfhka iqÿiq ia:dkhla  

f;dard .kak'

²² 'Select File Type ^By Extension&' 
ia:dkfhka wjYH f.dkq wdlD;sh ^File 
Format& f;dard .kak'

²² 'Export' la,sla lrkak'

	 ^fuys § úúO f.dkq wdlD;sj,g wkqj 

.%dmsl ixfldapkh isÿ fõ'& 

.%dmslhla ks¾udKh 

i|yd kj ljq¿jla 

,nd .ekSu

^Opening new 
Window&

²² File → New la,sla lsÍfuka New 
Image ixjdo fldgqj ^Dialogue box& 
újD; fõ' 

²² .%dmslfha mßudj i|yd wjYH ñKqï 

tallh f;dard .kak' 

²² Wi" m<, ilia lr .kak. ke;fyd;a 

l,ska ilia lrk ,o mßudjla 

^Template& ,nd .kak' 

²² OK la,sla lrkak' 

ks¾udKh lrk ,o 

.%dmslhla ;ekam;a 

lsÍu

^Saving a created 
image)

²² 'File' → 'Save' la,sla lrkak' 

²² 'Save Image' ixjdo fldgqfõ 'Name' 
ia:dkfhka .%d‍mslhg kduhla ,nd 

fokak' 

²² 'Places' ia:dkfhka iqÿiq ia:dkhla 

f;dard .kak' 

²² 'Save' la,sla lrkak' 

ie‍‍'hq'- GIMP uDÿldx.h u.ska ks¾udKh 

lrk ,o .%dmsl ;ekam;a lsÍfï § XCF 
f.dkq kdu È.=jg ^File extension& wkqj 

;ekam;a fõ'  ^Wod - image1.xcf&
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ks¾udKh lr 

;ekam;a lrk ,o 

.%dmslhla újD; lsÍu

^Opening an existing 
Window& 

²² 'File' → 'Open' la,sla lrkak'

²² 'Open' ixjdo fldgqfõ 'Places' 
ia:dkfhka f,aLkh ;ekam;a l< 

ia:dkh f;dard .kak'

²² 'Names' ljq¿fjka .%dmslh f;dard 

.kak' 

²² 'Open' la,sla lrkak'

GIMP uDÿldx.h Ndú;h

1' mska;+r tl;=jlska .%dmslhla ks¾udKh lsÍu

ks¾udKh i|yd ,nd .kakd rEm ,nd .kafka flfia o @

²² mß.Klfha ;ekam;a lr we;s rEm

²² ialEk¾ hka;%hla u.ska ialEka lr mß.Kl .; lrk ,o rEm

²² wxls; leurdjla u.ska PdhdrEm .; lr mß.Kl .; lrk ,o rEm

²² wxls; leurdjla iys; cx.u ÿrl;khlska ^Smart phone& PdhdrEm .; lr 

mß.Kl .; lrk ,o rEm

	 by; rEmfha olajd we;af;a fjka fjka jYfhka we;s rEm 3 la tla lrñka 

tla .%dmslhla ks¾udKh lr we;s wdldrhhs' fuh fufia ks¾udKh lruq'

	 fï i|yd Tn fï mß.Klfha ;ekam;a lr we;s fyda Tng myiqfjka fidhd 

.; yels mska;+r Ndú; lrkak'

mshjr 1 -	 GIMP uDÿldx.h újD; lrkak'

mshjr 2 -	 tys fukq ;Srefjka 'Windows' → 'Single -Window Mode' f;dard 

		  .kak'

ie'hq' - GIMP uDÿldx.fha mßYS,l w;=re uqyqK;a ljq¿j fohdldrhls' tkï  

tla ljq¿jla (Single -Window Mode) fyda fndfyda ljq¿ (Multi Windows Mode) 
jYfhks' fuh ks¾udKhg fmr fjkia l< hq;= h'
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mshjr 3 - 	 wjYH lrk rEm ,nd .ekSu i|yd - 'File → Open'
		  Open ixjdo fldgqfjka rEm f;dard újD; lr .kak' fuu rEm fjka  

		  fjka jYfhkaa újD; l< hq;= neúka 'Open as Layers' f;dard .ekSfuka  

		  j<lskak'

mshjr 4 -	 fuj,ï ;Srefjka fmrìu iy miqìu ^Foreground$background& 
		  j¾K ms<sfj<ska l¿ iy iqÿ f,i f;darkak' fï i|yd rEm  

		  igyfka oelafjk wdldrhg j¾K iys; fldgqj u; la,sla  

		  lsÍfuka wjYH j¾Kh f;dard .kak' tfia ke;fyd;a HTML  
		  notationys l¿ f;aÍfï § 000000 iy iqÿ f;aÍfï § fffffff hkqfjka  

		  h;=re ,shkh lr OK lrkak'

Foreground

Background

mshjr 5 -	 kj .%dmslhla i|yd ljq¿jla ,nd .ekSug 'File → New' la,sla 

		  lrkak'

		  'Create a New Image' ixjdo fldgqfjys m<, - 1200" Wi 800px  
		  ^mslai,& ilid 'OK' la,sla lrkak'

		  ^fjk;a mßud i|yd 'Templates' fhdod .; yels h'&

wjYH mßÈ mßudj 

m<, Wi ilia lr 

.ekSug

ilia lrk ,o mßud (Template) 
,nd .ekSug

mßudj i|yd 

ñkqï tAllh 

f;dard .ekSug
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bka miq GIMP Ñ;%l mßYS,l w;=re uQK; fufia ÈiA fõ'

újD; lr 

.kakd ,o rEm kj .%dmsl 

ljq¿j

mshjr 6 -	 m<uq rEmh f;dard .kak' thg wod< iA;r u; ol=Kq uQisl fnd;a;u  

		  la,sla lr 'Add an Alpha Channel' f;dard .kak'

we,a*d pek,h ^Alpha Channel& u.ska fhdod .kq ,nk rEmfha úksúo oelSu 

we;s lrhs' idudkHfhka fojeks rEmh tla lsÍfï § fuh iajhxl%Sh j tl;= fõ' 

kuq;a ia;r ljq¿fõ tla rEmhla muKla we;s wjia:dfõ § Add an Alpha Channel 
f;dard .; hq;= h'

mshjr 7 - 	 fuj,ï ;Srefjka b,smaidldr 

		  ^Ellipse& f;aÍfï fuj,u 

		  f;dard .kak'

		  'Tool options → Feathers' la,sla  

		  lr tu fuj,fuka f;dard .;a  

		  rEmh u; b,smaidldr j i,l=Kq  

		  lrkak'

mshjr 8 - 	 'Select → Feathers'
		  'Feather' mslai, 10g 

		  iliA lrkak'

		  'OK' la,sla lrkak'

		  'Edit → Copy Visible' 
		  f;dard .kak'
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mshjr 9 -	 kj .%dmsl ljq¿j u; la,sla lrkak'

		  'Edit' → 'Paste as' → 'New Layer' f;dard .kak'

		  ilia lr .;a rEm fldgi kj .%dmsl ljq¿j u; Èiafõ'

		  tyd fuyd lsÍfï fuj,u ^Move tool& Ndú;fhka rEmh ljq¿j u; 

		  ia:dk .; lrkak'

mshjr 10 - 	 fuu ks¾udKfhA § iEu 

		  rEmhla u tl u  

		  m%udKfhka ùu iqÿiq  

		  neúka ta i|yd" fuj,ï  

		  ;Srefjka Scale Tool  
		  f;dard .kak'

		  rEmh u; la,sla lrkak'

		  Scale ixjdo fldgqfjka 

		  rEmfha m<, iy Wi ms<sfj<sska mslai, 450" 600 f,i ilia lrkak'

		  Scale la,sla lrkak'

mshjr 11 -	 by; mshjr 5" 6" 7" 8" 9" 10 iy 11 oelajQ wdldrhg mshjr  

		  wkq.ukh lrñka b;sß rEm fol o .%dmsl ljq¿j u;g f.k tkak'  

		  ia:dk .; lrkak' mßudj fjkia lrkak'

 
	 fuu ia;r Layers ish,a, ia:dk .;ùu 

fufia oelafõ'
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ia;r ^Layers&
	 ixlS¾K fuka u ir, .%dmsl ks¾udKhla i|yd o ia;r Ndú;h 

b;d jeo.;a fõ' .%dmsl ks¾udKhla ;=< jia;= fh§fï § fjka fjka 

jYfhka ia;r Ndú; lsÍu u.ska tu jia;= yeisrùug myiq fõ' ia;r 

hkq úksúo fmfkk lvodis iuQyhla fuks' kuq;a iuyr wjia:dj, 

§ tlla u; tlla jia;= tl;= lsÍu ksid Bg my;ska we;s ia;rh fkd 

fmkS hhs'

²² ia;r ljq¿j u; tlsfkl rEm i|yd fjka fjka jYfhka ia;r 

fhÈh hq;= h'

²² tu ksid wod< ia;rh yd iïnkaO fjkia lsÍï wfkl=;a ia;r i|yd 

n,fkdmdhs' ^mdG fh§u" j¾K fh§u" yev;," ixialrK wdÈh&

²² ia;rh oDYHudk ùu fyda fkdùu fyda i|yd wei ^eye& Wmfhda.s 

lr .kak'

²² ia;r ljq¿fõ my; ;Srh ia;r i|yd jQ fkdfhl=;a fjkiaùï i|yd 

fhdod .kak'

1 3 5

2 4 6

mdrdkaO;dj

1'	 kj ia;rhla ^New&

2'	 ia;r lKavdhï ^Group&
3'	 ia;r ia:dk .; ùu ^Move&
4'	 ia;r wkqmsgm;a ^Duplicate layers&
5'	 ia;r kex.=rï oeóu ^Anchor&
6'	 ia;r bj;a lsÍu i|yd ^Delete&

²² mdrdkaO;dj ^Opacity& - ia;r ljq¿fõ 

by<ska oelsh yels h' f;dard .;a ia;rhl 

mdrdkaO;dj ^Opacity& wvq fyda jeä fyda 

lsÍu u.ska tu ia;rhg my;ska we;s 

ia;rh o¾Ykh ùu wvq fyda jeä fyda fõ'
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Opacity 100%

Opacity 75%

Opacity 50%

mshjr 12 -	 ia:dk.; lsÍu iy ixialrK wjika jQ miq ia;r ish,a, tlg  

		  tl;= lr tla ia;rhla njg m;a lsÍug wjYH fõ' ta i|yd" ia;r  

		  ljq¿j u; ol=Kq uQisl fnd;a;u la,sla lr"

	 	 'Merge Visible Layers' → 'Expand as necessary' → 'Merge' la,sla  

		  lrkak'

mshjr 13 -	 ilia lr.;a .%dmslfhA wkjYH fldgia bj;a lsÍu i|yd lemSfï 

		  fuj,u ^Crop& Ndú; lr wjYH m%foaYh muKla f;darkak'

mshjr 14 -	 .%dmslhg fndavrhla tl;=  

		  lsÍu i|yd"

		  'Filter' → 'Decor' → 'Add'  
		  Border fndav¾ X -10" fndav¾ 

		  Y -10" fndav¾ j¾Kh ks,a →  
		  Ok fndav¾ X -15" fndav¾  

		  Y-15" fndav¾ j¾Kh ly →  
		  OK by; oelajQ f,i jdr  

		  follska fndav¾ fhdokak'

mshjr 15 - 	 .%dmslh ;ekam;a ^Save& lrkak' bka miq th wmkhkh ^Export& 
		  lrkak'
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2' mdG iys; .%dmsl ks¾udKh

mshjr 1 -	 GIMP uDÿldx.h újD; lrkak'

mshjr 2 - 	 kj .%dmslhla i|yd ljq¿jla ,nd .ekSug 'File' → 'New' la,sla  

		  lrkak'

		  'Create a New Image' ixjdo fldgqfjys m<, - 640" Wi 400px 
		  ^mslai,& ilid 'OK' la,sla lrkak'

mshjr 3 - 	 miqìï j¾Kh ilia lsÍu i|yd"

		  Foreground iy Background j¾K 

		  i|yd ms<sfj<ska HTML notation w.h  

		  29c89c" e3216a hkqfjka fjkia lr  

		  j¾K ,nd .kak'

		  bka miq 'Gradient' fuj,u f;dard  

		  .kak'

mshjr 4 -	 uQislh la,sla lrñka miqìu ljq¿fõ 

		  ^Background window& jï fl<jf¾  

		  isg ol=Kq fl<jr olajd brla  

		  w¢kak' f;dard .;a j¾Kj,g wkqj  

		  miqìu j¾K .ekafõ'
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mshjr 5 - 	 mdGhla tl;= lsÍu i|yd"

		  fuj,ï fldgqfjka wlaIr fuj,u  

		  f;dard .kak' túg fuj,fï úl,am  

		  ;Srej ^Tool options& thg wkqrEmS j  

		  fjkia fõ' mdGhg .e<fmk wdldrhg  

		  my; oelafjk tAjd fufia ilia lrkak'

²² wl=re j¾.h Gill Sans Ultra Bold 
fyda m<, iys;" wl=re j¾.hla

²² wl=re m%udKh 72 Size
²² l¿ j¾Kh Color

	 bka miq ljq¿j u; la,sla lr NATURE hkqfjka 

h;=re,shkh lrkak' 'Move' fuj,u Ndú; lr ljq¿fõ 

ueog ia:dk .; lrkak'

mshjr 6 - 	 mdGh jgd fndavrhla oeóu i|yd

		  ia;r ljq¿fõ mdGh iys; ia;rh f;darkak' my; ;Srefjka kj 

		  ia;rhla ^Layer& ,nd .kak' th 'Text border' f,iska kï lrkak' 

		  B;, Ndú; lrñka 'Text border' ia;rh mdG ia;rfhka my<g 

		  ia:dk.; lrkak'‍

mshjr 7 - 	 mdG iA;rh f;darkak" ol=Kq uQisl fnd;a;u la,sla lr 'Alpha to  
		  selection' f;darkak'

mshjr 8 - 	 f;dard .;aa m%udKh jeä  

		  lsÍu i|yd"

		  'Select' → 'Grow' f;darkak'

		  'Grow Selection' m%udKh  

		  mslai, 2la olajd jeä lr  

		  'OK' la,sla lrkak'
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mshjr 9 - 	 'Text border' ia;rh f;dard .kak'

		  fmrìu j¾Kh ̂Foreground colour& i|yd iqÿ ̂white& j¾Kh o j¾K 

		  fh§u i|yd 'Bucket fill' fuj,u o f;dard mdGh u; la,sla lrkak'

	 	 bka miq 'Select' → 'None' f;darkak'

mshjr 10 - 	 mdGhg fijKe,a,la  

		  ^Shadow& tl;= lsÍu 

		  'Text border' ia;rh  

		  f;dard .kak'

		  fukq ;Srfhka 'Filters'  
		  → 'Light and Shadow' →  
		  'Drop Shadow' f;darkak'

		  rEmfha olajd we;s  

		  wdldrhg ilia lrkak'  

		  'OK' la,sla lrkak'

mshjr 11 - 	 ia:dk .; lsÍu wjika jQ miq ia;r ish,a, tlg tl;= lsÍug wjYH  

		  fõ' ta i|yd" ia;r ljq¿j u; ol=Kq uQisl fnd;a;u la,sla lr"

		  'Merge Visible Layers' → 'Expand as necessary' → 'Merge' la,sla  

		  lrkak'

mshjr 12 - 	 óg fmr bf.k .;a wdldrhg .%dmslhg fndavrhla tl;= lrkak'  

		  ksjerÈ ia:dkhl ;ekam;a lrkak' wmkhkh lrkak'

ie'hq' - fuu .%dmslfha miqìu ilia lsÍu i|yd úúO j¾K fuka u fudaia;r 

^Pattern& o fhdod .; yels h' f;dard .;a fudaia;rh u; uQislh la,sla lr th 

weof.k f.dia miqìu u; w;yßkak ^Drag and drop&'
úúO rEm tl;= lr miqìï ;,hla ks¾udKh lsÍug o W;aidy .kak' 

WodyrK 
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l%shdldrlu

1'	 Tn úiska PdhdrEm .; lrk ,o úfYaI wjia:djl PdhdrEm tl;= 

lr .%dmslhla ks¾udKh lrkak'

2'	 .%dmsl ks¾udKfha § fhdod .; yels fjk;a 'Filter' lsÍï Wmfhda.S 

lr .ksñka Tfí fï ks¾udKhg Wiia ksudjla ,nd fokak'

3'	 Y%S ,xldfõ úfYaIs; ia:dk iys; rEm wka;¾cd,fhka ,nd .ksñska 

.%dmsl ks¾udKh lr tajdg WÑ; wdldrfha ud;Dld fyda ye¢kaùï  

fyda we;=<;a lrkak'

4'	 äðg,a wdldrhg uqøKh l< yels jk mßÈ wdrdOkd m;%hla 

ks¾udKh lrkak'

5'	 mdif,a meje;afjk úfYaI isÿùula i|yd nekrhla ks¾udKh 

lrkak'
   

4'2  oaúudk iÔùlrKh (Two Dimensional animation)

	 wxls; iaÓ;sl .%dmsl ks¾udKh ms<sn|j;a .%dmsl ks¾udKh yd ine÷Kqq 

fkdfhl=;a úIhhka ms<sn|j;a by; mdvfï § wms idlÉPd lf<uq'

	 iaÓ;sl .%dmslhkag iÔj nj tla lrñka woyia m%ldY lsÍfï yelshdj ;j 

;j;a mq¿,a lsÍu iÔùlrKhla ks¾udKh lsÍfï uQ,sl wruqK fõ'

	 ks¾udKd;aul iÔùlrK" fjf<| m%ldYk udOHhla f,i o" ksIamdok 

m%j¾Ok udOHhla f,i o" úfkdaÞiajdoh i|yd fhdod .; yels mß.Kl l%Svd 

ks¾udKh iy ldgQka Ñ;%mg ks¾udKh lsÍu i|yd o fhdod .efka'

iÔùlrKhla hkq l=ula o@

	 iÔùlrKhla hkq hï lsis jia;=jla ^Object& fyda jia;= lsysmhla ^Objects& 
p,kh jk nj fmkaùu i|yd ks¾udKh lrkq ,nk oDIaá udhdjls' ^Optical 
illusion&' ld,dkql%ñl ̂Sequential& rduq fm<la ;=< fjka fjka jYfhka fm< .iajk 

,o ksYap, jia;=jla fyda lsysmhla fyda wLKaav j o¾Ykh lsÍfuka iÔùlrKhla 

ks¾udKh fõ' fuu o¾Yk fõ.h wvq fyda jeä fyda lsÍfuka tu jia;+kaf.a p,kh 

jk fõ.h wvq fyda jeä fyda l< yels h'
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iÔùlrK uQ,sldx.

rduq j¾.

	 iÔùlrKhla ks¾udKh i|yd rduq j¾. lsysmhla fhdod .efka' tkï" 

uQ,sl rduqj ^Key frame&" Üùka rduqj ^Tween frame&" rduq ^Frames& iy úhqla; 

uQ,sl rduq (Blank Key frames) hkqfjks'

²² uQ,sl rduqj ̂ Key frame& - uQ,sl rduqjla hkq iÔùlrKh i|yd fhdod .kq ,nk 

rduq fm<la ;=< jQ úfYaIs; tla ksYap, rEmhls ^rduqjls&' uQ,sl rduqj l=ula oehs 

;SrKh lr ilia lrkq ,nkafka mßYS,lhd úisks' iïmQ¾K p,khla ;=< b;d 

jeo.;aa ia:dkj, uQ,sl rduq lsysmhla ;sìh yels h'

	 WodyrKhla f,i" p,kh wdrïNfha § iy wjidkfha § we;s lrkq ,nk rduq 

uQ,sl rduq f,i oelaúh yels h'

²² Üùka rduq ^Tween frame& - p,kuh oDIaá udhdj ^Optical illusion& ks¾udKh 

jkafka Üùka rduq ;=< § h' uQ,sl rduq folla w;r iqug p,khla ks¾udKh 

lsÍu Üùka rduq we;s lsÍfï mrud¾:h hs' mßYS,lhd úiska uQ,sl rduq ks¾udKh 

lrkq ,nk w;r Üùka rduq ks¾udKh lrkq ,nkafka mß.Kl l%uf,aLh 

^Computer programme& u.sks' ;;amrhla ;=< rduq 24lska muK ^24 frames per 
second - fps& iqug jQ p,khla ks¾udKh l< yels fõ'

	 WodyrKhla f,i wdrïNhg tla rduqjl=;a wjidkhg tla rduqjl=;a jYfhka 

uQ,sl rduq folla we;' rduq 24l p,khl § mß.Kl l%uf,aLh u.ska b;sß 

rduq 22 Üùka rduq f,i ks¾udKh lrkq ,nhs' wjidkfha § mßYS,lhdf.a wju 

W;aidyhlska iqug p,kh iys; iÔùlrKhla ks¾udKh lr .; yels h'

²² rduq ^Frames& - wka;¾.;hla iys; rduqjlg hdno j ;j;a rduqjla tla l< úg 

iÔúlrKh ;=< wka;¾.;fha fmkajk ld,iSudj jeä lr .; yels h'

²² jHqla; uQ,sl rduq  ^Blank key frame& - ysia jHqla; rduqjla we;=<;a l< iEu 

fudfyd;l u" th hï wka;¾.;hla iemhSu i|yd ysia rduqjla imhhs' kuq;a 

Tn tys hula ks¾udKh l< úg th ;j ÿrg;a jHqla; uQ,sl rduqjla fkdfõ'

uDÿldx.hla weiqfrka iÔùlrKhla ks¾udKh lruq' 

Vectorian Giotto

	 iÔùlrK ks¾udKlrejka fjkqfjka u ksIamdokh lrkq ,enQ Vectorian 
Giotto uDÿldx.h wka;¾cd,fhka nd.; lr mß.Klfha ia:dmkh l< yels ksoyia 

uDÿldx.hls' fuu uDÿldx.h Ndú;h myiq jk w;r fjk;a iÔùlrK uDÿldx. 

fuka fla; fh§u ^Coding& wjYH fkd fõ'
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	 ks¾udKh lrk ,o rEmigyka i|yd p,khla ,nd §u fuu uDÿldx.h 

Ndú; lsÍfï m%Odk wruqK jk w;r ta i|yd u ieliQ *a,EIa iÔùlrK fuj,ï 

50la muK fuu uDÿldx.fha we;'

	 Giotto uDÿldx.fha úfYaI;ajh jkafka ixlS¾K jQ isoaêud,d rduq ^Complex 
scripts& w;r isr fkdù b;d ir, j iÔùlrKhla f.dv k.d .; yels ùu iy tu 

ks¾udKh i|yd ix.S;h o we;=<;aa l< yels ùuhs'

	 Vectorian Giotto uDÿldx.h my; olajd we;s URL ,smskh Tiafia Tnf.a 

mß.Klhg nd.; lr ia:dmkh lr .kak' http://vectorian.com/giotto/

Vectorian Giotto uDÿldx.fha Ñ;%l mßYS,l w;=reuqyqK; 

(Graphical User Interface)

1

7 8

63 52 4

1'	 we£fï fuj,ï ;Srej (Drawing Toolbar) - iÔùlrKhl § uQ,sl wjYH;djla 

jkafka p,kh lsÍug fyda fjk;a fjkia ùula isÿ lsÍug wjYH jia;==jla fyda 

mdGhla jev;,h u; ks¾udKh lr .ekSuhs' fuys we;s fuj,ï fï i|yd 

fhdod .; yels fõ' tajd kï"

5' jev;,h

6' cHdñ;sl jia;= iy yev;, 

7' j¾K

8' ;;a;aj ljq¿j

	 1' we£fï fuj,ï ;Srej

		  2' Built-in-player
	 3' ia;r

	 4' ld, rduqj
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Line tool (N)
bß we£fï 

fuj,u

jev;,h u; bß we£u i|yd fhdod .; yels h' 

1'	 fuj,u u; la,sla lrkak' 

2.	 'Shape' ;Srfha 'Pen' fldgiska we¢h hq;= bß j¾.h iy j¾Kh 

f;darkak' >k;ajh i|yd wxlh fhdokak'

3'	 uQislh la,sla lrñka jev;,h u; w¢kak'

ie'hq'- bß we£fuka miq j 

th f;dard wjYH wdldrhg 

j¾.h" j¾Kh iy >k;ajh 

fjkia l< yels h'

>k;aj

j¾K

j¾.h

 

Insert bitmap
(M) rEm tl;= 

lsÍfï fuj,u

jev;,h u;g rEmhla tl;= lsÍug fhdod .efka' Giotto jev;,h 

u;g tl;= l< yels rEm f.dkq wdlD;s - bitmap ̂ bmp&" JPEG ̂ jpg&" 
TIFF ^tif&" PNG ^png&" GIF ^gif&" and ICO ^ico&'
1'	 fuj,u u; la,sla lrkak

2'	 tu.ska újD; jk 'Open' ixjdo fldgqj ;=<ska wjYH rEmh 

f;dard újD; lr .kak'

Text tool
(T)

mdG fuj,u

jev;,h u; mdG fh§ug fhdod .efka'

1'	 fuj,u u; la,sla lrkak

2'	 ta iu. u újD; jk 'Properties' ;Srfhka 

    wl=re j¾.h" m%udKh" tfl,a, lsÍu o" mskai,a (Brush)  ;Srfhka 

j¾Kh o f;dard jev;,h u; uQislh la,sla lr h;=re,shkh 

lrkak'

ie' hq - 'Properties' ;Srh o¾Ykh fkdfõ kï"

'Window' → 'Object Properties' la,sla lrkak'

h;=re,shkh lsÍfuka miq j o ‍wjYH wdldrhg fjkia lsÍï 

l< yels h'

T
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Oval tool
(O)

´j,dldr 

fuj,u

jev;,h u; ´j,dldr rEm we£ug fhdod .efka'

1'	 fuj,u f;dard .kak'

2.	 'Shape'  ;Srfhka rEm fndavrfha j¾.h" j¾Kh iy >k;ajh 

o" 'Brush' ;Srfhka rEm‍h i|yd j¾Kh o f;darkak' 

3'	 uQislh la,sla lrñka jev;,h u; w¢kak'

tla j¾Khla

j¾K 

ixl,khla

rEmhlaa

j¾K fh§fï § 

²² tla j¾Khla

²² j¾K ixl,khla fyda rEmhla fyda fhÈh yels h'

Rectangle tool (R) 
RcqfldaKdi%dldr 

fuj,u

²² jev;,h u; RcqfldaKdi%dldr rEm we£ug fhdod 

.efka' by; ´j,dldr rEm we¢ wdldrh u fhdod .kak'

Pencil tool (P) 
mekai,a fuj,u

²² mekai, u.ska jev;,h u; ksoyia f,i bß we£ug 

yels h'

1'	 fuj,u f;dard .kak'

2'	 by; bß we£fï § wkq.ukh l< wdldrh u fhdod 

.kak' 

Brush tool (B) 
mskai,a fuj,u

mskai,a u.ska jev;,h u; ksoyia f,i m<,ska jeä yev;, 

we£ug yels h' 

1'	 fuj,u f;dard .kak'

2'	 by; bß we£fï § iy mekai, Ndú; lsÍfï §  

wkq.ukh l< wdldrh u fhdod f.k ks¾udKh lrkak'
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Selection tool (V)
f;dard .ekSfï 

fuj,u

jev;,h u; ks¾udKh lrk ,o yev;," mdG fyda rEm 

f;dard .ekSu;a tyd fuyd lsÍu;a i|yd f;dard .ekSfï 

fuj,u fhdod .efka'

1'	 fuj,u f;dard .kak'

2'	 B ysi ks¾udKh lrk ,o 

jia;=j u;g f.k tkak" 

la,sla lrkak'

3'	 tu jia;=j iqÿ meye;s l=vd 

;s;aj,ska jeiS .sfha kï th f;dard f.k we;s nj 

oelafõ‍' 

Sub selection tool (A)
f;dard .ekSfï 

wkqfuj,u

ks¾udKh lrk ,o yev;,fhys fmkqu fjkia lsÍu 

i|yd fhdod .efka'

1'	 fuj,u f;dard .kak'

2'	 fjkia l< hq;= yev;,h u; 

la,sla lrkak'

3'	 tys jfÜg we;s i,l=K u; 

la,sla lrñka bj;g fyda 

we;=<g fyda wÈñka wjYH fjkia ùu lrkak'

Lasso tool (L)
,efida fuj,u

jev;,fha we;s rEm" yev;, wdÈh lmd fjka lsÍug 

fhdod .efka'‍

1'	 fuj,u f;dard .kak' 

2'	 rEmh u; la,sla lrñka wjYH fldgi f;dard .kak' 

Free transform tool 
(Q)

ksoyia rEmdka;r 

fuj,u

ks¾udKh lrk ,o yev;, fyda tl;= lrk ,o rEmj, 

mßudKh fjkia lsÍu" lrleùu iy yev;,h ‍fjkia 

lsÍu i|yd fhdod .kq ,nhs' 

1'	 fuj,u f;dard .kak

2'	 jia;=j u; la,sla lrkak

3'	 jia;=j jgd we;s lrkq ,nk 

fuj,ï u; la,sla lrñka wjYH 

fjkialu lrkak'
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Ink bottle tool (‍S)
;Ska; l=mams fuj,u

jev;,h u; w¢k ,o yev;,j, fndavrh fjkia lsÍu 

i|yd fhdod .efka' 

1'	 fuj,u f;dard .kak'

2'	 'Shape' → 'Pen' wdY%s; j ‍wjYH mßÈ m%udKh" j¾Kh 

iy j¾.h f;darkak'

3'	 yev;,h u; la,sla lrkak'

Paint Bucket tool (K)
;Ska; nlÜgqj

w¢k ,o yev;,j, j¾Kh fjkia lsÍu i|yd fhdod 

.efka'

1'	 fuj,u f;dard .kak'

2'	 'Shape' → 'Brush' wdYs%; j ‍wjYH mßÈ tla j¾Khla" 

j¾K ixl,khla fyda rEmhla f;darkak'

Eyedropper tool (I)

tla yev;,hla i|yd Tn úiska ks¾udKh lrk ,o 

j¾K ixl,khla fjk;a yev;,hla i|yd fh§ug 

f;dard .ekSu i|yd fhdod .efka'

1'	 fuj,u f;dard .kak'

2'	 j¾Kh iys; yev;,h u; la,sla lrkak'

3'	 bka miq j¾Kh rys; yev;,h u; la,sla lrkak'

Eraser tool (E) 
ulkh

ks¾udKh lrk ,o yev;,hl fldgila muKla uld 

oeóug‍ fhdod .efkk kuq;a fuu.ska iïmQ¾K yev;,h 

u bj;a fkd fõ'

2.	 Build-in-player - ks¾udKh lr .;a iÔùlrKhla l%shdlrùug ^Play&" 

keje;aùug ^Stop&" wdrïNl rduqjg hdug ^Rewind&" wjidk rduqjg hdug ^Go 
to End& wdÈ l%shd i|yd fhdod.kq ,nhs'

keje;aùu

l%shdlrùu

wdrïNl rduqjg

wjidk rduqjg
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3'	 ia;r (Layers) - ixlS¾K fuka 

u ir, iÔùlrKhla ks¾udKfha 

§ ia;r Ndú;h b;d jeo.;a fõ' 

iÔùlrKh ;=< jia;= fh§fï § fjka 

fjka jYfhka ia;r Ndú; lsÍu u.ska 

tu jia;= yeisrùug myiq fõ' ia;r 

hkq úksúo fmfkk lvodis iuQyhla 

fuks' tfy;a iuyr wjia:dj, § 

jia;= tlla u; tlla tl;= lsÍu ksid Bg my;ska we;s ia;rh fkdfmkS 

hhs' idudkHfhka Giotto uDÿldx.h újD; jk úg m<uq ia;rh oelsh yels 

h' th Layer 1 f,i oelafõ' ia;r rduqj u; ol=Kq uQislh la,sla lsÍu u.ska 

kj ia;rhla .ekSu" ia;r bj;a lsÍu" ia;rfha oDYH woDYH nj" ia;r w.=¨ 

oeóu$w.=, weÍu" ia;r ia:dk .; lsÍu wdÈ l%shdjka /ila lr .ekSug yels h'

4'	 ld, rduqj (Time line) - iÔùlrKhla ks¾udKh lsÍfï § jeo.;a wx.hla 

f,i ld, rduqj oelaúh yels h' iÔùlrKh i|yd .; jk ld,h ilia lsÍu 

fuys § isÿ lrkq ,nhs'

5'	 jev;,h (Work sheet) - iÔùlrKh i|yd wjYH ks¾udKh lrkq ,nkafka 

jev;,h u; h'

6'	 cHdñ;sl jia;= iy yev;, (Shapes) - ks¾udKh i|yd 

fhdod f.k we;s cHdñ;sl jia;=jla iy yev;, j¾K 

.ekaùu fuu ljq¿j wdOdrfhka isÿ lrkq ,nhs' fndav¾ 

j¾Kh iy fndav¾ j¾.h f;dard .ekSu" j¾K ixl,k" 

rgd fh§u" rEm fh§u wdÈh i|yd fuu ljq¿j fhdod 

.efka'

7'	 j¾K (Colours) - - fuj,ï rduqfjka ks¾udKh i|yd 

fhdod .kq ,nk fuj,fï ^mekai," mskai," ;Ska; 

nd,aÈh" wlaIr& i|yd j¾K uQ,sl j f;dard .kq ,nkafka 

fuu ljq¿fjks' fndavrh i|yd j¾Kh 'Pen' ia:dkfhka 

o msrùu i|yd j¾Kh 'Brush' ia:dkfhka o ,nd .; yels 

h'
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8'	 ;;a;aj ljq¿j (Properties Window) - - wlaIr fuj,u f;dard .;a úg thg 

wkqrEmS j fjkia jk ;;a;aj ljq¿j, wlaIrfhys m%udKh" wlaIr j¾.h" 

tfl,a, lsÍu wdÈ fkdfhl=;a f;dard .ekSï i|yd fhdod .; yels h'

iÔùlrK Ndú;fha uQ,sldx. 

iÔùlrK ks¾udKh 

i|yd kj ljq¿jla 

,nd .ekSu 
'File' → 'New Movie'

ks¾udKh lrk ,o 

iÔùlrK ;ekam;a 

lsÍu 

²² 'File' → 'Save' la,sla lrkak' 
²² 'Save Image' ixjdo fldgqfõ 'Name' 

ia:dkfhka  .%dmslhg kduhla ,nd 

fokak' 

²² 'Places' ia:dkfhka iqÿiq ia:dkhla 
f;dard .kak' 

²² 'Save' la,sla lrkak' 

Giotto uDÿldx.h wdY%s; j ks¾udKh lr ;ekam;a lrkq ,nk f.dkqjla .vgd 
^vectorian giotto document& f.dkq wdlD;shg wkqj ;ekam;a lr.kq ,nhs' tfia 

u fuu iÔùlrKh fjí wvú ks¾udKfha § fhdod .; yels wdldrfha f.dkqjla 

f,i ;ekam;a lr .; yels h' fuh *a,EIa iÔùlrK wmkhkh ^Export Flash 
Movie& lsÍu f,i y÷kajkq ,nhs' fuys § iÔùlrKh ;ekam;a jkafka .swf 
^small web format& f.dkq wdlD;shg wkqj h'

iÔùlrKh 

fjk;a f.dkq 

wdlD;shlg  

wkqj ;ekam;a 

lsÍu$wmkhkh 

lsÍu ^Export&

²² iÔùlrKh .swf ‍f.dkq wdlD;shg wkqj 

;ekam;a lsÍu i|yd" 

²² 'File' → 'Export Flash Movie' f;dard 

.kak' 

²² f.dkqj ;ekam;a lrk ia:dkh f;dard 

f.dkqjg iqÿiq kula ,nd § 'Save' la,sla 

lrkak' 

²² bka miq újD; jk 'Export Settings' 
ixjdo fldgqfõ 'Compress movie' 
la,sla lr 'OK' lrkak' 
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ks¾udKh lr 

;ekam;a lrk 

,o iÔùlrKh 

újD; lsÍu

²² 'File' → 'Open' la,sla lr f.dkqj ;ekam;a 

lrkq ,enQ ia:dkfhka f;dard újD; lr .; 

yels h' tu f.dkqj iÔùlrKhla wdldrhg 

újD; lr .ekSug kï"

²² f.dkqj ;ekam;a lrkq ,enQ ia:dkh újD; 

lr .kak'

²² f.dkqj u; uQislfha ol=Kq fnd;a;u la,sla 

lrkak'

²² Ndú;hg .kakd fjí fijqï hka;%h ^Web 
Browser& f;dard .kak'

²² iÔùlrKh fijqï hka;%h ;=< l%shd;aul 

jkq oelsh yels h'

fjlafgdaßhka .sfhdafgda Ndú;fhka ir, iÔùlrKhla ks¾udKh lruq

mshjr 1 -	 Giotto uDÿldx.h újD; lr .kak'

mshjr 2 - 	 rEmfha oelafjk wdldrhg jev;,fha by<ska RcqfldaKdi%dldr  

		  yevhla iy ´j,dldr yevhla  

		  we|.kak'

mshjr 3 - 	 fuu yev;, f;dard .ekSfï 

		  fuj,u wdOdrfhka fjka fjka  

		  jYfhka f;dard 'Pen' iy 'Brush'  
		  ;Srh wdOdrfhka fndav¾ iy  

		  we;=<; j¾K fhdokak'

mshjr 4 - 	 fuu l%shdj,sh ld, rduqfõ ^Timeline& m<uq rduqj ;=< igyka ù  

		  we;s nj ksÍlaIKh lrkak' fuh m<uq uQ,sl rduqjhs'

 

mshjr 5 - 	 ld, rduqfõ ^Timeline& 24 jk rduqj u; ol=Kq uQisl fnd;a;u 

		  la,sla lr 'Insert Key frame' f;dard .kak' túg ld, rduqfõ 1 isg 24 

		  olajd rduq fufia Èiafõ'
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	 f;dard .ekSfï fuj,u ^Selection tool& 
wdOdrfhka jev;,h u; w¢k ,o RcqfldaKdi%dldr 

iy ´j,dldr yev fjka fjka jYfhka jev;,fha 

my<g f.k tñka rEmfha oelafjk wdldrhg 

ia:dk .; lrkak'

mshjr 6 - 	 ld, rduqfõ 1 isg 24 olajd jQ ´kE u rduqjla u; uQislfha ol=Kq  

		  fnd;a;u la,sla lr ,efnk fukqfjka 'Create Motion Tween'  
		  f;darkak' túg ld, rduqj fufia Èiafõ'

mshjr 7 - 	 Built-in-player Ndú;fhka ks¾udKh l%shd;aul lr n,kak'

iÔùlrKhl fõ.h wvq fyda jeä fyda lsÍug;a" ks¾udKfhys miqìï 

j¾Kfhys fyda mßudfjys fjkila lsÍug;a wjYH kï"

'Modify' → 'Document' la,sla lr 'Document Properties' ixjdo 

fldgqfjka wjYH fjkialï lr 'OK' la,sla lrkak' 

miqìï j¾Kh 

fjkia lsÍu 

i|yd
;;amrhlg 

we;s rduq 

wkqmd;h wvq 

fyda jeä lsÍu 

u.ska p,k 

fõ.h wvq fyda 

jeä fyda lsÍu

mßudj
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mdG iys; iÔùlrKhla ks¾udKh lsÍu

mshjr 1 - 	 Giotto uDÿldx.h újD; lr.kak'

mshjr 2 - 	 rEmfha oelafjk wdldrhg 

		  jev;,h wdjrKh jk f,i 

		  RcqfldaKdi%hla w¢kak'

mshjr 3 - 	 Brush → Linear Ndú;fhka  

		  j¾K ilia lr j¾K nlÜgqj 

		  wdOdrfhkaa j¾K .kajkak'

mshjr 4 - 	 ia;r ;Srfha 'Layer 1' u; fojrla  

		  la,sla lr iA;rh ‘Background’  
		  f,i kï lrkak'

mshjr 5 -	 kj iA;rhla ,nd .ekSu i|yd  

		  'Layer' ;Srh u; uQislfha ol=Kq  

		  fnd;a;u la,sla lr ¬ 'Layer'  
		  f;dard .kak'

mshjr 6 - 	 tu ia;rh ‘Text’ hkqfjka kï   

		  lrkak' ia;r ;Srej fufia Èiafõ'

mshjr 7 - 	 'Text' ia;rh f;dard .kak' mdG 

		  fuj,u wdOdrfhka jev;,fha  

		  'Beautiful Sri Lanka' hkqfjka  

		  h;=re,shkh lrkak'

mshjr 8 - 	 tu mdGh f;dard 'Properties'  
		  ljq¿j wdOdrfhka mdGh ilia  

		  lr.kak' ^wl=re j¾.h Curlz  
		  MT" wl=re mßudj 35&' rEmfha  

		  oelafjk wdldrhg jev;,fha  

		  uOHfha ia:dk .;lrkak'

mshjr 9 - 	 mdGh u; ol=Kq uQislh la,sla  

		  lr  'Effect' → 'Add…' f;darkak'

mshjr 10 - 	 Effect ljq¿fõ mdGhg fhÈh  

		  yels fndfyda rxf.daml%u  

		  ^Effects& we;s nj oelsh yels h'  

		  ta w;=ßka 'Falling Leafs' f;dard  

		  .kak' 'OK' la,sla lrkak'
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	 tu iliA lsÍug wkqj 'Text' ld, rduqj fufia fjkia ù we;s nj ksÍlaIKh 

lrkak'

 

	 Text ld, rduqj fufia fjkia ù we;af;a f;dard.;a rxf.daml%uhg wkqj h' 

Bg idfmalaI j Background ld, rduqj o ilia lr.; hq;= h'

fï i|yd"

mshjr 11 -	 'Background' ld, rduqj f;dard .kak' tys 83 rduqj ^Text rduqj  

		  wjika jk ia:dkh& u; uQislfha ol=Kq fnd;a;u la,sla lr 'Insert  
		  Keyframe' f;dard .kak'

mshjr 12 - 	 ks¾udKh lr.;a iÔùlrKh ;ekam;a lr wmkhkh lrkak' bka  

		  miq újD; lr n,kak'

l%shdldrlu

1'	 Tn úiska ks¾udKh lrk ,o iaÓ;sl .%dmslhla miq;,h f,i fhdod 

f.k p,kh jkakd jQ iqÿiq mdGhla fhdod .ksñka iÔùlrKhla 

ks¾udKh lrkak' úúO rxf.daml%u w;ayod n,kak'

4'3   Y%jH ikaOdr

	 M,odhS woyia yqjudrejla i|yd fhdod .; yels iaÓ;sl .%dmsl ks¾udKh;aa" 

iÔùlrKh;a ms<sn| j miq.sh mdvï ud,dfjka bf.k .;suq' fufia ks¾udKh lr 

.;a iÔùlrK jvd yrj;a fuka u wdl¾IŒh lr .ekSug Yío fyda y~ fyda iys; 

f.dkq fyj;a Y%jH ikaOdr fhdod .; yels h' 

	 Yío fyda y~ fyda má.; lsÍfuka ilia lr .kakd jQ f.dkq Y%jH ikaOdr 

fõ' fuu Y%jH ikaOdr mß.Kl wdY%fhka ilia lsÍug;a tajd WÑ; wdldrhg 

ixialrKh lr .ekSug;a mß.Kl uDÿldx. fhdod.kq ,nhs' fï i|yd fhdod .; 

yels fndfyda uDÿldx. we;' ñka iuyrla kï"

²² Audacity 
²² Power Sound Editor 
²² Mp3DirectCut 
²² Music Editor Free 
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²² Wavosaur 
²² Ardour 
²² WavePad Sound Editor 
²² Sound Engine

Y%jH ikaOdr ks¾udKh i|yd Y%jH ixialrK uDÿldx.hla fhdÞ .ekSu

TvEisá ^Audacity& 

	 úkafvdaia fufyhqï moaO;shl fuka u Mac iy ,sklaia fufyhqï 

moaO;sj, o ia:dmkh lr" Ndú; l< yels TvEisá" ksoyia Y%jH ixialrK  

uDÿldx.hls' Y%jH ixialrKh fuka u Y%jH má.; lsÍu i|yd o fhdod .; yels 

nyq m:j,ska iukaú; fuu uDÿldx.h mß.Klhg ia:dmkh lsÍfï § tys Ñ;%l 

mßYS,l w;=re uqyqKf;ys NdIdj" mßYS,lhdf.a reÑl;ajhg wkqj f;dard .; yels 

h' 

TvEisá Ndú;fhka

²² iÔj Y%jH má.; lsÍu

²² mß.Klfha l%shd;aul jk ix.S; má.; lsÍu

²² fÜma fyda frfldav¾ Y%jH ikaOdr wxls; má.; lsÍu fyda kuH ;eá.; 

lsÍu njg m;a lsÍu

²² WAV" AIFF" FLAC" MP2" MP3 fyda Ogg Vorbis wdlD;s iys; f.dkq 

ixialrKh lsÍu

²² Yío msgm;a lsÍu" lmamdÿ lsÍu" ñY% lsÍu fyda tlg tl;= lsÍu wdÈ 

ixialrK lsÍu

²² Y%jH má.; lsÍfï § tys fõ.h fyda iajrudkh ^pitch& fjkia lsÍu jeks 

rx. m%fhda. fhdod .ekSu 

wdÈ fndfyda Y%jH ixialrK lr .; yels h'

	 TvEisá uDÿldx.h my; olajd we;s URL ,smskh Tiafia Tnf.a mß.Klhg 

nd.; lr ia:dmkh lr.kak' 

http($$audacity.sourceforge'net$
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TvEisá Ñ;%l mßYS,l w;=re uqyqK;

1
2 3 4

7
5

8

6

10

11

12

13

14

9

1' fukq ;Srej - (Menu Bar)
2' mßjyk fuj,ï ;Srej - (Transport Toolbar)
3' fuj,ï iys; fuj,ï ;Srej - (Tools Toolbar)
4' má.; lsÍfï óg¾ fuj,ï ;Srej - (Recording Meter Toolbar)
5' ms<sjehSfï óg¾ fuj,ï ;Srej - (Playback Meter Toolbar)
6' ñY%l fuj,ï ;Srej - (Mixer Toolbar) 
7' ixialrK fuj,ï ;Srej - (Edit Toolbar)
8' msgm;a lsÍfï fuj,ï ;Srej - (Transcription Toolbar)
9' Wml%u fuj,ï ;Srej - (Device Toolbar)
10' ld, ;Srej - (Timeline) 
11' m: md,k uKav,h - (Track Control Panel) 
12' Y%jK m:h - (Audio Track)
13' f;aÍfï fuj,ï ;Srej - (Selection Toolbar) 
14' ;;a;aj ;Srej - (Status Bar)
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Y%jH ikaOdr uDÿldx.hla Ndú;fha uQ,sldx.

Y%jH ikaOdrhla 

ks¾udKh i|yd 

kj ljq¿jla 

,nd .ekSu

'File' → 'New'

ks¾udKh 

lrk ,o Y%jH 

ikaOdrhla 

;ekam;a lsÍu

²² 'File' → 'Save' 
²² f.dkqj ;ekam;a lrk ia:dkh f;dard 

f.dkqjg iqÿiq kula ,nd § 'Save' 
la,sla lr ;ekam;a lrkak' 

TvEisá uDÿldx.h wdY%s; j ks¾udKh lr ;ekam;a lrkq ,nk f.dkqjla .aup 
(Audacity project) f.dkq wdlD;shg wkqj ;ekam;a lr.kq ,nhs' fuu wdlD;shg 

wkqj ;ekam;a lrkq ,nk f.dkq ixialrKh i|yd fhdod .; yels h'

tfia u fuu Y%jH ikaOdrh fjí wvú ks¾udKfha § fhdod .; yels wdldrfha 

f.dkqjla f,i o ;ekam;aa lr.; yels h' fuh Y%jH wmkhkh ^Export Audio& 
lsÍu f,i y÷kajkq ,nhs' fuys § iÔùlrKh ;ekam;a lr .; yels f.dkq 

wdlD;s fndfyduhla we;' bka lsysmhla kï" WAV" AIFF" FLAC" MP2" MP3 
wdÈhhs'

Y%jH ikaOdrhla 

wmkhkh lsÍu 

i|yd"

^Export Audio&

²² 'File' → 'Export Audio' f;dard .kak'

²² f.dkqj ;ekam;a lrk ia:dkh f;dard 

f.dkqjg iqÿiq kula ,nd fokak' 

²² wjYH f.dkq wdlD;sh 'Save as type' ;=<ska 

f;dard .kak' 'Save' la,sla lrkak' ^Y%jH 

ikaOdrh ixfldapkh ùu fuys § isÿ fõ&

²² bka miq újD; jk 'Edit Metadata' ixjdo 

fldgqj Wmfhda.s lr .ksñka Y%jH 

ikaOdrh ms<sn| úia;r ^ku" j¾Ih" 

ks¾udKfha ud;Dldj wdÈh& we;=<;a lr 

'OK' la,sla lrkak'
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TvEisá Ndú;fhka Y%jH má.; lsÍu

mshjr 1 -	 'File' → 'New' la,sla lrkak' 

mshjr 2 - 	 mßjyk fuj,ï ;Srefõ ^Transport Toolbar& má.; lsÍu ^Record&  
		  fuj,u u; la,sla lrkak' 

mshjr 3 - 	 mß.Klhg iïnkaO lr we;s uhsfl%dfmdakh wdOdrfhka wjYH  

		  Y%jH ikaOdrh má.; lrkak' 

mshjr 4 - 	 wjidkfha § mßjyk fuj,ï ;Srefõ keje;aùfï ^Stop& fuj,u  

		  u; la,sla lrkak' 

mshjr 5 - 	 tu fuj,ï ;Srefõ we;s l%shdlrùfï ^Play& fuj,u la,sla lr 

		  má.; lsÍu Y%jKh lrkak' 

mshjr 6 -

l%shdlrùu

(Play)

keje;aùu 

(Stop)

má.; lsÍu 

(Record)

ks¾udKh lr.;a Y%jH ikaOdrhl wkjYH fldgia lmd bj;a lr ixialrKh lsÍu

mshjr 1 -	 ks¾udKh lsÍfuka miq j" .aup (Audacity Project) f.dkq wdlD;shg  

		  wkqj ;ekam;aa lr.kq ,enQ f.dkqj újD; lr .kak' 

mshjr 2 - 	 mßjyk fuj,ï ;Srefõ f;aÍfï fuj,u Ndú;fhka Y%jH  

		  ikaOdrfha wjYH fldgi f;dard .kak'

f;aÍfï fuj,u 

(Selection Tool)
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mshjr 3 -	 ixialrK fuj,ï ;Srefõ ^Edit Toolbar& Y%jH lmamdÿ lsÍfï  

		  fuj,u u; la,sla lrkak' túg wkjYH fldgia bj;a jkq oel .;  

		  yels h'

Y%jH lmamdÿ 

lsÍfï fuj,u  

(Trim Audio)

mshjr 4 -	 ixialrKh wjidkfha § Y%jH f.dkqj ;ekam;a lrkak'

4'4   oDYH ikaOdr ks¾udKh

	 rEmrduq fm<la tl;= lrñka ks¾udKh lrk ùäfhda o¾Ykhla oDYH 

ikaOdrhla kï fõ' fï i|yd má.; lrkq ,enQ ùäfhda o¾Yk fyda iaÓ;sl .%dmsl 

iy Y%jH ikaOdr fhdod .kq ,nhs'

 	 oDYH ikaOdr mß.Kl wdY%fhka ilia lsÍug;a tajd WÑ; wdldrhg 

ixialrKh lr .ekSug;a mß.Kl uDÿldx. fhdod .efka' fï i|yd fhdod .; 

yels fndfyda uDÿldx. we;' thska iuyrla kï"

²² PhotoBucket
²² YouTube Remixer
²² Movie Masher
²² One True Me
²² dia
²² Motion Box
²² Stash Space
²² Windows Movie Maker
²² AVI Edit
²² Super DVD Video Editor

oDYH ikaOdr ks¾udKh i|yd oDYH ixialrK uDÿldx.hla fhdod .ekSu

úkafvdaia uQú fïl¾ ^Windows Movie Maker&
	 úkafvdaia uQú fïl¾ uhsfl%dfid*aÜ wdh;kh úiska ,nd fokq ,nk ksoyia 

oDYH ixialrK uDÿldx.hls' fuu.ska oDYH ikaOdr ks¾udKh lsÍug;a tajd 

ixialrKh lsÍug;a yels fõ'

	 úkafvdaia uQú fïl¾ uDÿldx.h my; olajd we;s URL ,smskh Tiafia Tnf.a 

mß.Klhg nd.; lr ia:dmkh lr .kak'

http://www.windows-movie-maker.org/
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úkafvdaia uQú fïl¾ Ñ;%l mßYS,l w;=reuqyqK;

1 2 3

1' mQ¾j o¾Yk$l%shd lrùfï ljq¿j

2' ld, ;Sr fõÈldj

3' ixialrKh lsÍfï ljq¿j

1' mQ¾j o¾Yk$l%shd lrùfï ljq¿j ^Preview/ Player pane& 
	 oDYH ikaOdrhla ks¾udKh lsÍu i|yd fhdod .kq ,nk ùäfhda o¾Yk iy 

rEm rduq o¾Ykh lr .ekSug;a" ks¾udKh lrk ,o oDYH ikaOdrh ;ekam;a lsÍug 

m%:ufhka keröu i|yd;a mQ¾j o¾Yk$l%shdlrùfï ljq¿j ^Preview/Player pane& 
iy tys fuj,ï Wmldr fõ'

2' ld, ;Sr fõÈldj ^Timeline stage&

	 ks¾udKh i|yd fhdod .kq ,nk ùäfhda o¾Yk" rEm rduq iy Y%jH ikaOdr 

fm<.iajkq ,nkafka fuu wx.Khg h' ld, ;Srhla u; § fuka fkdj fhdod .kq 

,nk ùäfhda o¾Yk iy rEmrduq meyeÈ,s j o¾Ykh ùu fuys isÿ fõ'

3' ixialrKh lsÍfï ljq¿j ^Editing function panel&
	 ks¾udKh lrk oDYH ikaOdrh ixialrKh i|yd ixialrKh lsÍfï 

ljq¿fjys we;s fuj,ï fndfyda fia jeo.;a fõ' fuu ljq¿fjys we;s fuj,ï 

Wmfhda.s lr .ksñka oDYH ikaOdrh yeisrùu" oDYH rxf.daml%u ^visual effects& 
fh§u iy Y%jH ikaOdr yeisrùu hkdÈh l< yels h'
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úkafvdaia uQú fïl¾ Ndú;fhka oDYH ikaOdr ks¾udKh

mshjr 1 - 	 úkafvdaia uQú fïl¾ uDÿldx.h újD; lr .kak' 

mshjr 2 - 	 'Home' → 'Add Videos & Photos' Ndú;fhka ks¾udKh i|yd fhdod  

		  .kakd rEm iy ùäfhda f;dard .ksñka újD; lr .kak' túg fufia  

		  Èia fõ'

ks¾udKh i|yd ixl%dka;ss ^Transitions& fhdod .ekSu

	 fhdod .kq ,nk rEmrduq folla w;r iïnkaO;djla we;s lsÍug iy rEm 

rduqjl ;srhg m%úIag jk wdldrh oelaùu i|yd ixl%dka;s fhdod .kq ,nhs' 

mshjr 1 -	  'Animations' fukqj újD; lr .kak' 

mshjr 2 -	 m<uq rEm rduqj u; la,sla lrkak'

	

mshjr 3 - 	 'Transitions' ldKavfha we;s tla tla ixl%dka;sh u;ska uQislh f.k 

		  hkak' túg f;dard .;a rEmh újD; jk úúO wdldr o¾Ykh jkq  

		  we;' iqÿiq ixl%dka;sh u; la,sla lrñka th f;dard .kak' 

4'	 fufia ld, ;Sr fõÈldj ^Timeline stage& u; we;s  wfkl=;a rEm i|yd o iqÿiq 

wdldrhg ixl%dka;s fhdod .kak' ixl%dka;s fhdod .;aa miq ld, ;Sr fõÈldj 

^Timeline stage& ;=< we;s rEm rduq Èiajkafka fufia h'



fkdñf,a fnod yeÍu msKsihs130

5'	 mQ¾j o¾Yk$ l%shdlrùfï ljq¿j ̂Preview/ Player pane& fhdod .ksñka ks¾udKh 

l%shdlrjkak' wjYH ixialrK lrkak'

6'  rEm rduqjla o¾Ykh úh hq;= ld,h ilia lsÍu 

i|yd 'Animations' → 'Duration' u.skaa fjkia 

ùï lrkak' 'Apply to all' f;dard .ekSu fuka 

tla rEm rduqjla i|yd lrkq ,nk ixialrK 

wfkl=;a rEm rduq i|yd o fhdod .ekSug yels 

h' 

7'	 rEm rduq p,kh lsÍu i|yd" 

	 i)  rEm rduqj f;dard .kak'

 	 ii) 'Pan and Zoom' ldKavfha we;s tla tla p,k wdldrh u;g uQislh 

	     f.k hkak' iqÿiq wdldrfha p,khla u; la,sla lrkak'

8'	 ks¾udKhg ud;Dldjla tl;= lsÍu i|yd

i)	 m<uq rEm rduqj f;darkak' 

ii)	 'Home → Title' f;darkak'

iii)	.e<fmk ud;Dldjla h;=re,shkh lrkak' 

iv)	 'Format' fukqj újD; lrñka ud;Dldjg wjYH yeviùï fuka u  

rxf.daml%u ^Effects& fhdokak' 

9'	 rEm rduq i|yd fjka fjka jYfhka ye¢kaùï we;=<;a l< yels h' ta i|yd"

i)	 rEm rduqj f;darkak' 

ii)	 'Home → Caption' f;dard wjYH ye¢kaùu h;=re,shkh lrkak' 

iii)	óg fmr oelajQ wdldrhg yeviùï lrkak' 

10'	ilia lrk oDYH ikaOdrh wdrïNhg fyda wjidkhg fyda tys wOHlaIKh" 

rx.k Ys,amSka" ix.S;h" ia:dk ms<sn| j y÷kajd §u i|yd fjka fjka jYfhka 

rEm rduq we;=<;a l< yels h' ta i|yd"

i)	 'Home → Credits' ;=<ska wjYH y÷kajd §u f;dard .kak' 

ii)	 wjYH f;dr;=re h;=re,shkh lrkak'
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ia;=;sh

wOHlaIKh

rx.k odhl;ajh

fhdod .;a ia:dk

ix.S;h

11'	 ks¾udKh i|yd Y%jH ikaOdr f.dkqjla tl;= lsÍu u.ska ks¾udKh lrk oDYH 

ikaOdrh jvd;a yrj;a lr .; yels h' fï i|yd" 

i)   m<uq rEm rduqj f;darkak' 

ii) 'Home' → 'Add music' f;dard .kak' 

12'	óg fmr ilia lr ;ekam;a lrk ,o Y%jH f.dkqjla f;dard újD; lr .kak' 

wjidkfha § ld, ;Sr fõÈldj fufia Èiafõ'

13'	ks¾udKh lr .;a oDYH ikaOdrh l%shdlrjkak' wjYH wdldrhg ixialrKh 

lrkak' 

oDYH ikaOdrh ;ekam;aa lsÍu

'File' → 'Save Project'

	 f.dkqj ;ekam;a lrk ia:dkh f;dard f.dkqjg iqÿiq kula ,nd § Save 
la,sla lr ;ekam;aa lrkak'
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úkafvdaia uQú fïl¾ uDÿldx.h wdY%s; j ks¾udKh lr ;ekam;a lrkq ,nk 

f.dkqjla 'wlmp ̂ Movie Maker Projects& f.dkq wdlD;shg wkqj ;ekam;a lr .kq 

,nhs' fuu wdlD;shg wkqj ;ekam;a lrkq ,nk f.dkq ixialrKh i|yd fuh 

fhdod .; yels h'

tfia u fuu oDYH ikaOdrh fjí wvú ks¾udKfha § fhdod .; yels f,i 

;ekam;a lsÍu fuka u iudc cd,j, ^Facebook, YouTube, Flicker& újD; l< 

yels wdldrfha f.dkqjla f,i ;ekam;a lr .; yels h'

oDYH ikaOdrh ùäfhda mghla f,i ;ekam;a lsÍu iy fnod yeÍu 

	 oDYH ikaOdrh mß.Klhl" rEmjdyskshl" cx.u ÿrl:khl keröug 

fyda iudc cd,hl újD; lsÍu i|yd ùäfhda mghla f,i ;ekam;a lsÍfï mshjr 

my; ±lafõ'

mshjr 1 - 	 'File' → 'Save Movie'/ or  'Publish  movie' ;=<ska újD; fukqfjka  

		  wjYH ;ekam;a lsÍfï udOHh f;dard .kak'

mshjr 2 -	 f.dkqj ;ekam;a lrk ia:dkh f;dard f.dkqjg iqÿiq kula ,nd §  

		  'Save' la,sla lrkak'

B-fï,a i|yd

mß.Kl i|yd

úfYaI ;sr i|yd

cx.u ÿrl:k 

i|yd

 

iudc cd, i|yd

Y%jH ikaOdrhla 

f,i

;ekam;a lsÍfï úúO udOHhka iy fnod yeÍu
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l%shdldrlu

1'	 nyqudOH mdvï ud,dfjka bf.k .;a wdldrhg Y%S ,xldfõ iqkaor 

ia:dk iys; PdhdrEmj,ska iukaú; iaÓ;sl .%dmsl lsysmhla 

ks¾udKh lrkak'

2'	 tu iaÓ;sl .%dmsl miqìug fhdod .ksñka p,kh jkakd jQ mdG 

iys; oaúudk iÔùlrK lsysmhla ks¾udKh lrkak'

3'	 ilia lrk ,o .%dmsl iy iÔùlrKj,g WÑ; jk wdldrfha Y%jH 

ikaOdrhla ks¾udKh lrkak'

4'	 tf,i ilia lr.;a .%dmsl" iÔùlrK iy Y%jH ikaOdr fhdod 

.ksñka Y%S ,xldfõ iqkaor ia:dk ms<sn| j oDYH ikaOdrhla 

ks¾udKh lrkak'

5' ydks jk ^Lossy& ydks fkdjk ^Lossless& .%dmsl ixfldapkh 

ixikaokh lrkak'

6'	 rdiag¾ .%dmslh ^Raster graphic& iy fjlag¾ ^Vector graphic& 
ixikaokh lrkak'

²² mß.Kl .%dmsl uDÿldx. Ndú;fhka ks¾udKh lrk ,nk hï lsis 

f;dr;=rla ,nd fok Ñ;% fyda rEm" wxls; .%dmsl (Digital graphic) f,iska 

ye¢kafõ'

²² wxls; .%dmslhl uQ,sldx. lsysmhla we;' tajd kï"

	 mslai,a ^Pixel&" úfNaokh ^Resolution&" m%udKh ^Size& iy j¾Kh ^Colour& 
fõ'

²² mslai,hla hkq wxls; .%dmslhl uQ,sl ;ekqï tAllhhs' wxls; .%dmslhla 

^Digital graphic& mslai,a oyia .Kklska ks¾udKh ù we;'

²² mslai,hla ìgqj,ska ^Bits& iukaú; h' tal j¾K mslai,hla ìgq 8 la o 

j¾Kj;a mslai,hla ìgq 24 la o fõ'

²² wxls; .%dmslhl fN!;sl mßudj ^Physical dimension& uekSfï tallh 

mslai,a jk w;r fN!;sl mßudj .%dmsl úfNaokh ^Image resolution& 
f,iska ye¢kafõ'

²² mslai, m%udKh jeä Wiia úfNaokhlska ^High resolution& hq;= wxls; 

Ñ;%lhla by< .=Kd;aul njlska hq;= h'

idrdxYh
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²² j¾K wdfoaYl foj¾.hls' tkï"

¾¾ RGB wdfoaYlh ^RGB Model& - r;=" fld< iy ks,a ^Red, Green and 
Blue&

¾¾ CMYK wdfoaYlh ^CMYK Model& - <d ks,a" oï" ly iy l¿ ^Cyan, 
Magenta,  Yellow, Black&

²² ;ks j¾K } uQ,sl j¾K ^Primary colours&
²² j¾K folla } oaú;Shsl j¾K ^Secondary colours&
²² j¾K ;=kla } ;D;Shsl j¾K ^Triplet colours&
²² uQ,sl j¾Khl m%fNao 256 ^0-255& we;'

²² ;D;Shsl j¾Khla zRGB TripletZ iE§u 000, 000, 000, 255, 255, 255 olajdh' 

²² zRGB TripletZ = RGB ^245, 102, 36& fyda RGB ^F5" 66" 24& IâoYu ixLHd 

f,i ±laúh yels h'

²² .%dmsl ixfldapk ^Graphic compression& l%u folls'

1' ydks jk ^Lossy& ixfldapkh

2' ydks fkdjk ^Lossless& ixfldapkh

²² .%dmsl m%rEm ^graphic types& folls'

1' rdiag¾ .%dmsl ^raster graphic&
2' fjlag¾ .%dmsl ^vector graphic&
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fuu mdvu yeoEÍfuka Tng"

²² fjí wvúhl wjYH;dj iy wka;¾.;h

²² fjí wvúhla ie,iqï lsÍu

²² fjí wvúhla ks¾udKh lsÍfï l%u

²² fjí wvúhla m%ldYhg m;a lsÍu

²² fjí wvúhla kv;a;= lsÍu

	 hk lreKq ms<sn| ukd wjfndaOhla ,nd .ekSug yels jkq we;'

5'1 fjí wvú ks¾udKh i|yd f;dr;=re jHqy.; lsÍu
	
	 fjí wvúhla ks¾udKfha § wjOdkh fhduq l< hq;= wxY fndfyduhla we;'  

oeka" Tn we;=¿ YsIH lKavdhug fjí wvúhla ks¾udKh lsÍug mejÍ we;ehs 

is;kak' Tn úiska fjí wvúh idokq ,nkafka" l=ula i|yd o" ld i|yd o" flfia 

o" kv;a;= lrkafka flfia o hk lreKq ms<sn| j mq¿,a j iy .eUqßka úuid ne,sh 

hq;= h'

5'1'1 fjí wvúhl Ndú;h (Application of web site)

fjí wvúhla ks¾udKh lsÍfï wjYH;d my; mßÈ y÷kd .; yels h'

i)  f;dr;=re ikaksfõokh (Information Communication)
	 wka;¾cd, mßYS,l fj; wOHdmksl" fi!LH wdÈ jYfhka úúO f;dr;=re 

ikaksfõokh fjkqfjka ilia l< fjí wvú we;'

ksoiqk - www.nie.lk, www.surgery.lk, www.webopedia.org

ii)  fjf<|du (e Commerce)
	 wka;¾cd,fhka NdKav yd fiajd wf,ú lrk fjí wvú fuhg wh;a fõ'

ksoiqk - www.farlin.lk, www.lego.lk, www.amazon.com

5
nyq udOH ;dla‍IKh fhdod .ksñka 

ir, fjí wvú ks¾udKh 
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iii)  úfkdaodiajdoh (Entertainment)
	 .S;" Ñ;%mg" fg,skdgH wdÈh wdiajdokh lsÍu fyda nd.; lr.ekSu" úfkdao 

l%Svdj, fh§u" .=jka úÿ,shg ijka§u fyda rEmjdysksh keröu wdÈ jYfhka 

úfkdaodiajdoh ,nd .; yels fjí wvú we;' 

ksoiqk - www.islandcricket.lk, www.netflix.com, www.youtube.com

iv)  m%pdrKh (Advertising)
	 úúO wdh;k ksIamdokh lrk NdKav yd fiajd ms<ssn| úia;r wka wh fj; 

m%o¾Ykh lsÍu i|yd lghq;= lrk fjí wvú ;sfí' 

ksoiqk - www.onclickads.net, www.adcash.com, www.myadvertisingpays.com

v)  m%jD;a;s fnodyeÍu (News)
	 fuu fjí wvú b;d blaukska nyqudOH wdldrhg m%jD;a;s ,nd fok neúka 

ck;dj w;r fndfyda m%p,s; h'

ksoiqk - www.itnnews.lk, www.rupavahini.lk, www.bbc.co.uk

vi)  iudc iïnkaO;d f.dvke.Su (Building up social media)
	 wOHdmk uÜgu" /lshdj" reÑl;ajh fyda fjk;a fya;= u; úúO iudc 

lKavdhï w;r iïnkaO;d f.dvke.Su iy tajd mj;ajdf.k hdug myiqlï 

ie,eiaùu fuu fjí wvú u.ska isÿ flf¾'

ksoiqk - www.facebook.com, www.linkedin.com, www.twitter.com,  
 	   www.pinterest.com

vii)  fijqï wjYH;d (Search engine)
	 jpkhla fyda jdlH LKavhla h;=rla f,i Ndú; lr" f,dal jHdma; cd,h 

;=<ska wmg wjYH f;dr;=re fidhd .ekSug myiqlï imhk fjí wvú we;' fïjd 

fijqï hka;% ^Search Engine& f,i ye¢kafõ'

ksoiqk - www.google.com, www.msn.com, www.bing.com

viii) fm!oa.,sl wjYH;d (Personal)
	 fndfyda úg f,aLlhka" foaYmd,lhka jeks m%isoaO mqoa.,hka fyda mqoa., 

lKavdhï Tjqkaf.a f;dr;=re wka wh fj; ikaksfõokh lsÍug Ndú; lrk fjí 

wvú fuhg wh;a h'

ksoiqk - www.president.gov.lk, www.arthurcclarke.net, www.nelsonmandela.org

5'1'2 .%dyl lKavdhï úYaf,aIKh

	 fjí wvúhlg m%fõY ù th mßYS,kh lrk mqoa.,fhda tu fjí wvúfha 

.%dylhka ^Users& f,i ye¢kafj;s'
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	 WodyrK f,i f,dalh mqrd úisÍ isák www.google.com fjí wvúh Ndú; 

lrk mqoa.,fhda .+.,a fjí wvúfha .%dylfhda fj;s' 	

fjí wvúhla ks¾udKfha § .%dyl úúO;ajh my; whqßka y÷kd .; yel'

1'  NdIdj yd ixialD;sh 

2'  jhia uÜgu

3'  wOHdmksl uÜgu

4'  ia;%S mqreI nj

5'  reÑl;ajh

	 .%dyl lKavdhï úYaf,aIKh hkq b,lal.; .%dyl lKavdhu ms<sn| j 

fyd¢ka úuid n,d Tjqka i;= iqúfYaI ,laIK iy fjkialï y÷kd .ekSuhs' 

fï i|yd úúO l%u wkq.ukh l< yels h' ksoiqka f,i"

1'  b,lal.; .%dylhka ms<sn| j wOHhkhl fh§u

2'  fujeks u jQ fjk;a fjí wvú ms<sn| j úuid ne,Su

	 WÞyrKhla f,i" rEmh 5'1ys jQ Y%S ,xldfõ ks, fjí wvúfha iy rEmh 

5'2ys jQ úÿ,s ixfoaY kshduk fldñiug wh;a fjí wvúfha uq,a msgqj, Y%S ,xldfõ 

Ndú; lrk NdId ;=fkka u lshùug myiqlï imhd we;'

 	 rEmh 5'2ys jQ fjí wvúh" ;u ;ukaf.a oDIaá mrdihg .e<fmk f,i 

wl=rej, m%udKh fjkia lsÍfï myiqlï iy iudc fjí wvú lrd msúiSfï 

myiqlï o imhd we;'

isxy, NdIdfjka 

msúiSug 

bx.%Sis NdIdfjka 

msúiSug 

fou< NdIdfjka 

msúiSug 

rEmh 5'1 - www.srilanka.lk fjí wvúfha uq,a msgqj o¾Ykh jk wdldrh
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wl=rej, 

m%udKh fjkia 

lsÍug

fijqï 

fldgqj

ùäfhda
rEm

mdG

ysñlu iy 

hdj;ald,Sk j¾Ih
fjí msgq w;r 

ixp,k ;Srej

NdIdj fjkia 

lsÍug

ckm%sh iudc 

fjí wvú i|yd 

wêikaOdk

rEmh 5'2 - www.trc.gov.lk fjí wvúfha uq,a msgqj 

 5'1'3 fjí wvúhl wka;¾.;h (Web content)

	 fjí wvúhla ;=< we;s Y%jH oDYH f;dr;=re iy fiajd ish,a, tys wka;¾.;h 

f,i ye¢kafõ'

	 fjí wvúh ks¾udKhg ;=vq ÿka wjYH;dj$wjYH;d iy .%dyl lKavdhï 

úYaf,aIKfha § y÷kd .;a .%dyl wjYH;d ie,ls,a,g .ksñka kj fjí wvúfha 

wka;¾.;h f;dard .; hq;= fõ' ta ;=< .%dylhdg ikaksfõokh l< hq;= ish¨ 

f;dr;=re fuka u fjí wvúh mßYS,kh myiq lsÍu i|yd .%dylhd fj; iemhsh 

hq;= fiajd o wvx.= l< hq;= h'

	 úúO fjí wvú mßYS,kfha § tajdfha wka;¾.;h ;=< úúO j¾.fha 

f;dr;=re iy fiajd yuqjk w;r bka iuyrla my; olajd we;'

²² úúO mdG ^text& ( flá úia;r f,i olajd we;s f;dr;=re 

²² rEm ( leurdjlska ,nd.;a PdhdrEm" miqre is;a;ï ^Clip Arts&" iqmÍlaIlhla 

wdOdrfhka mß.Klhg we;=¿ lr.;a w;ska w¢k ,o rEm jeks oE

²² Yío ( .S;" y~ mg ^Voice clip& 
²² ùäfhda ( ùäfhda mg ^Video clip&
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²² iÔùlrK ^Animations& 
²² m%ldYk ysñlu ^Copyright& yd hdj;ald,Sk nj ms<sn| f;dr;=re 

²² fjk;a f,aLk" rEm" Y%jH oDYH f.dkq" iudc fjí wvú wdÈh i|yd jQ 

wêikaOdk 

²² oekaùï

²² fijqï myiqlï

²² fjí wvúh mßYS,khg wod< we;eï uDÿldx." wl=re j¾. nd.; lr .ekSfï 

myiqlï

	 fjí wvúhl wka;¾.;h y÷kd .ekSug ksoiqkla f,i rEmh 5'2ys olajd 

we;s úÿ,s ixfoaY kshduk fldñiug wh;a fjí wvúh ^www.trc.gov.lk& mÍlaId 

lr n,kak'

 5'1'4 ikaOdrh ixúOdkh ^Content Management&

	 fjí wvúhla i|yd f;dard.;a wka;¾.;h" l%uj;a ms<sfj<lg fm< .eiaùu 

ikaOdrh ixúOdkh hkafkka woyia fõ' fuys m%Odk wruqK jkafka .%dylhkag 

ld¾hlaIu f,i fjí wvúh mßYS,khg myiqlï ie,iSuhs' fyd¢ka ixúOdkh 

lrk ,o fjí wvúhl .=Kdx. iuyrla my; olajd we;'

²² mßYS,kh lsÍug myiqhs'

²² b;d blaukska .%dylhdg wjYH f;dr;=re fidhd .; yel'

²² .%dylhka wdl¾IKh lr.kS'

²² hdj;ald,Sk lsÍu myiqhs'

²² miqld,Sk j kj wx. tl;= lsÍfï bv m%ia;d iys;hs'

        fjí wvúfha wka;¾.;h f,i f;dard.;a f;dr;=rej, m%udKh l=vd kï 

ikaOdrh ixúOdkh myiq ld¾hhls' kuq;a úúO j¾.j, Y%jH oDYH f;dr;=re 

úYd, m%udKhla wvx.= fõ kï tjeks fjí wvúj, ikaOdrh ixúOdkh i|yd 

úúO l%u wkq.ukh lsÍug isÿ fõ' ksoiqka f,i bka iuyrla my; olajd we;'

1' rEmuh ieliqulg wkqj j¾.SlrKh

	 fjí wvúfha wka;¾.;h iqÿiq j¾.SlrKhlg wkqj j¾. lr rEmuh 

ieliqula ^Site Map& f.dv k.d .ekSfuka fjí wvúh fjkqfjka ilia l< hq;= 

fjí msgq iy tajd w;r we;s l< hq;= wka;¾-iïnkaO;d ms<sn| meyeÈ,s wjfndaOhla 

,nd.; yels fõ' ksoiqkla f,i my; rEmh 5'3ys oelafjk mdi,l fjí wvúhg 

wod< rEmuh ieliqfuys fldgq yeve;s jHqyh u.ska ilia l< hq;= fjí msgq 

ksrEmKh lrk w;r f¾Ld u.sska fjí msgq w;r wka;¾-iïnkaO;d we;s lsÍug 

fhÈh hq;= wêikaOdk fmkakqï lrhs'
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uq,a msgqj 

j¾;udk

 f;dr;=re 
b;sydih l%Svd wdÈ YsIH

md'i 

lñgqj
iïnkaO 

lr.ekSu

t,af,a

idys;H fn!oaO isxy,

l%slÜfjd,sfnda,a

ix.ï
l<ukdlrK 

jHqyh 

rEmh 5'3 - mdi,l fjí wvúhg wod< rEmuh ieliqu (Site Map)

2'	 uq,a msgqfjka (Home Page) fjí wvúfha iuia; wka;¾.;h fláfhka ksrEmKh 

lsÍu 

fuys § uq,a msgqfõ bv md,kh lr .ekSu i|yd"

²² fukq iy wkqfukq ^rEmh 5'4& Ndú; flf¾'

²² wê ikaOdk ^rEmh 5'5&²²

wkqfukq

m%Odk fukq

rEmh 5'4 - fukq iy wkq fukq

3'   f;dr;=re fláfhka bÈßm;a lsÍu

	 fjí msgqjl fndfyda f;dr;=re m%udKhla we;s úg tys jQ we;eï f;dr;=re 

fj; .%dyl wjOdkh fhduq fkd ùug bv we;' tneúka tla msgqjlg we;=<;a lrk 

f;dr;=re m%udKh iSud l< hq;= h'

4'	 wxls; ,ehsia;= (Numbered List)" wxls; fkdjk ,ehsia;= (Bulleted List) fyda 

wkqfþok (Indentation) Ndú;h

	 fjí msgqjla ;=< È.= fþo f,i we;s f;dr;=re lshùfuka .%dylhd fjfyig 

m;a ùu j<lS' 

5'	 myiqfjka fjí wvúfha ießieÍfï fyj;a ixp,kh (Navigate) ùfï myiqlu 

,efí' 	
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      rEmh 5'5 - www.laksala.gov.lk fjí 

wvúh ;=< wêikaOdk u.ska fjí 

msgq w;r we;s lrk ixp,k myiqlï

Home

  Gem & jewellery f,i kï l< msgqj 
Gem & jewellery 

wêikaOdkh click l< úg 

About 
Us 

click 
l< úg 

Home msgqj click l< úg 

Home msgqj click l< úg 

 uq,a msgqj 

  About us f,i kï l< msgqj 
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6'  hdj;ald,Sk nj

	 m%ldYk ysñlu yd hdj;ald,Sk ld, jljdkq ms<sn| f;dr;=re fyd¢ka 

fmfkk f,i iEu msgqjl u we;=<;a lr ;eîfuka .%dylhdg ;ud mßYS,kh 

lrk f;dr;=rej, ksrjoH nj ;yjqre fõ'

 5'1'5 fjí msgqj, jHqyh yd msßie,iqu ^Structure and layout&

	 	
	 ñka woyia jkqfha fjí msgq i|yd fhdok miq;," j.=" rduq" j¾K" wl=re 

j¾." wl=re m%udK" wl=re yev hkdÈhhs' fuys § ie,lsh hq;= lreKq rdYshla 

y÷kd.; yel' bka lsysmhla kï"

1'	 ieu msgqjl u fjí wvúfha wkkH;dj mj;ajd .ekSu

	 fuys § tl u fjí wvúhlg wh;a fjí msgq iuQyfha u jHqyh iy msßie,iqu 

taldldrj mj;ajd .ekSu woyia flf¾' 

2'	 jeo.;a lreKq Woa§mkh

	 fï i|yd tlS f;dr;=rg wod< j wl=re j¾.h" wl=re m%udKh" j¾Kh 

fjkia j oelaùu jeks l%u Ndú; l< yels h'

3'  ´kE u $ úúO j¾.fha mß.Klj,ska fjí wvúh mßYS,kh l< yels ùu 

remh 5'6 - úúO m%udK ;sr

    	 úúO j¾.fha fm!oa.,sl 

mß.Kl" cx.u ÿrl:k wdÈ 

úúO Wmdx. fjí wvú mßYS,kh 

i|yd Ndú; flf¾' fuys § fjkia 

m%udKj, ;sr fhdod .efkk w;r 

tAjdfha ;sr úfNaok fjkia neúka 

we;eï fjí msgq tla tla ;srj, 

§ fjkia wdldrhg o¾Ykh ùu 

je<elaùug ;srfha m%udKhg wkqj 

fjí msgqfõ m%udKh ilia jk 

wdldrhg fjí wvú ks¾udKh l< hq;= h'  

l%shdldrlu

Tfí .=rejrhd iu. tla j my; fjí ,smskj,ska olajd we;s fjí wvú 

msßlaid n,d tajdfha ks¾udKh ;=< mj;sk m%n,;d yd ÿn,;d ms<sn| 

j idlÉPd lrkak'

	 www.srilanka.lk		  www.schoolnet.lk
	 www.doenets.lk		  www.bbc.co.uk/education
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 5'1'6 udOH iïm;a f;dard .ekSu

	 fjí wvúhlg we;=<;a lsÍu i|yd úúO mdG" rEm" Yío" ùäfhda" iÔùlrK 

wd§ ́ kE u j¾.hl udOHhl iïm;a f;dard.ekSfï § my; lreKq ms<sn| ie,ls,su;a 

úh hq;= h' 

1'  Odß;dj 

	 fjí msgqjlg we;=<;a lrk udOH iïm;aj, Odß;dj iy tu fjí msgqj 

újD; ùug .;jk ld,h w;r oeä iïnkaOhla we;' tajdfha Odß;dj jeä kï 

fjí fiajdodhlfha isg .%dyl mß.Klh fj; jeä o;a; m%udKhla nd.; úh hq;= 

ksid fjí msgqj újD; ùug idfmalaI j jeä ld,hla .; fõ' fjí msgqj mßYS,khg 

fndfyda fõ,djla /£ isàug isÿùfuka .%dylhka th yer hdug bv we;' tneúka 

udOH j¾.h wkqj fï i|yd úúO l%u wkq.ukh lsÍug isÿ fõ' ksoiqka f,i"

²² .%dmslhla i|yd" 

◦◦ .%dmsl uDÿldx.j, crop/trim Ndú;fhka wkjYH fldgia bj;a lr mslai, 

m%udKh wvq lsÍu

◦◦	 .%dmsl ixfldapk ^graphic compression& 
²² ùäfhda f.dkqjla i|yd" 

◦◦ rduqjl m%udKh ^frame size& wvq lsÍu

◦◦ ;sr úfNaokh ^resolution& wvq lsÍu

◦◦ rduq fõ.h wvq lsÍu ^frame rate&
◦◦ wkjYH rduq iy wkjYH Yío bj;a lsÍu

²² Y%jH f.dkqjl"

◦◦ ìgq fõ.h ^bit rate& wvq lsÍu

◦◦ idïm, fõ.h ^sample rate& wvq lsÍu

◦◦ kd,sld ^channel& ixLHdj wvq lsÍu

◦◦ wkjYH Yío bj;a lsÍu

2'  ysñlï kS;shg wkql+, j udOH iïm;a we;=<;a lsÍu

	 fjk;a whl= úiska ks¾udKh lrk ,o udOH iïm;a fhdod .kafka kï 

ksis wjir ,nd .; hq;= h' tfia fkdjqK fyd;a th iodpdr úfrdaë l%shdjla jk 

w;r kS;suh .eg¨j,g uqyqK mEug o isÿ úh yel'

	 tfy;a idOdrK Ndú; m%;sm;a;shg wkqj m%jD;a;s jd¾;dlrKh" úoaj;a 

l%shd" újrK wdÈh i|yd fujeks udOH iïm;a wjirhlska f;dr j Ndú; lsÍfï 

yelshdj we;' 
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l%shdldrlu

Tfí mdif,a fjí wvúhla ks¾udKh i|yd by; 5'1'1 isg 5'1'6 olajd 

jQ wkqud;Dld yhg wod< j úia;r lrk ie,iqula f.dvk.kak'

 5'1'7 uQ,sl HTML Ndú; lsÍu  

	 HTML kue;s flá fhÿfuka y÷kajk Hyper Text Markup Language hkq 

f,dal jHdma; cd,h i|yd f,aLk ieliSug Ndú; flfrk uQ,sl NdIdjhs' fjí 

w;ßlaiqjla wdOdrfhka ixo¾Ykh l< yels wdldrfha HTML f,aLkhla" fjí 

msgqjla f,i ye¢kaúh yel' Tn fuhg fmr W.;a Pascal jeks mß.Klh i|yd 

jev igyka ,shk NdId fuka fkdj HTML NdIdfõ fla; u.sska fjí msgqjg fhdod 

we;s wka;¾.;h" mß.Kl ;srh u; ixo¾Ykh l< hq;= wdldrh ms<sn| j fjí 

w;ßlaiqjg fmkajd fohs' fï ksid u HTML hkq mß.Kl NdIdjla fkdj úia;r 

lsÍfï NdIdjla ^Markup/Descriptive Language& f,i y÷kajkq ,nhs'

	 oeka HTML NdIdj Ndú; lr ir, fjí msgq lSmhla ks¾udKh i|yd my; 

l%shdldrlfuys fhfouq'

l%shdldrlï wxl 01

rEmh 5'7 - Notepad msgqjla újD; lsÍu

mshjr 1 -  wxl 5'7 rEmfha olajd we;s mßÈ"

	      Start→ All Programme →  
	      Accessories → Notepad

	    hk ud¾.h Tiafia Notepad msgqjla  

	     újD; lrkak' Notepad hkq úkafvdaia  

	    fufyhqï moaO;sh;a iu. ,efnk  

	     ir, joka ilik jev igykls'

mshjr 2 -   Notepad msgqj u; rEmh 5'8ys  

	      oelafjk mßÈ j.ka;s ,shkak'
					             		  		
	

	         						              

rEmh 5'8 - Notepad msgqjl ,shk ,o HTML j.ka;s lsysmhla
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mshjr 3 -	 rEmh 5'9 mßÈ tu Notepad msgqfõ f.dkq kduh myfirst.html  f,i;a 

		  f.dkq j¾.h All Files f,i;a olajd iqÿiq f*da,avrhl ;ekam;a  

		  lrkak'

rEmh 5'9 - Notepad msgqj ;ekam;a lsÍfï § Èiajk ixjdo fldgqj

mshjr 4 -	 myfirst.html f.dkqj újD; lr n,kak' rEmh 5'10 mßÈ Tfí m<uq  

		  fjí msgqj ixo¾Ykh jkq we;'

rEmh 5'10 - újD; lrk ,o HTML f.dkqj

mshjr 5 -	 by; 2 jk mshjf¾ § Notepad msgqj u; ,shk ,o "This is the title'' 
		  iy "My first web page" hk j.ka;s fjkqjg fjk;a j.ka;s wdfoaY  

		  lrñka ;j;a fjí msgq ks¾udKh lr mÍlaId lr n,kak'

mshjr 6 -	 by; mßÈ j.ka;s ,sùug" Notepad jeks joka ilik jev igyka  

		  fjkqjg HTML ixialdrl ^HTML editors& f,i y÷kajk uDÿldx.  

		  Ndú; l< yel' WodyrK f,i tjeks uDÿldx. lsysmhla tajd nd.;  

		  lr .; yels fjí ,smsk iu. my; olajd we;'

  1. CoffeeCup (www.coffeecup.com/html-editor)
  2. Seamonkey Composer (www.seamonkey-project.org)
  3. Eclipse (https://marketplace.eclipse.org/content/html-editor-wtp)

		  bka tla uDÿldx.hla Tfí mß.Klhg ia:dmkh lr .kak' 

 

mshjr 7 -	 Tfí mß.Klfha jQ fjí ks¾udK fuj,u újD; lrkak'  

		  File → New HTML document f,i úOdkh ,nd ÿka miq CoffeeCup 
		  kï jQ HTML ixialdrlh újD; jk whqre wxl 5'11 rEmfhka  

		  olajd we;'
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rEmh 5'11 - CoffeeCup,  HTML ixialdrlh újD; ùfï § Èiajk whqre

	 by; 2 jk mshjf¾ § Tn úiska Notepad msgqj u; ,shk ,o jokaj,ska 

iEfyk m%udKhla fuys bfí u ,sheù ;sfnkq oelsh yel' th Tfí ld¾hh myiq 

lrhs'

	 oeka Tfí fjí msgqjg we;=<;a l< hq;= foa muKla iqÿiq ia:dk n,d we;=<;a 

l< yelshs' uq,a fjí msgqfõ § Tn we;=<;a l< "This is the title" iy "My first web 
page" hk j.ka;s we;=<;a lr we;s wdldrh 5'12 jk rEmfha olajd we;'

	 File → Save As úOdkh Tiafia coffeecup1.html f,i Tfí f*da,avrfha 

;ekam;a lrkak'

Preview tool

“This is the Title”

“My first web page”

rEmh 5'12 - CoffeeCup, HTML ixialdrlfha § j.ka;s we;=<;a lrk whqre
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mshjr 8 -	 oeka by; preview tool Ndú; lr fjí msgqfõ iajrEmh n,kak'  

		  fjk;a j.ka;s wdfoaY lrñka ;j;a fjí msgq ks¾udKh lr mÍlaId  

		  lr n,kak'

 

ksÍlaIKh 

	Notepad iy fjk;a fuj,ï Ndú; lrñka Tn úiska fuf;la 

,shk ,oafoa HTML NdIdfõ j.ka;s fyj;a HTML fla; we;=<;a 

HTML f,aLk fõ'

	 Tn úiska  <html>, <head>, <title> wdÈ f,i flda‚l jryka ;=< ,shk 

,oafoa tu NdIdfõ uQ,sl wx.hla jk HTML Wiq,k (HTML tags) j¾. fõ' fuu 

Wiq,k u.ska fjí msgqjl wka;¾.;h" mßYS,lhdg ixo¾Ykh l< hq;= wdldrh 

fjí w;ßlaiqjg fmkajd foa' tkï Tn f;dard.;a jHqyh yd msßie,iqu fjí 

msgqjg we;=<;a lrkafka HTML Wiq,k u.sks'

 5'1'8 HTML f,aLkhl uQ,sl jHqyh

	 my; 5'13 jk rEmfha olajd we;s HTML f,aLkhl uQ,sl jHqyh ;=< 

w;HjYH Wiq,k lsysmhla fmkajd we;' fndfyda úg Wiq,khl wdrïNl wjia:djla 

^opening tag& iy wjidk wjia:djla ^closing tag& we;' tfy;a wdrïNl wjia:djla 

muKla we;s Wiq,k lsysmhla o Tng bÈßfha § yuqjkq we;' 

<html>
	 <head>

	 </head>

	 <body>

	 </body>

</html>

wdrïNl html 
Wiq,kh  

wdrïNl head 
Wiq,kh  

wjika lsÍfï head 
Wiq,kh  

wdrïNl body 
Wiq,kh  

wjika lsÍfï body 
Wiq,kh  

wjika lsÍfï html 
Wiq,kh  

}
}

head fldgi

body fldgi

rEmh 5'13 - HTML f,aLkhl uQ,sl jHqyh
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	 HTML f,aLkhla head iy body f,i m%Odk fldgia follska iukaú; 

fõ' f,aLkfha wdrïNh" wdrïNl <html> Wiq,kh u.ska o f,aLkfha wjidkh" 

wjika lsÍfï  </html> Wiq,kh u.ska o olajk nj rEmfhka meyeÈ,s fõ'

	 fjí msgqj ;=<g we;=<;a úh hq;= iEu fohla u body fldgi ;=< igyka 

l< hq;= fõ' Tfí m<uq fjí msgqfõ "My first web page" hkak igyka l< wdldrh 

kej; n,kak'

	 Head fldgi ;=< igyka fhdok úfYaI wjia:d we;' WodyrK f,i Tfí 

m<uq fjí msgqfõ <title> Wiq,k hq.,h ;=< "This is the title" hkak igyka l< 

wdldrh kej; n,kak' th Tfí fjí msgqfõ by<ska u msysá Title pane ;=< Èia fõ'

 5'1'9 HTML ys ,laIK

i)	 HTML Wiq,k u.ska fjí msgqj ixo¾Ykh l< hq;= wdldrh fjí w;ßlaiqjg 

fmkajd fohs' HTML f,aLkhl jQ fujeks úOdk HTML fla; f,i ye¢kafõ' 

ii)	 HTML Wiq,khl uq,g yd w.g flda‚l jryka ;sìh hq;=hs'

	 Wod ( fþohl wdrïNh i,l=Kq lsÍug <p>

iii)	idudkHfhka HTML Wiq,k hq., jYfhka olajkq ,nhss' wjidk lsÍfï 

Wiq,kh i|yd —$˜ ^back slash& iu. Wiq,kfha ku oelaúh hq;=hs'

	 Wod ( fþohl wdrïNh i,l=Kq lsÍug <p> yd tys wjidkh i,l=Kq lsÍug  

	       </p>

iv)	idudkHfhka fuu Wiq,k case sensitive fkd fõ' tkï bx.%Sis NdIdfõ jQ 

capital wl=re fyda simple wl=re fhdod .ekSfuka tys w¾:hg lsisÿ fjkila isÿ 

fkd fõ'

	 Wod ( <TITLE>, <Title> fyda <title> f,i fh§fuka fjkila fkd fõ'

v)	 Wiq,kh jerÈ wdldrhg olajd we;skï ta i|yd fodaI m%ldY ^error messages& 
ksl=;a lsÍula isÿ fkdjk w;r fjí w;ßlaiqj úiska wod< úOdkh fkdi,ld 

yeÍu muKla isÿfõ'  

vi)	HTML Wiq,khl uQ,sldx.h ^element&" .=Kdx.h ^attribute& yd w.h ^value&  
f,i fldgia ;=kla  we;'

	 Wod( —uu mdi,a isiqfjlañ˜ hk idudkH mdGh ^plain text&" iskoola  
	      pota wl=re j¾.fhka yd ks,amdáka o¾Ykh ùug wjYH HTML  
	       fla;h fufia h'
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<font face = zziskoolapotaZZ  color = zzblueZZ >  uu mdi,a isiqfjlañ</font>

w.hhka (values)

uQ,sldx. (Element) .=Kdx. (Atributes)

	 HTML i,l=Klg wod< .=Kdx. wdrïNl Wiq,kh ;=< muKla olajk 

w;r Bg wod< w.hhka iEu úg u we;=<;a ùfï fldud ;=< oelafõ'

 5'1'10 fjí msgqjla ks¾udKh 

	 my; 5'14 jk rEmh mßÈ —Y%S ,xldj˜ ms<sn| flá ye¢kaùula lrk fjí 

msgqjla ilia lruq' 

ud;Dld 

mdGh

rEmhla

fþohla

wêikaOdkhla

j.=jla

fma<s lsysmhla

rEmh 5'14 - —Y%S ,xldj˜ ms<sn| flá ye¢kaùula lrk fjí msgqj
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ud;Dld mdGh ilia lsÍu 

	 Tn leu;s ´kE u HTML ixialdrlhla Ndú;fhka kj fjí msgqjla újD; 

lr 5'15 jk rEmfha olajd we;s mßÈ HTML fla; we;=<;a lrkak' tu fjí msgqj 

Tfí mß.Klfha iqÿiq ia:dkhl Tng leu;s kulska ;ekam;a lrkak' Tfí fjí 

w;ßlaiqj yryd fjí msgqj ixo¾Ykh lr 5'15 jk rEmfha olajd we;s m%;sodkh 

iu. fuka u 5'14 jk rEmfha ud;Dld mdGh iu. ixikaokh lr n,kak'

<html>
	     <head>
		    <title> Sri Lanka </title>
	     </head>
	     <body>
       		    <h2><center><font face="Arial" color="blue"> 
				    SRI LANKA 							     
				    </font></center></h2>
                </body>
</html>

m%

;s 

od

k

h

SRI LANKA

Header 
Wiq,kh

Center 
Wiq,kh

Font
Wiq,kh

rEmh 5'15 - ud;Dld mdGh ieliSug wod< HTML fla;h iy wod< 

m%;sodkh

fuys § Tn Ndú; l< kj HTML Wiq,k ms<sn| j jeä ÿr úuid n,uq'

Header Wiq,kh

	 fjí msgqjl ud;Dld" Wmud;Dld iy fjk;a iuyr mdG tu f,aLkfha jQ 

wfkl=;a mdGj,ska fjka j Woa§mkh lr oelaùu i|yd wl=rej, m%udKh úYd, 

lsÍu" wl=rej, >klu jeä lsÍu wdÈ Wml%u header Wiq,k Ndú; lrhs' <h1> isg 

<h6> olajd wxl ms<sfj<sska jQ header j¾.fha Wiq,k we;' fïjdfhka <h1> u.ska 

m%udKfhka yd >klfuka jvd;a u úYd, f,i wl=re yev .kajhs' <h1> isg <h6> 
olajd hdfï § wl=rej, m%udKh yd >klu l%udkql+, j wvq fõ'

	 Tfí fjí msgqfõ <h2> Wiq,kh fjkqjg wfkl=;a header Wiq,k wdfoaY 

lr fjí msgqj ixo¾Ykh jk whqre mÍlaId lr n,d Tng iqÿiq hhs yefÕk 

m%udKfhka ud;Dldj ilia lr .kak'
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Font Wiq,kh

	 Tn oekgu;a yodrd we;s mßÈ HTML Wiq,khl" uQ,sldx.h ^element&" 
.=Kdx.h ^attribute& yd w.h ^value&  f,i fldgia ;=kla we;' Font Wiq,kfha 

§ size" face yd color f,i m%Odk .=Kdx. ;=kla we;' Font size .=Kdx. u.ska 

wl=rej, m%udKh olajhs' ta i|yd 1 isg 7 olajd mrdifha jQ w.hhka mejßh yelshs' 

fmr ksñ m%udKh (Default size) 3 fõ' tkï Tn úiska font size i|yd w.hhla 

fkdoelajQ úg fjí w;ßlaiqj úiska iajhxl%Sh j fmkajk m%udKhhs'

	 Font face .=Kdx.h u.ska wl=rej, j¾.h olajhs' ta i|yd w.h jYfhka 

Tfí mß.Klfha jQ ´kE u wl=re j¾.hla ^Wod( ''Arial", ''verdana"& fhÈh yelshs'

	 Font color .=Kdx.h u.ska wl=rej, j¾Kh olajhs' fï i|yd w.hhka 

bÈßm;a lrk l%u folla we;'

i) my; olajd we;s ^rEmh 5'16& iïu; j¾K oyih tajdfha kñka u fh§u

rEmh 5'16 - iïu; j¾K oyih

WodyrK ( <font   size =zz5" face =zzverdana"   color = zzfuchsia" >SRI  LANKA</font>

		
m%;sodkh SRI LANKA

ii)	 5'17 jk rEmfha fmkajk mßÈ r;=" fld<" ks,a hk j¾K uQ,sl lr.;a RGB Iâ 

oYul fla; fh§u

		  fuys § # wkq,laIKh fmrgq lr.;a 0 isg F olajd jQ b,lalï yhlska 

fla;h ilia ù we;' fuys uq,a b,lalï foflka r;= j¾Kh;a" B<Õ b,lalï 

foflka fld< j¾Kh;a" wjidk b,lalï foflka ks,a j¾Kh;a ksremKh 

flf¾'
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rEmh 5'17 - RGB j¾K ixl,k lsysmhla

WodyrK ( <font size = zz5''  face = zzverdana" color = ''#0000FF'' >SRI  LANKA</font>

	
m%;sodkh SRI LANKA

Center Wiq,kh

	 Tfí fjí msgqfõ ud;Dldj ;sria wlaIh Tiafia ueog tfl,a, lsÍu i|yd 

fhdod f.k we;s Wiq,khls' th fujeks mdGhla i|yd muKla fkdj rEmhla" 

fþohla jeks ´kE u fohla i|yd Ndú; l< yel'

	 by; center Wiq,kh fhdod we;s wdldrhg u mdG yev.ekaùu i|yd Ndú; 

l< yels ;j;a ir, Wiq,k fndfyduhla we;' bka iuyrla j.=j 5'1ys olajd we;'

j.=j 5'1 - mdG yev.ekaùu i|yd Ndú; l< yels Wiq,k lSmhla

HTML i,l=K wlaIr yev .ekaùfï iajNdjh WodyrK

<b> ;o meye;s ^bold& SRI LANKA 
<i> weo yev ^italic& SRI LANKA
<u> há brla iys; ^underline& SRI LANKA

<em> wjOdrKh lrk ,o ^emphasis& SRI LANKA
<s> wl=re yryd brla iys; ^strike out& SRI LANKA

<sup> Wvq ,l=Kq lrk ,o ^superscript& SRI LANKA

<sub> há ,l=Kq lrk ,o ^subscript& SRI LANKA
<marquee> ;sria ÈYdjg p,khla fmkajk 

^horizontally moving text&
^fuh fjí msgqjlg fhdod 

mÍlaId lr n,kak&



PB

fkdñf,a fnod yeÍu msKsihs 153

WodyrK(    <b> SRI  LANKA </b>

m%;sodkh SRI LANKA

	 iqÿiq fjí wvú mßYS,kh lr mdG yev.ekaùï i|yd Ndú; jk HTML 
Wiq,k ms<sn| j ;j ÿrg;a yodrkak' 

WodyrK( 	 http://www.w3schools.com/html
		  http://www.tutorialspoint.com/html

l%shdldrlu

	 my; 5'18 jk rEmfha olajd we;s fla;fha jQ mdif,a ku fjkqjg 

Tfí mdif,a ku fhdod Tn leu;s fjkia yev .ekaùï iys; j 

fjí msgqjla ks¾udKh lrkak' fuys § Tn isxy, hqksfldaâ wl=re 

^''iskoola pota''& fhdod .kafka kï f,aLkh ;ekam;a lsÍfï § 5'19 

rEmfha mßÈ Save As ixjdo fldgqfõ Encoding iajrEmh Unicode 
f,i ilia l< hq;= h' Tfí fjí msgqfõ 5'20 rEmfha jQ m%;sodkh 

iu. ii|kak'

rEmh 5'18 - HTML f,aLkh

<html>
	 <head><title> Text Formatting </title></head>
<body>
	 <font face = ''‍iskoola pota'' color = ''Green'' ><h1> 1' Tfí mdif,a ku  </h1></font>
	 <font face = ''iskoola pota''‍ color = ''‍lime'' ‍><h2> 2' Tfí mdif,a ku </h2></font>
	 <font face = ''iskoola pota'' color = ''olive''‍ ><h3> 3' Tfí mdif,a ku </h3></font>
	 <font face = ''‍iskoola pota'' color = ''‍Navy'' ‍><h4> 4' Tfí mdif,a ku </h4></font>
	 <font face = ''‍iskoola pota''‍ color = ''blue'' ‍><h5> 5' Tfí mdif,a ku </h5></font>
	 <font face = ''‍iskoola pota'' color = ''Aqua'' ><h6> 6' Tfí mdif,a ku </h6></font>
	 <font face = ''iskoola pota''‍ color = ''‍Teal'' ><h6> 7' Tfí mdif,a ku </h6></font>
</body>
</html>

 

rEmh 5'19 - save as ixjdo fldgqj
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rEmh 5'20 - m%;sodkh

l%shdldrlu

1'	 HTML fla; ms<sn| jQ fjí wvú iy .%ka: mßYS,kfhka fjk;a 

Wiq,k y÷kd f.k by; 5'1 j.=j mßÈ j.=jla ilia lrkak'

2'	 by; 5'18 jk rEmfha olajd we;s fla;fha jQ header Wiq,k fjkqjg 

úúO Wiq,k fhdod fjí msgqjla ks¾udKh lrkak'

3'	 <marquee> Wiq,khg wod< .=Kdx. lsysmhla we;' ta ms<sn| j jeä 

ÿrg;a wOHhkfha fh§ iqÿiq fjí msgqjla ks¾udKh lrkak'

PdhdrEmhla we;=¿ lr yev.ekaùu 

	 Tfí fjí msgqjg we;=¿ lsÍu i|yd iqÿiq PdhdrEmhla f;dard.kak' fjí 

msgqjlg rEm we;=<;a lsÍfï § tu rEmh we;=<;a f.dkqj .png , .gif fyda .jpeg jeks 

idfmalaI j wvq Odß;d iys; f.dkq j¾.hla úh hq;=hs' fjí msgqjlg we;=<;a lrk 

rEm ish,a, HTML f,aLkh mj;sk f.dkqj ;=< u ;ekam;a lrkafka kï jvd;a 

myiqhs'

Image Wiq,kh

	 rEmhla fjí msgqjg iïnkaO lsÍu i|yd image Wiq,kh f,i y÷kajk 

<img>  Wiq,kh Ndú; fõ' fuys § wdrïNl$wjidk f,i Wiq,k fldgia folla 

Ndú; fkd jk nj úfYaIfhka u u;l ;nd .; hq;= h' Blank tags fyda empty tags 
f,i y÷kajk fujeks Wiq,k lsysmhla u Tng bÈßfha § o yuqjkq we;' <img> 
uQ,sldx.hg wod< .=Kdx. fod<yla muK ;snqK o jeo.;a lsysmhla muKla my; 

j.=j 5'2 ka úia;r lrhs'
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 j.=j 5'2 - <img> uQ,sldx.hg wÞ< .=Kdx. lsysmhla

.=Kdx.h w.h ms<sn| úia;rh WodyrK

source fyj;a 

src
rEmh iys; f.dkqfõ kduh ta 

wdldrhg u f.dkq È.=j o iu. 

oelaúh hq;=hs' rEmh fjk;a 

f*da,avrhla ;=< kï wod< 

ud¾.h ksjerÈ j oelaúh hq;=hs' 

src=“C:\Users\Pictures\pet.
png”

alternative 
fyj;a alt

by; src .=Kdx.h u.ska olajk 

rEmh wod< ia:dkfha  fkdue;s 

kï muKla rEmhg ysñ ia:dkfha 

ixo¾Ykh l< hq;= mdGhla fuys 

oelaúh hq;=hs'

alt = “map”

width rEmh ixo¾Ykh l< hq;= m<, 

mslai, ixLHdjla f,i fyda 

msgqfõ m%udKfhka m%;sY;hla 

f,i fyda oelaúh hq;=hs'

width = “100” fyda 

width = “50%”

height rEmh ixo¾Ykh l< hq;= Wi 

mslai, ixLHdjla f,i fyda 

msgqfõ m%udKfhka m%;sY;hla 

f,i fyda oelaúh hq;=hs'

height = “100”fyda height = 
“50%”

border rEmh jgd fndavrhla wjYH kï 

tys >klu mslai, ixLHdjla 

f,i oelaúh hq;=hs' tfia fkdfõ 

kï tys w.h—0˜ f,i olajkak'

border= “3”    

align left, right, top, bottom, middle 
hk tajdfhka iqÿiq tfl,a, 

w.hhla fhÈh yelshs'

align= “middle”  

m%;sodkh

WodyrK (

<img   src = ''‍C:\Users\Pictures\srilanka.jpg'' 
alt =''Map'' width =''100''  height =''200''  
border =''3''  align =''middle''>	
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	 m<uq mshjf¾ § wdrïN l< Y%S ,xldj ms<sn| fjí msgqjg PdhdrEmh we;=¿ 

lsÍu i|yd my; 5'21 jk rEmfha mßÈ fla; we;=<;a lrkak' fjí msgqj ixo¾Ykh 

lr m%;sodkh iu. fuka u 5'14 jk rEmfha PdhdrEmh iu. o ixikaokh lr 

n,kak'

<html>

<head><title> Sri Lanka </title></head>

<body><h2><center><font face="arial" color ="blue"> SRI LANKA 
		  </font></center></h2>
		  <center><img src=" C:\Users\Pictures\srilanka.jpg"
		  ></center><center><font face="arial" size="2">
 		  A map of Sri lanka  </font></center>
</body>
</html>

m%

;s 

Þ 

k

h

rEmh 5'21 - PdhdrEmh we;=¿ lsÍug wod< fla;h iy m%;sodkh

fþohla we;=¿ lr yev.ekaùu  

	 fojk mshjf¾ § we;=¿ l< PdhdrEmhg my<ska fþohla we;=<;a lsÍu i|yd 

jQ fla;h o my; 5'22 jk rEmfha mßÈ Tfí fjí msgqjg we;=<;a lrkak' fjí msgqj 

ixo¾Ykh lr 5'23 jk rEmfha jQ m%;sodkh iu. fuka u 5'14 jk rEmh iu. o 

ixikaokh lr n,kak'

<html>
<head><title> Sri Lanka </title></head>
<body><h2><center><font face="arial" color="blue"> SRI LANKA </font></center></h2>
	 <center><img src=" C:\Users\Pictures\srilanka.jpg" ></center>
	 <center><font face="arial"  size="2"> A map of Sri lanka  </font></center>
<p>  Sri Lanka is an island located off the southern coast of India. Sri Lanka is  
	 surrounded by the Indian Ocean. The geography of Sri Lanka includes 
	 coastal plains in the north and hills and mountains in the interior. The 
	 government system is a republic.  The chief of state and head of government  
	 is the President. </p>
</body>
</html>

paragraph Wiq,kh
fþoh

rEmh 5'22 - fþoh we;=¿ lsÍug wod< fla;h
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rEmh 5'23 - rEmh 5'22 g wod< m%;sodkh ‍‍‍

	 fuys § Tn Ndú; l< paragraph Wiq,kh f,i y÷kajk <p> Wiq,kh  

ms<sn| j jeä ÿr úuid n,uq' 

paragraph Wiq,kh

	 <p> Wiq,kh Ndú; lr Tn ieliQ fþoh jï tfl,a, f,i mj;sk nj Tn 

ksÍlaIKh lrkakg we;' ta tys fmrksñ ^default& iajrEmhhs' <p> Wiq,kfhaa align 
f,i y÷kajk .=Kdx.hg —left˜" —right˜" —center˜ iy —justify˜ hk w.hhka Ndú; 

lr fjkia tfl,a, iajrEm y;rla ,nd Èh yelshs' 

j.=j 5'3 - fþo tfl,a, lsÍu

WÞyrKh Wiq,kh tfl,a, lsÍu

< p align = ''left'' > jug 

< p align = ''center'' > ueog

< p align = ''right'' > ol=Kg

< p align = ''justify'' > fofl<jrg iudka;r j



fkdñf,a fnod yeÍu msKsihs158

jdlHhl jpk w;r mr;rh ilia lrk whqre  
	

	 Character entity Wiq,kh f,i y÷kajk j¾.hg wh;a &nbsp: Wiq,kh 

fh§fuka jpk w;r mr;rh ilia lr .; yels h' 

<p> The government system is &nbsp;  a republic. The chief of state and head 
of government is &nbsp; &nbsp&nbspthe President. </p>

m%;sÞkh

The government system is    a republic. The chief of state and head of 
government is          the President. 

l%shdldrlu

HTML fla; iïnkaO fjí wvú fyda .%ka: mßYS,kh lr Character 
entity f,i y÷kajk j¾.fha ;j;a Wiq,k lSmhl l%shdldß;ajh y÷kd 

.kak'

fma<s lsysmhla we;=<;a lsÍu 

	 f;jk mshjf¾ § we;=¿ l< fþohg my<ska fma<s lsysmhla we;=<;a lsÍu 

i|yd jQ fla;h o my; 5'24 jk rEmfha mßÈ Tfí fjí msgqjg we;=<;a lrkak' 

Line Wiq,k

rEmh 5'24 - fma<s lsysmhla we;=<;a lsÍug wod< fla;h  
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rEmh 5'25 - rEmh 5'24g wod< m%;sodkfhka fldgila  

 	 fma<s ì÷u i|yd Tn Ndú; l< Line break f,i y÷kajk <br/>  Wiq,kh 

Tn fuhg fmr Ndú; l< <img>  Wiq,kh mßÈ u blank tag /empty tag j¾.hg 

wh;a fõ' wdrïNl$wjidk f,i Wiq,k folla fkdj <br/> Wiq,kh muKla 

yßhg u fma<s ì÷u we;s l< hq;= ia:dkhg fhdok nj y÷kd .kak' 

	

 
,ehsia;= we;=<;a lsÍu     

	 tlsfkl w;r iïnkaOhla iys; whs;u iuqyhla wkqms<sfj<ska oelajQ úg 

,ehsia;=jla f,i ye¢kafõ' fndfyda úg tu whs;u" tllg my<ska tlla f,i 

olajkq ,efí' fjí msgq ks¾udKfha §  HTML NdIdj ;=< Ndú; jk m%Odk ,ehsia;= 

j¾. ;=kla we;'	

i) wxls; fkdjk ,ehsia;= (Unordered list)
	 wxls; fkdjk ,ehsia;=jl wdrïNh iksgqyka lsÍug <ul> i,l=K Ndú; 

flfrk w;r tys uQ,sldx.h iu. wod< úfYaI ixfla;fha yevh yeÕùug type 
.=Kdx.h Ndú; fõ' thg mejßh yels w.hhka ;=k fufia h'

1.	 Disc
2.	 Square
3.	 Circle 

	 ,ehsia;=fõ jQ tla tla whs;u tlsfklska fjka lr oelaùug <li> Wiq,kh 

Ndú; flf¾'

²² isxy,

²² fou< 

²² uqia,sï 

²² n¾.¾

m%;sodkh

<ul type = ''disc''	       <li> isxy,</li>	       <li> fou<</li>	       <li> uqia,sï</li>
       <li> n¾.¾</li>
</ul>

rEmh 5'26 - <li> Wiq,kh iy tys m%;sodkh
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ii) wxls; ,ehsia;= (Ordered list)
	 b,lalï fyda wlaIr Ndú; lr wkqms<sfj<ska ilia l< whs;u iuQyhla" 

wxls; ,ehsia;=jla ^rEmh 5'27& f,i ye¢kafõ' fjí msgq ;=< fufia oelaùug <ol> 
iy <li> f,i Wiq,k folla tla j fhdod .efka' 

	 fhdÞ .kq ,nk wlaIr j¾.h fyda b,lalï j¾.h yeÕùug type .=Kdx.h 

Ndú; flf¾'

	 j.=j 5'4 - wxls; ,ehsia;= 

w.h w¾:h

1 yskaÿ wrdì b,lalï 

A bx.%Sis capital wlaIr 

a bx.%Sis simple wlaIr

i bx.%Sis simple wlaIr iys; frdau b,lalï

I bx.%Sis capital wlaIr iys; frdau b,lalï

WodyrK(

I.	 isxy,

II.	 fou< 

III.	uqia,sï 

IV.	n¾.¾

m%;sodkh

<ol type = ''I'' >
	
       <li> isxy,</li>
	
       <li> fou<</li>
	
       <li> uqia,sï</li>
       <li>n¾.¾</li>

</ol>

rEmh 5'27 - wxls; ,ehsia;= 

iii)  úia;rd;aul ,ehsia;= (Description/definition list)
	 whs;u iuQyhla Bg wh;a úia;rhla o iu.ska ,ehsia;=jla f,i ^rEmh 5'31& 

ksrEmKhg úia;rd;aul ,ehsia;= Ndú; flf¾'

	 j.=j 5'4 - úia;rd;aul ,ehsia;= 

Wiq,kh úia;rh

<dl> úia;rd;aul ,ehsia;=jl wdrïNh

<dt> whs;uh ye¢kaùu 

<dd> whs;uhg wh;a úia;rh

WodyrK(  5'28 jk rEmfha mßÈ úia;rd;aul ,ehsia;=jla" fjí msgqjla ;=< ksrEmKhg  

	    wod< HTML fla;h my; mßÈ ,shd m%;sodkh mÍlaId lr n,kak'
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m%;sodkh

<dl>
     <dt> úoHd úIh Odrdjg wh;a m%Odk úIhhka </dt>
				    <dd> Ôj úoHdj </dd>
				    <dd> fN!;sl úoHdj </dd>
				    <dd> ridhk úoHdj </dd>
				    <dd> ixhqla; .‚;h </dd>
     <dt> jd‚cH úIh Odrdjg wh;a m%Odk úIhhka </dt>
				    <dd> wd¾Ól úoHdj </dd>
				    <dd> jHdmdr wOHhkh </dd>
				    <dd> .KldêlrKh </dd>
<dl>

       

rEmh 5'28 - úia;rd;aul ,ehsia;= 

l%shdldrlu

1'	by; rEmj,ska oela jQ mßÈ ,ehsia;= iys; fjí msgq" Tn leu;s 

whs;u Ndú; lr ilia lrkak'

2'	tl ,ehsia;= j¾.hla ;=< ;j;a j¾.hla we;=<;a jk wdldrhg fjí 

msgq ks¾udKh l< yels h' tjeks fla;hla yd tys m%;sodkh 5'29 

rEmfha olajd we;' th wdY%s; j úúO iajrEm ,ehsia;= f.dvk.kak' 

 rEmh 5'29 - ,ehsia;= j¾. lsysmhl tl;=jla oelafjk fla;h yd tys m%;sodkh

<ul type = ''disc''>
    <li>isxy,</li>
    <li>fou<

	 <ol type = ''1''>
	 <li> Y%S ,dxlsl fou< </li>
	 <li> bkaÈhdkq fou< </li>
	 </ol>	 </li>
   <li> uqia,sï </li>
   <li> n¾.¾ </li>
</ul>

m%

;s

od

k

h
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wêikaOdk ks¾udKh (Hyperlink)    

	 5'14 jk rEmfha kï lr we;s mßÈ ''President'' hk mdGhg wêikaOdkhla 

we;=<;a lruq' ta i|yd jQ fla;h o my; 5'30 jk rEmfha mßÈ Tfí fjí msgqjg 

we;=<;a lrkak' 

<html>
<head><title> Sri Lanka </title></head>
<body><h2><center><font face="arial" color="blue"> SRI LANKA </font></center></h2>
	 <center><img src=" C:\Users\Pictures\srilanka.jpg" ></center>
	 <center><font face="arial" size="2"> A map of Sri lanka  </font></center>
	 <p>  Sri Lanka is an island located off the southern coast of India. Sri Lanka is surrounded  
		  by the Indian Ocean. The geography of Sri Lanka includes coastal plains in the 
		  north and hills and mountains in the interior.The government system is a republic. 
		  The chief of state and head of government is the 
		  <a href=”http://www.president.gov.lk“ >President.</a></p>
		  People in Sri Lanka have four main categories in ethnically. They are <br/>
		       Sinhala <br/>Tamil <br/> Muslim <br/> Burghers <br/>
</body>
</html>

href .=Kdx.hanchor Wiq,kh iïnkaê; f.dkqj

rEmh 5'30 - mdGhlg wêikaOdkhla we;=<;a lsÍu

rEmh 5'31 - wêikaOdkhg wod< fla;fha m%;sodkh 

	 fjí msgqj ixo¾Ykh lr n,k w;r wêikaOdkh fh¥ ''President'' hk 

mdGh u; click lsÍfuka fyda right click lr újD; lsÍfï úOdkh ,nd §fuka fyda 

wod< iïnkaê; f.dkqj újD; fõ'
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Anchor Wiq,kh

	 HTML fla;j, jQ <a> Wiq,kh Ndú; lr hï mdGhla fyda rEmhla i|yd 

wêikaOdk ,nd Èh yelshs' fuu Wiq,khg wod< .=Kdx. lsysmhla o we;' jeo.;a 

u .=Kdx.h jk href u.sska iïnkaOh we;s l< hq;= ia:dkh fmkajd fohs' th tu 

fjí msgqj wvx.= f*da,avrfha u jQ fjk;a f.dkqjla kï f.dkq kduh" f.dkq È.=j;a 

iu. u oelaùu m%udKj;a h' 

WodyrK (	 <a href=“President.jpeg”>President </a>
		  <a href=“President.html”>President </a>
	 tfy;a fjk;a fjí msgqjlg iïnkaO l< hq;= kï wod< ud¾.h ^path& 
ksjerÈ j oelaúh hq;=hs'

WodyrK ( 	 <a href=“http://www.president.gov.lk/president”>President </a>

l%shdldrlu

1'	 Tfí fjí msgqfjys jQ PdhdrEmh" .e<fmk wka;¾cd, fjí wvúhla 

iu. wêikaOdk lrkak'

2.	 HTML fla; iïnkaO fjí wvú fyda .%ka: mßYS,kh lr <a> 
Wiq,khg wod< .=Kdx. ,ehsia;=jla ilikak'

mshjr 7 - 	 j.=jla we;=<;a lsÍu 

	 fjí msgqjlg j.=jla fh§fukaa úúO mdG" rEm wdÈ f;dr;=re fma<s yd ;Sre 

f,i úêu;a iajrEmhlg bÈßm;a l< yelshs'

	 Tfí fjí msgqfõ Sinhala" Tamil" Muslim" Burghers f,i ckj¾. y;rla 

fh§ug <br/> Wiq,kh weiqßka ,shk ,o HTML fla;hg wk;=rej j.=j we;=¿ 

lsÍu i|yd jQ fla;h 5'32 rEmfha mßÈ tla lrkak'

table 
Wiq,kh

border .=Kdx.h j.=fõ fma<s ms<sn| Wiq,kh

o;a; we;=<;a 

fldaI ks¾udKh

rEmh 5'32 - j.=j we;=<;a lsÍug wÞ< fla;h
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	 Tfí fjí msgqj ixo¾Ykh lr wod< fldgi muKla oelafjk 5'33 rEmfha 

jQ m%;sodkh iu. fuka u 5'14 jk rEmh iu. o ixikaokh lr n,kak'

rEmh 5'33 - rEmh 5'33 fla;hg wod< m%;sodkh

Table Wiq,kh

	 fuu Wiq,kh u.sska j.=jl wdrïNh iksgqyka lrk w;r tys uQ,sldx.h 

iu. j.=j yev.ekaùug wÞ< .=Kdx. Ndú; fõ' 5'4 j.=j u.ska bka lsysmhla 

úia;r flf¾'

j.=j 5'6 - <table> Wiq,khg wod< .=Kdx. lsysmhla

.=Kdx.h úia;rh

align msgqfõ jQ wfkl=;a mdG iu. j.=j tfl,a, úh hq;= wdldrh 

fmkajhs' w.h f,i left, center, right Ndú; fõ' 

width j.=fõ m<, mslai, ixLHdjla f,i fyda fjí msgqfõ m<,ska 

m%;sY;hla f,i olajhs'

Height j.=fõ Wi mslai, ixLHdjla f,i fyda fjí msgqfõ Wfiys 

m%;sY;hla f,i olajhs'

bgcolor j.=fõ miqìï j¾Kh olajhs' mdG i|yd j¾K fh¥ wdldrhg 

u w.hhka fhÈh yels h' 

border j.=fõ fldaI jgd fndavrhla wjYH kï —1˜ o tfia fkdfõ 

kï —0˜ o w.h f,i Ndú; fõ'

bordercolor fndavrfha j¾Kh olajhs'

background j.=fõ miqìug rEmhla fh§ug Ndú; fõ' w.h f,i f.dkq 

kduh fyda rEmhg wod< path fhdohs'

cellpadding fldaIfha udhsu iy tys wka;¾.;h w;r mr;rh fmkajhs' 

mslai, ixLHdjla f,i w.h bÈßm;a lrhs'

cellspacing fldaI w;r mr;rh fmkajhs' mslai, ixLHdjla f,i w.h 

bÈßm;a lrhs'
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Tfí j.=jg by; .=Kdx. we;=<;a lr yev .kajkak'

WodyrK (  <table border="1"width ="400"  height ="150" 					   
	     cellpadding="5" cellspacing="5" bordercolor="green" bgcolor="yellow">

m%;sodkh

rEmh 5'34 - Table Wiq,khl m%;sodkh

Caption Wiq,kh

	 j.=jg ud;Dldjla fyda úia;rhla tys by<ska we;=<;a lsÍug Ndú; flf¾' 

.=Kdx. lsisjla fkdue;s jqj;a mdG yev .ekaùug wod< Wiq,k fhdod fuu ud;Dld 

mdGh yev .ekaúh yel'

WodyrK ( < Caption><b><u>Principle Forms of Land use </ u></ b></ Caption>

<tr> Wiq,kh

	 <tr> f,i olajk fuu uQ,sldx.h u.ska j.=jg w¨;a fma<shla tl;= l< 

yels h' <table> ys § fuka u fma<s i|yd o fjk fjk u align, bgcolor, bordercolor 
wdÈ .=Kdx. fjkia f,i fhÈh yel'

WodyrK (  <tr bordercolor = ''green'' bgcolor=''yellow'' background= ''image.png''>

<td>  Wiq,kh

	 fma<shla ;=< o;a; we;=<;a lsÍu i|yd jQ fldaI ^Cells& ks¾udKhg fhdod 

.efka' fma<s i|yd fuka u fldaI i|yd o fjka fjka f,i .=Kdx. tla l< yels 

h' 

WodyrK ( <td  width = ''4'' ‍bordercolor= ''green'' bgcolor = ''‍yellow'' background 
	        =‍''image.png''‍>
	 we;eï úg j.=fõ fma<s lsysmhla fyda ;Sr lsysmhla fyda tl;= jk fia 

fldaIhla ^Merge cell& ilia lsÍug isÿfõ' ta i|yd Ndú; jk .=Kdx. folla we;'
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1. Colspan - ;Sre lsysmhla tl;= lr fldaIhla ieliSug Ndú; flfrhs' tl;= lrk 

                ;Sre ixLHdj fuu .=Kdx.fha w.h fõ'

WodyrK(

rEmh 5'35 - ;Sre lsysmhla tl;= lr fldaIhla ieliSu

2. Rowspan - fma<s lsysmhla tl;= lr fldaIhla ieliSug Ndú; flfrhs' tl;= lrk  

                    fma<s ixLHdj fuu .=Kdx.fha w.h fõ'

WodyrK(

<th>
Wiq,kh

rEmh 5'36 -  fma<s lsysmhla tl;= lr fldaIhla ieliSu

<th>  Wiq,kh

	 Table header Wiq,kh f,i y÷kajk fuh j.=fõ ;Srej, YS¾I oelaùug 

Ndú; flfrhs' tfy;a j.=fõ ´kE u fldaIhlg wod< j <td> Wiq,kh fjkqjg 

fhÈh yels h' fuys úfYaI;ajh jkafka fldaIh ;=< we;=<;a mdGh ;o meye wl=ßka 

ixo¾Ykh ùuhs' Colspan, rowspan we;=¿ j <td> Wiq,khg wod< .=Kdx. ish,a, 

u fuu Wiq,kh i|yd o Ndú; l< yels h'
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l%shdldrlu

	 my; mßÈ j.=jla we;=<;a fjí msgqjla ks¾udKh lrkak' Tn 

fuf;la W.;a foa weiqßka tu j.=fõ úúO fjkialï lsÍfukaa j.= 

ks¾udKhg wod< úúO Wiq,k iy tajdfha .=Kdx. fyd¢ka wjfndaO 

lr.kak'

    iqÿiq HTML ixialdrlhla weiqßka Tfí lKavdhu úiska ie,iqï 

    lrk ,o fjí wvúh f.dvkÕkak'

 5'2  fjí ks¾udK uDÿldx. 

	 ir, joka ilik fyda HTML ixialdrl Ndú; lr HTML fla; ,shñka 

fjí wvú ks¾udKfha §" HTML NdIdj ms<sn| by< oekqula wjYH jk w;r 

fla;khg jeä ld,hla .; fõ' fjí wvúh hdj;ald,Sk lsÍu iy ixfYdaOkh 

i|yd kej; uq,a HTML fla;fha fjkialï lsÍug isÿ fõ'

	 kuq;a" fjí wvú ks¾udKhg myiqlï imhk uDÿldx. fyj;a fjí ks¾udK 

uDÿldx. Ndú; lr fjí wvú b;d blaukska w,xldr j ilid .; yels h' Ñ;%l 

w;=reuqyqK;la ;=< fjí wvú ks¾udKhg" ixfYdaOkhg" fmr oiqka oelaùug fuka 

u we;eï úg fjí wvúh Wvq.; lsÍug o myiqlï imhhs' WYSIWYG ̂ What You 
See Is What You Get& f,i y÷kajkq ,nk ixl,amhg wkqj rEmuh w;=re uqyqK; 

;=< ie,iqï lrk wdldrhg u fjí msgq ks¾udKh l< yels h'

úúO j¾.fha fjí ks¾udK uDÿldx. we;' ksoiqka f,i"

	 1'  fjí ixialdrl ^Web authoring tools&
	 2'  ikaOdr l<ukdlrK moaO;s ^Content Management Systems / CMS&
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5'2'1  fjí ixialdrl ^Web authoring tools&

	 fuu fjí ks¾udK uDÿldx.j, úfYaI;ajh jkafka ks¾udKlre úiska 

Ñ;%l w;=re uqyqK; Ndú;fhka fjí msgqj ksujkq ,nk w;r;=r iajhxl%Sh f,i 

wod< HTML f,aLkh o fjk u w;=re uqyqK;l iliaùuhs' ks¾udKlreg HTML 
NdIdj ms<sn| oekqu ;sfí kï Ñ;%l w;=re uqyqK; fuka u HTML f,aLkh o 

Ndú; lrñka fjí msgq ks¾udK ld¾hh l< yelsùu w;sf¾l jdishls'

	 Kompozer, Ckeditor, Bluegriffon jeks újD; fla; fjí ixialdrl 

fndfyduhla wka;¾cd,fhka nd.; lr.; yels w;r Adobe dream weaver, 
Microsoft front page, Visual studio wdÈ f,i ñ, § .; yels j¾.fha fjí ixialdrl 

o we;'

rEmh 5'37 - újD; fla; fjí ixialdrl

fjí ixialdrl uDÿldx.hla Ndú; lr fjí wvúhla idok whqre 

	 ksoiqka f,i ñksidf.a moaO;s ms<sn| fjí msgq yhlska hq;a fjí wvúhla 

ks¾udKhg ie,iqï lr we;ehs is;kak' tys uq,a msgqfjys jHqyh yd msßie,iqu;a" 

wka;¾.;h;a rEmh 5'38ys olajd we;'

fjk;a fjí wvú i|yd wêikaOdk fjk;a fjí msgq i|yd wêikaOdk

 ñksia isref¾ moaO;s

remh 5'38 - fjí wvúh i|yd ie,iqï l< uq,a msgqj 

lsishï ld¾hhla bgqlsÍu i|yd

wka;¾ iïnkaO;djhlska hq;=j

lghq;= lrk wjhj iuqy 

—moaO;shla˜ f,i y÷kajhs' 

tosfkod lghq;= isÿlsÍug wod,

jQ moaO;s rdYshla ñksia isrer

;=, y÷kd.; yel'

fuu moaO;sj, ixúOdkd;aul

ieleiau ñksia cSú;h ir, iqug

f,i .,d hdug iDcqju fya;= ù

we;'

iajik

moaO;sh

iakdhq 

moaO;sh

nysY%dù 

moaO;sh

reêr ixirK 

moaO;sh

m%ckk 

moaO;sh

jeäÿr f;dr;=re i|yd '''''''''''''''''''''''
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	 fuu uq,a msgqfjys m%Odk ud;Dldj" moaO;s fmkajk rEmhla" flá úia;rhla" 

m%Odk moaO;s myla ms<sn| úia;r" wfkla fjí msgq my i|yd wêikaOdk iy jeä 

ÿr úia;r i|yd wêikaOdkhla  olajd we;'

	 Tn leu;s fjí ixialdrl uDÿldx.hla Ndú; lr fuu fjí wvúh 

ks¾udKh l< yels w;r Kompozer uDÿldx.h Ndú; lr fuu ld¾hh isÿ lsÍug 

wod< mshjr my; olajd we;'

mshjr 01 -	 iqÿiq fjí wvúhla Ndú; lr .kak' 

		  ^Wod ( www.kompozer.net/download-07.php& nd.; lr .;a  

		  Kompozer.exe f.dkqj l%shd;aul l< miq ,efnk m%Odk w;=re 

		  uqyqK; rEmh 5'39ys olajd we;' tys fldgia y÷kd .kak'

j.= we;=<;a lsÍug 

mska;+r we;=<;a lsÍug 

weuqKqï we;=<;a lsÍug 

fjí msgq ks¾udK 

m%foaYh
HTML fla;h ±laùug fmr oiqk ±laùug

wl=re iy mdG yev 

.ekaùug 

remh 5'39 - Kompozer uDÿldx.fha m%Odk w;=re uqyqK;

mshjr 02 - 	 fjí msgq ks¾udK m%foaYfha by<ska u ˜‍ñksia isref¾ moaO;s˜‍ hk  

		  ud;Dld mdGh h;=re,shkh lr wl=re yd mdG yev .ekaùfï WmlrK  

		  Ndú;fhka wl=re j¾.h" wl=rej, m%udKh" wl=rej, j¾Kh" mdGfha  

		  miqìï j¾Kh wdÈh iqÿiq mßÈ fhdod yev .kajkak' 

mshjr 03 -	 File fukqfõ jQ úOdk Ndú; lr iqÿiq f*da,avrhl iqÿiq kulska  

		  ;ekam;a lrkak' fjí w;ßlaiqjla u.ska Tfí fjí msgqj ixo¾Ykh 

		  lr n,kak'
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රුපය 42 :  වගුවක් ඇතුළත් කිරීමට අදාල සංවාද ෙකොටුව  remh 5'40 - j.=jla we;=<;a lsÍug wod< 

ixjdo fldgqj

mshjr 04 -	 by; mßÈ u rEmh yd  

		  wfkl=;a mdG fhÈh yels  

		  jqj o iqÿiq ikaOdr  

		  ieliqula ^Layout&  
		  Ndú;fhka ld¾hh myiq  

		  flf¾'

		  ta i|yd j.=jla we;=<;a  

		  lruq' fukq ;Srefõ jQ  

		  —Insert menu˜ fyda  

		  —Table tool˜ wdOdrfhka  

		  my; 5'40 rEmfha  

		  oelafjk ixjdo fldgqj  

		  ,nd .kak' fma<s 06la  

		  yd ;Sr 03la f,i j.=j we;=<;a lrkak'

mshjr 05 -	 Tn joka ieliqï uDÿldx.j, § j.= yeisrjQ wdldrhg u fma<sj,  

		  iy ;Srej, È. m<, fjkia lsÍu" fldaI we;=¿ lsÍu" fldaI uld  

		  oeóu" fldaI taldnoaO lsÍu ^Merge cells& l< yels nj y÷kd  

		  .kak' rEmh 5'41 wdldrhg fldaI ilid .kak'

 ñksia isref¾ moaO;s

rEmh 5'41 - j.=fõ fldaI ieleiau

mshjr 06 -	 j.=fõ fldaI ;=<g wxl 5'39 rEmfha jQ myiqlï weiqßka mdG"  

		  rEm" wêikaOdk fhdod yev .kajkak' fuys § fjí msgq iE§ug  

		  Ndú; flfrk ish¨ u mska;+r tl u f*da,avrh ;=< ;ekam;a  

		  lrkafka kï jvd iqÿiq h'
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mshjr 07 -	 —New tool˜ wdOdrfhka kj msgq újD; l< yels h' uq,a msgqfõ jQ tla  

		  tla moaO;s i|yd fjka fjka msgq ilia lrkak' tajd iqÿiq kï fhdod  

		  uq,a f*da,avrh ;=< u ;ekam;a lrkak'

mshjr 08 -	 tla tla moaO;s i|yd wod< msgq" uq,a msgqfõ wod< mdGj,g wêikaOdk 

		  lsÍfuka miq Tfí fjí wvúh ixo¾Ykh lr wjYH fjkialï  

		  lrkak'

5'2'2 iaÓ;sl fjí wvú yd .;sl fjí wvú 

	 ikaOdrfha iajNdjh wkqj iaÓ;sl fjí wvú (Static website) yd .;sl fjí 

wvú (Dynamic website) f,i fjí wvú j¾. folla we;'

1'	 iaÓ;sl fjí wvú

	 fjí wvúhl ikaOdrh fkdfjkia j fyj;a ia:djr f,i hï lsis ld,hla 

mj;ajdf.k hkafka kï th iaÓ;sl fjí wvúhla f,i ye¢kafõ' idudkHfhka 

HTML NdIdj uq,a lr.;a fjí wvú iaÓ;sl fjí wvú fõ' fïjdfha jHqyh yd 

ikaOdrh HTML fla;h ;=<ska ks¾udKh fõ' th ixfYdaOkh l< úg muKla  

fjí wvúfha ikaOdrh fjkia fõ'

	 fjí msgq iuQyhl tl;=jla f,i b;d ir, j fuu j¾.fha fjí wvú 

ilia l< yels h' fjí wvú mßYS,kfha § .%dylhka" fiajdodhlh ^Web Server& 
iu. Rcq j u iïnkaO fkd fõ' fjí wvúfha ks¾udKlreg muKla fjí wvúh 

;ekam;a lr we;s fiajdodhl mß.Klhg iïnkaO ù wod< fjkialï we;=<;a l< 

yel' fï i|yd jeä ld,hla .; jqj o fuu fjí wvú jvd;a wdrlaIs; h' 

	 Tn úiska fuf;la ir, joka ieliqï uDÿldx." HTML ixialdrl" fjí 

ixialdrl wdÈ úúO uDÿldx. wdOdrfhka ilia lrk ,oafoa iaÓ;sl fjí wvú 

fkdfõoehs fudfyd;la is;d n,kak'

2'	 .;sl fjí wvú

	 fjí wvúhl ikaOdrh ksrka;r j fjkia jkafka kï th .;sl fjí 

wvúhla f,i ye¢kafõ' fïjd PHP (Hypertext Preprocessor), ASP.net (Active 
Server Page.net), JSP (Java Server Page) jeks mß.Kl NdIdj,ska ilia lr we;' 

.;sl fjí wvúhl ikaOdrh ;=< fiajdodhlh u.ska ckkh jk f;dr;=re we;' 

fndfyda úg o;a; mdolhla u.ska fyda fiajdodhlh ;=< Odjkh jk fhojqula 

u.ska úh yels h'

WodyrK(

	 1'	 fjí wvúhl j;auka fõ,dj .;sl f,i fmkakqï lsÍu

	 2'	 úNd. wxlhlg wod< j úNd. wfmalaIlhdf.a m%;sM, fmkakqï lsÍu 
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	 fuu fjí wvú Ndú;fha § .%dylhka" fiajdodhlh iu. Rcq j u iïnkaO 

flf¾' .%dylhdf.ka fiajdodhlh fj;g fyda thg m%;súreoaO f,i fyda f;dr;=re 

yqjudre fõ' fï ksid iaÓ;sl fjí wvúhlg idfmalaI j fjí wvúfha wdrlaIdjg 

;¾ck we;s úh yels h'

	 ksrka;r j fjkia úh hq;= wdldrfha jd‚cuh" iudcuh fyda  ;;ald,Sk 

úNd. mj;ajk fjí wvú i|yd fuh jvd;a iqÿiq fõ' tfy;a wdrlaIs; f,i 

fujeks fjí wvú iE§ug by< oekqula yd m<mqreoaola wjYH fõ'

fiajdÞhl 

mß.Klh (server) 
mßYS,l 

(Client/browser)

iaÓ;sl (Static)

fjí fiajdÞhl 

mß.Klh 

(Web server)

o;a; .nvd fiajdÞhl 

mß.Klh

(Database server) 

mßYS,l

(Client/browser)

.;sl (Dynamic)

rEmh 5'41 - ia:s;sl yd .;sl fjí wvú

	5'2'3  ikaOdr l<ukdlrK moaO;s 
	 (Content Management Systems - CMS)

	 .;sl f,i fjí wvú ks¾udKhg" ikaOdr l<ukdlrKhg yd m%ldYhg 

m;alsÍug Ndú; flfrk uDÿldx.hla" ikaOdr l<ukdlrK moaO;shla f,i ir, 

j y÷kajd Èh yel' fjí wvú ks¾udKlreg" ksrka;r j ikaOdrh fjkia lrñka 

;u fjí wvúh m%ldYhg m;a l< yel'
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	 CMS Ndú; lr fjí wvú ks¾udKh iy l<ukdlrKh" b;du;a myiq iy 

fõ.j;a jk w;r mß.Kl NdId ms<sn| oekqula wjYH fkd fõ' tu ksid CMS hkq 

j¾;udkfha § jvd;a u ckm%sh fjí ks¾udK fhÿï j¾.hhs'

	 uDÿldx.h u.ska imhd we;s iels,s ^Templates& iy ;ekSï wdldr ^Wizard& 
muKla Ndú; lr úúO Y%jH oDYH f;dr;=re fjí wvúhg we;=¿ lsÍfuka ks¾udKh 

hï mrdihlg iSud fõ' ilia lrk fjí wvú ish,a, taldldr njla .kS' HTML, 
PHP, javascript, CSS, SQL jeks NdId oekqu we;s úg" wod< fla;fha fjkialï isÿ 

lr fndfyda ÿrg tu ÿ¾j,;d uÕyrjd .; yels h'

	 újD; fla; CMS uDÿldx. nd.; lr .; yels fjí ,smsk lsysmhla my; 

olajd we;'

1.	 Joomla (www.joomla.org/download.html)
2.	 Wordpress (www.wordpress.org/download)
3.	 Drupal (www.drupal.org/download)

CMS uDÿldx.hla Ndú; lr fjí wvúhla ilia lrk whqre    

	 Tn leu;s CMS uDÿldx.hla Ndú; lr fuu fjí wvúh ks¾udKh l< 

yels w;r Joomla  uDÿldx.h Ndú; lr fuu ld¾hh isÿ lsÍug wod< mshjr my; 

olajd we;'

mshjr 01 -	 my; i|yka uDÿldx. j¾. ;=k Tfí mß.Klhg ia:dmkh lr  

		  .kak' 

ksoiqka f,i fïjd nd.; lr .ekSug wjYH fjí ,smsk o olajd we;'

1.	 APACHE (www.apache.org)
2.	 PHP(www.php.net)
3.	 MySql (www.mysql.com)

	 tfy;a fuu uDÿldx. ;=k u we;=<;a ;ks meflachla ia:dmkh lr .ekSu 

jvd;a myiq fõ' ksoiqka f,i tjeks uDÿldx. folla my; olajd we;'

1.	 WAMP (www.wampserver.com)
2.	 XAMPP (www.apachefriends.org/index.html)

mshjr 02 -	 www.joomla.org fjí wvúfhka JOOMLA uDÿldx.h nd.; lr" 

		  Tfí mß.Klhg ia:dmkh lr.kak' fuys mshjr rdYshla we;s  

		  neúka iqÿiq fjí wvúhlska wjYH Wmfoia ,nd.kak'

		  ksoiqka - https://docs.joomla.org/J3.x:Installing_Joomla
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mshjr 03 -	 kj fjí wvúhla i|yd iqÿiq iels,s ^Templates& f;dard .ekSu"  

		  m%ldYk ^Article& we;=<;a lsÍu" ixrpl ^Component& we;=<;a  

		  lsÍu l< hq;= h' fï i|yd Wmfoia iqÿiq fjí wvúhlska ,nd 

		  .kak'

mshjr 04 -	 Tfí fjí wvúh ixo¾Ykh lr n,d wjYH fjkialï l< yel'

l%shdldrlu

   Joomla uDÿldx.h Ndú;fhka Tfí lKavdhu úiska ie,iqï lrk 

,o fjí wvúh f.dvk.kak'

5'2'4  fjí wvú ks¾udKh wdY%s; N+ñld

	 fjí wvúhla ks¾udKh iy th hdj;ald,Sk lrñka mj;ajd .ekSu hkq 

mqoa., iuQyhla iyNd.s jk lKavdhï l%shdjls' tys tla tla mqoa.,hdg wh;a N+ñld 

(Role) lsysmhla my; ±lafõ'

    1'   fjí wvú ks¾udml (Author) - fjí wvúfha w;=re uqyqK;a ie,iqï lsÍu

2'	 ixialdrl (Editor) - fla; ,sùu" fodaI mÍlaIdj yd fodaI ksjerÈ lsÍu

3'	 m%ldYl (Publisher) - fjí wvúh m%ldYhg m;alsÍu 

4'	 fjí wvú mßmd,l (Administrator) - fjí fiajdodhlhdg iy o;a; 

mdolj,g wod< kv;a;= lghq;= isÿ lsÍu

5'	 mßYS,lhka (Users) - fjí wvúh mßYS,kh lsÍu

 5'3 fjí wvú m%ldYhg m;alsÍu (Publication of a website)

	 fjí wvúhla ks¾udKh" fjí i;aldrlhla ^Web host& fj;g Wvq.; 

lsÍu" jßka jr isÿlrk hdj;ald,Sk lsÍï iy ud¾..; m<lsÍï ^Web post& hk 

ld¾hhka ish,a, fjí wvúhla m%ldYhg m;a lsÍug wh;a fõ' fï i|yd fjí wvú 

m%ldYlhl= imqrd .; hq;= wjYH;d lsysmhla we;' 

1'	 fjí wvú ks¾udK uDÿldx.hla

2'	 fjí i;aldrlhla

3'	 jiï kduhla 

4'	 Wvq.; lsÍfï uDÿldx.hla

5'	 wka;¾cd, iïnkaO;djla 
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5'3'1 fjí i;aldrl ^Web host&

	 ks¾udKh lrk fjí wvúh" wka;¾cd,h Tiafia ´kE u whl=g ´kE u 

fudfyd;l ´kE u ;ekl isg m%fõY úh yels f,i lsis hï ia:dkhl ;ekam;a 

lr ;eìh hq;= h' fujeks fiajd imhk mß.Kl fjí i;aldrl f,i ye¢kafõ'

	 fjí wvúh ks¾udKh lrkqfha uyd mßudK wdh;khla i|yd kï fndfyda 

úg Tjqka i|yd u fjka jQ fjí i;aldrlhla ^Dedicated host& mj;ajd .kq ,efí' 

l=vd mßudK wdh;k kï fjk;a wdh;k úiska mj;ajdf.k hk yjq,a fjí 

i;aldrlj,ska ^Shared hosts& lsis hï bvla ,nd.kshs' yjq,a fjí i;aldrl ;=< 

wdh;k iuqyhl fjí wvú mj;ajd .kakd w;r tajdg fjka lrk .nvd Odß;dj 

wkqj uQ,sl .dia;=jla iy jd¾Isl .dia;=jla wh flf¾' Y%S ,xldj ;=< fuka u 

f,dalh mqrd u fujeks fjí i;aldrl fiajd imhk wdh;k fndfyduhla mj;S'

	 fkdñf,a fjí i;aldrl fiajd imhk wdh;k o we;' úúO fjí wvú 

Tiafia fuu myiqlu ,nd.; yels h' fuys § Tfí fjí wvúh ;=< Tjqkaf.a 

oekaùï o m%o¾Ykh fõ'

l%shdldrlu

	 fkdñf,a fjí i;aldrl fiajd imhk wdh;k 02la wod< fjí 

,smsk iu. kï lrkak'

5'3'2 jiï kduh ^Domain name&

	 f,dalfha ́ kE u mqoa.,hl= wkkH j y÷kd.ekSu i|yd mqoa.,hka ,shdmÈxÑ 

lsÍfï wdh;k úiskA cd;sl ye÷kqïm;a wxl ,ndfokq ,efí' fï wdldrhg u f,dal 

jHdma; cd,h ;=< jQ fjí wvúhla wkkH j y÷kd.ekSu i|yd ICANN (Internet 
Corporation for Assigned Names and Numbers) f,i y÷kajk wka;¾cd;sl 

wdh;khla we;' th fjí wvú i|yd wkkH jQ jiï kdu mejÍu iy md,kh 

ms<sn| j.lSu orhs' fjí wvúhla ilia l< miq iqÿiq jiï kduhlska tu wdh;kh 

;=< ,shdmÈxÑ l< hq;= fõ' ;j;a tjeks wdh;k lsysmhl fjí wvú my; ±lafõ'

1.	 www.godaddy.com
2.	 www.bluehost.com
3.	 ww.nic.lk

	 tjekakla Ndú; lr uQ,sl .dia;=jla f.jd ,shdmÈxÑ lsÍu jvd;a iqÿiq 

fõ' jd¾Isl .dia;=jla f.jd ,shdmÈxÑh w¨;a lsÍug isÿ fõ' we;eï úg fjí 

i;aldrlhd úiska u fuu ld¾hh isÿ lrkq ,efí' tfy;a miqld,Sk j Tfí fjí 

wvúh fjk;a fjí i;aldrlhl= ;=< .nvd lsÍfï wjYH;djla we;s jqjfyd;a tys 

,shdmÈxÑh ms<sn| .eg¨ u;= úh yel' tneúka m%ldYlhd úiska u fjí wvúh 

,shdmÈxÑ lsÍu jvd;a iqÿiq fõ'
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fjí wvúhla i|yd jiï kduhla f;dard .ekSfï § ie,lsh hq;= lreKq we;'

1'	 jiï kduh u.skaa fjí wvúh wh;a wdh;kh ms<sn| j fyda fjí wvúh ilia 

lsÍfï wruqK ms<sn| j y÷kajd§u iqÿiqhs' túg mßYS,lhkag" fijqï hka;% 
u.ska fjí wvúh fidhd .ekSu myiq fõ'

	 WodyrK ( www.nie.lk fjí ,smskfha mßYS,l jiï kduh jk —nie˜ ;=<ska  

	 fjí wvúh wh;a wdh;kh yÕjhs'

2'	 fjí wvúfha iajNdjh wkqj iqÿiq mßÈ  —.com˜" —.edu˜" —.org˜" —.lk˜ wdÈ by< 

uÜgfï jiï kdu iïnkaO l< yel' .lk hk jiï kduh ,nd .ekSu i|yd  

www.nic.lk hk fjí wvúfhka b,a¨ï lr ,nd .; hq;= h'

	 WodyrK ( www.wikipedia.org fjí ,smskfha by< uÜgfï jiï kduh 

	 ^Toplevel domain& jk—.org˜ u.ska th jd‚cuh fkdjk fjí wvú j¾.hg  

	 wh;a nj yÕjhs'

wdh;ksl Oqrdj,sh 

(Organizational hierarchy)
N+f.da,Sh Oqrdj,sh 

(Geographic hierarchy)

.(Root)

com edu uk fr pe sp jp cd gr ...milgov net ... ...

rEmh 5'42 - fjí ,smskhl jiï kdu

3'	 jiï kduh flá ùfuka mßYS,lhkag u;l ;nd.ekSug fuka u ksjerÈ j 

h;=re ,shkh lsÍug o myiq fõ'

4'	 jiï kduh ;=< b,lalï" hd bß jeks wlaIr fkdjk fjk;a wkq,laIK 

we;=<;a ùu iqÿiq fkd fõ' jdÑl j fjí ,smskh lsheùfï §" wikakd fj; th 

ksjerÈ j ikaksfõokh úh hq;= h'

WodyrK(

www.myweb2.org www.mywebtu.org

l%shdldrlu

	 www.nic.lk hk fjí wvúhg msúi .lk jiï kduh ,nd .ekSfï 

mshjr wOHhkh lrkak'
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5'3'3 Wvq.; lsÍfï uDÿldx. (File Transfer Protocol/FTP)

	 ks¾udKh lrk ,o fjí wvúh wod< wka;¾cd, iïuq;Skag wkqj" f;dard.;a 

fjí i;aldrlhd fj; Wvq.; lsÍug Ndú; lrk uDÿldx. fï kñka ye¢kafõ' 

fïjd ñ, § .ekSug fyda wka;¾cd,h Tiafia fkdñf,a nd.; lr.ekSug fyda yels 

h'

     WodyrK(  1. Filezilla (https://filezilla-project.org)
	              2. SmartFTP (https://www.smartftp.com)

	 fndfyda fjí ks¾udK fuj,ï ;=< fjí wvú Wvq.; lsÍfï myiqlï o 

mj;sk neúka fjk;a uDÿldx.hla wjYH fkdfõ' tfuka u yjq,a fjí i;aldrl 

fiajd imhk wdh;k o fjí wvú Wvq.; lsÍfï myiqlï imhhs'

5'3'4 wka;¾cd, iïnkaO;dj

	 fjí wvúhla m%ldYhg m;alsÍfï l%shdj,sh ;=< isÿ jk Wvq.; lsÍu" 

hdj;ald,Sk lsÍu iy ud¾..; m<lsÍï hk mshjr i|yd wka;¾cd, iïnkaO;djla 

w;HjYH fõ' .%dylhka iy fjí i;aldrlhd hd flfrk udOH jkafka wka;¾cd, 

iïnkaO;dj neúks'

	 wka;¾cd, iïnkaO;djla ,nd.ekSu i|yd iqÿiq wka;¾cd, fiajd imhk 

wdh;khla (Internet Service Provider) f;dard .; hq;= h' fuys § tu iïnkaO;dfõ 

fõ.h" .dia;=" kv;a;= fiajd hkdÈh ms<sn| j ie,ls,su;a fõ'

Y%S ,xldfõ jQ wka;¾cd, fiajd imhk wdh;k lsysmhla my; olajd we;'

1'	 Y%S ,xld fg,sfldï 

2'	 ,xld fn,a

3'	 fudìfg,a

4'	 vhf,d.a welaishdgd 

5'3'5 fjí wvú kv;a;=j

	 ksrka;r j kv;a;= lsÍu" fjí wvúhl id¾:l;ajh i|yd w;HjYH 

idOlhls' fuh wxY lsysmhla Tiafia úia;r l< yels h'

1'	 fjí wvúfha iajNdjh u; ffoksl j" i;sm;d fyda udisl j tys wka;¾.;h 

hdj;ald,Sk l< hq;= h' fuys § fjí wvúfha wvx.= lreKq muKla fkdj lreKq 

bÈßm;a lrk wdldrh" rEm" j¾K" yevh iy fjk;a jia;=j, o fjkialï l< 

hq;= h' fjí wvúfha uq,a msgqj ;=< kj mqj;a oelaùu i|yd fjka jQ ;Srejla 

mj;ajd .ekSfukaa ld,Sk fjkialï laI‚l j we;=<;a lsÍug myiq fõ'
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2'	 ffjria jeks wys;lr fla;" wkjir we;=¿ùï wdÈh ksid fjí wvúfha fodaI 

we;s úh yels h' tneúka ksrka;r wjOdkfhka isàu" jßka jr Wmia: fh§u 

iy iqÿiq wdrlaIl Wml%u fh§u l< hq;= h'  

3'	 fjí wvúh ks¾udKhg fhdod.;a uDÿldx.j, kj wkqjdo ksl=;a ù ;sfí kï ta 

wkqj fjí wvúh hdj;ald,Sk l< hq;= h' th fjí wvúfha wdrlaIdjg jeo.;a 

fõ'

l%shdldrlu

1'  iqÿiq mshjr wkq.ukh lrñka Tn lKavdhu úiska ks¾udKh lrk 

,o fjí wvúh m%ldYhg m;a lrkak'

	 fjí wvú ks¾udKh lsÍu iy ixj¾Okh lsÍfï l%shdj,sh my; wdldrhg 

idrdxY .; lr ±laúh yels h'

1&  ixl,amh

(The concept)

3&  jiï kduh

(Domain name)

2&  ks¾udKh iy 

ixj¾Okh

(design develop)

4&  i;aldrl 

lsÍu

(Hosting)5&  Wvq.; lsÍu

   (Upload)

6&  mÍlaId lsÍu

(Test)

7&  hdj;ald,Sk  

lsÍu iy 

kv;a;=-j

(Update and 
manage)

fjí wvú ks¾udK 

iy ixj¾Ok mshjr 

(Stages in web design 
and development) 

rEmh 5'43 - fjí wvú ks¾udKh lsÍu iy ixj¾Okh lsÍfï l%shdj,sh
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²² fjí wvú ks¾udKfha §" tu wjYH;dj,g iy fjí wvúfha .%dylhkag 

.e<fmk f,i iqÿiq wka;¾.;hla f;dardf.k th l%uj;a j ixúOdkh 

lsÍu" jHqyh yd msßie,iqula iys; j ks¾udKh lsÍu w;HjYH h'

²² ikaOdrfha iajNdjh u; iaÓ;sl yd .;sl f,i fjí wvú j¾. folls'

²² HTML hkq fjí wvú ks¾udKhg fhdod .kakd uQ,sl NdIdjhs' id¾:l 

fjí wvú ixialdrlfhl= ùug fuu NdId oekqu w;HjYH h' fuu.sska 

HTML fla; ,sùu myiq lrhs'

²² HTML NdId oekqula fkdue;sj jqj o fjí ixialdrl iy ikaOdr 

l<ukdlrK moaO;s hk uDÿldx. Ndú;fhka ir, fjí wvú ks¾udKh 

l< yels h'

²² ikaOdr l<ukdlrK moaO;s Ndú;fhka .;sl fjí wvú ks¾udKh l< 

yel'

²² ks¾udKh l< fjí wvúhla m%ldYhg m;a lsÍu i|yd iqÿiq fjí 

i;aldrlfhla" jiï kduhla" Wvq.; lsÍfï uDÿldx.hla f;dard.; hq;= h'

²² fjí wvúhl id¾:l;ajhg kv;a;= lsÍfï jev ms<sfj<la ;sìh hq;= h'

idrdxYh
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fuu mdvu yeoEÍfuka Tng"

²² úfkdaÞiajdoh i|yd f;dr;=re yd ikaksfõok ;dlaIKfha Þhl;ajh 

²² f;dr;=re ikaksfõok ;dlaIKh Ndú;fha § u;=jk ffk;sl yd 

iÞpdrd;aul .eg¨

²² f;dr;=re yd ikaksfõok ;dlaIK WmlrK Ndú;fha § u;=jk wdrlaIdj 

iïnkaO .eg¨j,g .; yels mQ¾fjdamdhka 

²² f;dr;=re yd ikaksfõok ;dlaIKh Ndú;hg wdfõ‚l fi!LH .eg¨ yd 

iudÔh .eg¨ 

		  hk lreKq ms<sn| ukd wjfndaOhla ,nd .ekSug yels jkq we;'

6'1  úfkdaodiajdoh i|yd f;dr;=re yd ikaksfõok 
       ;dlaIKh

	
	 wúfõlS Ôjk rgdjg wiajeis,a,la ,nd .kq ms‚i ñksid fkdfhla 

wdldrfha riú£ï Wmfhda.s lr .kshs' fï w;=ßka úfõlS wjia:djkays § Ñ;%mg 

keröug fndfyda wh reÑ lr;ss' mer‚ Ñ;%mg ksIamdokfha § w;aÿgq wvqmdvq 

u.yrjd .ksñka b;d Wiia .Kfha Ñ;%mg ks¾udKh lsÍug ksIamdoljreka iu;a 

ù we;af;a f;dr;=re yd ikaksfõok ;dlaIKfha mßKduh;a iu.ska ks¾udKh jQ 

fuj,ï iy Wml%u Ndú;fhks' ñka iuyrla fufia h'

 rEmh 6'1 - ;%sudk rEm ;dlaIKh

i).	 ;%sudk rEm ;dlaIKh ^3D - three-dimension& 
		  mer‚ Ñ;%mgj, olakg ,enqKq oaúudk 

rEm fjkqjg b;d Wiia ;dlaIKh fhdod 

.ksñka ksmojk Ñ;%mgj, we;s ;%sudk rEm 

;dlaIKh ksid Ñ;%mgj, iÔù nj j¾Okh 

ù we;' kùk ;dlaIKhg wkqj ksmojd we;s 

Wmeia hq., fhdod .ksñka krUkakdg  Ñ;%mg 

ri ú£ug i,id we;'

6
iudch iy f;dr;=re yd ikaksfõok 

;dlaIKh
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rEmh 6'2 - fydf,da.%e*sla m%;sìïn 
ieliSfï ;dlaIKh

ii).	fydf,da.%e*sla m%;sìïn ieliSfï ;dlaIKh        

^Holographic image processing technology& 
 		  fjk;a ia:dkhl rE.; lrk ,o 

rEmhl m%;sìïnh leurd ldph ;=< 

;ekam;a lr .ksñka th fjk;a o¾Yk 

;,hla u; oelaùu i|yd fuu ;dlaIKh 

fhdod .kq ,nhs' fndfydaúg w;sìysiqKq 

cjksld rE.; lsÍfï § fuu ;dlaIKh 

fhdod .efka'

rEmh 6'3 - ldgQka Ñ;%mg

iii).	 ldgQka Ñ;%mg - 

		  l=vd orejkaf.a fuka u jeäysáhkaf.a 

o m%sh;u wx.hla jk ldgQka Ñ;%mg b;d 

ckm%sh ù we;af;a fïjdfhys rEm ;%sudk 

f,i ^3D three-dimensional& ks¾udKh 

jk ksid;a ta i|yd fhdod .kakd uDÿldx. 

iy ;dlaIKfha ÈhqKqj ksid;a h'

rEmh 6'4 - wxls; Y%jH ixialrKh

iv).	 wxls; Y%jH ixialrKh - 

		  ix.S; ks¾udKfha § iy ixialrKfha § 

mß.Klh yd kùk uDÿldx. fhdod .ekSu 

j¾;udkfha olakg we;' .S; má.; lsÍu 

fuka u" úúO .S; ixfhda. lsÍu u.ska 

Y%djl ri úkaokh jeä lsÍu;a" kdo rgd 

ks¾udKh lsÍu i|yd;a kj;u uDÿldx. 

Ndú; lrkq ,nhs'

rEmh 6'5 - ksfjia rx. Yd,d moaO;s

		  tfia u fuu ksIamdok ixhqla; ;eá 

fhdod .ksñka myiq wdldrfhka .nvd lr 

;nd .ekSug o" wjYH jQ úfgl ksjfia isg 

u ksfjia rx. Yd,d moaO;s ^Home theatre 
system& ^rEmh 6'5& Ndú;fhka keröug 

fyda ijka §ug o yels ù we;'
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rEmh 6'6 - wxls; l%Svd

v).	wxls;$ixLHdxl l%Svd 

(Digital games)  -
		  j¾;udkfha § b;d 

u ckm%sh wx.h jkafka 

wxls;$ixLHdxl l%Svd h' 

mß.Klj, fyda cx.u 

ÿrl:kj, fyda ia:dmkh 

lrk ,o wxls;$ixLHdxl 

l%Svd fndfyda fofkla ;u 

úfkdaodiajdoh i|yd fhdod 

.ks;s' ;%sudk rEm ^3D& 

iy p;=¾udk rEm (4D) 
;dlaIKfhka ks¾udKh 

lrk ,o wxls;$ixLHdxl 

l%Svd j¾;udkfha fndfyda ckm%sh ù we;'

vi).	 iurEmK l%Svd (Simulation games) - 	
	  idudkH Ôú;fha § isÿ jk l%shd 

wkqidrfhka iajdNdúl mßirhla jHdc 

f,i ks¾udKh lr §u fuys § isÿ fõ'

		   fuh l%Svd mqyqKq lsÍï" úYaf,aIKh 

lsÍï fyda ie,iqï lsÍï i|yd fhdod .kq 

,nk w;r fï i|yd WodyrK f,i hqO 

mqyqKqùï" l%Svd iy N+ñld ksrEmKh oelaúh 

yels h'

rEmh 6'7 - iurEmK l%Svd
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 6'2  f;dr;=re yd ikaksfõok ;dlaIKh Ndú;fha § 	 
 	  we;s jk .eg¨

	 ñksidf.a tÈfkod Ôú;h myiq lsÍug w;HjYH fndfyda wx. ksmojñka 

ñksidf.a ióm;u ñ;=rd jkakg f;dr;=re yd ikaksfõok ;dlaIKhg yels jqj o 

th Ndú;fha § we;sjk .eg¨ fndfyduhlg uqyqK §ug fï jk úg ñksidg isÿù 

we;' fuu .eg¨ j¾. lsysmhlg fufia fnod oelaúh yels h' 

ffk;sl 

.eg¨

iÞpdrd;aul

 .eg¨

fN!;sl 

.eg¨

ydkslr 

uDÿldx. mßirhg jk 

ydks

fi!LH 

.eg¨

idudÔh

 .eg¨

f;dr;=re yd 

ikaksfõok 

;dlaIKh 

iy .eg¨

rEmh 6'8 - f;dr;=re yd ikaksfõok ;dlaIKh Ndú;fha § we;sjk .eg¨

fuu .eg¨ iy tajdg úi÷ï fudkjd oehs úia;rd;aul j fufia olsuq'

6'2'1	  ffk;sl .eg¨

rEmh 6'9 - o;a; fidrd .ekSu iy 

wkjirfhka msúiSu

i).	 fm!oa.,sl o;a; fidrd .ekSu - 

		  mqoa.,fhl=f.a wkkH;djh oelafjk 

f;dr;=re (PII-Personally Identifiable  
Information) mß.Klhlska fyda Wml%uhlska 

fyda fidrd .ekSu

Wod -  mqoa., kdu" ÿrl:k wxl PdhdrEm" wdÈ  

	 fm!oa.,sl f;dr;=re we;=<;a lr we;s  

	 mß.Kl u;l iefK,s" wxls; leurd  

	 fyda cx.u ÿrl:k fidrd .ekSu fyda  

	 tu f;dr;=re ryis.; j ,nd .ekSu

ii).	wkjirfhka mß.Kl moaO;sj,g msúiSu - 	    

  		  mß.Kl moaO;shlg fyda fjí wvúhlg fhdod we;s mßYS,l kduh iy 

uqrmoh fidrd .ksñka fyda Wml%uYS,S j ,nd .ksñka fyda wdh;ksl o;a; 

fidrlï lsÍu'
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iii).	 nqoaêuh foam< ‍fidrd .ekSu -

	 1' nqoaêuh foam<la hkq l=ula o@

	 mqoa.,fhl= fyda wdh;khla fyda úiska lrk ,o kj ks¾udKhla tkï 

ñka fmr  Ndú;fha fkdmej;s fyda ck;dj úiska oekqïj;a j fkd;snQ fyda kj 

ksIamdokhla fyda l%shdj,shla fyda nqoaêuh foam<la f,i ye¢kaúh yel' th 

mqoa.,hdf.a fyda wdh;kfha fyda ysñluls' th nqoaêuh foam<la f,i ie,fla' 

	 fuu nqoaêuh foam< fjk;a kduhlska bÈßm;a lsÍu" whs;slref.a wjirhlska 

f;dr j fjk;a ks¾udK i|yd fhdod .ekSu iy úlsŒu nqoaêuh foam< ‍fidrd 

.ekSu f,iska ye¢kafõ'

	 2' nqoaêuh foam<j, ffk;sl wdrlaIdj i|yd fmagkaÜ n,m;%hla ,nd  

	    .; yels h'

	 fmagkaÜ n,m;%hla hkq kj ksmehqï i|yd rch úiska m%odkh lrkq ,nk 

nqoaêuh foafmd< whs;sjdislï h' fmagkaÜ whs;sjdislu ,nd .ekSu i|yd wod< 

cd;sl ld¾hd,h fj; ksIamdolhd úiska b,a¨‍ïm;la bÈßm;a l< hq;= h'

iv).	jxpd - wka;¾cd,fha fyda ixhqla; ;eáhl m%ldYs;" mqoa.,fhl= i;= ,shú,s  

^nexl= wxl" w;aika&" l,d lD;s wdÈh msgm;a lsÍu fyda wkqlrKh lsÍu‍" úúO 

.kqfokq uqjdfjka mqoa.,hka rjgñka Tjqkaf.a Kh m;a ^Credit Card& u.ska 

uqo,a jxpd lsÍu

6'2'2  iodpdrd;aul .eg¨

rEmh 6'10 - ,sÅ; oE fidrlu

i).	 ,sÅ; oE fidrlu ^Plagiarism&  

		  ks¾udKlrejl=f.a woyia" rpkd fyda 

fjk;a ks¾udKhla msgm;a lr .ksñka 

Tyqf.a wjirhlska f;dr j th ;udf.a 

ks¾udKhla f,i bÈßm;a lsÍu ,sÅ; 

oE fidrlu fyj;a rpkd fidrlu kï 

fõ' wka;¾cd,h Ndú; lrñka o;a; iy 

f;dr;=re /ialrkakka fya;=fjka tys 

m%ldYs; rpkd wdÈh msgm;a lsÍu ‍ b;d 

nyq, f,i jHdma; ù we;'

		
	 fuu ks¾udK ioaNdjfhka Ndú; lsÍfuka rpkd fidrlu kj;d oeñh yels h'

ioaNdjfhka Ndú;h hkq ‍hï lsis mqoa.,fhl=f.a whs;sjdislula iys; ks¾udKhlska 

f;dr;=re ,nd .ekS‍fï § th Tyqf.a fm!oa.,sl;ajhg ydks fkdjk whqßka fhdod 

.ekSuhs' tkï"‍
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1'	 Wmqgd oelaùu ^Citing& - rplhdf.a fyda rplhkaf.a f;dr;=re i|yka lsÍu

2'	 f.k yer oelaùu ^Quoting& - msgm;a lr .kakd ,o fldgi WoaOD; mdGhla  

^ —……˜ & f,iska oelaùu

3'	 fhduqj oelaùu ^Referencing& - f;dr;=re ,nd.;a fjí msgq ,smskh rpkdj 

wjidkfha § i|yka lsÍu

	
6'2'3  fN!;sl .eg¨ iy ;d¾lsl .eg¨

	 mß.Kl Ndú;fha § tajd wdrlaIdldÍ j Ndú; fkdlsÍu u.ska fN!;sl iy 

;d¾lsl .eg¨ u;=fõ' tkï"

	 wkjYH úÿ,s úikaêùï u.ska mß.Kl fodaI we;sùu" fidr i;=re Wjÿre 

we;sùu" wka;¾cd,h u.ska wdl%uKh lrkq ,nk ydkslr uDÿldx. ksid mß.Kl 

cd, ì|jeàu" mdßißl idOl wdÈh fN!;sl .eg¨ hg;g .efka' uqrmo Ndú;fhka 

fm!oa.,sl mß.Kl fyda mß.Kl moaO;sj,g wkjir msúiqu" nqoaêuh foam< 

ysñlï W,a,x>kh wdÈh ;d¾lsl .eg¨ f,i ie,fla' 

f;dr;=re yd ikaksfõok ;dlaIKh Ndú;fha § we;s jk fN!;sl iy ;d¾lsl 

.eg¨j,ska wdrlaId jkafka flfia o@

¾¾ fN!;sl wdrlaIdj (Physical Security)

i).	 wkjr; n, iemhqu ^Uninterrupted Power Supply - UPS& -  

		  n,dfmdfrd;a;= fkdjQ úÿ,s úikaê ùul § mß.Kl moaO;shg iy 

f,aLkj,g isÿ jk ydksh j<lajd .ekSu i|yd wkjr; n, iemhqula yryd 

mß.Klhg úÿ,sh ,nd §u fhda.H fõ' fuys § wkjr; n, iemhqfuys we;s 

wdfrdamKh lrk ,o negßh u.ska úÿ,s úikaê ùul § fkdkj;ajd úÿ,sh 

n,h mß.Klh fj; ,nd fohs' ^rEmh 6'11&

rEmh 6'11 - wkjr; n, iemhqu ^UPS&

mß.Kl moaO;sh

UPS
m%Odk iemhqu
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ii).	oDV .sksmjqre ^Hardware firewalls& -
		  fjk u Wmdx.hla f,i ñ, § .; yels oDV .sksmjqre mq¿,a l,dm  

ud¾.lh ̂ broadband routers& ;=< olakg we;' fuh úfYaIfhka wka;¾cd,h yd 

iïnkaO jk mß.Kl moaO;shla msysgqjd .ekSfï § b;d jeo.;a fõ' fuu.ska  

wka;¾cd,fhka ,nd .kakd fyda ,nd fokq ,nk fuka u mß.Kl cd,hla ;=< 

yqjudre jk iEu f;dr;=rla u fmrkh lrkq ,nhs' Bg wÞ< uDÿldx. fuu 

Wmdx.h ;=< ia:dmkh lr we;' fuh wkjir msúiSïj,ska mß.Kl moaO;shla 

wdrlaId lrhs‍' ^rEmh 6'12&

rEmh 6'12 - oDV .sksmjqr ^Hardware firewalls&

o;a; neyer-

lsÍu 

o;a; ,nd 

.ekSu

.sks mjqr

wka;¾cd,h

rEmh 6'13 - fÞr.=¨ 

u.ska iSñ; msúiqu

fodr.=¿‍ u.ska iSñ; msúiqu - 

	 iEu úg u mß.Kl úoHd.drhla fodr.=¿‍ oud wdrlaId 

lr ;sîu jeo.;a h' ndysr mqoa.,hskaf.a msúiSu iSñ; lsÍu u.ska  

úoHd.drfhys we;s mß.Kl moaO;s iy wfkl=;a Wmdx.j,g o 

f;dr;=re i|yd o isÿ jk ydksh j<lajd .; yels h' ̂ rEmh 6'13&

rEmh 6'14 - ixjD; 

mßm: rEmjdysks

iii). ixjD; mßm: rEmjdyskS ^CCTV& - 

		  mß.Kl úoHd.drhl wdrlaIdj i|yd fhdod .kakd 

mß.Kl ixjD; mßm: rEmjdyskS Wmfhda.s lr tys lghq;= 

ndysßka ksÍlaIKh lsÍu fyda ojfia l%shd ùäfhda mghla 

f,i ;ekam;a lr ;nd miq j keröu fyda l< yels h' ̂ rEmh 

6'14& 

rEmh 6'15 - i¾ck wdrlaIl

iv).	i¾ck wdrlaIl 

	 ^Surge protector&  - 
		  mß.Kl úoHd.drhl we;s 

mß.Kl we;=¿ wfkl=;a úÿ,s 

Wmdx. i|yd iemfhk úÿ,s 

n,fhys fjda,aàh;dj md,kh 

lsÍu i|yd fhdod .kq ,nk 
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fuu WmlrK u.ska mß.Kl yd wfkla Wml%uj, wdrlaIdj ;yjqre fõ' 

ksjdi fyda ld¾hd, fyda i|yd iïu; fjda,aàh;d w.h jkafka fjda,aÜ 230 V 

ls' fuu m%udKh blaujd hdfukaa úÿ,s Wmdx. úkdY ùu i¾ck wdrlaIl u.ska 

md,kh lrkq ,nhs' ^rEmh 6'15&

 rEmh 6'16 - mdßißl idOl

v).	 mdßißl idOl  -

		  iajdNdúl mßirfha we;s idOl 

mß.Kl moaO;shl meje;aug n,mdhs' 

mß.Kl úoHd.drhla fyda fm!oa.,sl 

mß.Klhla fyda l=Kq" ÿyqú,s" f;;ukh 

wdÈfhka f;dr j mj;ajd .ekSfuka 

mß.Klhl meje;au wdrlaId lr .; 

yels h' ^rEmh 6'16&

¾¾ ;d¾lsl wdrlaIdj (Logical Security)

rEmh 6'17 - uqrmo 

i).	 uqrmo (Passwords)  - 
		  mß.Kl uDÿldx.j, iy ;ekam;a 

lr we;s f,aLkj, wdrlaIdj i|yd uqrmo 

Ndú; lrkq ,nhs' fuu.ska mß.Kl 

;=<g wkjir msúiSu iy Ndú; lsÍu 

md,kh l< yels h' ‍ uqrmohla fh§fï 

§ th wl=re" b,lalï" i,l=Kq wdÈfhys 

iïñY%Khla ùu u.ska ‍ uqrmofhys m%n, 

nj jeä fõ' ^rEmh 6'17&

 rEmh 6'18 - uDÿ .sksmjqre

ii).	uDÿ .sksmjqre (Software firewalls) -
		  mß.Kl cd,hl we;s mß.Kl 

u.ska wka;¾cd,hg msúiSfï § wkjir 

msúiqïlrejkaf.ka mß.Kl cd,h 

wdrlaId lr .ekSu i|yd uDÿ .sksmjqr  

m%fhdackj;a fõ' mß.Kl fufyhqï 

moaO;sfhys tla wx.hla jk uDÿ .sksmjqr 

iEu úg u il%sh lr ;eìh hq;= h'  

fuu.ska wka;¾cd,h Tiafia ,efnk 

ish¨ u m‚jqv mÍlaId flfrk w;r 

iel iys; m‚jqv wjysr lrkq ,eîu 

fuka u cd,hla ;=< we;s mß.Kl o 

ydkslr uDÿldx.j,ska wdrlaId lrkq 

,nhs' 
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rEmh 6'19 - wkqmsgm;a ^Backups&

iii). wkqmsgm;a (Backups) -
		  mß.Kl moaO;shl isÿ jk yÈis 

ì|jeàul § tys ;ekam;a lr we;s 

w;HjYH o;a; iy f;dr;=re úkdYùu o 

ks;e;ska isÿ fõ' tajd wdrlaId lr .ekSu 

i|yd tajdfhys wkqmsgm;a ;nd .ekSu l< 

hq;= h' fï i|yd ndysr oDV ;eá" ixhqla; 

;eá" ixLHdxl nyqúO ;eá" *a,EIa Odjlh" 

u;l ldâm;a wdÈh fhdod .; yels w;r" 

jvd;a  iqÿiq jkafka tu udOHhka ndysr 

fjk;a ia:dkhl wdrlaId iys; j ;eîu 

h' ^rEmh 6'19&

6'2'4  ydkslr uDÿldx.

rEmh 6'20 -  ydkslr uDÿldx.

	 mß.Kl moaO;shla Ndú; lsÍfï § úúOdldr 

;¾ck iy n,mEï we;sfõ' ydkslr uDÿldx. 

(Malicious software/Malware) tfia;a ke;skï 

ydkslr fla; ^Malicious codes& úiska mß.Klj,g 

‍iy mß.Kl cd,j,g lrkq ,nk ydksh b;d n,j;a 

h' tu ydksj,ska" iuyrla my; ±lafõ'

²² mß.Klfha ld¾hlaIu;dj wvq lsÍu" ^ksjerÈ 

f,i l%shd;aul fkdùu" wkjYH f,i kej; 

kej; mK .ekaùu ^Restart& 
²² mß.Kl uDÿldx. úkdY lsÍu iy wl¾uKH lsÍu

²² fjk;a uDÿldx. ia:dmkhg fkdyels ùu

²² mß.Kl oDVdx. wvmK lsÍu ^kuH ;eá Odjl wl¾uKH ùu" oDv ;eá 

l%shdúrys; ùu wdÈh&

²² mß.Kl cd, lvdlmam,a lsÍu

²² o;a; fidrlï lsÍu iy úkdY lsÍu

²² wkjYH f,aLk iy f.dkq tl;= lsÍu ksid oDV ;eáfhys Odß;dj wvq ùu 
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ydkslr uDÿldx. j¾. iy tajdhska isÿ jk ydksh

ydkslr uDÿldx. j¾. lsysmhla iy tAjdhska isÿjk ydks fufia ±laúh yels h'

ydkslr uDÿldx.h isÿjk ydksh

mß.Kl ffjri 

(Computer virus)
mß.Kl jevigykla yd iïnkaO fjñka ;udf.a msgm;a 

mß.Klh ;=< m;=rejk mß.Kl ffjri" cd, u.ska o" 

USB *a,EIa Odjl iy u;l ;eá jeks ndysr wdphk 

Wmdx. fyda úoHq;a ;eme,a weuqKqï u.ska o mß.Kl 

wdl%uKh lrhss' o;a;" uDÿldx. iy oDVdx.j,g ydks 

muqKqjk iEu ffjri j¾.hla u iïnkaO jkafka 

l%shdldÍ f,aLk ^Executable files& iu. h' tkï 

mß.Kl ffjrihla we;=¿ jQ úg th iEu úg u moaO;sh 

;=< il%sh j mj;S'

mß.Kl j¾ïia 

(Computer worms)
mß.Kl j¾ïia o ^Computer worms& ffjri yd iudk 

f,iska l%shdlrhs' kuq;a j¾ïiaj,g ;ks j u l%shd;aul 

ùfï iy me;sÍfï yelshdjla we;s w;r ta i|yd úoHq;a 

;eme,a weuqKqï" jHdc fjí wvú" laI‚l j u;= jk 

m‚úv rduq jeks mß.Kl uQ,sl iudc bxðfkare (Social 
engineering& Wml%u fhdod .kq ,efí'

T;a;=lrejka 

(Spyware)
fg%dacka wYajhd (Trojan Horse)
.%Slhska úiska fg%dahs rdcHh ‍‍ hg;a lr .ekSug  

fhdod.kq ,enQ ,Sfhka ;ekQ wYajhd ksoiqka lr .ksñka 

kï lrk ,o fg%dacka wYajhd hkq ;j;a ydkslr uDÿldx.

hls' wjHdc njla fmkakqï lrk kuq;a ydkslr uDÿldx.

hla jk fuh mßYS,lhd fkdoekqj;a j u moaO;shg 

iïnkaO ‍fjhs' wkjYH f,i újD; jk mß.Kl ljq¿ 

iy fjkia jk jev;, ̂ Desktops& we;slrñka o" f,aLk 

uld ouñka iy ‍ o;a; fidrlï lrñka o mßYS,lhd 

wmyiqjg m;a lrk fg%dacka ‍wfkl=;a ydkslr uDÿldx. 

mß.Klhg we;=¿ùu i|yd myiqlï i,ihs' úoHq;a 

;eme,a weuqKqï újD; lsÍfuka iy wka;¾cd,h Tiafia 

nd.; lrkq ,nk f.dkq iu. mß.Klh wdl%uKh 

lrkq ,nk fg%dacka wYajhd mß.Kl ffjri yd j¾ïia 

fuka fndaùu isÿ fkd lrhs'
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wkjYH oekaùï 

^Adware&
wkjYH oekaùï mß.Kl ;srh u; o¾Ykh lsÍu fuu 

ydkslr uDÿldx.fha iajNdjhhs' tu oekaùï Wmfhda.s 

lrf.k jd‚cH f;dr;=re ,ndfohs' wkjYH  oekaùï 

mß.Kl ffjri fuka ydksodhl fkdjQj;a mßYS,lhd 

udkisl jYfhka mSvdjg m;alrhs'

fndÜia

(Bots)
frdfndÜ ̂ Robot& hk kdufhka Wlyd .kq ,nk fndÜia 

^Bots& hkq wfkl=;a cd, iu. iïnkaO;d ;nd.kakd 

iajhxl%Sh j l%shd;aul jk ydkslr uDÿldx.hls' ‍laI‚l 

m‚jqv iy wka;¾cd, ixjdo u.ska ‍fm!oa.,sl f;dr;=re 

/ia lr.ekSu i|yd fndÜia  fhdod .efka'

fld,a,lrejd 

(Hijacker/  Browser 
hijacker)

fjf<|" jd‚cHh iy fjf<| m%pdr lghq;= i|yd 

ks¾udKh lrk ,o fld,a,lrejd úiska mßYS,lhd 

wka;¾cd,h yd iïnkaO jk wjia:dfõ § Tyq fkdu. 

hjñka fjk;a fjí msgq ‍ fj; tu iïnkaO;dj fhduq 

lrkq ,nhs' fuh weâfjhd ;¾ckh yd iudk fõ'

*sIska ^Phishing& *sIska m%ydr hkq mßYS,lhka rjgd Tjqkaf.a nexl= .sKqï 

fyda úoHq;a .sKqï wdÈfhys f;dr;=re ,nd .ekSuhs' 

fï i|yd úoHq;a ,sms fhdod .efkhs' fuu ,sms m%isoaO  

iud.ula fyda ñ;%fhl=f.a kdufhka mßYS,lhd fj; 

tjkq ,nk w;r fjk;a fjí wvúhlg hdu i|yd 

iïnkaOlhla ^link& o tjkq ,efí' tu iïnkaOlh 

la,sla lsÍfuka fyda úia;r m;%sld msrùfuka ,nd .kakd 

f;dr;=re mßYS,lhkaf.a uqo,a iy jeo.;a f;dr;=re 

fidrlï lsÍug Ndú; flf¾'

wdhdÑ; ;emE, 

^Spam&

wkjirfhka ,efnk úoHq;a ;eme,a" wdhdÑ; ;emE, 

f,i ye¢kafõ' fïjd fndfyda úg NdKav i|yd jQ 

fjf<| oekaùï fyda fkdy÷kk wfhl=‍ úiska tjk ,o 

úoHq;a ;emE,la o úh yels h' fï fya;=fjka ;eme,a 

.sKqï msÍhdu ksid mßYS,lhd wmyiq;d‍jg m;aúh yels 

h' tfia u mqoa.,hskaf.a úoHq;a ,smsk jxpd iy.; j ,nd 

.ksñka fkdfhl=;a uqo,a jxpd i|yd fm<Uùug tjkq 

,nk úoHq;a ;eme,a o" wdhdÑ; ;emE, fõ'

ydkslr uDÿldx.hkaf.ka mß.Klhla iy mß.Kl cd,hla wdrlaId lr.ekSu

²² mß.Klhg ffjria wdrlaIl uDÿldx.hla ia:dmkh lr .kak' th ksis mßÈ 

hdj;ald,Sk lrkak' tys wdrlaIl Wml%u ^Guard/Shield/Auto scan/Update& 
iEu úg u újD; j ;nkak'
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²² ndysr wdphk Wml%u ^USB u;l& ;u mß.Klhg iïnkaO lsÍfï § m%fõYï 

jkak' th ffjria wdrlaIl uDÿldx.hla u.ska mÍlaId lr.kak' 

²² iEu úg u kS;Hkql+, jQ uDÿldx. mß.Klhg ia:dmkh lrkak'

²² idudkH Ndú;h i|yd mßmd,l .sKqu ^Administrator account& fjkqjg 

idudkH mßYS,l .sKqula ^User account& fhdod .kak'

mß.Klh wka;¾cd,hg iïnkaO lr we;akï"

²² wdrlaIs; fjí wvú i|yd msúfikak' tys kS;Hkql+, nj taldldr iïm;a 

ksYapdhlh (URL) mÍlaId lsÍfuka oek .; yels h'

²² uDÿldx. fyda fjk;a nd.; lsÍï i|yd wdrlaIs; fjì wvú muKla u f;dard 

.kak'

²² nd.; lsÍug fmr tu f,aLh fyda uDÿldx.h ffjri wdrlaIl uDÿldx.hla 

u.ska mÍlaId lr.kak' 

²² úoHq;a ;eme,a weuqKqï újD; lsÍfï § iqmÍlaIdldÍ jkak' tu weuqKqï nd.; 

lsÍug wjYH kï Bg fmr wdrlaIl uDÿldx.hla u.ska mÍlaId lr.kak' iel 

iys; úoHq;a ;eme,a újD; lsÍu fyda weuqKqïj, we;s iïnkaO;d ^link& la,sla 

lsÍfuka j<lskak'

²² iel iys; oekaùï fyda m‚úv fyda la,sla lsÍfuka j<lskak'

²² ;ukaf.a ryis.; f;dr;=re" wdrlaIdj mÍlaId lsÍfuka f;dr j fjí wvú 

i|yd we;=¿ fkd lrkak'

²² .sks mjqr$iq/l=ï mjqr ^Firewall&" ffjri wdrlaIl uDÿldx. ^Virus guards&"  
úoHq;a ;eme,a fmrk ^email filters& Ndú; lsÍfuka wjodku wvqlr .; yels h'

ydkslr uDÿldx.j,ska wdrlaIdùu i|yd mß.Klh ia:dmkh l< yels m%p,s; 

ffjria wdrlaIl uDÿldx. lsysmhla my;ska oelafõ'

²² Kaspersky Antivirus 
²² Panda Cloud Antivirus [ B ]
²² Microsoft Security Essentials 
²² Norton Antivirus 
²² BitDefender Antivirus 
²² McAfee Antivirus 

²² Avira Antivirus 
²² Avast Antivirus AVG Antivirus 
²² K7 Antivirus 
²² Digital Defender Antivirus 
²² Norman Antivirus 

m%;sldrhg jvd j<lajd .ekSu kqjKe;s l%shdjls æ
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1'	 by; olajd we;s ffjria wdrlaIl uDÿldx. fuka u fjk;a ffjria 

wdrlaIl uDÿldx. lsysmhla wka;¾cd,fhka fidhd ,ehsia;= .; 

lrkak' tajdfha ksIamdok wdh;k iy ksIamdÈ; j¾I ms<sn| j úia;r 

.fõIKh lr j.= .; lrkak'

l%shdldrlu

wka;¾cd," f;dr;=re yqjudrej i|yd Y%S ,xldj ;=< wdrlaIdj imhk wdh;k

	 fï jk úg wka;¾cd,h ;=<ska o;a; iy f;dr;=re ,nd fkd.kakd whl= 

fyda wdh;khla fydA fkdue;s ;rï h' f,dalh mqrd u iudc cd," .sKqï fjí wvú" 

fjí úi÷ïj,g wkjirfhka we;=¿ ù tajdg yd tajdfha ysñlrejkag ydks isÿ 

lsÍu miq.sh jir lsysmh ;=< jeä ù we;' Y%S ,xldfõ o tjka isÿùï nyq, j jd¾;d 

ù we;' tuksid fuu wka;¾cd, lghq;= i|yd wdrlaIdj imhk wdh;k wjYH ù 

we;' fuu wdrlaIdj ihsn¾ wdrlaIdj f,i y÷kajkq ,nhs'

	 ihsn¾ wdrlaIdj b-fï,a" wka;¾cd, úi÷ï" fjí wvú yd iudc cd,j,g 

muKla iSud fkd fõ'  th ;u mß.Kl cd, yd mß.Kl fufyhqï moaO;sj,g o 

wod< fõ' ihsn¾ wdrlaIdj imhk wdh;k lsysmhla fufia h'

²² Y%S ,xld yÈis mß.Kl iQodkï ixioh ^Institution for Information Security of 
Sri Lanka&

	 ICTA wdh;kh ^Information and Communication Technology Agency 
u.ska msysgqjk ,o tu ixioh úiska fkdfhl=;a wdldrfha md¾Yajhkag fiajd 

imhkq ,efí' tkï"

°	 mqrjeishkg 

°	 jHdmdßl wdh;kj,g

°	 rdcH wdh;kj,g
	

²² ICTA wdh;kh" Y%S ,xld m%ñ;s wdh;kh yd Y%S ,xld yÈis mß.Kl iQodkï 

ixioh ^Sri Lanka Computer Emergency Readiness Team - CERT) tla j rdcH 

wdh;k i|yd ‍f;dr;=re wdrlaIK l<ukdlrK moaO;s ^Information Security 
Management System - ISMS& iy;sl ,nd §fï lghq;= wrUd we;' mqoa.,hka yd 

wdh;k tu jevigyk i|yd ,shdmÈxÑ ùfuka f;dr;=re wdrlaIKh iqrlaIs; 

lr .; yels h'

1'	 my; olajd we;s fjí wvú fj; msúfikak' tu fjí wvú weiqfrka 

Tng ,nd .; yels mß.Kl wdY%s; fiajd ,ehsia;= .; lrkak'

http://www.gov.lk/web/
   http://www.engage.icta.lk

    https://www.techcert.lk/si/

l%shdldrlu
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6'2'5  f;dr;=re yd ikaksfõok ;dlaIKh Ndú;hg wdfõ‚l 
	   fi!LH .eg¨

²² iqfLdamfhda.S nj ^Ergonomics& iy fi!LH .eg¨

	 iqfLdamfhda.S nj fkdfyd;a Y%ulaIu;d úoHdj ^Ergonomics& hkq .%Sl jpk 

foll tl;=jlska iEÿKq ;ks jpkhls' .%Sl NdIdjg wkqj ˜‍ergon"˜‍ hkq /lshdj 

fyda ld¾hhhs‍' ˜‍nomos˜‍ hkq kS;shhs' fuys ir, f;areu jkafka"

—/lshdjla ks¾udKh l< hq;af;a Y%ñlhdg .e<fmk wdldrhg nj;a Y%ñlhd  

/lshdj i|yd yev.eiSug n, fkdl< hq;= nj;a"  tfia fkdue;s jQ úg Y%ñlhd 

fkdfhl=;a wd;;Ska iy frda.dndOj,g f.dÿreùu fkdje<elaúh yels˜ nj;a h'

	 wo jk úg ;dlaIKh ñksidg w;HjYH wx.hla ù we;s w;r ;dlaIKh 

yd ñksid ‍fjka l< fkdyels f,i tlsfkl yd iïnkaO ù we;' ;dlaIKh Ndú; 

lrkakka Èfkka Èk j¾Okh jkjd fia u ;dlaIKh ksid we;s jk fi!LH .eg¨ 

o ta yd iudk j j¾Okh ù we;' fuu ;;a;ajh we;s jkafka idudkH mß.Kl 

Ndú;fhka f;dr j meh 4lg jeä ld,hla fkdkj;ajd mß.Klh Ndú; lsÍu 

ksid h' tu fi!LH .eg¨ fudkjd oehs fufia úuid n,uq'

rEmh 6'21 - udxifmaYs iy 

wiaÓ wdY%s; .eg¨

i)	 udxYfmaYS iy wiaÓ wdY%s; .eg¨ 

	 ^Musculoskeletal problems& 
		  fkdkj;ajd mß.Klh Ndú;h ksid YÍrfha 

úúO ia:dkhkays udxi fmaYsj, iy wiaÒj, 

fõokd we;sùu iq,n h' óg m%Odk u fya;= idOlh 

jkafka mß.Klh Ndú; lsÍfï § jerÈ bßhõfjka 

isàuhs' ^rEmh 6'21&

  

rEmh 6'22 - mqk¾j¾;S wd;;s 

mSvdj ^RSI&

 ii)    mqk¾j¾;S wd;;s mSvdj 

    ^RSI - Repetitive Stress Injury& 
		  Wrysfia isg wf;a weÕs,s olajd we;s jk 

fõokdj mqk¾j¾;S wd;;s mSvdj f,iska ye¢kafõ' 

tu ia:dkj, bÈuqu" ;o .;sh" fõokdj we;s fõ' 

uQislh i|yd w;a, tyd fuyd lsÍug wmyiq nj 

fuys ,laIKhls' ksjerÈ bßhjq wkq.ukh fkd 

lsÍu fuhg fya;=jhs' ^rEmh 6'22& 
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rEmh 6'23 - ldm, fodakd 

iy,laIKh ^CTS&

iii)                                 ldm, fodakd iy,laIKh 

	  ^CTS - Carpel Tunnel Syndrome&  
		  wf;a weÕs,sj, we;s jk ysßjeàu iy fõokdj 

ldm, fodakd iy,laIKh f,i ye¢kafõ' ue‚lalgqj 

wdY%s; j we;s jk f;rmSu ksid fuu fõokdj we;s fõ' 

uQislh yd h;=remqjrej ksjerÈ‍ wdldrfhka mdúÉÑ fkd 

lsÍu;a ia:dk .; fkdlsÍu;a fuhg fya;= fõ' ^rEmh 

6'23&

rEmh 6'24 - mß.Kl oDIaá 

iy,laIKh ^CVS)

       iv)	         mß.Kl oDIaá iy,laIKh 

	  ^CVS/Computer Vision Syndrome&  
		  fkdlvjd meh 6la 7 w;r ld,hla 

mß.Klfha we,S .e,S isàu fya;=fjka 

weiaj, we;s jk wdid;añl;d" mß.Kl oDIaá 

iy,laIKh ^CVS& f,i ye¢kafõ' weia 

úh<Su" r;= ùu" l÷¿ .e,Su" fmkqu wvqùu" 

ysfia fyda fn,af,a lelal=u fuu oDIaá 

.eg¨fjys iajNdjhhs' ^rEmh 6'24&

rEmh 6'25 - ysfia lelal=u

v)	  ysfia lelal=u ^Headache& 
		  fn,af,ys udxi fmaYSkaf.a wd;;sh iy 

weiaj, we;s jk fjfyildÍ nj ksid we;s 

jk ysfia lelal=u mß.Kl Ndú; lrkakka 

;=< nyq, j olakg ,efí' ^rEmh 6'25&

rEmh 6'26 - wd;;sh

vi).	 wd;;sh ^Stress& 
		  ÈhqKq jk ;dlaIKfha n,mEu ksid we;s 

ù ;sfnk ld¾h nyq, nj iy /lshd jgmsgdj 

wd;;shg fya;= idOl fõ' kskao fkdhdu" 

fjfyildÍ nj" wdydr wreÑh wd;;sfha 

m%;sM, lsysmhls' ^rEmh 6'26&
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fi!LH .eg¨ u.yrjd .ekSu

	 ksjerÈ bßhõj ^Correct posture& - fuh iqfLdamfhda.S nj fkdfyd;a 

Y%ulaIu;d úoHdfjys ^Ergonomics& i|yka jk jeo.;a wx.hls'

 	 mß.Klh Ndú; lsÍfï § ksjerÈ bßhõjlska wiqka .ekSfuka fndfyda 

fi!LH .eg¨ u.yrjd .; yels h' tkï"

rEmh 6'27 - ksjerÈ bßhõj

1

3
5

4

2 }
1'	 mß.Kl ;srh ;udf.a weia uÜgug fyda Bg jvd my;ska fyda msysgk fia 

mß.Kl mqgqj iy fïih yev .iajd .ekSu

2'	 mß.Kl ;srh iy weia w;r mr;rh wÕ,a 18-28 ^fi'ñ 45-70& muK ùu

3'	 mqgq wekaog fya;a;= jk fia msg fldkao fl<sska ;nd Wrysi ieye,a¨‍fjka 

;eîu

4'	 ll=,a fmdf<djg ,ïnl j o m;=,a fmd‍f<dj u; o ieye,a¨‍fjka ;nd 

.ekSu

5'	 uQislh h;=re mqjrej wdikakfha ;nd .ekSu" ieye,a¨‍fjka h;=re,shkh 

lsÍu" ue‚la lgqj tla ia:dkhl isrlr fkd isàu"  h;=re mqjrej je,ñgg 

fl<ska fyda Bg my;ska fyda ia:dk .; lsÍu wdÈ ksjerÈ bßhjq wkq.ukh 

lsÍu o"

²² weig fjfyildÍ fkdjk fia mß.Kl ;srfhys wdf,dalh ilia lr .ekSu

²² úáka úg ;srfhka msg; ne,Su iy weismsh .eiSu
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²² ld¾hh w;r;=r § flá úfõl .ekSu iy flá ÿr weú§u

²² orejkayg mß.Kl l%Svd i|yd ld,h fjkalr §u" Tjqka ndysr l%Svd i|yd 

fhduq lsÍu'

²² meh 7-8 olajd ld,hla mß.Kl iu. l%shdlrk jeäysáhka ksjfia § 

mß.Klh Ndú;fhka je<lS isàu iy uki ieye,a¨‍fjka ;nd .ekSu

	 jeks l%shdldrlï fh§u o u.ska mß.Kl wdY%s; fi!LH .eg¨ fndfyda ÿrg 

u.yrjd .; yels h'

 

6'2'6  bf,lafg%dksla wmøjH - ydkslr uQ,øjH yd tu.ska   
	  mßirhg jk ydks

	 mß.Kl" rEmjdyskS" cx.u ÿrl;k" uqøK hka;% wdÈ úÿ,sfhka fyda 

negßfhka fyda l%shdlrk fkdfhl=;a bf,lafg%dksl ksIamdok tAjdfha l%shdldÍ" 

m%fhdackj;a ld,h wjika jQ úg tAjd bf,lafg%dksl wmøjH f,i i,lkq ,efí' 

^rEmh 6'28&

h;=re mqjre" uQisl 

iy wfkl=;a 

bf,lafg%dksl 

Wmdx.

iqmÍlaIl 

iy uqøK 

hka;%

mß.Kl ;sr iy 

fm!oa.,sl mß.Kl 

Yío Wmdx.

bf,lafg%dksl 

wmøjH

cx.u 

ÿrl:k
CFL n,an

rEmjdyskS 

hka;%

rEmh 6'28 - bf,lafg%dksla wmøjH

	 fkdfhl=;a ydkslr uQ,øjHhkaf.ka ksIamdokh lrkq ,enQ fuu ksIamdok 

ld,h wjidkfha § wksis f,i neyer lsÍu ksid ñksidg fuka u mßirhg o isÿ 

ù we;s ydksh w;suy;a h' mßirh wmú;% ùfï §  tys wys;lr n,mEug f.dÿre 

jkafka ñksid u h' 	
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wlaudj

iu

fmky¨

fud<h

	 le,sli, iu. bj; oukq ,nk CFL n,an ̂ ix.Dys; m%;s§ma; wdf,dal úÿ,s 

myka& ukqIH fi!LHhg wys;lr f,i n,mdk riÈh mßirhg tla lrhs'	

riÈh wdYs%; frda. iy tAjdfha n,mEu  

²² iakdhq moaO;sh wvmKùu

²² fud<fha ffi,j,g ydksùu

²² ifï wid;añl;d

²² riÈh wdYajdi lsÍfuka uOH iakdhq moaO;sh

²² jl=.vq iy wlaudj hkdÈhg ydks meñŒu

²² DNA (Deoxyribonucleic Acid) iy lafrdufidauj,g ydksùu

	 tfia u wfkl=;a bf,lafg%dksl wmøjH wl%uj;a f,i neyer lsÍu ksid 

we;s jk frda.dndO w;r YÍrh bÈuqu iys; oeú,a," Tlaldrh" wd;;sh" yDojdysks 

wdndO" DNA ydksh iy ms<sld ‍je,£u wdÈh mj;S'

tjeks ydkslr uQ,øjH lsysmhla kï" 

wd¾iksla (Arsenic)" fíßhï (Barium)" fnß,shï (Beryllium)" leâñhï (Cadmium)"  
lafrdañhï (Chromium)" vfhdlaiska (Dioxins)" Bhï (Lead)" riÈh (Mercury)" 
fi,Skshï (Selenium) wdÈhhs'

bf,lafg%dksl wmøjH wdrlaIdldÍ j neyer lsÍu
 

1'	 Ndú;h wvq lsÍu Reduce - oekg m%fhdackhg .kakd bf,lafg%dksl WmlrK 

ksis wdldrfhka kv;a;= lsÍu iy iïmdokh lsÍu ;=<ska wkjYH wdldrfhka 

ñ, § .ekSï wvq lr .ekSu

2'	 kej; m%fhdackhg .ekSu Reuse - mer‚ kuq;a l%shdldÍ ;;a;ajfha we;s 

bf,lafg%dksl WmlrK úkdY fkdfldg mß;Hd. lsÍu fyda úlsŒu

3'	 m%;spl%SlrKh Recycle - w¨;ajeähd l< fkdyels WmlrK m%;spl%SlrKh 

lrkq ,nk wdh;khla fj; fhduq lsÍu
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1'	 uOHu mßir wêldßfha fjí wvúhg msúi bf,lafg%dksl wmøjH 

neyer lsÍug f.k we;s mshjr y÷kd .kak'

2'	 Y%S ,xldj ;=< § bf,lafg%dksl wmøjH wdrlaIdldÍ j neyer lsÍu 

i|yd Wmldr jk www.ewaste.lk wdh;kfha fjí msgqj fj; 

msúfikak' tu wdh;kh u.ska iem‍fhk fiajd iy tajd ,nd .kakd 

wdldrh ms<sn| j f;dr;=re /ialr fmd;a msxpla ilia lrkak'

l%shdldrlu

6'2'7 f;dr;=re yd ikaksfõok ;dlaIKh Ndú;hg wdfõ‚l 
	 iudÔh .eg¨

rEmh 6'30 - wxls; fnÿu 

^digital divide& 

ys;j;a lu,a" 
Tnf.a iqjÿla
flfiao@''''''''''''''''''''''''''

i).	 wxls; fnÿu ^Digital divide&  - 
		  f;dr;=re yd ikaksfõok ;dlaIKh 

Ndú; lsÍug we;s myiqlu iy yelshdj" 

yeisrùfï yelshdj iy ta ms<sn| j we;s 

oekqu ñksid wd¾Ól jYfhka yd iudÔh 

jYfhka tlsfkld fjka lrkq ,nhs' fuh 

wxls; fnÿu f,iska ye¢kafõ' ^rEmh 6'30&

	 wxls; fnÿug fya;= idOl ^rEmh 6'31& 

lsysmhla fufia oelaúh yels h'

²² W.;alu

²² ;dlaI‚l yelshdj iy oekqu-

we;slu

²² fmdfydi;alu

²² ld¾ñl jQ nj

²² kd.ßl Ôú;h

²² kQ.;alu

²² ;dlaI‚l yelshdj iy oekqu 

fkdue;slu

²² ÿmam;alu

²² ld¾ñl fkdjQ nj

²² .ïno Ôú;h

rEmh 6'31 - wxls; fnÿug fya;= idOl
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²² W.;alu$kQ.;alu - f;dr;=re yd ikaksfõok ;dlaIKfha fhÿï iy tajdfhys 

M, m%fhdack fudkjd oehs okakd nj iy fkdokakd nj ñksiqka w;r ÿria nj 

we;s lrhs' 

²² ;dlaI‚l yelshdj" oekqu we;slu$fkdue;slu - ‍ f;dr;=re yd ikaksfõok 

;dlaIKh Ndú; lsÍug yelshdjla we;s ta ms<sn| oekqu ,nd .;a ñksiqka o lsis 

u wdldrfha oekqula fkdue;s ñksiqka o w;r tlsfkld yd iïnkaO;d we;s 

fkd fõ' 

²² fmdfydi;alu$ÿmam;alu - f;dr;=re yd ikaksfõok ;dlaIKh yeoEÍug 

wjYH jqj o" tys fhÿï Ndú; lsÍug wjYH jqj o ta i|yd wjYH msßjeh oeÍug 

fkdyels ùu wxls; fn§ug ;j;a fya;=jls'

²² ld¾ñl jQ nj$ld¾ñl fkdjQ nj - rgla ld¾ólrKh ùu f;dr;=re yd 

ikaksfõok ;dlaIK fhÿï Ndú; ùug tla fya;=jls' tfia fkdjQ l, rglska 

rglg ‍wxls; fn§u olakg ,efí'

²² kd.ßl Ôú;h$.ïno Ôú;h - kd.ßl j Ôj;a jk ñksid b;d ld¾h nyq, 

h' TjqyQ f;dr;=re yd ikaksfõok ;dlaIKfha fhÿï fndfyda f,i fhdod 

.ks;s' kuq;a b;d ir," ksoyia mßirhl Ôj;a jk .ïno ñksid ‍f;dr;=re yd 

ikaksfõok ;dlaIKfha fhojqï ms<sn| j ie,ls,a,la fkd olajhs' fï ksid 

ñksiqka w;r wxls; fnÿula we;s ù ;sfí' 

ii).	wxls; fia;=j ^Digital bridge& - 
		  wxls; fnÿu ÿr,ñka ñksiqka w;r we;s lrkq ,nk ne£u wxls; fia;=j f,i 

ye¢kafõ' ieug u mß.Klhla fyda cx.u ÿrl:khla fyda ,nd §fuka wxls; 

fia;=jla we;s l< fkd yel' ñksid úúO ;dlaI‚l Wmdx. i;= lr.kakjd 

fuka u tajd ksjerÈ f,i Ndú; lsÍug o" tajd ms<sn| j oekqïj;a ùu o" tajd 

i;= lr.ekSfï Wkkaÿj o wjYH fõ' tfia fkdue;skï ;dlaIKh jákdlula 

fkdue;s fohla jkjdg ielhla ke;' 

wxls; fia;=j we;s lrkafka flfia o"

rEmh 6'32 - wxls; fia;=j ^Digital Bridge&
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²² wxls; idlaIr;dj ^Digital literacy& ms<sn| j wjOdkh fhduq lsÍu -  f;dr;=re 

yd ikaksfõok ;dlaIKh ms<sn| j ñksid ,nd.kakd oekqu" wxls; fn§u 

ÿrelsÍug bjy,afõ' úod;d uOHia:dk" keKi, uOHia:dk" mß.Kl iïm;a 

uOHia:dk jeks fkdñf,a iy b;d wvq uqo,lg wxls; idlaIr;dj ,nd fokq 

,nk ia:dk úúO m%foaYj, we;s lsÍu yd ta i|yd iyNd.s;ajh j¾Okh lsÍu 

i|yd cx.u m%pdrh" w;a m;%sld fnod §u" fmdaiag¾ m%o¾Ykh lsÍu wdÈh fhdod 

.ekSu

wxls; idlaIr;dj (Digital literacy) we;s lsÍfuka ñksidg ,eìh yels jdis

°	 f;dr;=re yd ikaksfõok ;dlaI‚l fhojqï Ndú; lsÍfï wjYH;dj 

f;areï .ekSu iy ta ms<sn|‍ j Wkkaÿjla we;s ùu 

°	 f;dr;=re yd ikaksfõok ;dlaI‚l fhÿï Ndú; lsÍfï § we;sjk .eg¨ 

fndfyda ÿrg ksrdlrKh lr .ekSfï yelshdj

°	 ì,am;a f.ùu" wOHdmk f;dr;=re .fõIKh yd /ia lsÍu" ffjoH f;dr;=re 

wkdjrKh" orejkaf.a wOHdmksl f;dr;=re ,nd .ekSu i|yd Wojq lr 

.ekSu" /lshd i|yd b,a¨‍ï lsÍu wdÈ lghq;= wka;¾cd,h Ndú; lsÍfuka 

b;d myiq nj jgyd .ekSu

²² mß.Kl ,nd §u - wxls; idlaIr;dj wxls; fia;=jg wä;d,u jk l,ays" b;d 

iykodhS ñ,g mß.Kl ,nd §fï jHdmD;shla wdrïN lsÍfuka tys Yla;sh 

;j;a j¾Okh l< yels h' fuh wxls; idlaIr;dj ,nd.ekSu i|yd iyNd.s 

jkakka‍yg fuka u mjqf,a wfkl=;a idudðlhkag o m%fhdackj;a fõ'

²² wfkl=;a uQ,H ndOl bj;a lsÍu iy iu wjia:d - ieug fkdñf,a fyda b;d wvq 

uqo,lg fyda wka;¾cd, myiqlï ,nd .ekSfï yelshdjla we;s lsÍu iy ta i|yd 

we;s ndOd bj;a lsÍu iy tA u.ska ore oeßhkaf.a wOHdmk lghq;= i|yd wjYH 

f;dr;=re /ialr .ekSu" ud¾..; ÿria: wOHdmkhg yelshdjla we;s lsÍu"  

/lshd i|yd mq¿,a wjia:d ,eîu" fjf<|‍fmd< ;;a;ajh wOHhkh" iudc cd, 

Tiafia f;dr;=re yqjudre lsÍu wdÈ wjYH;d /ila bgq lr .; yels h'

²² w;rueÈhkaf.a iyNd.s;ajh - fkdfhl=;a yjq,a jHdmdr" m%cd ixúOdk" ‍rdcH 

fuka u fm!oa.,sl wdh;khkaf.a iyNd.s;ajh fuka u wdOdr iy wkq.%yh o 

wxls; fia;=j id¾:l lr .ekSu i|yd b;d jeo.;a fõ'

1'	 Y%S ,xld rch úiska wxls; fnÿu ^Digital divide& ÿrelrñka wxls; 

fia;=j ̂ Digital bridge& we;s lsÍu i|yd f.k we;s l%shdud¾. fudkjd 

oehs fidhd j.= .; lrkak'

l%shdldrlu
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iii).	 yiqre l=i,;d wfydais ùu (De-skilling)

rEmh 6'33 - yiqre l=i,;d wfydais ùu ^De-skilling&

	 yiqre l=i,;d wfydais ùu ̂ rEmh 6'33& f;dr;=re yd ikaksfõok ;dlaIKfha 

;j;a w;=re m%;sM,hls' /lshd kshqla;slhka ish oyilf.a /lshd wjia:d wysñ 

lrñka kj;u hka;%iQ;% Tjqkaf.a ia:dkh meyerf.k we;' l<ukdldß;ajh 

iy yeisrùu myiq jqj o fndfyda l=i,;djkaf.ka fyì mqoa.,hska /ila fï 

jk úg wirK ù we;' mqoa.,hska iy wdh;k i;= m%dfhda.sl oekqu fhdod  

fkd.ekSu" wOHdmkhg we;s bvlv wysñ ùu iy meyer yeÍu wdÈh iajhxl%ShlrKfha 

iuyrla wjdis fõ' fï i|yd WodyrK lsysmhla kï"

²² l¾udka;j, hka;% iQ;% u.ska ñksia Y%uh iy yelshdjkaf.a ia:dkh ysñ 

lr .ekSu

²² bf,lafg%dksl fmd;am;a iy iÕrd fya;=fjka mqia;ld, jeiS hdu iy ta 

wdY%s; /lshd wysñ ùu

²² ud¾..; bf.kSï iy wka;¾cd, f;dr;=re ,nd .ekSfï myiqj ksid 

.=rejrekaf.a wjYH;dj wvq ùu

²² ksj‍fia isg u fi!LH ;;a;ajh mÍlaId lr .ekSfï yelshdj ksid  

mÍlaIKd.dr lghq;= yd iïnkaO /lshd wysñ ùu

 ;dlaIKfhka ire /lshd wjia:d

rEmh 6'34 - ;dlaIKfhka ire /lshd 

wjia:djka

	 ;dlaIKh ksid fkdfhl=;a wdldrfhka 

/lshd wjia:d ^rEmh 6'34& wysñ jk nj 

wms by; § bf.k .;suq' kuq;a fï jk úg 

;dlaIKh ñksidf.a Ôú;hg ke;s j u neß 

wx.hla njg m;a j we;' óg m%Odk u fya;=j 

ù we;af;a ‍f;dr;=re yd ikaksfõok ;dlaIK 

oekqqu we;s ñksidg ,nd.; yels ire /lshd 

wjia:d h'
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	 f;dr;=re yd ikaksfõok ;dlaIK oekqu iy th yeisrùfï ukd m,mqreoao 

we;s mqoa.,hska i|yd‍ f;dr;=re yd ikaksfõok ;dlaIKh yd iïnkaO b;d by< 

jegqma ysñ ire /lshd wjia:d lsysmhla fufia oelaúh yels h' óg wu;r j f;dr;=re 

yd ikaksfõok ;dlaIKh yd iïnkaO ;j;a fndfyda /lshd wjia:d we;'

²² mß.Kl l%uf,aLl (Computer Programmer)
²² mß.Kl moaO;s úYaf,aIl (Computer/Information System Analyst)
²² o;a; ikaksfõok úYaf,aIl (Data Communication Analyst) 
²² o;a; iuqodh l%uf,aLl iy úYaf,aIl (Database Programmer and Analyst)
²² mß.Kl fhojqï iydhl (Desktop/Application Support Specialist)
²² cx.u ÿrl:k uDÿldx. ks¾udKlrejka (Mobile Application Developer)
²² cd,lrK iy moaO;s wdrlaIl úfYaI{ (Network and System Security 

Specialist)
²² cd, l,ukdldr iy mßmd,l (Network Managers and Administrator)
²² uDÿldx. bxðfkare (Software Engineer) 
²² ;dlaIK fjf<| úfYaI{ (Technical Sales Specialist)
²² ;dlaIK mqyqKqlre (Technical Trainer)
²² úÿ,s ikafoaY l,ukdlre (Telecom Manager)
²² úÿ,s ikafoaY cd, ia:dml (Telecommunication Line Installer)
²² fjí wvú ks¾udKlrejka (Website Developers)

	 fï w;=ßka Y%S ,xldj ;=< fuka u fjk;a rgj, o uDÿldx. bxðfkarejreka 

i|yd b,a¨‍u b;d úYd, h' fï jk úg fuu /lshdj wm rgg úfoaY úksuh f.k 

tkq ,nk m%Odk /lshdjla ù we;af;a ta i|yd f.jkq ,nk b;d by< jegqma ksid 

h' tneúka mß.Kl uDÿldx. ks¾udKh ms<sn| j fuka u ‍f;dr;=re yd ikaksfõok 

;dlaIK iïnkaO Wiia wOHdmkh ,nd .ekSfuka ire /lshd wjia:djlg Tng o 

ysñlï ,eìh yels‍ h'

6'7'8  f;dr;=re yd ikaksfõok ;dlaIKh iudc úfrdaë f,i  
	  Ndú;h

i) iudc fjí wvú ^Social Media&

rEmh 6'35 

	 f,dj kka foi Ôj;ajk mqoa.,hka w;r 

wka;¾ iïnkaO;dj we;s lr .ekSug;a" fmdÿ 

wNsreÖka we;s mqoa.,hkaf.a woyia yqjudrejg 

bv ie,iSug;a" iqyo;d we;s lsÍug;a" fm!oa.,sl 

woyia t<s oelaùug;a yels jk f;da;ekakla 

f,i iudc fjí wvú ye¢kaúh yels h'  

fuu.ska Tng isÿ jk fiajd lsysmhla fufia 

oelaúh yels h'
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²² ,dNodhS f,i ;u ksIamdok wf,úlrKh lr .ekSu i|yd iudc fjí wvú 

m%fhdackhg .; yels h'

²² íf,d.aia (Blogs) - fjí f,d.a (Web logs) hkafkys flá fhÿu jk  

íf,d.aia (Blogs) hkq ud¾. .; fm!oa.,sl Èk igykla fyda iÕrdjls' fuu 

iudc fjí wvúh ks¾udKh lr we;af;a mqoa.,hkag ;u ;ukaf.a ffoksl 

w;aoelSï fyda iudcfha isÿ jk wlghq;=lï bÈßm;a lsÍug hs' tajd lshjd 

fjk;a whf.a woyia oelaùu l< yels h'

²² wka;¾cd,h Ndú; lrkq ,nk mqoa.,hska ;udf.a fjí wvúhg" ksIamdok 

m%j¾Ok fjí msgqjg fyda íf,d.aia msgqj fj; fhduq lsÍu iudc cd, u.ska 

isÿjk ;j;a fiajdjls'

²² ixjdo uKavm (Forum) fkdfyd;a ud¾. .; ixjdo uKavm f*darï f,iska 

ye¢kafõ' mqoa.,hkaf.a fmdÿ woyia újD; j f.kyer oelaùug ixjdo uKavm 

iqÿiq ia:dkhls' fuh iudc fjí wvú u.ska ,nd fok ;j;a fiajdjls'

²² f,dj kka foi Ôj;a jk mqoa.,hka tl;= lsÍug;a" Tjqkaf.a woyia yqjudre 

lr .ekSug;a" ys; ñ;=rka yd iqyo ixjdofha fh§ug;a" rEm" ùäfhda mg" .S; 

yqjudre lr .ekSug;a iudc fjí wvú ksid b;d myiq ù ;sfí'

ii) ihsn¾ wmrdO ^Cyber crime&

	 iudc fjí wvú whq;= f,i Ndú; lsÍu ksid tajd iudchg ms<s,hla ù we;' 

fuh ihsn¾ wmrdOh fkdfyd;a ysxikh f,i ye¢kafõ' 

tjka ihsn¾ wmrdO lsysmhla my; ±lafõ'

²² wkjirfhka mqoa.,hkaf.a PdhdrEm wka;¾cd,hg uqod yeÍu 
²² ldka;djkaf.a fyda ;re‚hkaf.A fkd.e<fmk PdhdrEm fyda ùäfhda mg 

wkjirfhka wka;¾cd,hg uqod yeÍu iy tajd Wmfhda.s lr .ksñka Tjqka ìh 

jeoa§u" ;¾ckh lsÍu fyda lmamï .ekSug fm<öu

²² mqoa.,hkaf.a lS¾;s kduhg ydks jk wdldrfha m%jD;a;s m%pdrh lsÍu

²² mqoa.,hka fkdu. heùu i|yd jHdc f;dr;=re iy PdhdrEm wka;¾cd,fha 

m<lsÍu iy fm!oa.,sl;ajhg ydks meñKùu

²² jHdc f;dr;=re Ndú; lrñka mqoa.,hka rjgd wksis iïnkaO;d we;s lr 

.ekSug iudc cd, fhdod .ekSu u.ska mqoa., Ôú; úkdY ùu

²² l+g Wml%u Wmfhda.s lr .ksñka fm!oa.,sl .sKqï fj; msúi fm!oa.,sl 

f;dr;=re fidrd .ekSu 
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iudc cd, Ndú;fha § m%fõiï jkafka flfia o@

²² wka;¾cd, lghq;= i|yd iudc cd, f;dard .ekSfï § m%fõiï jkak'

²² iudc cd, u.ska ñ;=rka f;dard .ekSfï § m%fõiï jkak'

²² iudc cd,hla fj; m%ldY lrkq ,nk fm!oa.,sl f;dr;=re ms<sn| j ie,ls,su;a 

jkak'

²² iel iys; úoHq;a ;eme,a újD; lsÍfuka j<lskak'

²² úoHq;a ;emEf,ys we;s iel iys; wka;¾-iïnkaO;d (links) la,sla lsÍfuka 

j<lskak'

²² ks¾kdñl úoHq;a ;eme,a úYajdi fkd lrkak'

²² úoHq;a ;eme,a ,smsk fmd; (email address book) mÍlaId lsÍu i|yd iudc cd, 

fj; wjir fkd fokak'

²² fm!oa.,sl úoHq;a ;emE, u.sska iudc cd, fj; msúiSu fkd lrkak' tys ,smskh 

w;ßlaiqfõ ^browser& h;=re ,shkh lr ta i|yd msúiSu lrkak'

²² iudc cd, u.ska ,nd fokq ,nk wu;r fhojqï mß.Klfha ia:dmkh lsÍfuka 

j<lskak'

²² iudc cd,hla Ndú; lsÍug fmr fojrla is;kak'

²² iudc cd, iy tys w;=re M, ms<sn| j l=vd orejka iy hy¿jka oekqïj;a 

lrkak'

²² ú‍fkdaodiajdoh i|yd úúOdldrfhka ;dlaIKh fhdod .efka'

²² f;dr;=re yd ikaksfõok ;dlaIKh Ndú;fha § we;s jk .eg¨ lsysmhls' 

tkï"

	 ffk;sl .eg¨" iodpdrd;aul .eg¨" fN!;sl .eg¨" ydkslr uDÿldx. 

    mdßißl .eg¨" fi!LH .eg¨ yd idudÔh .eg¨ fõ'

²² fmagkaÜ n,m;%h nqoaêuh foamf<ys ffk;sl wdrlaIdj ;yjqre lrhs'

²² fN!;sl wdrlaIdj i|yd wkjr; n, iemhqu" oDV .sksmjqre" ixjD; mßm: 

rEmjdyskS" fodr.=¿‍ u.ska iSñ; msúiqu" i¾ck wdrlaIl fhdod .; yels h'

²² ;d¾lsl wdrlaIdj i|yd uqrmo fh§u" uDÿ .sksmjqre il%sh lsÍu" wkqmsgm;a 

;nd .ekSu isÿ l< yels h'

²² ydkslr uDÿldx. ke;skï ydkslr fla; úiska mß.Kl ‍iy mß.Kl cd, 

úkdY lrkq ,nhs'

idrdxYh
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²² mß.Kl ffjri" mß.Kl j¾ïia" T;a;=lrejka" fndÜia" fld,a,lrejd" *sIska 

wdhdÑ; ;emE, ‍hkqfjka ydkslr uDÿldx. we;‍'

²² ydkslr uDÿldx.j,ska wdrlaId ùu i|yd ffjria wdrlaIl uDÿldx. fhdod 

.kq ,nhs'

²² ksjerÈ bßhjq wkq.ukh lsÍfuka fi!LH .eg¨ wju lr .; yels h'

²² bf,lafg%dksla wmøjH‍ ksishdldr j neyer fkdlsÍfuka mßirhg ydks isÿ‍ 

fõ'

²² wxls; fnÿu f;dr;=re yd ikaksfõok ;dlaIKh ksid we;s jk idudÔh 

.eg¨jls'

²² wxls; fia;=j u.ska tu .eg¨ u. yrjd .; yels h'

²² yiqre l=i,;d wfydais ùu f;dr;=re yd ikaksfõok ;dlaIKfha ;j;a w;=re 

m%;sM,hls'

²² ‍f;dr;=re yd ikaksfõok ;dlaIK oekqu we;s ñksidg ,nd .; yels ire  

/lshd wjia:d fndfyda h'

²² iudc cd, iqmßlaIdldÍ f,i Ndú;fhka iudc cd, u.ska isÿjk iudc 

úfrdaë l%shd wju lr .; yels h'
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